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1 Introduction

Auditbase is an integrated information system for hearing clinics. The system seeks to integrate
all the working operations of a hearing clinic and to collect in one database all data concerning
clients, hearing instruments, administration, etc.

The Auditbase system has been designed as a Microsoft Windows based client-server complex
program for application in PC based networks.

Auditbase consists of a number of modules, which reflect the various working operations at a
hearing Audiology clinic.

An Auditbase system uses an SQL database in which all the data is saved. Using an SQL
standard provides the use of a range of standard tools to query information from the database.
For an outline of the database tables and their columns, please consult the technical help.

The SQL database and the Auditbase design provide the facility to link with other databases
and systems as is the case with a number of Auditbase versions.

Auditbase is also integrated with the Noah Framework for office systems platform by means of
the Noah4Auditbase subsystem. It means that you can run a variety of Noah fitting and
measurement modules and store the resulting data in the Noah database. For more
information about Noah, please visit the HIMSA website. For more information about
Noah4Auditbase please refer to the Noah4 Auditbase subsystem topic.

To facilitate the work with clients and their records in the database, Auditbase supports
recognition of data read by magnetic card scanner attached to the computer. Reading a client's
personal number by barcode scanner is also supported. In Stock, barcode scanners can be
used to read and process device barcodes.

The Auditbase system modules have all been provided with on-line help. To activate this
function, press F1, Shift+F1, or select Help in the menu.

To search for and retrieve a client in the system from anywhere in the system, press F3, fill in
the search criteria and select from the list of clients matching the criteria.

Client quick search (that is, search by personal number) is accessible by pressing Ctrl+F3.

Documentation

From the Help menu in Auditbase, you can access the most recent user guide and change
guides concerning different areas in Auditbase that have changed significantly since Auditbase
version 4.15.xx.

© Auditdata - 2022, ID: 20.0040/29 1
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2 Clients and Client information

Click the button below to access our training materials.

Client registration and client information is managed from the Client information module.

A client must be registered in the client module before you can work with the client in the other
modules.

© Auditdata - 2022, ID: 20.0040/29
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2.1 General information

General client information is listed to the left. It contains a primary identification code, usually
labelled Hospital no. or Case no. and a secondary identification code usually labelled as NHS
no. The formats of the identifier codes i.e., what types of characters can be used at what
position, the maximum length and any hyphenation or space characters that can be entered for
new patients’ are set by the System Administrator. The visible lengths of the fields can be set
larger to view historical or imported patients. Other fields shown include Title (which is a drop-
down list that can be edited by the System Administrator or you can type in individual values),
name, Address, GP, Date of birth, Age (years and months for under-fives), phone numbers,
Email, Location and Department that the client is most associated with and more. Unlike
other date fields in the application, which all activate a calendar on right click, the Date of
birth field brings up an edit dialog on right click. You must highlight the field first and then the
date can be copied to paste elsewhere. The Date of Birth is expected to be entered by
keyboard rather than calendar.

« Last name (Surname) is always a mandatory field to complete. In addition, First name,
Extra name and Birth date can be made mandatory via the Administration tool.

) Auditbase - [Client information] - m] x
L] Client <T>T11001 MASTER FIRSTNAME1001 LASTNAME1C ~ = H|user SYSTEM ADMINISTRATOR Alllocations ¥ All departments - ¢ ?

File Edit View Functions Settings

c%\c?i.:%) @ ‘OFT'Ea == -@ @b -’% CO'U {U

Detailed | Quick MNew | Save | Systeminfo Print | Printlsbel Importdata | Exportdsta | ExporttoMosh Logoff | Exit Auditbase
Search Client Print Import/Export Client data Exit

favigation hew Save Delete || Search || Label EditID PASupdate £

- Favourites
&5, Referral Hospitalno. ~ T11001 NHS no Contacts | Details | ListsiPhoto | Devices | Implant Paedialric | PPP

B4 Booking
i-gf=] Documents and attachments Tite MASTER e Additional professional contacts Add Rem

aiting list S | LS THANE 10 K _[Type [Mame | Address |Postcode [Phone | Email [Information | GP Code | City | Fax| Prac
AB Audiogram Firstname FIRSTNAME1001 [0 GeneADAM|123STR makkr|
NOAH module selection

E Extra name 12
i/ Attention list

L3 NOAH session browser Address 993000000 00001241110
KHOHKK KK 1111
200000011

Individual client K001

.5, Client information Postcode PC.4642 City

{1 FEETELE Gender Male - User + USER NAMES -

g Joumal Date of bith ~ 27/03/2000 Age 19 Date of death < ?

-] Documents and attachments < v K: Local keyworker

Alert ~  PASalert

f‘ Referral . LEUETT Relatives and other contacts Add E Delete

2 Clients entries Home phone 99999 9999991 Mobile phone

2 Device list wark e P_[cc[Relationship [Name Address |Postcode |Home phone | Mabile phone |Work phon

[ obsenvations and procedures orkpnone. | 1 ECEELDES Father 1 1 1 1 1 1

3 Earmoulds Email Postand email* O |0 Mather 123|123 1 4 2 3

-';\.lj Hearing Therapist Customer 5K3 SWINDON PCT -

-[1] Medical history - Sovamei S

55 Directreferral HA (adull) ocation Alllocations - epartment 2 Depariment2 -

L)) Tinnitus: Doctor GP * DR ROWLANDSON

4/ Surgery DoctorENT  MISS SE CHALSTREY, CONSULTANT ENT SURGEON, GREAT W

[:1] HI satisfaction Questionnaire —— 114d
EHE Measurements il status i b4
E-[i] Questionnaires Signif other 213 P: Priority contact. CC: Send copy of letters
B[] Tests Transport 312 Relative's information
-G Implant 4

Information XX CGCCOCO0000000 XK J0O0000122121

w'ﬂ Run external application

Individual client

Client pathway view
Clinic management
Stock management

User tasks

I 5diED 15 53 Do

PPP list

o
k-
-
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You can set an alert for the patient that is distinct from a PAS alert; both are displayed. If an
alert is set, the client’s name changes colour to red in the tool bar and you can see which alerts
are associated with the patient by hovering your mouse over the patient name in the tool bar.

G:‘:l Auditbasze - [Chent information]

L] Client <T=T11001 MASTER FIRSTNAME1001 LASTNMIF'IE1E - > Bl|user SYSTEM ADMINISTRATOI
File Edit View Functions Settings
Alert 'Transport’ is set for client
o o O ) e 7
ame and a Fess.
Q| £ N d add -» Z]
Detailed | Cuick MNew Save MASTER FIRSTMNAMETD0T LASTNAMET001 |data | Export data | Export to Moat
G0 H0COCO0 )0G01241110
Search Client | XCCGGCCC0O1TN Import/Export Client data

— XK1
Navigation W00 belete | Search || Label
B Favourites PC:4642

o Referral

] Hospital no.: T11001 NHS no.

E Sl NHS no.: - R -

-LIF] Documents and attachments

--F- Waiting list Phone, home: 99999 9999991 ME1001

AB Audiogram Phone, work: 11 ALE1001

-3 NOAH module selection Date of birthe 27/03/2000

A\ Aftention list =t e

SMS Appointment Reminder consent
Sending SMS appointment reminders to clients is a licensable extra within Auditbase.

For a client to receive an SMS reminder, the client’s mobile phone number must be recorded in
their Client Information.

If the Consent to SMS box shows on the Client information page and the patient consents to
SMS reminders, record their mobile phone number in the Mobile phone field and check
Consent to SMS. If the patient does not consent to SMS reminders, do not check the box.

Home phone

Work phone ||

Mobile phone | 077 ¥55566589

| B Consentto SMS

If the No consent to SMS box shows on the Client information page and the patient does not
consent to SMS reminders, check the No consent to SMS box. Leaving the No consent to SMS
box unchecked implies consent has been given.

Home phone Mobile phone | 0777 5556589 |

Work phone B Mo consentto SM3

SMS will be sent to all patients with appointments configured for SMS. Should the SMS facility
stop working for a period, it will check back upon re-start and send up to two reminders to
those clients that were missed because of the close down but will not send more than one per
patient on any day.

Viewing SMS notifications for a particular client
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If SMS Appointment Reminder is licensed, then the date and time of any SMS appointment
reminders sent will be shown in the two columns called SMS1 and SMS2 on the Client’s
entries dialog. This can be found in two ways. In Navigation-> Booking -> Functions ->
Client’s entries or in Navigation-> Client’s entries.

Client's appointments and waiting lists >
Client MRS FIRSTNAME106 LASTNAME106 Close
Appointments list- 393 item(s) History of changes Attached actions Delete from history Sho apptboo
Date | Time |L0c:.| Dep1.| Appt. |Status|Resource Reason Declined offer ]
28M2/2018 | 08:00 b *  |Alan A
28M2/2018 | 08:00 ¥ * | Charlie A
28M2/2018 | 08:00 b *  |Res70 A
101212018 1230 & * Charlie | ++GP direct referral Sh
10M2/2018 12:00 E| * Alan ++GP direct referral PE
05/07/2018 | 10:00 1 * | Trawy 1
04/07/2018 | 12:00 & * | Travy SA
230062018 11:00| 2 | 2 E] * | Stassy Pk w
4 >
Waiting list entries - 13 item(s) Add E = waiting lis
Wait time Date | Waiting list Information ~
-275 03H0/2013 |z SAVERNAKE-OLD DO NOT USE OR DELETE (Aud ass) + 1231231
-324 01M10/2013 | ZTGW - PAED HEARING AID CLINIC 3 333333333
-292 09/04/2014 |TGW -FOLLOWUP 3 testinfo Az
-271 27M0/2014 | TGW - CALORICS & POSITIOMALS - PP 41@#5%"8> 7\ abcdefgsdf
-258 271012014 | TIDWORTH - review 3 abcdefgsdf
-253 05/03/2015 |TGW - DOMI new 1 123123123
20 TAMAMNAE TAl O L MAR LI 2 A v

Email

Having entered the clients email address, select the clients preferred method of receiving
letters and documents. Use the browser button next to the email address to select from the
variations of post or email. If the site default option is used it will be starred with an asterisk.

Email jany@com.com Only postt El ETHNICTTY

Site default (Only post, ignore email address)
Customer UNKNOWN PCT ~ . .

Only post, ignere email address
Location All locations - Depariment Al depariments -

Post and email if email is available

Doctor GP DRALALLIK, 123 STR, SOME CITY ABC 1234 CITY . . - .
Only emall, post if email is not available

Dactor ENT MRS AMMAN, 222 STR, HOME CITY

Be aware: Please ensure the e-mail address is correct; entering an incorrect e-mail can cause
sending the client's data to a wrong addressee.

Delete client
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A client can be deleted from the database in two ways; either a recoverable delete or a
permanent delete. These are extended rights which have to be assigned to the Auditbase user
for them to be able to perform this function. The recoverable delete right and the permanent
delete right are now separate from each other.

To delete a client from the database that can be recovered, click the Delete button. The user is
warned that carrying out this action cannot be undone.

o Pressing Yes to this security question of deleting disables future handling of that client.

o Pressing No ends deleting session without erasing client information.

« Recovering deleted clients can be done by the system administrator in the System
Administration tool.

To delete a client that is permanent and cannot be recovered, select Permanent delete from
the drop-down menu on the Delete button or select Edit -> Delete client -> Permanent
delete.

A warning message appears, advising you that this is a permanent function and cannot be
undone. You have the option to Preserve Gender and Year of birth only for research
purposes.

Client information X

:/-'\II Warning! The "Permanent delete’ function is irreversible,
il,-‘l/l you will not be able to recover the client data.
Are you sure you want to continue?

Preserve Gender and ear of birth

Yes Mo

« Select Yes to permanently delete the client or No to cancel the deletion. The client will
then be permanently deleted from the database and cannot be recovered.

Client labels
You can create and print a client label for a client.

Press Label from Client information.

« The Label window opens with a predefined label text containing the client’s name,
address, postcode and city.

« You can edit this text.

« Click Print to print the label. Note that a label printer must be specified by the system
administrator.

Edit ID

To edit the ID fields on an existing client in the database, click the Edit ID button. This will
open a dialog where you can change the ID.
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To change either of the IDs, click Change to and enter the new ID value or check for a
temporary ID to be generated.

A ‘Verification’ status of ‘Verified’ can be set by Users, or set by PAS, on either the Primary or
Secondary Identifier Code. These settings are enabled in the system administration.

To set the client’s code as verified, open the Edit ID dialog from the Client Information screen
and choose a verification status from the dropdown list. The Verification status will be set with
the User, date, and time of the verification. The verification status can be removed by choosing
the empty line in the dropdown list and clicking Save.

Edit ID *

Zancel

Hospital no. | MHS no.

Current value T4110

Verification
Status -

ser

Diate

The Verification status will be shown on the System Information dialog for the Client, available
from the File menu.

PAS update

If PAS link is set up, this function updates the demographic data for the selected client.

A Please ensure that the client is the same as requested before saving.

System information

This window presents technical system information about a selected client. To open the
window, select File -> System information from Client information.

The user who created the client in the database and the creation time is shown in Record
creation.
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The user who last edited the client and the time for the modification is shown in Last record
modification.

ID (Internal system client identifier) and GUID (Global Unique ldentifier are shown in Record
identification keys. GUID can be copied to the clipboard by clicking Copy.

Customers

o Select Settings -> Customer from the Client information module. This will open a
window where the customer's name, address, invoice address, contact person, customer
number (max. 9 characters), etc. can be defined.

« Before entering details click on New. The name of the Customer can be entered and the
Priority can be set. Auditbase uses this priority to list the customers. If no priority is set,
the customers are listed alphabetically.

« A Customer code can be set; this can be up to 10 symbols in length. Please note that a
customer code can be mandatory if configured in the Administration tool.

« The Address and Invoicing address (if not the same) are entered in the appropriate
boxes as well as the Contact person and their Telephone no.

« From the drop-down list, select the default payment account for the customer. If the
customer is included in a customer group, select the group from drop-down list.

« Click Save to save customer information to the database.

« Editing the customer data is done by highlighting the fields with the saved information,
altering this information and pressing Save.

Click Delete to delete a defined customer from the database. Note that the system does not
allow deleting a customer which is referenced elsewhere in the system. If a customer is no
longer in use as the requirements have changed then it is now possible to outdate the
customer within System Administration.
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2.2 Tabs

The tabs on the right, Contact, Details, Devices and Visit charge, contain further information
related to the client including contact information for relatives and professionals, condition,
client’s ethnicity and possible need for an interpreter, privately granted aids, notes, and other
site specific information. Depending on licensing you will also see a PPP and Implant tabs -
please see chapters on PPP, Client Information, and on Auditory Implant Module, Auditory
Implant Module and Client Information Screen.

To set a tab as the default tab, go to View -> Default information tab and select which tab you
would like as the default tab. The selected tab will be the default tab when entering Auditbase
and when changing client.

The layout of the Client Information module can be modified from the Administration tool (via
Client module settings and/or User specific options) in a way that some or all of the following
tabs can be hidden from view: Contacts, Lists (Trials)/Photo, Devices, Implant, Paediatric, PPP
or Record history.

o Details is a mandatory tab and will appear in any layout.

2.2.1 Contacts

From the tab Contacts you can Add, Edit or Delete professional or personal contacts of the
client. These can be used when making correspondence.

Contacts | Details | Lists/Photo | Devices Implant | Visitcharge Paediatric | PPP 4 »

Additional professional contacts Add Remove

K| Type| Name| Address Postcode| Phone| Email| Information| GP Code| City| Fax| Practice
[/ Gené DRAA 3 VALE Al PC:6376 olepus 3453544 K84074
[ Otha| AMANL MERCHI PC:3523

< >
K: Local keyworker
Relatives and other contacts Add Ed Delete
F'|CC|Relationsh\p|Name|Address‘F'ostcode Home phone|Mobile phone| Work phone| Er
[C [ | Father MR AL Universit

=[] | Mother MRS B Universit

< >

P: Priority contact. CC: Send copy of letters

Relative's information
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When adding or editing a Relative and other contact, you can select that contacts preferred
method of receiving letters or documents. Select from the various post and email options.
Relatives can be updated by a PAS interface if this has been set up by the System
Administrator. Relatives that have been created manually may be removed by a PAS interface if
they are not included in a PAS interface message.

When adding a professional contact, such as a teacher or consultant, you either search on part
of the name through all the referring agents in Auditbase or add a new referring agent. One of
the professional contacts can be marked as the local keyworker, shown as a check under the

K column. A professional contact can automatically be added as a recipient of a specific letter

in the Letter dialog from the Booking module.

When adding a personal contact, such as parent or legal representative, you click Add to enter
the details you have been given. A personal contact, unlike the professional contacts, will only
be added for the selected client, so you cannot re-use these for other clients.

One of the personal contacts can be set as the priority contact, shown as a check under the P
column. If you try to set a second contact as the priority contact, you will be prompted to either
keep the existing priority contact or update the priority contact to the currently selected
contact. You may also set any number of contacts as copy to, shown as a check in the CC
column, so that they can be included on letters by default.

When designing a letter, you can list all contacts that have been marked as CC and all other
contacts chosen as recipients by using the variable List of recipients under Letter specific
information.

2.2.2 Details

Under the tab Details, you will find an array of extra information about the client such as which
condition the client is in (physical, visual and attitude), the ethnic category the client belongs
to and whether or not the client requires an interpreter, special aids and forms and other site
specific information which is configurable by your System Administrator.

Irrelevant information can be hidden via the Administration tool. Thus, any of the following
fields can be excluded from the tab layout:

o Referral outcome

« Ethnic category
Special aids and forms
Other invoice receiver
Travelling distance
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Contacts | Details | Lists/Photo | Devices | Implant | Visit charge  Paediatric | BFP <4 »

Alerts Add Remove Parameters Add
Code|Name|User|Date| Name|User|Date|
Current referral outcome 30a, Treatment commenced, 29/03/2010 Stopped

Condition Ethnic category -
A Interpreter required

Physical -

Attitude

Video appointments accepted
Site specific information Special aids and forms
ETHNICITY Tinnitus analysis
h Direct referral

TEACHER OF HEARING IMPAIRED

EDUCATIONAL SETTING

COMNDITION / SYNDROME

Latest PAS update

Other invoice receiver

Travelling distance (one way) On laptop

You can also set multiple alerts and parameters for the patient. The specific alerts and
parameters are set up by your System Administrator. The user responsible for setting the alert
is recorded in the details tab as well as the date that it was added on. This is as well as a
record of the user who set the alert being added to the Security Log in the System
Administration tool.

The System Administrator can also enable an Auto Journal Event (1490: Client Alert Removed)
that will trigger a record to be created in the Journal specifying the User who removed the
Client Alert and the time the Alert was removed.

If a client is marked as Deceased, users will be prevented from making appointments or
referrals for the client or adding the client to any waiting lists. You can still make a Treatment
summary for the client but you will be warned beforehand that the client is marked as
deceased.

The time when a deceased alert is set, and by which resource, is registered in the system’s
security log, which is accessible for System Administrators.

A snapshot of a patient’s most recent or Current referral outcome entered on their referral is
shown in the Details tab. Since outcomes can be entered with retrospective dates, the most
recent one is the one which most recently applies, rather than the one most recently entered.

The information shown is

o Outcome status code
o Outcome status name
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o Date the outcome applies to the referral
o Clock action of the outcome

If you check the need for Interpreter, you can also choose which language the interpreter
should speak. After choosing language, if you uncheck Interpreter, language is left on, which
can be useful if you just want to make a note of which language the client speaks.

Whether or not a patient is suitable or consents to have Video Appointments can be recorded
on the Video appointments accepted checkbox. This value can also be both seen and set on
the Make Booking dialog.

The Travelling distance (one way) can be added. This is shown in Client lists/Trials.

2.2.3 Lists/Photo

The Lists/Photo tab will display all Client lists/Trials that the client is assigned to and is a place where a
photo of the client can be uploaded. The active client can be added to or removed from a list and their
status on the list can be changed.

Contacts | Details | Lists/Photo | Devices | Implant | Visitcharge | Paediatric | PPP 4 »

Add to List

Start date | End date Title Client status | Status| Respc
01/01/2016 | 01/0212017 Titie 4 Notasked |Active USER M

< >

Upload

Download

Client's picture

Remove

Show large

If a client has not been assigned to a list yet, all the buttons on this tab, except Add to List, will
be inactive. If you wish to add this client to a current list, select Add to List and all active lists
will be displayed in a window.
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Add client to Client list it

Close

Choose Client listto add client

Startdate | Enddate | Status | Tile | Responsible | Type| Min. clients| Act clients
01/01/2016 | 01/02/2017 | Active | Tille 4 | USER NAME29. 444 8
09/01/2020 Planned | Test list| SYSTEM ADMINISTRATOR 0

Select a list by clicking on it and Select. The client will then be added to the list with the

default Client status. This Client status can be changed by selecting the Change status
button or click into the Status column directly in the table. You will be able to Select new
status for client from the drop-down list prepared by your System Administrator.

If the client is already on a list, Show in list will take you to the Client list and display more
details. A client can be removed from a list by highlighting the list and selecting Remove from
list. A confirmation message will ask you to confirm that you want to remove the client from the
list, Yes will confirm and No will return you to the client’s information.

A photograph of the client can be added to the Lists/Photo tab. Select Upload and navigate to
the photograph image file, there is no maximum size control so do not load more than a few
hundred kilobytes otherwise the database will grow. Once the file has been selected, Open will
add this to the tab. If you wish to save a copy of the photograph, Download will open a window
where the image file can be saved. Remove will remove the photograph from this tab, after you
have confirmed this is what you intended. A larger version of the photograph can be shown by
selecting Show large which shows up to a maximum height of the minimum screen resolution.
The window that opens can be closed using the Close button.

2.2.4 Devices

The tab Devices is a quick overview of the currently issued devices for the client. It shows
Earmoulds, serial controlled current Devices and quantity controlled current devices, which
are marked in System Administration as Accessories.

Earmoulds synopsis is shown below. This demonstrates the type of mould per ear and the vent
size which has been selected for each mould. It also shows the date of the last stage of where
the earmould is e.g. Sent to Manufacturer, Ready or Issued.

ACCESSO0MY iS5Ue Refresh (F5)

Earmoulds
L * 28/06/2018 -EM2112ALL SOFT SHELL Yent:
R * 28/06/2018 -EM2112 ALL SOFT SHELL Yent:

Issued *- Currently worn
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Devices

Modified date | Stock type to| Article| LIR| User

Serial number| ltem information

10/02/2017 |SENTFORRMNHSS | Oleks 5464568 test info
18/10/2016 |REPLACEMENHS S- | full n: 925104
26/11/2015 |SENTFORRNHSS | SYSTPOS90909
26/06/2015 |RECONDITI( Testm L | full n: 2221
& (1410512015 | FITTED/EXCINHS SR | full ng 1121
08/05/2015 | FITTEDIEXCINHS SL | full nz 123123 1
& |08105/2015 |FITTED/EXCIMHS L |full nz 12121 1
08/05/2015 | FITTED/EXCINHS SL | full n: 1123 3
01/05/2015 | FITTED/EXCI Testm R |full n: 2222
Accessories Mew status
Created date Stock type to | Stock Group |

03/10/2013 | FITTED/EXCHAMGED (Issued) BATTERIES (Quantity-Accessory) | b
24105/2007 | POSTAL BATTERIES (Issued batteries) BATTERIES (Quantity-Accessary) |
< >

You can change the status of a device or an accessory, for example, to register it's returning to
stock, by selecting it in the list and then clicking the New status button.

When designing a letter, you can insert variables with information about the four latest serial
number controlled devices and the four latest accessories from the Current issued devices
and Current issued accessories groups, respectively.

2.2.5 Implant

The Implant tab is only available if you are licensed to use the Auditory Implant module. The
tab will show you an overview of the client’s implant status.

On this tab, you can create a ‘quick’ version of the Pre-Op, Surgery and Switch-on records with
just the minimum of information directly from this tab.

o Click the down arrow on the New button to choose which type of record to create.
« Mandatory information depends on the type of record. However, date, an ear side and a
referral are required for all types.
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Contacts | Details | Trials/Photo | Devices | Implant | Paediatric | PPP

Invoice services Print device info report
rRIGHT r LEFT
Implant type Implant type
First Latest First Latest
Assessment Assessment
Surgery Surgery
Switch-on Switch-on
Upgrade due date Upgrade due date
MNew - Open = Mer /M P

- Quick Pre-op assessment
Client preferences

Imm Quick Implant surgery
Seledt Quick Switch On
Type | Rl L| Mame | Status
Cable ] ITE10MR -
Magnet |1 (] TE100ML Date =

Surgical consent

4

Date

Consortium (Customer Group)

Funding Status

Implant keywaorker

« Ear side is pre-selected depending on which New button you click (from left or right),
but you can change the value to unknown or bilateral.

Client MR FIRSTNAMES7E3 LASTNAMEST7 68 Save Close

Create Pre-op assessment *

Date 12/06/2021 E User SYSTEM ADMINISTRATOR A

Ear side Left - Referral

Right
Bilateral
Unknown

« You must either choose to attach to an existing referral or create a new one.
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Create Pre-op assessment *
Client MR FIRSTMAMESTE8 LASTNAMESTEE Save Close
Date 12/06/2021 E User SYSTEM ADMINISTRATOR -
Ear side Lef - Referral L?
New

Attach
Detach
If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the
details in Quick referral creation.

= button to the right of the Referral field. See

In order to view full records to which the dates of Assessment, Surgery and Switch-on refer,
use the Open button to select the relevant form.

Contacts | Details | Trials/Photo | Devices ||Implant | Paediatric n PPP

Invoice senvices Print device info report

rRIGHT rLEFT
Implant type Implant type
First Latest First Latest

Assessment Assessment
Surgery Surgery
Switch-on Switch-on
Upgrade due date Upgrade due date

New |~ Open | - New |~ Op~~ =

- Pre-op assessment
Client preferences P

Immunisation Implant surgery
Select
Switch On %

Status

Type |R| L| Mame

2.2.6 Visit charge

This tab is primarily used in Sweden. It gives you the overview of a patient’s eligibility for free
of charge visits, including annual card number, date due (the date the annual card expires),
preferred payment method (used if the client is not eligible for free of charge visits) and the
client’s free of charge status (enabled or disabled). Additionally, it shows the client’s self-
check-in status (allowed or prohibited) where applicable.

2.2.7 Paediatric

The paediatric tab allows new information to be entered and will collate information from the
Paediatric module and the History in DR Medical Assessment.

If a client has an ABR and OAE screening and diagnostics entry where Test type is screening
referral, the most recent outcome will be shown in the box labelled Hearing screening
referral.

16
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Contacts | Details | Lists/Photo | Devices | Implant | Visit charge | Paediatric | BPP <4 »

Hearing screening referral Clear Response - Mo Follow-up Required
RIGHT LER
Diagnosis SMHL - Diagnosis SMHL -
Current Hl type BTE - Current Hl type ITE -

Medical history

Date 271012015 - Edit MNew Open
Hearing loss
Right Severe Left Mild
Confirmed syndromes Risk factors
Name MName
Progressive unknown Absence of Tibia
Meningitis

Risk factors and syndromes are taken from the Paediatric module. Medical history lists are
empty

SCBUMNHUMICU Well baby -

Confirmation of PCHI: Date 011002013 E Age 24 Year(s) 6 Month(s) 13 Day(s)

Weight at birth (kg) 89.00 Gestation (weeks) 2

Diagnosis and Current HI type can be entered from the drop-down lists for left and right; this
information is not displayed anywhere else in Auditbase. The options cannot be adjusted in

System Administration.

DR-Med - Information from the most recent DR-Med questionnaire can be shown. Previously
created questionnaires will be shown in the drop-down box labelled Date. New or Edit can be
used to create or edit just the information in this box in a pop-up dialog. It will save to a DR-
Med record. Open DR-Med will open the full DR Med History.

SCBU/NHU/NICU, Confirmation of PCHI Date and Age, Weight at Birth and Gestation can
be entered here and will be repeated on the Paediatric module and vice versa.

2.2.8 Record history
The Record history tab shows:

o when a client's record was created or modified

if/when the deceased alert was issued

NHS number verification status and the time it was set
last updates to the record by a PAS/HL7 interface

At the bottom of the screen, there is the Client origin information (e.g., whether a Client
originated from a merge or conversion, and when).

17
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o NOTE: This data is not backdated.

Contacts | Details | Lists/Photo = Devices | Implant | Visit charge @ Paediatric | PPP
Record creation
User USER NAMES

Timestamp 1212311999 0:00:00

Last record modification
User USER NAME29

Timestamp 4/3/2008 13:53:24

Deceased alert modification
User

Timestamp

MHS no. verification

Status 01, Number present and verified
Timestamp 06/20/2022 11:56:58

User SYSTEMADMINISTRATOR
Latest PAS update
Clients arigin

Record history
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2.3 Card reader input - restricted to Danish users

From Client information, you can perform a client search by scanning the barcode or reading
the magnetic strip on the client's card. You can also search for other information scanned from
the card. The system administrator defines how the system recognizes input from the barcode
and the card reader.

The Card reader input window is used for capturing and recognizing data read by the
magnetic card reader attached to the computer. The window is activated when the user scans
the magnetic card.

The recognition of reader input is performed according to settings made by the system
administrator. If the recognition is successful, the system performs a search for the client by
personal number read from the card.

If the client does not exist in the database, the system initiates a creation of a new client and
fills the window with the data read from the card.

If the client already exists in the database, which was initiated from Client information, the
system shows details for the client and compares the information read from the card with the
data already present in the database. If there are differences, the system opens the Correct
differences in client information window.

The inconsistencies are shown in a table with 4 columns:

Column 1 shows the name of the data with inconsistency. The following data are read from the
card and compared with the database: Client first name, Last name, Address, Postal code,
Customer number, and GP code.

e Column 2 shows the value stored in the database.

e Column 3 shows the value read from the card.

« Column 4 contains checkmarks. When you select a check box, you select to use the value
read from the card. Use Select all to select all data.

To correct the data, click Correct. Note that this only changes the content in Client information.
You need to save the data to the database.
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2.4 General search for a client

Press F3 or File -> Client Detailed search.
Enter Basic search criteria.

If you list the surname and first name, you get a list of all clients registered to the
Auditbase System matching the criteria. Auditbase will also search for part of a name; i.e.

entering 'sm' in surname will list all clients whose surname starts with 'sm'.

Select all - No rows selected

Client advanced search X
Search Clgar Exportto CSV || To Clientlist || To Waiting list Print Select Close
Basic search criteria

Sumame |:| First name Date of birth

Address Postcode Gender -

Hospital no. NHS no Location All locations -

¥ Show advanced criteria

Hospital no ‘NHS no. |DOEI‘Name‘Address|PmstcudelTiﬂe|Firstname Last name

MNUM

Click Search or press Return.

« Click on the appropriate client and click Select or double-click on the appropriate client.
« Where the search should be abandoned, and a new search started there is an option to
Clear the Search fields. This allows for the Auditbase user to clear all of the fields which

have been populated.

o Once the list of clients has been produced, this list can be saved to a CSV file which can
be read in Excel. Select Export to CSV and a window opens where the CSV file can be

saved.

o)) Savefile

Savein: | [ Desktop

% a admin
Quick access
m -

Libraries
Desktop n

=l ef E-

Q This PC
@ MNetwork

[ Patients attending multiple
m ABASE X unscheduled appt types 201...
Libraries Microsoft Excel Comma Sep...
This PC
Network
File name: || j Save |
Save as type: |CSV file j Cancel
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o Itis an extended user right to be able to export these clients. If you do not have the
rights, a window will appear informing you of this. You will need to contact your System
Administrator to assign you the extended right.

Insufficient privileges *

BRIAN HARRIS <BH> has insufficient privileges in AuditBase for Client: Export clients data’feature.

L
— Contact your system administrator.

When you have selected the appropriate client, the system returns to the main screen of the opened
module, for instance Booking. The selected client's name will be displayed at the top of the screen.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

Multiple clients can be selected using the check boxes in the left-hand column. This multiple
selection may be printed or added To Client list or To waiting list. During the creation of a
group booking a selection of clients with the same settings in Advanced criteria can be made
using this feature.
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2.5 Quick searching for a client

o Press Ctrl+F3 or File -> Quick.

« Enter the client’s personal number or a hospital no. assigned to the client

e You can use the wild card ‘%’ in this field.

o Click Search or press Return

« If the client exists, the system selects it automatically

o If the client is not found, or multiple clients share an incomplete personal number, the
Client advanced search screen is activated

Client quick search >

Search criteria

Hospital no. ||

[f none aor mare than ane client match the search
criteria, the result will be shown in the narmal
search window.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

Contact your system administrator to configure which type of hospital code is searched
for in this feature.
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2.6 Advanced Search criteria

o Press F3 or File -> Client Detailed search.

« The Client advanced search window will open.

o Click Show advanced criteria to show and enter more details such as Alerts and
Parameters, Email, Department, Date of Birth, Date of Death and Customer if
needed.

e You can use the search criteria Phone to search for any phone number, such as work,
home or mobile phone number.

« You can also search for clients with a specific Alert, either a patient alert or a PAS alert.

« If you want to exclude deleted clients, check the box Exclude deleted clients.

« You can also search on a Parameter to find clients with either of two specific parameters.

« You can use the ‘%’ wild card in the search fields that are not dropdown lists.

Client advanced search X
Search Clear Exportto CSV || To Clientlist || To Waiting list Pr Select Close
Advanced search criteria
Surname I:I First name Date of birth
Address Postcode Gender -
Hospital no. MHS no. Location Al locations -
Phone Email Department  All departments -
Date of birth Period from To Alert v
Date of death Period from To PAS alert v
Customer - B Exclude deleted clients
Parameter # 1 - Parameter # 2 -
ETHNICITY - TEACHER OF HEARING IMPAIREC -
EDUCATIONAL SETTING COMDITION / SYNDROME
Audiogram (latest curve) Device

Searchby g, Curve Search by device(s)
hearing loss -

125 | 250 | 500 | 750 | 1K |1.5K] 2 | 3K | 4k | 6K | 8K |
125 | 250 | 500 | 750 | 1K |1.5K] 2 | 3 | 4k | 6K | 8K |
Select all - No rows selected # Hide advanced criteria
Hospital n0.|NHS n0.|DDB|Name|Address|F'ostcode|TitIe|Firstname Last name

NUM

2.6.1 Searching for clients by audiogram
Clients can be searched for by hearing threshold using the client’s latest Audiogram curve.

« Select Search by hearing loss and the Ear, Curve and date range options will become
available.
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« The date range will default from one year ago to the current date.

o There are three options for Ear; Bilateral, Unilateral and Distinct ears.

« Enter the Min and Max thresholds for the relevant frequency. Selecting Distinct ears will
activate both threshold fields which are not side specific.

« Different types of audiogram can be chosen using the Curve selection. Only the latest
curve of the selected type will be searched.

o Search will show the results and these can be selected by checking the box to the left of
the name or Select all and can then be added To Client list, To Waiting list or can be
printed by selecting Print.

Audiogram (latest curve)

hearing loss

Min
L Max
09/01/2019
to
09/01/2020

Bilateral - Curve  Air -

125 | 250500 | 750 | 1K [1.5K) 2K | 3K | 4K | 6K | 8K |

125|250 500 | 750 | 1K [1.5K] 2K | 3K | 4K | 6K | 8K |

2.6.2 Searching for clients by device

Clients can also be searched for by Device:

« Check the box Search by device(s) and selections can be made from Stock group,
Manufacturer and Article type. These options are taken from your Stock module. Each
Article in Stock is defined as one of several Article types.

« Search will show the results and these can be selected by checking the box to the left of
the name or Select all and can then be added To Client list/Trial, To Waiting list or can
be printed by selecting Print.

Drevice

B Search by device(s):

Stock group

Manufacturer

Aricle type
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2.7 Recently accessed clients

Each user of the system has a list of the 9 most recent clients. To access the list, click on [T/ on
the toolbar to the right of the patient name on the Booking screen or press Shift+F3.

—

: DR, TESTFNAMET TESTSMAMET

: MASTER FASTS MASTS %
: DR, TESTFMAMEZ12 TESTSMNAMEZ12

: MISS FIRSTMAME34294 LASTMAMES4204

: MISS FIRSTMAME36249 LASTMAMESR24S

: MST FIRSTMAMEZ25177 LASTNAMEZ25177

: MR FIRSTMAME45367 LASTMAME4S867

: MRS FIRSTMAMES16T LASTMAMES16T

: MRS FIRSTMAME43408 LASTNAME45408

Wots o e o b W pa |
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2.8 Adding a new client to the database

o Click New.
o Enter the client details.
o Click Save.

Search for the client first to ensure the client is not already in the database.
Navigation-> Client information, press Ctrl+Shift+C, or click A .

The fields Surname and Case number or NHS number are mandatory. You can enter as much
or as little other information as you require.

Gender options are expanded beyond just Male or Female and can be defined by your System
Administrator from a default Department of Health list.

If two users are working on the same client, a Refresh button is available to update the client’s

details immediately.

Postcode validation may be applied in Administration which restricts formats of postcodes

allowed to be entered.

Contact your system administrator to find out which fields are mandatory.
Contact your system administrator to configure the default first field when creating a new

©)) Auditbase - [Client information] - o X
E Client  <T>T11001 MASTER FIRSTNAME1001 LASTNAME1( - | 2 | = | B |User SYSTEM ADMINISTRATOR | All locations = All departments - Q ?
File Edit View Functions Settings
2855 DA&E 88 B AT
s Wl qyac) B & 4 =R
Detailed | Quick ~New = Seve Systeminfo Print  Printlabel Importdata Exportdats | ExporttoMNoah Logoff | Exit Auditbase
Search Client Print Import/Export Client data Exit
Navigation New Delete | Search = Label EditiD PASupdate 2
- Favourites
; g Referral Hospitalno.  TH1001 NHS no. Contacis | Details | Lists/Photo | Devices | Implant | Pasdiatric | PPP
- Booking
Title -
i) Documents and attachments NASTER Additional professional contacts Add Remove
; E’: Waiting list Surname LASTNAME1001 K |Type ‘Name‘Address|Pust:ode|Phune|EmaH‘ ‘GP Codelcny‘Fax‘Frac
2 AB Audiogram Firstname FIRSTNAME1001 [0 |GeneADAM 123 STR| makkn
& NOAH module seleciion Edaname 1231
A\ Aftention list
L @ NOAH session browser Address 99 2000CC0000001 241110
J0000C 000 1111
00000011
Individual client K00
-5, Clientinformation Pastcode PC:4642 City -
-{fif Paediatric Gender Wale M User *USER NAMES v
(gl Dateofbih 27032000 Age 19 Date of dealn < 2
@ Documents and attachments 0 o K: Local keyworker
Referral Aert T, Transport v PASalet =
.éi* 2 L Relatives and other contacts Add Edit Delete
-1 2 Clients entries Home phane 99999 9999991 Mabile phone
[ Device list Work ph P ‘CC‘ ‘Name|Address‘Fnstcnde‘Hnme phone | Mobile phone  Work phon
= ork phone
Observations and procedures b n LIS Father 1 1 9 1 9 9
(%) Earmoulds Email Post and email* 0 [ Wother 123 1233 1 1 2 3
“i\;‘j Hearing Therapist Customer  5K3 SWINDON PCT v
[t1] Medical nistory - —
&5, Direct referral HA (adult) ocalion |Alllocations v epartment 2 Deparment2 |+
(3 Tinnitus DoctorGP * DR ROWLANDSON .
_l{ Surgery DoctorENT  MISS SE CHALSTREY, CONSULTANT ENT SURGEON, GREAT W
- [11] HI Satisfaction Questionnaire —— s
B+ Measurements i stalus < ’
&[] Questionnaires Signif. other 213 P: Priority contact. CC: Send copy of lefters
E @ Tests Transport 312 Relative’s information
B8 Implant 1 N
vr? Run external application Information (300X 000 J00CCECCK X000X 100122121 -
- -

NUM e
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Alternatively, you can register a new client by scanning barcode or pressing F4 and scanning
the client’s magnetic card.

If no hospital number or personal identification number is entered, Auditbase will assign a
temporary ID or give a warning that mandatory data is missing. The system remembers what
the last code used was and adds one. If it finds a problem with codes that have been used
manually it will search for the lowest free code and use that one. You can change the
temporary ID number any time by clicking Edit ID.

You can also select a client by filling in client ID. The information for the client will be
displayed. You can only enter data in this field when no client is currently selected or you have
pressed the New button. When filling in client ID, the information will be displayed in the
window.

If PAS link has been set up, you use PAS update to look up a client in the Patient
Administration System and transfer the data.

o To print alabel, click Label.

o To view technical details such as creation date, modification time, internal ID, GUID for
the client select the File -> System information menu item.

« To print demographic and other data presented on the screen, select File->Print.

When saving a new patient, Auditbase will offer to verify it automatically.

Set Hospital no. verification status X

Save Cancel

¥ou have just saved averifiable identifier. Do you want to verify now?

Yerification status: 01, Mumber present and verified -

01, Mumber present and verified |

02, Mumber present but not traced =
03, Trace required =
04, Trace attempted - Mo match or multiple match fo
05, Trace needs to be resolved - (NHS Mumber or p:
06, Trace in progress

07, Mumber not present and trace not required

08, Trace postponed (baby under six weeks old)

1ate| Stock type to| Stocl

o Choose a verification status in the dropdown list and then Save. The Verification status
will be set with the User and date and time of the verification.

o A patient identifier can also be verified after the patient has been saved by pressing the
Edit ID button.
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Edit ID
Save Cancel
Huospital no. || MHS no.
Current value TIITiTTiT
B Change to
Werification
Status 01, Number present and verified -

User SYSTEM ADMINISTRATOR
Date 09/01/2020 14:19:03

« Choose from 8 different verification statuses in the drop-down box.

« The verification status is removed by choosing the empty line in the drop-down box.

o Click Save.

If your system administrator has enabled that only verified NHS numbers will be printed,
then the NHS number will not appear on any printouts, reports or letters unless it has the

right verification status.

« The verification status and details can also be viewed on the System information dialog
for any client, opened from the File menu on the Client information screen.
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28



User Guide

2.9 Adding a doctor to the client information

o Select Client information.
o Enter GP code if you know it and press the tab button.

OR

o Click the Browse button next to the Doctor GP field.

Doctor GP L_I o e
Create new
Doctor EMNT
Search all B
Civil status
Select from list
Signif. oth
1anit- ofmer Clear field
Transport

o Select from the list.

o Double-click the doctor to add to the client information.

« If the doctor does not appear on the list already, add the doctor by choosing New and
filling in the form.

« To delete a doctor from the client information, click the button next to the Doctor GP
field and select Clear field.

© Auditdata - 2022, ID: 20.0040/29
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2.10 Client Access Restriction

Restrict which users have access to specific clients’ information in Auditbase. You will need
extended user rights to be able to restrict users’ access to a client or to be able to override any
restrictions in place.

« Select Client Information for the client you wish to restrict access to.
o Select the Functions ribbon to display the Access restriction icon.

File Edit View Functions Settings
o= o] o EE@ %o =
d i =3 Cobp S5

Label |Access restriction Magnetic card Add to PPP list  PAS refresh  Merge clients = Mew task

A pop up will display, allowing restrictions to be put in place.

Restrict access to client's data >

Client 23423423 Save Close

Filter
Location All locations -

Users without restricted access Users with restricted access

Test user new role - PROG
testuser SYSTEM ADMINISTRATOR
TEST123 testfullname
testazs

testazme.

TESTQZ

TTT1T

USER MAME11..

USER MAME13

USER MAME14 III

USER MAME1S 4

USER MAME1G

USER MAMEZ2

USER MAMEZ24.

USER MAMEZ3.

USER MAMEZ29.

USER MAME30.

USER MAME32

USER MAME3S

USER MAME38 -

Add All Remove All

3 restricted users filtered

3 restricted users in total

Select the users you wish to restrict and use the arrow to move them to the restricted column.
All users will be displayed and can be filtered on location for fast selection. You can check the
Select All checkbox if you wish to restrict access to all users in the list.

Save this and all users moved to the restricted access column will no longer be able to view
Auditbase records for the selected client.

© Auditdata - 2022, ID: 20.0040/29 30



User Guide

The restricted user will be able to see the client listed on the waiting list, referral overview and
on the booking screen. If restricted users attempt to select the client, an information box will
appear advising of the restriction in place.

If the user has the further extended right they can break the restriction which will be logged as
a security event. Users can be denied access to view details of patients who are not associated
with their Locations or Departments.

If the user has the further extended right they can break the restriction which will be logged as
a security event.
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2.11 Merge Clients

To merge two records for a client, use Functions -> Merge clients. Your System Administrator
must provide you with the extended user permissions. Merges are logged in the Security Log.

After Merge clients has been selected, the currently selected client will become a Master client
for merge. If the selected client should be the Minor one, then use the Select buttons to
reselect as Minor and to select a different Major. If no client was pre-selected, use the Select
button to search for a client.

The details of the record you want to keep are shown in the top boxes; the lower boxes are the
record which will be removed upon completion of the merge. It is important that you get these
the correct way around. The client can be chosen using the Select button. This will bring up
the standard Client search window and a client can be selected in the usual way. Once both
records have been selected, the Merge button becomes active. A warning message is displayed
to ensure that you have selected the proper records, the correct way around.

Cuestion

/@™  You are about to merge the data of the selected clients.
' _/.' Please check once more that you have selected the comect clients as unmerge is not possible.

.-
Should clierts be merged?

Yes No

If this is correct, select Yes and the records will be merged.

If a Minor patient has been selected by another Auditbase user and is in active use, then an
error message will appear:

Merge information

4% The minor client is cumently selected by the user SYSTEM ADMINISTRATOR. & is likely that the data are being edited for that client.
|\ /.l Do you want to proceed with menging?

Yes Mo

This will not prevent the merge from taking place if Yes is selected however this will affect any
data which is being managed by the other user.

The merge process may take some time. The cursor changes into an hourglass while the merge
is ongoing. Once the cursor changes back to an arrow, you can continue working in Auditbase.

A further message will display the Case number that will be lost when the client is merged. It
is recommended to record this number if you later need to apply it to the merged master client.

Besides demographic data, the merged client will also contain the following data where it
exists for either of the clients:
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o Audiogram (Including Noah sessions)
« Journal data

e« Ear mould

e Tinnitus

o Stock

+ Booking data

o Observations and procedures

« Hearing therapist report

o Documents

o Referral

o Implant

o Repair list

e Surgery

o Tests

o Clinical actions

« Waiting list

o Invoice

o Task list

o Adult assessment questionnaire

If both clients have any of the below data, the user will be notified that the merge is not
possible until the record on one of the clients is removed:

e Open PPP sessions

o Bone Anchored Hearing Aid questionnaire

o Direct referral HA (Adult) data

o Open waiting list entries with the same type

o Paediatric data - If a client has Paediatric data, the following warning will be displayed
"Both the master and the merge client have a Paediatric Module record, only the record
belonging to the master will be retained after merging. Please ensure you have copied all
important data from the Paediatric Module record of the client to be merged into the
Paediatric Module record of the master client before merging”. When this is done you can
proceed with the merge.

« COSI data for the same date

« Direct Referral - medical data for the same date

o Hearing Attitudes in Rehabilitation data for the same date

o Satisfaction with Amplification in Daily Life data for the same date

« Auditory Lifestyle and Demand Questionnaire data for the same date

o Abbreviated Profile of Hearing Aid Benefit (Initial or Follow up) data for the same date

o Attitude, Motivation, Expectation Questionnaire (Re-assessment) data for the same date

o Attitude, Motivation, Expectation Questionnaire (New) data for the same date

o Q3 questionnaire data for the same date

« Questionnaire for IHR Family Hearing Aid Benefit data for the same date

o Hearing Aid and Programme Selection questionnaire data for the same date

« International Outcome Inventory for Hearing Aids questionnaire data for the same date

« Hearing Direct Routine Follow-up questionnaire data for the same date

« Both clients have records in the same waiting list
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Once the merge is done, the Information window appears.

Information

Clients merged successfully

oK

x

The record that was merged is then removed.

When a user has removed the data from one of the clients via the Auditbase application, the merge will

be possible, and the data left will be available for the client.
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3 Referrals

Click the button below to access our training materials.

The Referral module is opened from Navigation -> Referral or Shift+Ctrl+F. If the module is
opened with no client pre-selected, then it opens on the Referral overview tab. If a client is
selected, the module opens on the Client’s referral tab and displays the Client’s latest existing
referral. If a different tab is selected and then a different module, Auditbase will open this
selected tab when the Referral module is re-opened.
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3.1 Referral overview

Columns
The columns available contain most of the fields on the Client’s referral tab, such as:

o Current stage

« Active length

o Assessment

o Status - (Outcome status)

o Clock action

« RTT end date

o RTT end status

o Previous and Next appointments- shows appointment status as well as date.

o Latest appt date and Next appt date - shows only the date, for easier chronological
sorting.

o Latest appointment outcome

o Medical Priority

o Waiting List - (If referral is attached to one (Must be activated in System administration))

Referral overview Clients referral | Referral progress | Referral answer | Clinical actions

Filter: v || Setas user default Setup filters Book Search and book Print list Exportto CSV Refresh

Pathway ID| RTT start ‘ Client name Hospital no.|NHS n0.|A|:1ive length Assessment Treatment
11/03/2010 MR FIRSTNAMEZ23026 LASTNAME23026 | T123026 582w, 4d |1214/2010, Has been breached. No appt 02/02/2011, Has been breacl
11/09/2010 MR FIRSTNAME 1941 LASTMNAME 1941 T11941 581w,5d |12/20/2010, Has been breached. No appt 02/08/2011, Has been breacl
11/22/2010 MRS FIRSTNAME19079 LASTHNAME19079 | T119079 579w,5d |01/02/2011, Has been breached, status not'completion’ | 02/22/2011, Has been breacl
11/29/2010 MRS FIRSTMAME3281 LASTMAMES281 T13281 578w, 6d |01/09/2011, Has been breached, status not'completion’ | 02/28/2011, Has been breacl
1115/2010 MR FIRSTMNAMEZ1335 LASTMNAMEZ21335 | T121335 580w, 6d |12/26/2010, Has been breached, status not'completion’ | 02/14/2011, Has been breacl
12/31/2010 MR FIRSTMNAMEGT 48 LASTNAMEGT 46 T16746 574w, 2d |02M0/2011, Has been breached, status not'completion’ | 04/01/2011, Has been breacl
01/05/2011 MR FIRSTNAME39376 LASTMNAME39376 | T139376 569w, 6d | 0313201 05/02/2011
01/06/2011 MR FIRSTNAMEG105 LASTMNAMEG 105 T16105 573w, 3d |02M6/2011, Has been breached, status not'completion’ | 04/07/2011, Has been breacl
01/06/2011 MRS FIRSTNAMEZ29548 LASTMNAMEZ29548 | T129548 573w,3d |02M6/2011, Has been breached, status not'completion’ | 04/07/2011, Has been breacl
01/07/2011 MRS FIRSTMNAME2741 LASTNAMEZ741 T12741 573w,2d |02M7/2011, Has been breached, status not'completion’ | 04/08/2011, Has been breacl
01/07/2011 | MRS FIRSTNAMEG232 LASTMAMEG232 T16232 573w, 2d |02M7/2011, Has been breached, status not 'completion’ | 04/08/2011, Has been breacl

The order these columns are shown can be adjusted by clicking under the column heading and
dragging the column to the desired position. This can be saved for future viewing by right
clicking anywhere on the grid and choosing Save user view. An information window then
informs you that you need to have the same number of stages to use this view for another
filter.

Message X

Because the number of columns varies with different Fitters depending on what Stages are included,
y I % this view configuration is only saved for Fitters with the same number of stage columns.
T A new view configuration must be made for Filters with a different number of stage columns

oK
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If a user has a Location or Multiple locations selected, the results will be further filtered by
the client’s Location and they will not see all records. When Location is selected globally, the
corresponding message will appear on the status bar, informing that the "List is filtered by
clients' location".

o)) Auditbase - [Referral] - ] b4
File View Functions
E Client  T101010 Mr. John Smith - |2 Z Bl user SYSTEM ADMINISTRATOR L Taw Hill ~ All departments - Q ?
N_m'igati“" Referral overview Clients referral | Referral progress | Referral answer = Clinical actions -
B Favourites
Filter: Setas userdefault | Setup filters Boo Se Print list Exportto CSV Refresh
Pathway ID | RTT start Clientname Hospital no. | NHS nu.lAdwe length Assessment | -~
11/02/2010 | MR FIRSTNAMEZ22026 LASTMAME22026 | T122026 582w, 4d | 12/14/2010, Has been breached. No appt 02/02/207
11/09/2010 | MR FIRSTNAME1941 LASTNAME 1941 T11941 581w, 6d |12/20/2010, Has been breached. No appt 02/08/207
11/23/2010 | MRS FIRSTNAME19079 LASTNAME13079 | T119079 579w, 56d | 01/03/2011, Has been breached, status not‘completion’ | 02/22/207
11/29/2010 | MRS FIRSTNAME32381 LASTNAME3281 T13281 578w,6d |01/09/2011, Has been breached, status not‘completion’ | 02/28/20°
11/15/2010 | MR FIRSTNAMEZ21335 LASTMAME21335 | T121335 580w, 6d | 12/26/2010, Has been breached, status not ‘completion’ | 02/14/20°
12/31/2010 | MR FIRSTNAMEG746 LASTNAMEGT 46 T16746 574w,2d | 02M0/2011, Has been breached, status not'completion’ | 04/01/207
01/05/2011 | MR FIRSTNAME39376 LASTNAME39376 | T139376 569w, 6d 03132011 05/02/20°
Modules 01/06/2011 | MR FIRSTNAMEG105 LASTNAMEGS105 T16105 573w,3d | 02M6/2011, Has been breached, status not'completion’ | 04/07/207 »

A\ The list is filtered by clients' location

If the user wants to see all clients, they should change to All Locations.

© Auditdata - 2022, ID: 20.0040/29 37



User Guide

3.2 Referral filters

A number of different filters can be set up so that the referrals can be viewed in many ways.
Click on Setup filters to define filters.

Filters for referrals overview K
Up Down Concise mode Mew Save Delete Close
newOneTest 4| Filter name:

COUNTING CLOCKS

COUNTING CLOCKS

AUDIO REVIEW - counting
AUDIO REVIEW - stopped

DIRECT REFERRALS - counting

DIRECT REFERRALS - stopped
PAEDS counting

TINNITUS

DMA & inappropriate referrals’s
Mullified referrals

Copy and replace criteria from the filter:

Incorrect outcomes hd T -
Filter criteria
ey eaEtE from | 0B/02/2008 |t | DG02/2008
RTT end date
Treatment type: * DO NOT USE-HEARING AID FITTING - Reason
B All stages All statuses B Al clock actions Regardless of breach warning
Current stage Status Clock action Filtering by breach warning
Stage Name . Status ~ | ® Counting W Display referrals without breach warning
v | Assessment | SUSP Suspended B Suspended [W] Display referrals with breach warning
[v | Treatment [~ | 10a, Awaiting first ACTIVITY B Stopped Filter on warning type and the stage it applies to:
v Followup I~ | 11a, End Active monitoring - tn O e Before target date
v  Completed I~ | 11b, End Active monitoring - di B Liable to breach
- " n M Referral closed .
[~ | 20a, Decision to treatl@#5% W Wil breach
[~ 20b, Cancelled - RTT rebook After target date
[~ 20c, DMAtreatment- rebook Has been breached, no appt
[~ | 20d, Further assessment req: Has been breached
Iv | 30a, Treatment commenced Has been breached, status not"completion’
[~ | 31a, Active monitoring - patien Breach warning activated for stage(s):
[ | 32a, Active monitoring - clinici; . Stage Name
[~ | 32b, Neonate 8 mth review res v |Assessment
| 33a, DMA1st assessment v | Treatment
|~ | 33b, Inappropriate referral [~ |Followup
[ | 34a, Treatment not required [~ | Completed

Al Mnfarend fn nneesband (T

This window can be seen by all users but the filters can only be edited and saved by users with
the extended user right for this.

To use an existing filter as a template, choose it from Copy and replace criteria from the filter
and click Copy.

To set up a new filter, click New.

The window can be viewed in Concise mode or Advanced mode.
There is an option to filter on RTT end date instead of RTT start date.
Existing filters will retain the original settings of RTT start date.

Newly created filters will default to using the RTT end date criteria but either start date or end
date can be selected.

38
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If RTT end date is selected then only referrals that have an RTT end date within the date

parameters selected will populate. Multiple results will be shown if all end dates are within

the date period selected.

Concise mode

Filters for referrals overview

AUDIO REVIEW - counting
AUDIO REVIEW - stopped
DIRECT REFERRALS - stopped
PAEDS counting
TINMITUS
DMA & inappropriate referrals’s Copy and replace criteria from the filter:
Mullified referrals
Incorrect outcomes A
Filter criteria
= RTT start date

RTT end date
Treatment type: ++DIRECT REFERRAL / Audio assessment = Reason

from 01/04/2009 1o

Up Down Advanced mode Mew Delete Close
newOneTest 4| Filter name:
COUNTING CLOCKS DIRECT REFERRALS - counting

All stages All statuses All clock actions Regardless of breach warning

Parameters are made simpler in concise mode by checking the boxes for stages, statuses, clock

actions and breach warning boxes to show all or no options.

Advanced mode

A more detailed filter can be created using the Advanced mode button and selecting specific

stages, outcomes, clock actions or breach warnings.
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Filters for referrals overview X
Up Down Concise mode Mew Save Delete Close
newOnaTest | Filtername:
COUNTING CLOCKS DIRECT REFERRALS - counting
AUDIO REVIEW - counting
AUDIO REVIEW - stopped
DIRECT REFERRALS - counting
DIRECT REFERRALS - stopped
FAEDS counting
TINNITUS
DMNA & inappropriate referrals’s Copy and replace criteria from the filter:
Mullified referrals o
Incorrect outcomes v h sl
Filter criteria
«| RTT start date fom | 0110412009 |ig
RTT end date
Treatment type: ++DIRECT REFERRAL / Audio assessment |~  Reason hd
All stages All statuses All clock actions Regardless of breach warning
Current stage Status Clock action Filtering by breach warning
] | Stage Name | ] | Status ~ | W Counting B Display referrals without breach waming
v | Assessment — | SUSP Suspended Suspended M Display referrals with breach warning
v | T Iv | 10a, Awaiting first ACTIVITY Stopped Filter on warning type and the stage it applies to:
[~ | Follow up [~ | 11a, End Active monitoring - tn Nullified Before target date
[~ Completed [~ | 11b, End Active monitoring - di W Liable to breach
- Referral closed
[~ | 20a, Decision to treatl@#3%*" B Wil breach
[~ | 20b, Cancelled - RTT rebook After target date
[ | 20c, DNAtreatment - rebook M Has been breached, no appt
| | 20d, Further assessment reqi M Has been breached
[~ | 30a, Treatment commenced B Has been breached, status not‘completion®
[~ | 31a, Active monitoring - patien Breach warning activated for stage(s):
[ | 32a, Active monitoring - clinici: . Stage Mame
[ 32b, Neonate 8 mth review re ¥ | Assessment
[~ 33a, DMA1stassessment ¥ | Treatment
[~ | 33b, Inappropriate referral [~ |Followup
I~ | 34a, Treatment not required [~ | Completed
W

Note: Both Clock action and Referral outcome status need to be completed to show the

correct data set of patients.

You can also choose to view All referrals from the Referral overview tab, which is likely to take a
long time to populate as it will include all referrals ever created. For this reason, All cannot be
selected as the default filter with the Set as user default button. Any other filter can be set as

your user default.

Once afilter or the Refresh button has been selected, a progress bar will be displayed. This
bar shows the total number of records that meet the criteria; it also shows the number of
records that have been processed or completed and the number that have been found in the

search so far.

Referral overview | Client's referral | Referral answer | Clinical actions
Filter: PAEDS counting * | Setas user default Setup filters Book Search and book Print list Export to CSV
Pathway ID RTT start Client name Hospital no.| MHS no. |Active length Assessment |

02/11/2010 |MST FIRSTNAME33372 LASTMAME33372 | T133372 479w, 2d  |[13M2/2010, Has been breached. Mo appt 01/02/20
08/11/2010 |MST FIRSTNAME46057 LASTMNAME4G6057 | T146057 478w, 3d [19/12/2010, Has been breached. Mo appt 0710220
121172010 |MISS FIRSTNAME46130 LASTNAME46130 | T146130 477w, 6d |23M2/2010, Has been breached. Mo appt 1102120
1511172010 |MST FIRSTNAME46153 LASTMNAME46153 | T146153 477w, 3d |26M2/2010, Has been breached. Mo appt 14102720
06/12/2010 |MISS FIRSTNAME45916 LASTNAME45916 | T145916 474w, 3d |16/01/2011, Has been breached. No appt 07/03/20
14M12/2010 MISS FIRSTMAME46544 LASTNAME46544 | T146544 473w, 2d | 24/01/2011, Has been breached. Mo appt

151202010 |MST FIRSTNAME46553 LASTMAME46553 | T146553 473w, 1d |25/01/2011, Has been breached. No appt

161212010 |MST FIRSTNAME43958 LASTMAME43958 | T143958 473w, 0d |26/01/2011, Has been breached, status not’completion’ | 17/03/.
201202010 |MST FIRSTNAMEZ29636 LASTMAMEZ29636 | T129636 472w, 3d |30/01/2011, Has been breached, status not'completion’ | 21/03/
201212010 |MST FIRSTNAME36584 LASTMAME36584 | T136584 472w, 3d |30/01/2011, Has been breached, status not’completion’ | 21/03/20
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Click on Book or Search and book to book a client’s appointment directly from the overview
screen.

When booking an appointment directly from the referral overview, you will receive a breach
warning, if so configured by your system administrator, if the date is set to exceed the target for
the current stage. Click OK to continue and book the appointment regardless or Cancel to go
back and change the date.

You can export the Referral overview to CSV by clicking Export to CSV.
To print the filtered list, click on Print list.

The Print list function is best used if you want an overview of one patient, whereas the Export
to CSV function is best used if you want an overview of several patients or specific information
such as stages or outcome statuses.

To see changes to the list, click on Refresh.
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3.3 Client’s referral

When the client's details have been saved, an initial referral must be created.

Use the Referral dialog to record the referral from a GP or ENT clinic to an audiologist or a
referral from an audiologist to hearing therapy.

Statistics on referrals is available in the Booking module.

Client's referral tab can have a single or a split view.

If configured in administration, Referral progress information can be displayed on a separate

tab.

SPLIT VIEW

Referral overview Client's referral | Referral progress | Referral answer | Clinical actions
Referrals: Client name MST FIRSTNAME417 LASTNAME417 =
Book Search and book Add to list Add observation Print referral Print receipt | Print answer Save Delete
Waiting list entries Attach Detach Edit Show in waiting list
Wait time Date Waiting list Information
-5489 11/30/2010 | TGW - PHAC Temporary loss Reassessmentreview 6 months
Appointments Attach Detach Edit Show in Booking
Date | Time | Symbol | Statusl Resource Reason
11/30/2010 | 11:30 i} D |Res70 AUDIOLOGY referral
04/27/2010 0915 @ 5 |Res70 ENT referral
Observations and procedures Detach Edit
Obsno. | Date |Adds| Text Comment
Current status
Outcome  32a,Active monitoring - clinician start  Clock  Stopped Referral stages
i Active length: Ow 4d
since 04/27/2010 12:08:55 Addnew | | History Name _|Target date and warings Current _ ~ 2
o = e AL T, T SR GT RS E T I Assessmer | 06/03/2010 [ RTT end date: 04/27/2010
SEmINEL e it Treatment |07/23/2010 v RTT end date set by outcome status
MNew outcome status 32a, Active manitoring - clinician start = |Follow up I v 32a Active monitoring - clinician start
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Referral overview Client’s referral | Referral progress

Referral answer

Clinical actions

Referrals: 1 04/23/2010, PAEDIATRIC hearing aid journey (PHAC) ~| Clientname MST FIRSTMAME417 LASTNAME417 =

Book Search and book Add to list Add observation Print referral Print receipt Print answer Mew Delete
Treatment type PAEDIATRIC hearing aid journey (PHAC) - Information Edit
RTT start date 04/23/2010 Age at start 10y Reassessment

review 6 months

Referral date 04/237/2010 Other date 04/23/2010
Waittime
Customer BERKSHIRE WEST PCT (RG) -

Referred by
Referring agent ref.
Reason AUDIOLOGY referral
Medical priority High
Referral handling

Put on waiting list Booked directly

DR N CURRIE, THE SURGERY, BOCKHAMPTON ROAD, LAMBC .

Client contact date

Interview

PathwaylD Edit Registered by USER NAMESO -
Referral overview | Client's referral | Referral answer | Clinical actions
Referrals: 104762, 04/23/2010, PAEDIATRIC hearing aid journey (PHAC) ~ Clientname MST FIRSTNAME417 LASTNAME417 =
Book Search and book Add to list Add obsemvation Print referral Print receipt Print answer Mew Save Delete
Selected referral
PathwaylD Edit Waiting list entries Attach E St waiting lis
RTT start date 04i23/2010 Age atstart 10y Waittime Waittime Date Waiting list Informati
Referral date 04/23/2010 Other date 04/23/2010 -549 11/30/2010 | TGW - PHAC Temporary loss Reassessmentreview 6 months
Treatment type PAEDIATRIC hearing al (P!
Reason AUDIOLOGY referral -
Customer BERKSHIRE WEST PCT (RG) - < >
Referred by DR N CURRIE, THE SURGERY, BOCKHAMPTON RC| .| Appointments Attach | | C Ec 5 B g
Referring agent ref. Date | Time | Symbol | Status] Resource
Medical priority High - 12012010 (1130 @ D |Res70 AUDIOLOGY re
. 0412712010 |09:15) @l S |Res70 EMT referral
Referral handling -
Information Put on waiting list Booked directly Edit
Reassessment - < >
review & months - = =
Observations and procedures Detach E
Interview ERTLETEEIEE 0bs no. Date | Add[s| Text Comment
“
-
Registered by USER MAMESO -
Current status
Outcome | 32a, Active monitoring - clinician start | Clock  Stopped FETETE SERES —
i ~ Active length: w,
S 0412712010 12:08°55 aRITE History Mame Target date andwarnmgs{Current
i e AT . T R G T D Assessmer 06/03/2010 r RTT end date: 04/27/2010
SEET e Sy et Treatment | 07/23/2010 W RTT end dale set by outcome status
New ogutcome status 32a, Active monitoring - clinician start - |Follow up r v 32a Active monitoring - clinician start

Primary information

« Thered area in the below screen shot is the main window of the client’s referral where
you will find the primary information like RTT start date, Referral date, referral Reason,
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etc.

o The RTT date is the date that will be used for calculating the Active length. This date will
transfer to a Waiting list if the Waiting list is booked from the referral.

o The Referral date is the date when the referral letter was written or sent to your
department. Auditbase automatically enters the current date, which can be edited. This
date is not involved in calculations

« Treatment type is the pathway which the patient is following. The Treatment Type is
shown in the list of Referrals a patient has had.

« Reason is definable and set up by the system administrator - it can be mandatory or
disabled.

« Other date is usually used where referrals have another important date such as date of
referral to ENT - this date is not used in calculations.

« Medical priority is used to indicate an overall medical priority for the patient besides the
clinics internal waiting list priorities.

« Referral handling can be used to support extended pathways in corporation with other
hospital departments. Use it to indicate how the referral has been handled, i.e. if it was
accepted, denied, referred onwards etc.

« Information that is relevant for an appointment can be added which will be transferred
to Waiting List Information. This free text can be up to 254 characters in length.

Active length period

« Inthe blue ringed areas, you will find the active length period information i.e. RTT start
date, Active length and RTT end date.

« The Active length period is directly related to the Clock value of the outcome Status of a
referral and only increases when the outcome Status has a clock action of Counting.

« Ifitis Suspended, the Active length will not increase.

« If itisthen set to Counting again, it will start counting from when it was suspended.

o Only 5 Suspension periods are supported by the Active length and Current Outcome
feature in one referral.

« If the clock is set to Stopped and then to Counting again, it will start counting again from
zero.

o Dynamic data is used to see which sub-journey (first, second, third, fourth or fifth) is
current.

« If the clock is set to Nullified, nothing will show in the Active length field.

Current outcome status and last appointment

o The purple areas relate to the Current outcome status of the client’s latest
appointment.

« Outcomes appearing on the Booking information drop down list represent an
Appointment outcome. Those selected from the New outcome status list on the referral
screen represent a Referral status. Outcomes selected from the New outcome status on
a Waiting list represent a Waiting list status. Outcomes can transfer from appointments
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to waiting lists and referrals and from waiting lists to referrals if the entries are linked
and if the Outcome is configured as being applicable to these functions. l.e. if an
Appointment Outcome is configured as a Referral outcome but not as a Waiting list
outcome, it can transfer from the appointment to the referral but not to the waiting list.
Most outcomes could be required as an Appointment, Referral and Waiting list outcome
status but some, e.g. referral received and referral closed, may only be required as a
Referral status.

o The Appointment field shows the client’s last appointment including the status of the
appointment.

« Appt outcome is the appointment outcome of the above appointment.

« In the Status field the current outcome Status assigned to the client is displayed
followed by the Clock action and the time and date when the Status was last changed,
as well as any Comments.

« The New outcome status can be changed manually or it can be set from the next
appointment, if that has been set up by your System Administrator.

« To change the New outcome status manually, either choose a new outcome status in
the dropdown list next to New outcome status.

o Oruse the Add new button where a date in the past or future can be set, if the
associated extended user right in System Administration, Referral: Edit Status History,
has been enabled. Setting a date in the future is particularly useful for future patient
unavailability.

MNew outcome status *

Save Cancel

Date 01/02/2022

Cutcome status: 11b, End Active monitoring - discha JRg Clock action Stopped

Comment

The same Outcome status can be set twice or more in succession, either by using the Add new
button or by auto-assigning from the Booking module.

Outcome statuses can be paired so that setting one outcome will immediately initiate another.
This is particularly useful where a stopped status precedes a close status. For example, if a
client declines treatment, you may want to stop and close their referral. This can be done by
pairing these two outcome statuses. Your System Administrator will set this up and the first
outcome can be selected by auto-assigning from the Booking module or using Add new as
described above. These changes will be shown in History.

Multiple clock stops and starts can be viewed in one referral. The Target date and Active
length is shown for the 'current instance', i.e. from a new clock start after a stop there is a new
active length and Target date for up to five restarts, and indicates when it is not the first
instance.

All outcome status changes can be found under the History button.
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Outcome status history and journey summary X
Close

Outcome status history Mew outcome status | | Edit outcome status ||| Delete outcome status
Date Outcome status | clock | Comment

01/01/2022 18:38: 11 1003, Referral closed Closed

01/01/2022 18:24:03 10a, Awaiting first ACTIVITY Counting

01/01/2022 17:58:48 100a, Referral closed Closed Standard efterfalger til '"11b, End Active monitoring - disch:

01/01/2022 17:58:47 11b, End Active moanitoring - discharge | Stopped

01/01/2022 17:52:34 100a, Referral closed Closed Standard efterfglger til "11b, End Active monitoring - disch:

01/01/2022 17:52:33 11b, End Active monitoring - discharge | Stopped
12/29/2021 14:56:23 11b, End Active monitoring - discharge | Stopped

12/24/2021 18:37:54 10a, Awaiting first ACTIVITY Counting
< >
Clock summary Active length summary as of today
Date Clock Duration Journey Start End In suspension | Active length
01/01/2022 |Closed Ow 1d 3 01/01/2022 | 01/01/2022 0w, Od 0w 0d
01/01/2022 | Counting Ow 0d 2 01/01/2022 | 01/01/2022 0w, Od 0w 0d
01/0142022 |Closed 0w 0d 1 12/24/2021 | 12/29/2021 0w, 0d O0w5d
01/01/2022 | Stopped Ow 0d

01/01/2022 | Counting Ow 0d
01/01/2022 | Closed Ow 0d
1212912021 | Stopped 0w 3d
12/24/2021 | Counting Owb5d

When the client does rearrange, the appointment for the future outcome status can be found
under the History button and can be deleted or modified and new ones can be added
retrospectively.

The history dialogue shows the referral outcome status history, which can be manually
modified if the appropriate extended user right is enabled. In addition, the history dialogue
shows the Clock summary and Active length summary, which cannot be manually modified. If
an outcome is applied that has a no change clock action, the status is shown, but there is no
change to the current clock action and there are no changes to the clock summaries.

Referral stages
Auditbase generates the referral stage from the current outcome status.

The current stage is checked in the Current column of the Referral stages table.

If the stage is incorrect and needs to be changed, it must be done by changing the outcome
status to one that puts the client in the correct stage of the referral.

If the Referral stage is still incorrect, then inform your system administrator who can check the

set up in the system administration tool.

Target dates will be shown depending on the settings entered by your System Administrator.
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If clock suspensions are permitted, an outcome status that has a suspended clock action will
suspend the clock. Any target dates will increase by a day for each day that the clock is in
suspension. Suspension periods do not count towards the Active length total. Active length
does not increase while the clock is suspended.

Depending on how your System Administrator has set up Auditbase, the Book and Search and
Book buttons will default to different settings for each of these referral stages.

It is possible for Auditbase to be set up so that when either of these buttons is selected, the
next appropriate appointment is found, with symbols etc. pre-selected.

If Search and book has been set up but the required appointment symbol is not listed, you
need to check that you are searching for the correct appointment type and that is it appropriate
to link it at this stage.

If all is correct, but the symbol is still not displaying, then Close the Search and book window
and you will then be taken back to the Referral module.

Select Book and book the appointment directly, attaching the appointment to the referral as
previously described - your system administrator should then be informed.

If a Referral has a Closed outcome the Book and Search and Book buttons will generate a
message preventing their use. An appointment can be attached to the referral with an
extended user right.

Referral >

The selected refemal is Closed. Cannot book an appointment faor this referal

I'x

Furthermore, Waiting List entries cannot be attached to a closed referral, if a Referral has a
closed outcome then the user will get an error message stating that they are unable to attach
the waiting list entry.

Referral *

The selected referral is closed /nullified. Cannot attach the waiting list entry with start date: 12/23/2021

l.\

Waiting list entries

Click Add to list to open a Client to waiting list window.
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Client to waiting list >
Letter Concise mode Save Cancel
Client Mr. John Smith Appointments Aftach Detach
PathwayiD Edit Date | Time | Symbol|8tatus| Resource
Active wait Projected wait
List GW - CORDAFITTINGS +2 -
Initial wait 0 weeks ZEST Mo -
Registered 122412021 Time on waiting list  20:38
< >
Other relevant date 010212022 -
Edit
Information Qutcome status history Add Edit Delete
Date Outcome status Clock
Reason ENT referral -

Letter printed Print letter after saving

Current outcome status

since
Mew outcome status -
Linked referral’s current outcome
20d, Further assessment required  SINCE  01/02/2022 20:35:20 Counting
Current stage breach date
Medical priority < >

Any waiting list entries saved in this way will appear on the Waiting list entries table at the top
right of the main referral screen.

Waiting list entries Aftach Detach Edit Show in waiting list

Waittime Date Waiting list Infarmation
g 12/29/2021 | TGW - FOLLOW UP 3
-1 12/24/2021 | TGW - Audio Review +1 GP LETTER
25 1212412021 | TGW - PHAC Tempaorary loss
12 121 | TGV DAFITTINGS +2

The waiting list entry is saved with current time as the registration time whether the entry is
made in the Waiting List module or the Referral module so that clients are sorted in the correct
arrival time order on the waiting list if used for walk-in clinics.

Therefore, when a Waiting List entry is made from an existing Referral then on the Waiting List
entry, the Date will default to when the Referral was made, but the time will default to when
the Waiting List entry was made.

If you create a waiting list entry directly in the Waiting list module, it will not be linked to a
referral unless you have auto-linking enabled by your system administrator.

You can link it using the Attach button, which will open a window with a table showing existing
waiting list entries that could be linked to the referral.
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Attach WL entry to referral ¥

Select Cancel

Treatmenttype: Al -

Date  |Pathway D Waiting list | status | Referral Treatmenttype | A
1212512021 TGW - DOMI follow up 3 ENT Hearing aid referral
1212412021 TGW - PHAC Temporary loss 109548, 1272472021 |ENT Hearing aid referral
1212412021 MHSP - 8 month fallow up ENT Hearing aid referral

TGW - CORDAFITTINGS +2 109548, 12/24/2021 |ENT Hearing aid referral
1212412021 TGW - Audio Review +1 108548 12/24/2021 |ENT Hearing aid referral
1212412021 TGW - SPEECH AUDIO 1 EMNT Hearing aid referral

If a mistake has been made and the waiting list entry should not be attached to this referral,
the Detach button on the main referral screen can be used to select and detach a waiting list
entry.

Click the Edit button to edit the selected waiting list entry and the Show in waiting list button
to open the waiting list that the selected entry is part of.

Note:

If the ‘Keep client’s entries on waiting list after booking an appointment’ box has been
checked in the system administration tool, a client waiting list entry will remain until they
are deleted manually from the waiting list.

If an appointment has been booked for this client and then they are deleted from the
waiting list, any appointments associated with that waiting list entry remain attached to
the referral. This is explained in an information message when deleting from the waiting
list.

To prevent confusion at a later date, the appointment which remains attached to the
referral can be detached manually, if required using the Detach button on the
Appointments section.

Appointments

The Appointments table at the right shows all the appointments linked to this referral. This
includes:

« Any appointments created from a waiting list entry that is linked to this referral.
o Any appointments created directly from this screen from the Book or Search and book

buttons.

« Any appointments created in the booking screen when the window opens to link the
appointment to a referral.

o Any appointments added to the referral by the Attach button from this screen. This
includes cancelled appointments from the Cancellation History.
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Appointments Attach Detach Edit

Date | Time | Symbol | Statu# Resource Reason
01/01/2022 |12:00) W * | Charlie .ENT referral
12/28/2021 |10:00, (W * | Charlie .ENT referral
122812021 | 10:00 [m] * | Travy (ENT referral
12/2512021 | 09:45 [m] * | Stassy (ENT referral

If a mistake has been made and the appointment should not be attached to this referral, select
the appointment and click on Detach.

Right-click on an appointment to open the Booking information window.

Click the Show in booking button to open the selected appointment in the Booking module
and the Edit button to edit the selected appointment in the Edit appointment window for that
appointment.

Observations and procedures

The Observations and procedures table at the right shows all the observations and
procedures linked to this referral including;:

« Any observation or procedure created on the Appointment information window of any
appointment linked to this referral.

« Any existing observation or procedure linked directly to this referral from the Add
observation button on this screen.

Observations and procedures Detach
Obsno. | Date |Add|S]| Text Comment
126 122412021 Dtoscleros

Select an observation or procedure and click on Edit to edit it.

If a mistake has been made and the observation or procedure should not be attached to this
referral, select it in the table and click on Detach.

Print Receipt

You may wish to send an acknowledgement of referral to the referrer or client. Click the Print
Receipt button and the letters dialog will open displaying those templates that have been
authorized for use as a receipt. Select the letter you wish to use from the table and open,
preview or print/email it.

Referral receipt templates are created in the letters module (Booking — Functions — Settings
— Letters) and should be marked as Available for Referral receipt.
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3.3.1 Quick referral creation

If the referral does not exist or an existing one cannot be used, you can create a new ‘quick’
referral.

This option is available for:

Booking (when Referral linking to an appointment is mandatory for that appointment
type)

Waiting list linking to referral

Surgery

Implant screens

Client module (Implant tab)

To create a quick referral:

In the Booking and Waiting list modules, click New Referral

| MNew Referral | Select Cancel

Mew referral >

Treatment type:

Hefemalddel] o MR FIRSTNAMEB768 LASTNAMEB768 Save Close

02/27/2017 |
RTT start date f2m7i2021

02i27/2017
Treatment type -

07/06/2008
09/05/2005
09/01/2005
09/13/2004 Customer -

101212001 Referred by

Reason -

PathwaylD

e In the Surgery and Client modules as well as Implant screens, click ' and then New to

the right of the Referral field.

Referral I__I |

Mew

Attach
Detach

« Select the relevant options for Reason, Customer and Referred by fields.
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Mew referral bt
Client MR FIRSTMAMESTGEE LASTNAMESTGE Save Close
RTT start date 12/06/2021

Treatment type ENT Hearing aid referral -

Reason

ENT referral -
Customer WILTSHIRE PCT -
Referred by MELSON (SC), NEW COURT SURGERY, BOROUGH FIELDS, WOOTTOMN BAE |
PathwaylD [l
o Save.

For convenience and ease of use, the system administrator can configure default values for
Reason, Customer and Referred by dependent on the Treatment Type.

Note that Reason may not be shown if disabled in Administration.
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3.4 Referral answer

After saving a referral, you can enter and print an answer.

« Enter the Date.

o Typethe answer text.
o Click Print answer.

When the answer has been saved, it may be disabled for editing, if this is defined by the
system administrator.

Referral overview Client's referral = Referral progress || Referral answer | Clinical actions
Referrals |109548‘ [42/24/2021, ENT Hearing aid referral | Clientname Mr. John Smith =
Book Search and book Add to list Add observation Print referral Printreceipt || Printanswer Save Delete
Date 122512021

User SYSTEM ADMIMNISTRATOR

-

-
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3.5 Clinical actions

This tab lists the clinical actions which have occurred within one of the appointments that are
linked to the referral.

The type of actions to be caught are configured in the System Administration tool.

Referral averview Client's referral = Referral progress | Referral answer || Clinical actions

Referral 109548, 12/24/2021, ENT Hearing aid referral Client name Mr. John Smith

Refresh Detach ew audiogram Open

Action date | Appt.date Stage Appt. symbol Action type Description

12/24/2021 | 12/125/2021 | Assessment | ENT new patien | Stock: Lend out article MNHS HEARING AID (Serial Mo.), NHS SUPPLIES, BE101G, RFG312
12/24/2021 |12/25/2021 |Assessment | ENT new patien | NOAH action

12/24/2021 | 12/25/2021 |Assessment| ENT new patien | Audiogram 1212412021, no. 1, Aided

121242021 | 1212512021 Assessment | ENT new patien | OtoSurgery Pre-op

1212512021 | 1212512021 | Assessment | ENT new patien | BKB test

122412021 | 12/25/2021 |Assessment EMT new patien | Document Headed letter template

Clinical actions may have a description, either entered manually or generated automatically by
the system.

For example, a Glasgow questionnaire has an automatically generated description which
contains the abbreviated questionnaire type and the values of global scores; the earmould
impression description is in the form of "L: Name, Material; R: Name, Material", where L/R
stands for the left/right mould, Name - the name of the mould, and Material - the material of
the mould.

The Refresh button will re-populate the list of clinical actions.

Any clinical actions that are not required can be removed from the list using the Detach
button.

Any saved audiograms can be viewed by selecting the View audiogram button.

Any action can be viewed by selecting it and clicking on the Open button - this will open the
required module/page in Auditbase so that details can be read.

For example, for a clinical action related to stock, the Device list dialogue box will open where
you can review devices, accessories, earmoulds and repair tasks, as well as attach an
appointment to the stock transaction.
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Infarmation Show in stoc History Print receipt Client MR. JOHN SMITH Print Close

Devices | Accessories | Repairlist | Earmoulds

Present < History Accessory issue Aftach Detach |
Modified date Stock type to Article LR User Serial number | Notes | Version | Reason to issue
02 LOAM (Lent outto client) | NHS SUPPLIES, BE101G |L | SYSTEMADMINISTRATOR |RFG31257
Attach appointment to stock tranzaction X
Close
Date | Symbol| Description Resource Status

121252021 [m] ENT new pa Stassy

If you try to delete an appointment which has Clinical actions attached to it, you will get a
message and will not be allowed to delete the appointment.

To delete the appointment, you must first detach the Clinical actions:

o Select the action and then Detach.

o You will be asked if you want to add this action to another appointment or not.

o Select the appropriate option and continue until all actions have been detached.
You can now return to the Booking module and delete the appointment.

NOTE: If a clinical action is created that requires an appointment to be attached to it—
this is defined in the system administration tool — the most relevant appointment will be
added. If only one appointment occurs for the patient that day, and the appointment
start time is earlier than the current time, then the action will be attached to that
appointment. If it is not clear which is the most relevant, for instance if there is more than
one appointment on the same day or none that day, an information box will appear
asking you to Attach the most appropriate appointment.
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3.6 Linking Bookings and Waiting lists to Referrals

When making certain appointments directly in the booking screen or when making a waiting
list entry directly in the waiting list module, Auditbase can pop-up a window requesting you to
link this to an existing referral or make a new one.

This can be configured in the System Administration tool, as well as whether this window can
be cancelled.

Select referral for attaching to waiting list entry bt
MNew Referral Select Cancel
Treatment type: All -

Referral date | Pathway ID Treatment type Active length Status

1 015 +AUDIO REVIEW r sment 2 0d |20d Furthera sment required
1000412015 +AUDIO REVIEW reassessment 247w, 6d | 10a, Awaiting first ACTIVITY
2410312015 ++AUDIO REVIEW reassessment 250w, 2d | 20a, Decision to treatl@#5 % &~7\["
121062001 ++DIRECT REFERRAL /Audio assessment| 951w, 6d | 10a, Awaiting first ACTIVITY

All referrals are shown in date order — Auditbase will, by default, select the most recent referral.

o If necessary, you can create a ‘quick’ referral by clicking the New Referral button. See
details in Quick referral creation.

If it is allowed to be cancelled, then an Automatic Journal Event may be generated and opened
to accept some text explaining why the appointment or waiting list was not linked to a referral.

Journal events *

Selected event
1461

User rejected attaching WL entry to referral

Keyword
GENERAL -
User SYSTEM ADMINISTRATOR has rejected attaching the following waiting list entry to a referral: ~

09/01/2020, TGW - CALORICS & POSITIONALS - PP 41@#$%"&7/?"

[os ]
H
(=]
]
Ml
]

L[ 1 RSl
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If your System Administrator has set that you may not cancel, you must link the appointment or
waiting list entry to a referral or make a new referral.

© Auditdata - 2022, ID: 20.0040/29 S7



User Guide

3.7 Referral statistics

The referral statistics are accessed from the Booking module under Functions -> Referral
statistics.

Referral statistics ordinary et

RTT start date from D‘HD'UEEI'IQ to  09/01/2020 Show Close

Treatment type Customer £ £ £ - = ~
Mew Waiting list| Booked | Booked & WL Total

0

++DIRECT REFERRAL / Audio BERKSHIRE WEST PCT (RG) 0
++DIRECT REFERRAL /Audio GLOUCESTERSHIRE PCT (GL 0
++0IRECT REFERRAL /Audio BRISTOL PCT ]
++DIRECT REFERRAL / Audio| Auto-created customer with cod 0
++AUDIO REVIEW reassessm SWINDOMN PCT 1
++AUDIO REVIEW reassessm GLOUCESTERSHIRE PCT (GL 1
++AUDIO REVIEW reassessm BATH & NE SOMERSET 0
++ALDIO REVIEW reassessm FORCES-UK 0
++ADIO REVIEW reassessm SURREY PCT 0
++ADI0 REVIEW reassessm Auto-created customer with cod 0
++TINMITUS FORCES-UK 1
¥ DO NOT USE-OAE Auto-created customer with cod 0
¥ DO MNOT USE-BATTERIES | BUCKINGHAM PCT 1
++NEOMNATAL ASSESSMENT | OXFORDSHIRE PCT (OX) 0
++FITTING - from previous refe WILTSHIRE PCT [\
+FITTING - from previous refe ABCD 0
++FITTIMNG - from nrevinns refe Auto-created customer with cnd bl

s O PSR VO W e T S J S S N W Y e P R Y T
e e = R = =R e T T A e R o i s P e
RN JRPRRE VRV TV NN AN UV DS N A QS A U A RS U Y O S R Y O

e Y e e R = R = = R B T = ) e e e Y

3.7.1 Referral ordinary statistics

An overview of referrals at a given time is listed by selecting Functions -> Referral statistics ->
Ordinary statistics from Booking.

Period from/to can be entered and information such as treatment type, customer, indication of
number of new referrals, how many are put on waiting list/booked directly together with the
total number, are listed when hitting Show.

Symbols of + and - are added over the columns to indicate how the total number is calculated.
The total number of referrals is calculated based on New referrals plus referrals put on a
Waiting list plus referrals Booked directly from an appointment minus referrals both from a
waiting list and a booked appointment.

3.7.2 Referral advanced statistics

Access Referral statistics advanced via Functions->Referral statistics->Advanced statistics
from Booking.

Here you can calculate referral advanced statistics using the specified criteria.

The statistics contain the following data:
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« New referrals: the number of referrals not booked and not included in a waiting list.

o In waiting list: the number of referrals put on waiting list.

« Waiting list entries without referral: the number of current entries on waiting list without
reference to a referral, plus the number of appointments with reference to a waiting list
entry, but with NO reference to a referral.

« Booked directly: this is the number of referrals booked directly without creation of a
waiting list entry.

« The numerical results in the statistics are sorted and grouped first by referral reason,
then by customer. This means that the statistics contain totals by reasons and subtotal
by customers within each reason.

o The Calculation criteria section is used to specify parameters of the calculation. The
following parameters can be specified:

o Date range: referrals, waiting list entries and appointments within a specified date range
will be included in the statistics. Empty date in the range means unlimited interval.

o Age interval: referrals, waiting list entries and appointments for clients within the
specified interval will be included in the statistics. Empty value in the range means
unlimited interval.

« Show detailed rows: When checked, the statistics will include detailed rows, with names
and personal numbers of the clients each sub-total comprises.

When all criteria have been specified, press Calculate. The result is shown in the Result table
below. Detailed rows are shown in black and sub-total rows are shown in blue.

Press Print to print the results.

It is also possible to export results into a comma-separated values (CSV) file by pressing Export
to file button. Press the button, then select target file in the opened file selection dialog to get
results exported into the selected file.
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4 Waiting lists

Click the button below to access our training materials.

Waiting lists are user-defined. To access the Waiting List, got to Navigation -> Waiting List or
use Shift+Ctrl+W. The Waiting list can also be accessed via Booking and Referral.
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4.1 Adding a client to a waiting list

Press F3 to search for the client or Ctrl+F3 to make a quick search or add a new client to
the database using Client information and New.

Select Navigation -> Waiting List or Shift+Ctrl+W and click Add to list.

Alternatively, from the Referral module select Add to list.

Enter Pathway ID - can be made mandated by your system administrator.

Select the appropriate waiting list from the drop-down list.

Enter Initial wait (shown as Wait time on the list.) The Initial wait is always entered as a
number of weeks. This field can be filled with a predefined waiting time for this waiting
list, if so configured by your system administrator.

+ Registered date is automatically entered but can be adjusted manually.
« Other relevant date defaults to the current date, if so set up by your system
administrator. It can also be set to either mandatory or optional.

o Add any further Information.
o Specify a Reason if required.

o There is an option to Print letter after saving if required.

« A New outcome status will default, if so designed by your system administrator.

« Any Appointments and the Outcome status history attached to this waiting list entry
can be viewed on the right-hand side of the waiting list window. This can be hidden by

selecting Concise mode.
« Click Save.

Client to waiting list

Letter Concise mode Save

Cancel

Client MR JOHN SMITH

Appointments

PathwaylD

Active wait Projected wait

List TGW - AUDIO ASSESSMENT +1

Initial wait 52 weeks

Earmould No
Registered 09/01/2020

Other relevant date

Information

Reason

Print letter after saving

Current outcome status

since

Mew outcome status

Linked referral’s current outcome
since

Current stage breach date

Medical priority

Time on waiting list 15

-

-

22

Edit

Date | Time | Symbol | Status

Resource

Qutcome status history

Date

Outcome status

Clock

The name of the No/Yes Optional attribute (Earmould in above screenshot) may be changed

by your system administrator.
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Besides changing the value from the Client to waiting list window, you can also double-click
on the value field in the list on the main waiting list screen.

| Title | First name Last name | Earmould |Transpnrt| Letter | Pathway 1D |
MRS | FIRSTMAME: LASTMNAMEZ272 | Mo
MR |FIRSTMNAME: LASTMNAME4G88T | Mo
MISS | FIRSTMAME | LASTNAME1505T | Mo
MR |FIRSTMAME: LASTMNAMEZ94021 Mo 1

Good to know
How status works

An outcome status can be set on either an appointment or on a waiting list entry. When the
outcome status for an appointment is set, this affects the outcome status of any waiting list
entries linked to the appointment and vice versa.

If configured by your system administrator, the outcome status can be updated by the
appointment status, so when the appointment status changes, so does the outcome status.

Outcomes appearing on the Booking information drop down list represent an Appointment
outcome. Those selected from the New outcome status list on the referral screen represent a
Referral stats. Outcomes selected from the New outcome status on a Waiting list represent a
Waiting list status. Outcomes can transfer from appointment to waiting list and referrals and
from waiting lists to referrals if the entries are linked and if the Outcome is configured as
being applicable to these functions, i.e. if an appointment Outcome is configured as a Referral
outcome but not as a Waiting list outcome, it can transfer from the appointment to the referral
but not to the waiting list. Most outcomes could be required as an Appointment, Referral and
Waiting list outcome status but some, e.g. referral received and referral closed, may only be
required as a Referral status.

Clock actions and closing

Once the outcome status is set, this effects the clock action. Set up in the system
administration, different outcome statuses have different clock actions, so for instance an
outcome status of “Discharged/Referred back to GP” would typically have the clock action
Stopped associated with it.

If a waiting list entry has been set to Closed, it can be referred completely from the waiting list,
if so set up by your system administrator.

Once a waiting list entry has been linked to an appointment, the single row in the list is
automatically refreshed. You also have the option of using the Refresh button on the waiting
list screen or press F5, to see any hew changes made by your colleagues.

© Auditdata - 2022, ID: 20.0040/29 62



User Guide

0.‘) Auditbase - [Waiting list]

Eile View Edit Functions

S0 a0

Log off | Exit Auditbase

iz

Export to Noah

A& s BB

Detailed Quick Printlist |mport data = Export data

Search Print Import/Export Client data Exit

E Client T18765 MR JOHN SMITH -\ & |Z B |user SYSTEM ADMINISTRATOR Multiple locations

~ Multiple departiments.

hlt e

5QH

= Client's entries Journal || Referral Export || Book |[Searchand book || Letter o Clientlist || Addfolist| Edit Delete Print_|[Mew outcome status | =
g
=
e Waiting list Registration period Selection
= Selectall Clearall Refresh waiting list (F5)
= TGW - AUDIO ASSESSMENT +1 - to
Mo entries selected | 4 | P
Appointments Outcome status and Clock action
iting i Apply defaults
Mext Previous Outcome Al = Clock Counting+Suspended Q EEmt T 15 EEH
From Referral
Latest previous appointment|Next upcoming appointment Reason MHS no. | Customer no. Customer name | Other date | Title ‘ First name Lastname Earm
Mot displayed Mot displayed ++External health prof 2222222222 |5K3 SWINDON PCT MRS FIRSTNAME: LASTNAMEZ278 | Mo
Mot displayed Mot displayed ++External health prof 124

GLOUCESTERSHIRE PCT (Gl

MR FIRSTNAME: LASTMAME46887 |No

Your system administrator can set up for the whole site or you can configure in Administration
for when you log in whether or not the waiting list should refresh immediately after changing
filter criteria. If not, the Refresh button will turn yellow to indicate that changes have been

made and you should refresh the waiting list.

0)) Auditbase - [Waiting list]

File View Edit Functions

A& B8

Detailed | Quick  Print list

I

Log off | Exit Auditbase

3=}
Export to Noah

Import data | Export data

Search Print

Import/Export Client data

Exit

E Client - ,9\ = |Bl|user SYSTEM ADMINISTRATOR Multiple locations... ~ Multiple departments.. - ¢ 9
= Client's enfries Journal | Referral Export Book || Search and book Letter o Clientlist ||| Add to list Edit Delete Print  ||New outcome status ‘ =
£
‘; Waiting list Registration period Selection Clearall
E = Changes made, press to refresh (F3)
5 TGW - AUDIO ASSESSMENT +1 - to Selectall
Mo entries selected | 4 | p
Appointments Qutcome status and Clock action
0 Apply defaults
Next Previous Outcome Al ~| Clock FEEL ] st
From Referral
Date Active wait Wait time | Outcome status | Clock ac‘udHUsp\Ia\ no. MName ‘ Postcode ‘ DoB |Nc| ‘ Information
| |0910/2007|639w,2d -587 20b, Cancelled - Counting | 712278 MRS FIRSTNAMEZ2278 LASTNAMEZ2: PC:4541 12/051959 1
| |19/01/2011 468w, 1d -416 20a, Decision to| Counting MR FIRSTMAME46887 LASTMAME4E PC:208 011101998 2109075 G.P. letter- FF
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4.2 Viewing and filtering Waiting lists

« Select Navigation -> Waiting list.

o Select the relevant waiting list from the drop-down list.

e You can view the individual waiting lists or select All to view all the waiting lists at the
same time.

« When scrolling to the right, you will see a column called Projected wait, which shows
what the wait will be when the booked appointment occurs. It only shows when the
option to show Previous and Next appointments is enabled on the particular list. The
appointment must be linked to the waiting list for the predicted wait to be displayed.
Appointments with certain statuses chosen in System Administration are not included.

« Limit the Registration period, if required.

« If all entries do not fit into the table, use the Right arrow button to see further entries.

« You can also filter the waiting lists, if so set up by your system administrator.

o The filters have the following actions:

« Appointments - Next and Previous. This filter will display those clients that have a next
or previous appointment which can be Found or Not found.

« Outcome status. Displays all clients with the selected Outcome status.

« Clock action. Displays all clients with the selected Clock action or combination of
actions.

« Current stage breach date. Displays the target date for the current stage only. This does
not display the target date of the stage when the client was added to the waiting list.

« If you select From Waiting list, data will be filtered on the outcome status and clock
action from the waiting list entry; if you select From Referral, then data will be filtered
on the outcome status and clock action from the linked referral.

« Limit the Registration period, if required.

o Your System Administrator can set breach warnings allowing entries to change colour
dependent on how close to breach they are or if they have breached. The breach date
can be calculated in days or weeks.

NOTE: The From Referral option can be disabled from the Auditbase Administration tool
by clearing the Display medical priority, outcome and clock action from linked referral
on the main WL screen check box in the Waiting list types settings.

o When scrolling to the right, you will see columns called Referral outcome and Referral
clock action, which contain the current outcome status and clock action from the linked
referral. The columns will be empty if the waiting list entry is not linked to a referral and
will contain “<Not displayed>" if the From Referral option is disabled.

o These filters can be used singly or in combination with each other. The defaults set by
your system administrator can be applied by clicking the Apply defaults button.

« If the current filter excludes the chosen entry under Client’s entries, the filter will be
changed to show the entry. The new filter you see is only filtered on the date of the
selected client’s entry.

« Active wait and Projected wait will be shown in weeks and days or just days depending
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on the setting in Administration.
o Printif required.

o)) Audithase - [Waiting list] - m] ®
File View Edit Functions
O o, = % @ =» o’n 'U
@ | Em S > © i
Detailed | Quick  Printlist |mportdata Exportdata Exportto Moah Logoff | Exit Auditbase
Search Print Import/Export Client data Exit
@ Client T137586 MST FIRSTNAME37586 LASTNAME37586 |~ | 2| & B User SYSTEM ADMINISTRATOR Multiple locations... = Multiple departments... |- ¢ ?
= Client's entries Journal Referral Export Book | Search and book | Letter To Client list | Add to list Edit Delete Print | MWew outcome status
<
& Waiting list Registration period Selection
g Selectall S
= TGW - AUDIO ASSESSMENT +1 - to
1 entry selected 4/
Appointments Outcome status and Clock action
. Apply defaults
Next Previous Outcome Al + Clock Counting FROID U T R
From Referral
Date Active wait ‘Wait time | Quicome status | Clock acli4 Hospital no. Name Postcode DOB | Mo. | -~
09/10/2007 |639w, 2d -587 20b, Cancelled - Counting | T12278 MRS FIRSTMAME2278 LASTNAMEZ] PC 4541 12/05/1959 1
19/01/2011 |468 w, 1d -416 203, Decision to| Counting MR FIRSTMAME4G887 LASTNAME4E PC:208 01/10/1998 2|109075 G.P. letter- FF
18/02/2015 (255w, 1d -203 Counting | T115057 MISS FIRSTNAME15057 LASTNAME PC 64097 22/06/1998 3
18/02/2015| 255 w, 1d -203 Counting | 7128402 MR FIRSTMNAME294021FIRSTNAME] KK3 8LL 30/05/1951 4
20M11/2015 | 215w, 6 d Counting | truhwet MR OK OK B& 3EE 06/09/1943 i}
07/07/2017 (130w, 6 d -78 203, Decision to| Counting | T999811 Father dzee2 azel m 03/04/1992 7
07/07/2017 (130w, 6 d -78 Counting | T1105 MRS FIRSTMAME 105 LASTNAME10f PC 3649 16/08/1910 8
15/06/2018 |81 w, 6d -29 103, Awaiting firs Counting | T144659 MR FIRSTMAME44659 LASTMAME4: PC: 7386 06/0711947 9
15/06/2018 81w, 6d -29 20a, Decision to| Counting | T1120 MRS FIRSTMAME 120 LASTNAME12( PC:6082 19/08/1929 | 10| 555S5555S5X00000000XCCCZSSSS
O7N720MA I TRw A d -2R Countinn | TAR4RARG M= Surnerv 0412018 " e
< >
Waiting list: TGW -AUDIO ASSESSMENT +1 Client phone 99999 999999 Transport:
Customer name:  SWINDON PCT Customer no.: 5K3 Client location:Disabled in Admin

NUM

© Auditdata - 2022, ID: 20.0040/29

65



User Guide

4.3 Searching for a client on a waiting list

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Navigation-> Client’s entries or press Shift+Ctrl+Q.

« Highlight required waiting list entry in lower table.

« Click Show in waiting list or double-click.

« Click Edit to edit the entry.

« Click Add to create a new entry.

Client's appointments and waiting lists X
Client MSTFIRSTNAME37586 LASTNAME37586 Close
Appointments list - 17 item(s) History of changes Attached actions Delete from history Show in appt book
Date |Time |Luc.|Dept.| Appt. |Status|Resource| Reason |SMS1|SM32|DecIined offer Symbo A
2000612018 | 10:000 4 | 4 T Resdf | ++External health professional referral (eg.HV's) GWH Audio asses
19/06/2018 17:00 m] * | Trawy ENT new patient r
18/06/2018 16:00 I * | Charlie | ++External health professional referral (eg.HV's) from1
18/06/2018 | 10:00 E] * | Trawy +CIRENCESTER Treatment Centre (ISTC) PHAC new patient
10/06/2018 1 13:15 1" * | Stassy ALDIDLOGY referral to1
23M1/2015 | 10:15 7 5 |Res81 ENT referral 2
09M1/2015 | 10:45 7 * | Trawy ++External health professional referral (eg HV's) 2
051112015 | 12:00 T A | Trawy ++External health professional referral (eq HV's) 2 ]
< 3
Waiting list entries - 1 item{(s) Add Edit Show in waiting list
Waittime| Date| Waiting list| Information|
-166 021 TGW - AUID|" "2AL: "17A(]
Appointments where an offer has been declined will appear in a Burgundy colour on the
screen, with the associated Appointment status.
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4.4 Selecting clients’ entries from waiting list

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Select Navigation -> Waiting list.

« To select one client, click on the client’s row. Your System Administrator can configure
whether or not a warning will appear when changing a client.

« To select multiple clients, click each one in the grey column to the far left. This will turn
on the check mark.

« When a client is selected, he also becomes temporarily checked until another is
selected or the check is confirmed by clicking on it.

o Multiple selections can be used for Export, PPP, Delete, and Book functions.

« When multiple clients are checked, the client highlighted in black will be the one used
by the Client’s entries, Journal, Referral, Add and Edit buttons.
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4.5 Deleting client's entry from waiting list

It is not possible to delete a waiting list which contains client entries.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Waiting list.

o Select the client's entry (or entries) by clicking on it; a check mark will appear at the start

of the row.
« Click Delete.
« Click Yes.
« When multiple clients are checked, the whole group will be deleted.
Clients entries Journal | Referral | Export Book | Search and book | Letter | To Client list | Add to Jist Edit Delete Print | New outcome status |£‘,
Waiting list Registration period Selection
Select all Clear all
TGW - AUDIO ASSESSMENT +1 - to electa
3 entries selected 4| »
Appointments Oy Waiting li
g list 5 iting i Apply defaults
Mext Previous Ou T frorr_1 ‘._'Vamng = By
I@I Are you sure you want to delete selected 3 client(s) from waiting list? -
Date Active wait Waittime | Outco| & Postcode | DOB  [No.|
09/M10/2007 639w 2d -587 20b,d C4541 12/05/1959 1
19/071/2011 (468w, 1d -416 20a,0 Yes Mo Cc:208 01/10/1998 2109075 G.P. letter-
v |1 0 1d 203 C:6497 3
18/02/2015 255w, 1d -203 Counting | T129402 MR FIRSTNAME294021FIRSTNAME] KK9 8LL 30/05M1951 4
w2 I NUINAR 1212w 2 A -1RR Manntina | T127R08R MaT FIRSTRIAMEITRAR | AQTHAMET B-2010 nN7Iennn BT PIAL" =12A1- "12AL-
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4.6 Editing or moving a client's waiting list entry

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Waiting list.
« Highlight the client's entry.

« Click Edit or double click on the row (except in the Optional att column where a double-

click toggles the value).

Edit waiting list entry x
Letter Concise mode Cancel
Client MRS FIRSTNAME120 LASTNAME120 Appointments Aftach Detach
PathwaylD Edit Date |T|me | Symbol|8tatu51 Resource
Active wait Ow,0d Projected wait
List TGW - AUDIO ASSESSMENT +1 -
Initial wait 52 weeks Earmould MNo -
Registered 15/06/2018 Time on waiting list  14:30
< >
Other relevant date 15/06/2018 -
Edit
Infarmation 5555555555 “| Outcome status history Add Ed g
00000000 -
Date Outcome status Clock
Reason ++GP direct referral w | |15/06/2018 14:47:07 91a, Active monitoring - continued Stopped
i i 15/06/2018 14:39:07 100a, Referral closed Closed
Print letter after saving - -
15/06/2018 14:39:06 36a, Patient died before RTT treatment | Stopped
CITEHCTEID TS 15/06/2018 14:38:16 | 100a, Referral closed Closed
913, Active monitoring - continued  since  15/06/2018 14:47:07 Stopped 15/06/2018 14:38:15 36a, Patient died before RTT treatment | Stopped
Change 15/06/2018 14:32:36 31a, Active monitoring - patient start Stopped
Mew outcome status -
Linked referral's current outcome
33a, DMAst assessment since | 15/06/2018 14:65:27 Mullified
Auto assigned by: 15/06/2018, 333, PHAC new patient mould~
Current stage breach date
Medical priority ~ Mormal = N

« The Initial wait (weeks) and Registered can be modified. If a client is entered on a
waiting list with a waiting time of O weeks, Auditbase will calculate how long the client
has been on the waiting list. It can be used to prioritize clients i.e. entering 4 weeks for
urgent, 6 for soon and 8 for routine. Auditbase will then list the clients with the urgent

clients at the top of the list.

« On an entry editing, the system offers possibility of either initial Waiting time editing or
Waiting time rest editing. This depends on settings in the Administration tool.
« Active wait and Projected wait will be shown in weeks and days or just days depending

on the setting in Administration

« Set Optional attribute status to Yes or No. Note that this status can also be changed in
the main Waiting list by double-clicking on the Optional attribute column for a certain
entry. Note also that the name of the Optional attribute is configurable by the system
administrator for all lists or for a specific list, so it may have another name in your system.

© Auditdata - 2022, ID: 20.0040/29

69



User Guide

o Free text can be entered in the Information box.

« Reason can be selected from a drop-down list.

« Depending on the settings in the system administration, a waiting list entry can be
deleted automatically, if the New outcome status is set to Closed. In the system
administration, you can also choose to show a warning before the entry is deleted, in
which you can overrule the setting and not delete the entry.

Edit waiting list entry

4% The outcome status "100a, Referal closed’ will close the waiting list entry immediately after saving.
I.,\h /,I For the waiting list ‘Atesttype’, the default action after closing an entry is deletion.
= Do you want to delete the waiting list entry?

Yes Mo

« When you click Save, the dialog will close.

This procedure can be used to move a client from one waiting list to another.

70

© Auditdata - 2022, ID: 20.0040/29



User Guide

4.7 Exporting waiting lists to Comma Separated Values (CSV)

Navigation -> Waiting list.

Select a Waiting list from the drop-down menu.
o Functions -> Export CSV

A window will open called Create CSV file.

o)) Create CSV file x

Save in: |DThis PC j = FEEE g

i, Folders (7) P

Cluick access

' 3D Ohbjects
Deskt
=siop . Desktop
=
Libraries

: IEI Documents
' Downloads

Network r
e Pusic
W

File name: | j Save |
Save as type: |C5Vfiles (*.cav) j Cancel

« Give the CSV file a File name and choose where to save the file.

o Select Save to store the file in the selected location. This file will have a .csv extension.

o The CSV file that is created will contain all the data for the selected waiting list, no matter
what filters have been applied to that waiting list.

« Toopen the CSV file using Microsoft Excel, start Excel and use one of the Open
dialogues.

o You will need to change All Excel files to All Files in order to find the .csv file.

File name: waiting list > Al Files -

Tools = [ Open |v] ’ Cancel ]

o The file will now open in Excel and can be adjusted as required.
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5 Client lists/Trials

Click the button below to access our training materials.

Lists of clients can be created to be used for research or clinical trials, the name is configurable

as Client lists or Trials by your System Administrator. To access Client lists/Trials select
Navigation-> Client lists/Trials or press Ctrl+Shift+L.

The Lists tab will display all lists and these can be filtered by checking the relevant Status box

to Show planned, Show active, Show closed and Show only assignhed to me.

Highlighting a list and then selecting the Members tab will display all the clients that have
been assigned to that list.

Lists | Members

Mew Edit Copy | Delete || &2
Status
M Show planned M Show active Show closed Show only assigned to me
Startdate | Enddate | Status | Title | Responsible | Type | Min. clients| Act. clients
01/01/2016 | 01/02/2017 | Active | Title 4 | USER NAME29. 444 g

09/01/2020  09/01/2021 | Planned | Test list| SYSTEM ADMINISTRATOR
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5.1 Creating new Client lists/Trials

« To create a new Client lists/Trials, select the New button. A Create Client list window

opens and the Title for the new list can be added.

o A Start date and End date for the list can be added; a double click will insert the current

date while a right click will open the calendar.

« A minimum number of clients for the list can be added to the Min. clients field. The

actual number of clients field called Act. Clients will be inactive.

o Your System Administrator can set up the Type of list which can be selected from the

drop-down menu.

o The person Responsible for this list can be selected from the drop-down menu of users.
o The Status of the list can be selected from the pre-defined drop-down menu. The options

are Planned, Active and Closed.
« A Comment can be added to explain the list.
« Select Save or Cancel to return to lists without creating a new one.

Create Client list >

Cancel

Title | |

Start date End date
Min. clients Act. clients
Type

Responsible  SYSTEM ADMINISTRATOR -

Status Flanned hd

Comment

« The new list will now appear in Auditbase.

Lists | Members

09/01/2020 | 090142021 | Planned | Profound loss | SYSTEM ADMINISTRATOR
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Status

B Show planned Show active Show closed Show only assigned to me
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5.2 Editing Client lists/Trials

« To edit a Client list/Trials, highlight the required list and select Edit. All options are then
available to edit as required.
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5.3 Adding clients to Client lists/Trials

« Clients can be added to a list using the F3 search function.

o Clients can also be added to a list by highlighting the list and selecting the Members
tab.

« Toadd the active client to the list, select the Add selected client button.

« A confirmation window will appear, select Yes to add the client or No to go back to
Members.

Message

I{’g—"\l Do you want to add the selected client to the selected Client list?
L * 4

Yes Mo

o The client will now appear on the list with the default status set by your System
Administrator.

Lists | Members

Add selected client Search and Add clients Remove Change sfatus (<]
Status List
- Profound loss 09/01/2020 - 09/01/2021
Parameter #1 -
Parameter #2
- -
Clients in the Client list: 1, Filtered: 1, Min clients needed: 20
SelectAll Mo entries selected
Hospital no. Mame |Distance| Status |Date added User |F'i|:1ure|Parameters|Gender| MHS no.
T18765 MR JOHM SMITH Mot asked | 09/01/2020 | SYSTEM ADMINISTRATOR | Mo Male 88888888

o Search and Add clients will open the F3 search window and clients can be searched for
using the advanced criteria and added to a list.

o If client(s) are in a list already with intersecting dates or are deceased, the system will
warn and give the option to exclude these from the new list.

o If you need to remove a client from a list, highlight the client and select Remove.

o The Status of a client on a list can be changed by highlighting the client and selecting
Change status or by clicking into the Status field directly on the table. A new status from
the drop-down list can be selected. This drop-down list is defined by your System
Administrator.
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Change status >

Save Close

Mew status for selected 1 client(s)

« The list can be refreshed by selecting the = button.

« Alist can be filtered by selecting from the drop-down menus labelled Status, Parameter
#1 and Parameter #2.

« If afilteris applied, this is shown in the List information.

Clients in the Client list: 9, Filtered: 3, Min clients needed: 444
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6 Booking

Click the button below to access our training materials.

Go to Navigation -> Booking to open the booking module.

In this module, you can find and access all information that has been saved in the database for
the client you are working with. The Booking module handles client appointments, including
group appointments, and reservations.

Information can be represented by either the Resource plan or the Time plan. Appointments
of various kinds may be registered here.

An appointment can be booked either by searching for the next available timeslot or by double
clicking and thereby booking directly. The client must be selected before an appointment can
be booked. However, group appointments can be made without selecting a client.

Appointments can be booked from a number of dialogs in Auditbase, for instance from
Referral or Waiting list.

To edit an appointment or reservation, double-click it and modify as required.

Read more in the following chapters.
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6.1 Booking list

Go to Functions -> Booking list to display a list of the day's appointments for the selected
resource.

These appointments can be filtered as required by resource or time and sorted by time or
hospital number.

The list specifies time, client or activity and resource, sorted in time order and then in resource
order.

Booking list >
Date | 09/01/2020 M Show client/group appointments M@ Show reservations AM only PM only Print Close
=) Sort by time Sort by Hospital no. Resource - All Resources - -

Time MNHS no. Hospital no. Appointment name Resource Appointr
08:00-08:15 88588888 T18765 MR JOHM SMITH Charlie 1
08:00-08:15 T1110 MRS FIRSTNAME 110 LASTNAME110 Resdf 1
08:00-08:15 TEaas13 niu Stassy 2
08:15-08:30 88588888 T18765 MR JOHM SMITH Resdf 2
09:00-09:15 88585888 T18765 MR JOHM SMITH Res4f 1
13:00-14:30 T123026 MR FIRSTNAMEZ3026 LASTNAMEZ3026 Charlie 1
< >

General note Daily note
FY rFe
b -

Click Print to print list. When printing the list the phone numbers of the patient, available from
the client information module, will be demonstrated under the patient appointment.
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Booking list
Selected date: 09/01/2020
[X]Client appointments Reservations [ |AM only [ |PMonly
Belonging to- All
Time Hospital NHS no. Name Resource Appointment Information
no.
08-00-08-15 T18765  B8888888 MR JOHN SMITH Charlie 1
Tel: 99999 999999 Work: Mob :
08:00-08:15 T1110 MRS FIRSTMAME110 LASTRes46 1
Tel: 99999 999999 Work: Moab - +1232323
08:00-08:15 TBB5613 nlu Stassy 2
Tel: Work: Moab -
08:15-08:30 T18765 58658808 MR JOHN SMITH Res46 2
Tel: 99999 999999 Work: Moab -
09:00-09:15 T18765 58658808 MR JOHN SMITH Res46 1
Tel: 99999 999999 Work: Moab -
13.00-14:30 T123026 MR FIRSTNAME23026 LAS Charlie 1
Tel: 99999 999999 Work: Mob :
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6.2 Resource plan

« Select View -> Resource plan to view the Resource plan.

e The date is shown at the top of the screen.

o Times are located on the left of the screen in timeslots. The start and end time can be
modified by the System Administrator to suit the requirements of the department.

o The System Administer can migrate Auditbase from the default 15-minute appointment
units to using 5-minute appointment units permanently. Generally, the 5-minute unit
setting has slower performance than the 15-minute unit setting because three times as
much information is being transferred, processed and displayed. If migrated users have
both zoom and scale options for changing the view, while using 15-minute units users
have only the zoom option.

« The scale options are 5, 10, 15, 20, or 30-minute slots altering the units displayed on

the left-hand time column. It is possible to change the scale view by using the 4 15 min.
button or the following shortcuts which are displayed when the button is selected.
Ctrl+K to Scale up and Ctrl+L to Scale down.

Zoom in Ctrl+|

Zoom out Ctrl+0
¥ 100%

125%

150%

200%

Scale up Ctrl+K

Scale down Ctrl+L

3 Minutes
10 Minutes

n 15 Minutes

20 Minutes
30 Minutes

Using zoom the size of the booking area can be increased by the selected percentage.
This size can be adjusted using the Zoom in and Zoom out options which have the
keyboard shortcuts of Ctrl+L and Ctrl+0 respectively. These same options are available
from Selected zoom on the View ribbon at the top of the page. The zoom and scale
selections are remembered if a user logs off from Auditbase.
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Time CHARLIE Trev BERTA JUDITH ALAN | JAKE
08:00 |eald ke MISS. TESTINA K iz DR. ALAN HARPER LA MR. JAMES SCOTT [JA MR. JAMES SCOTT  |r L/ & FATHER DERF FRED
08:15 |l K i TESTER k& WA LA B L

08:30 |w L i e K& WA WA W LA

08:45 6Ll K ki WA Wé i LA

09:00 &ALl K K WA WA i LA

09:15 |en Ll K K & MISS. BETSY WA WA i Ll

09:30 |6 Ll K K & HARPER LA WA B L

09:45 |m L K K& WA WA b L

10:00 [e L K K& LA WA ]

10:15 el K K & MRS. EVELYN WA WA i Ll

10:20 |6 L K K & HARPER WA WA B L

10:45 [m L K K& WA WA ]

1100 |m L K K& LA WA ]

1115 CJ K K o MISS. MARIN HINKLE | LA WA vl
1130 |m L K K& WA WA b Ll

1145 |m L K K& LA WA b Ll

1200 [eald K k& i ] i L

1215 |m L K K Ll L ot

12:30 [m L K ot E] E} ot

12:45 |mll K E el E B Lol

1300 |jo} E K Ll 3N

1315 (i} E K lu# DR HERB MELNICK | LIA DR. HERB MELNICK | [

1330 |m L K K Ll WA b Ll

1345 |m L K K LA LA b Ll

14:00 |m L K K LA LA b Ll

1415 |m L K K LA LA ]

1430 |m L K K LA LA ]

14:45 |m L K K LA WA b Ll

15:00 [m L K K LA WA b Ll

1515 |m L K K LA WA ]

1530 enlu K k ' DR. CHRIS LYER WA WA i L

15:45 |l K K iz WA LA N

16:00 |l 4 K iz LA LA B L

16:15 |ealy k k N L B

16:30 en [ K K | L B

16:45 |1 L K K L L # L

17:00 |8 L K K ] ] # L1

1715 |l K K W L # L

17:30 |8 L K K W L # L

17:45 |8 L K K W L # L

Time CHARLIE Trev BERTA JUDITH ALAN JAKE

08:00 WSS, TESTINA DR.ALAN WR. JANES WR. JAMES FATHER DERF

0815 A L] k. b reerer b 82 fareer LA St L5 Sorr BF Lol &% Freo
L K de K i FIF:Y MF: BF Lol

e B K, s K i LA Ay b LA

L k K LA, LA, BF L&

0 gt Ll K k LA Ll BF Lol

L ‘ K & 9 LIA LAl

%930 pn L] K K & LA LA EF L]

45 gy || k k LA, Ll EF Ll

190 g L K, K i LA LA BF L]

10215 Bh ) K K i HES.PE\;{ELYN LIJH LIJH BF i

139 g L K, K i LA LA BF L]

10..45 eh L) K ki L A L A eF L

bh L] k k i L& L& B L

1 L ¢ K IR LA LA vl -
e Ll i ki Lol F:Y BF L

LN k. K & Ll & Ll & BF Lu]

= ew L] K K & Ll Ll EF L1

12:15 Bh ] K K | L] &

20 1 L] i &} &} &} Bl

5 g i ot ot ot BF Ll

:2:2 It It k L DR.HERB L DR. HERB =L

13:30 & jat k. L)% i ek )P weinex  [BF L
20 gn [ K k. BF Lo

1245 gn E E Lol Lol By BF L

400 g ] k k Ll ¥ B L

15 g L i i Lol A Lol A BF Ll
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When highlighting a slot in the table (the field is marked in dark blue), the whole of the
corresponding timeslot will be highlighted to the left for a clear overview.

Resource names are located from left to right near the top of the screen. Each resource
column has a drop-down list of the resources in the system.

Three dots at the end of the resource name allows you to choose the resources.

Trawy |

Clicking on a resource will display them in the column.

Bl

Resdb ' e
STUDENT MURSE Travy
ﬁ D, MS FIRSTHMAMEZ7310 LASTMAMEZT 310 Stassy

Tl Charlie
% Res109
v Resdf
ﬁ [ I |

If another resource is selected from the list, the current resource will swap places with
the selected resource. It is not possible to have the same resource on screen more than
once.

You can add or remove Resources from the view by going to the Settings ribbon and
selecting Resource setup.

Timeslots on a resource column can be empty or filled with either timetable or
appointment symbols if there is an entry for a specific time.

On the Resource view between the Timetable and Appointment symbols, two new
symbols for Location and Department can be seen if they are enabled by the System
Administrator.

The full length of client appointments will appear as a light blue colour covering the

duration of the appointment. Reservations are shown as mauve with group appointments

showing as green. Multi-resource appointments are shown in peach colour.

These colours can be suppressed by the system administrator for the whole site or by a
user in their user specific options.

Text in booked appointments will be in black except for Video Appointments which use
blue text to distinguish them. When the selected appointment is a Video appointment
the text will be in yellow rather than white.

Placing the mouse cursor over an appointment, a tool tip will show the length of the
appointment and the client‘s name.
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: . AuditBase 5 - [Booking]

Eile Edit View Functions
|| client 0000001 COLONEL CHARLIE HARPER -1&] (=]| 5| user SYSTEM ADMINISTRATOR Location |l locations ~ll~o
= 13:00-14:45 CHARLIE | Mo fiter] - |.|||# || General || Daily |[[L-]| 2| £ 15 min.
xg' Time CHARLIE 9 Trev . BERTA . JUDITH - ALAN i JAKE
Er‘_ 08:00 gy IA MISS. TESTINA TESTER 4+ MISS. TESTINA TESTER B E BF L) BF L (3]
] 15 K LA BE e 14 oF L & L bF 1]
ok LA B E e 14 oF L & L bF 1]
e K LA B, 1) Meeting Bk BF L o Ll [
el L CE ] b K L] o L bF L]
IA Bl HE BF L o L b L
IA Bl HE BF L o L b L
IA Bl HE BF L o L b L
I, REV. CHRISTOPHER K () K BF L o Lul B Ll
T ROBIN m B BF L B Lol i L]
I m Bk BF L o Lol b Lol
I m ik oF L oF Lol b Lol
It [ Harper family mk B L] o Ll b L
I R 1 oF L o Lol L]
I R 1 oF L o Lol L]
Ii W o [ /A COLONEL CHARLIE o [1] /4 COLONEL CHARLIE i 1] # COLONEL CHARLIE
Ta W Ll HARPER gl A HARPER el £ HARPER
ITa ek eFLl A EATTI-Y AT
h S K FLl A AN LAY
I= EE B L] e L ke L
j ) COLONEL CHARLIE K EBF Lil B Ll BF 1]
I B K BF L N — R
I HE BF Ll B Lol Calendar &J
I B E BF Ll & Ll |
I ) B K BF L N
L Wi b L | | August 2016 =
I ) K BF L L3N]
I K BF L L3N]
}‘e WE BFH BFH 25 26 27 28 29 30 M
i [ b 3
I‘: BE BF L B Lol 12 3 456 7
It BE B L o L g 9 10 11 12 13 14
15 16 17 18 19 20 21
22 23 24 @826 27 28
29 30 1 1 2 3 4
T Today: 25/08/2016
!

« If an appointment’s client name cannot be displayed in full, three dots will be shown

indicating that an appointment is present.

Time | Travy |
08:00 K, 2-1PAED

08:15

08:30

08:45

09:00

0915

09:30

09:45

10:00

10:15 Qg C, MRS FIRSTHNAME2G786888883858825838588 LASTHA. .
10:30 Fit C, MR FIRSTNAME 13050 LASTHAME 13050
10:45 fit C, MRS FIRSTMAME24246 LASTMNAMEZ24246
11:00 £ C, MR FIRSTNAMEZ2787 LASTMNAME2787T
11:15

11:30 fit C, MR FIRSTNAME25461 LASTMAME 25461
11:45 [fe] C, MR FIRSTNAME 10504 LASTNAME 10504
12:00 Fi C, MR FIRSTNAME20268 LASTMAMEZ20268
12:15 Z, MST FIRSTNAMEZ7 705 LASTNAMEZ27 705
12:45

13:00

« Placing the mouse cursor over the highlighted appointment will display a tool tip of the
appointment time/duration and the client’s name.

6.2.1 Resource set up

e The user can set up a personal view of resources in the appointment book.
« To activate the setup, select Functions -> Settings -> Resource setup from the Booking

module.
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Defined and active resources are shown in this window and can be checked to be listed
in the columns of the appointment book.

When checked as Show, a column will hold the resource's name.

When checked as List, the resource's name will be visible from the drop-down menu in
the columns.

When checked as Book, the resource's name will appear in the resource list when
booking appointments.

Click on the Up and Down arrow buttons to define the resource’s position in lists.

Click Save to store a new or changed resource set-up in the database. The changes will
take effect as soon as Save is selected.

Reset to default resource view will load the defaults and the list can be adjusted to one
of the users if necessary.

Resource setup >
Save Close

ser |S‘r’STEr-.«1 ADMIMISTRATOR v| Resetto default resource view || 4w | W
Shnw| List |Elﬂnk| Resource |Lﬂcatinn(s}lDepartment[s} ~

1 [0 | [ |Traw Location1 |Department

Stassy Location2 | Department2

Charlie

Res109

Res46

Res68

Res70

Res5d

Res78

Res73

Resg2

Res75

Res71

Res72

Res105

Resf3

Resds

Res106 v
Showing Resources will be overruled by Location, Department and Clinic filtering. Grey row calor
indicates resource is filtered out

6.2.2 Clinic filters set up

Resources on the Booking screen can be filtered by timetable symbol and/or location and/or
department to show specific clinics or groups of resources working on the same clinic. These
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filters do not override any restriction to resources based on location.

To set up filters, the extended user right Booking: Setup clinic filters is required. Your System

Administrator can provide this extended right. Once the filter has been set up, it will be
available to all users. Setup clinic filters is to the right of the filter drop down menu.

[Mofilter]

« Select New and enter a Name for the Selected filter.

o If Location or Department is required, select these from the drop-down menus.

« If Multiple locations or Multiple departments are required, a new window will open
where the Locations/Departments can be selected.

« Timetable symbols can be selected by checking the box next to their name or you can

Select All. Move the symbol selection to the right-hand box by using the arrow. Symbols
can be de-selected from the filter by checking the box and moving the symbol back to the

left using the arrow.

Clinic filters

Mew Copy

Delete

Close

“~ v
filter 1

Selected filter
MName filter2

Location All locations

filter2

-

Department Department1 -

Timetable symbaols: SelectAll

SelectAll

| Available symbols

~

1 1

22

Ol nNTS

" ENT CLINIC

[JH SAv - C&B - Dref/AGR
] PAED Hearing Aid Clinic
1@ PAED Transition

[1F SAVERMNAKE PAEDS
M TIDWORTH

[/ wiltshire PHAC

[J& 123

1@ FAIRFORD ENT

| Selected symbols

[JE PAED Assisting
[ COMMUNITY PAEDIATRICS
@ test

« A filter can be copied by selecting a current filter and choosing the Copy button.
o You will be asked if you wish to make a copy of the current filter.
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Clinic filters

I/g_'\l Do you want to make a copy of the selected fiter?
k. * 4

Yes Nao

o Select Yes.
« The name of the filter will then have - Copy after its name. You can modify and rename

the filter then Save to create a new filter.
« If afilteris no longer required, highlight the filter then Delete to remove it.

o To exit the filter setup, select Close.
o« These will now be available to all users.

6.2.3 Using Clinic filters

Clinic filters allow the use of filters that just show resources who have certain timetable
symbols, locations or departments for that day. For example, a filter set up to show ENT
clinics will only show resources that are timetabled with the various ENT symbols.

These filters do not override any restriction to resources based on location.

o Select the filter from the drop-down list of filters.
« The Booking screen will change to reflect the filter selection.

o) Auditbase - [Booking] - X
Hle  Edit
lew task
reate ings
L Client T126786 MRS FIRSTNAME26786608833880888888 - | O, 5 [ User  SYSTEMADMINISTRATOR | Muttiple lo ~ Multiple departments .~ (£ P
_ | | ednesday 2510422007 | |IE]| General || paiy |||/ || @ 15 min
5 [1me Traw Stassy Ress8
2 [os00 K 2-3+5A7 A SETUP
2 |os1s JPD @ SAVBKD £ PHYSIO 945, MR FIRSTNANE2S701 LASTNANE28701
0830 2 &
0845 4
09:00 %
0915 51227 5, MASTER FIRSTNAWE25340 LASTNAME25340
GETE101S
:
23 G, MISS FIRSTNAMEASS LASTNANEA56 R S, MR FIRSTNANET694 LASTNANET694 /2 2 75, MSTFIRSTNAME29102 LASTNAME29102
H MRS FIRSTNANE25521 LASTNANE2S521 & S, R FIRSTNAVE19122 LASTNAVE19122 of
R
[ C. MISS FIRSTNAME26063 LASTNAME26063 115 S, MR FIRSTNAME4946 LASTNAME4946
1 12 S, RS FIRSTNANEB279 LASTNAWES279 5
1 [ G, MST FIRSTNAVIE28504 LASTNAME28504 £4 S, RS FIRSTNANESS LASTNAMESES i
1a C.MISS FIRSTNAME28104 LASTNANE28104 ® S, RS FIRSTNANE15260 LASTNAVE 15260 50275, MISS FIRSTNAME29105 LASTNAWE29105
2 R o4
1215 C, ST FIRSTNAME27780 LASTNAME27780 ® IRS FIRSTNAMEQ 133 LASTNAMED 133
1230 D7 C, WS FIRSTNAME28585 LASTNAWE23585 ®
2 & S, RS FIRSTNANE26288 LASTNAVE26283
3 G, WIS FIRSTNAME25464 LASTNANE25454 R
3
330 {11 E]C. MISS FIRSTNAMEZ7108 LASTNANE7 108 o
345 1 ] £ C. MR FIRSTNAME26286 LASTNAME26286 1222
1400 111 C. MR FIRSTNAVE22551 LASTNAME22651 S, MST FIRSTNAVE28904 LASTNANE28904 5122 7 5. MISS FIRSTNAME25793 LASTNAWE25793
32 |11 AP S M & of
4 g 5
1445 11 o 572 2 7 S, MRS FIRSTNAME1023 LASTNAME1023
15:00 1 7 [ C,MST FIRSTNAME27581 LASTNAME27581 D, MST FIRSTNAME28905 LASTNAME28905 Gl
1515 11 ] C, MR FIRSTNAME13170 LASTNAME13170 s} 51227 S, USTFIRSTNAWE26854 LASTNANEZ6864.
111 & 57007 8. MRS FIRSTNAME17306 LASTNAME17306
71 7] 6 C, MST FIRSTNAVIE28897 LASTNAME28397 &
111%cm 40 522 7S, MRS FIRSTNAME20026 LASTNAME20026
11 ] (I C. MST FIRSTNAME2B614 LASTNANE28614 ot
1 -] E C. MST FIRSTNAME26207 LASTNAME26207 fol
111 [2 2 7'8, MST FIRSTNAME23071 LASTNAME23071
v od
7.
7

o Three dots at the end of the resource name allows you to choose the filtered resources.
Travy

o Clicking on a resource will display them in the column.
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Trawvy

K, 2 -3+5A
JPD @ SAY BKD

o If no resources are contained within the filter, Auditbase displays a blank resource plan.

« You must either choose a different date or filter to display resources.

0.‘) Auditbase - [Booking]
File Edit View Functions

m 5 B DB o o® &5 B

Booking list | Client's entries | Reservations | Client to waiting list | Client to group appointment | Efficiency analysis  Booking | Appointment | Referral  Mewtask  Settings

Functions Statistics Create Settings

E Client T126786 MRS FIRSTNAME267 81 - .-°~\ * Hl|user SYSTEM ADMINISTRATOR Multiple locations. ~ Multiple departments - Q 9

Wednesday 25/04/2007 | ||| General Daly ||| |/® 15min

Lonebinen
E
E
3

« If you try and view a Client’s entries when the appointment does not display due to a

filter, you will receive an information message.

Message

The appointment you are trying to wiew in Booking is not available because:

o A
= 1

- The Clinic filter you hawe applied does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

o You will need to select Yes to go to the appropriate date and then change the filter

settings. No will take you back to Client’s entries.
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6.3 Time plan general

« Select View and click on either Large booking view, Standard view, or Large grid view
to choose the preferred view

o)) Audithase - [Booking]
Eile Edit View Functions

& & & 8 &

Make new = Search for new Edit Move | Bulkmove Copy @ Cancel | Delete  Make @ Schedule | Copy
Booking Timetable

E Client  T126786 MRS FIRSTNAME2678! -2 = (B |user SYSTEM ADMINISTRATOR Multiple locations ~ | Multiple departments... = Q ')

z Wednesday 25/0412007 Travy | .|| general || paiy |||m=|[2]|[® 15 min| [ B [EH

é Time ‘ Location Department |Hospital no ‘NHS no. | MName L‘V| Sl Telephone | Information |Reasun‘ Referenced by

& 08:00 All All 2- 3+5AY K 99.9.99 0

- 15 Al All JPD @ SAV BKD 99.9.99 30X
30 Al All
45 Al All
09:00 All All
15 Al All
30 Al All
45 Al All
10:00 All All
15 Al All T1456 MISS FIRSTNAME456 LASTNAME4SE X| |[C|99999 999999 | JOO( )OO X0CL & JOCOO00C J00C
30 Al All T125521 MRS FIRSTNAME25521 LASTNAMEZ25521 |X| | C| 99999 999999 | @000 1000 )X
45 Al All
11:00 All All T126063 MISS FIRSTNAMEZ6063 LASTMAMEZ6063 | X| | C JOOOC 0000 30000 99
A5 Al All
30 Al All T128594 MST FIRSTMAME28594 LASTNAMEZ28594 |X| | C 000000000 99-9-99
45 Al All T128104 MISS FIRSTMAMEZ8104 LASTMAMEZ8104 | X| | C 9 JO0COO0 0COOCC G DOCC)
12:00 All All
15 Al All T127780 MST FIRSTMAME27780 LASTNAMEZ27780 |(X| C
30 Al All T128686 M3 FIRSTMAMEZ8686 LASTNAMEZ8686 (X | C| 99999 999999 | XX JOOGHXK
45 Al All
13:00 All All T125464 MISS FIRSTNAME25464 LASTMAMEZ25464 | X| | C 9 J000C00 00000 - X000GC

15 Al All

Resource

Stassy
Charlie
26 27 28 28 30 31 1 |Resioa
2 3 4 5 6 7 8 |Res4b
9 10 11 12 13 14 15 |Rests

Res70
16 17 18 19 20 21 22 [Roces

23 24 25 26 27 28 29 |Res73

A
REERRREERRRRR

30 1 2 3 4 g [ Res73 RRRRRRRRRRRRRRRRIB\IBII!IIBIR
Res82
Ty Today: 09/01/2020 Res75 85 3% 5% 5 BN 5555 5 55 5 B3 5 o B B B 58

Res71
# Booking or Timetable Res72
Res105
B TimeTable Resfl ARG S R R R BB RMEEBR R ERRRRRR RIER R [ mersrmms
B Booking Res85

Res106
Show in separate rows Res102
Res98
Res87 T B i B T B T B i A e B
Res47 020 [ 1 P10 2 e e e i = e e e o
Resd1
Res8B

« The different views can also be chosen by using the toolbar buttons on the top right:

e Standard view (displaying both the booking view and the grid view). Keyboard
shortcut Shift+F7 can be used for fast access.

m Large grid view (displaying a larger grid view with a smaller booking view). Keyboard
shortcut F7 can be used for fast access.
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i Large booking view (displaying one large booking view). Keyboard shortcut Ctrl+F7
can be used for fast access.

To adjust the size of the bottom half of the screen, the user should hover over the split
line and drag to resize the screen. The timeplan will remember the size that it has been
edited to if the screen is restored down and returned to full size.

Contact your System Administrator to set which view Auditbase defaults to when
opening the Time plan view.

o The different columns in Time plan can be moved, so you can decide in which order the
columns should appear.

« Let your mouse hover over the bottom line of the column header and the mouse cursor
changes symbol‘ﬁ’.

« Now click and drag the column to the relevant location.

o The time span will reflect the hours selected in System Administration -> Workstation
settings.

« The System Administrator can migrate Auditbase from the default 15-minute
appointment units to using 5-minute appointment units permanently. Generally, the 5-
minute unit setting has slower performance than the 15-minute unit setting because
three times as much information is being transferred, processed and displayed. If
migrated users have both zoom and scale options for changing the view, while using 15-
minute units users, have only the zoom option.

o The scale options are 5, 10, 15, 20, or 30-minute slots altering the units displayed on
the left-hand time column. It is possible to change the scale view by using the button or

the following shortcuts which are displayed when the *4 15min.| pytton is selected.
Ctrl+K to Scale up and Ctri+L to Scale down.

o Textin booked appointments will be in black except for Video Appointments which use
blue text to distinguish them. When the selected appointment is a Video appointment
the text will be in yellow rather than white.

Zoom in Ctrl+I
Zoom out Ctrl+0
® 100
125%
150%
200%
Scale up Ctrl+K
Scale down Ctrl+L
5 Minutes
10 Minutes
n 15 Minutes
20 Minutes
30 Minutes
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Using zoom the size of the lower Resource area can be increased by the selected percentage. This size
can be adjusted using the Zoom in and Zoom out options which have the keyboard shortcuts of Ctrl+l
and Ctrl+0 respectively. These same options are available from Selected zoom on the View ribbon at

the top of the page. The zoom and scale selections are remembered if a user logs off from Auditbase.

If a scale is set that prevents individual appointments from being displayed, the time band that
is affected is shown as grey and <Multiple content> is displayed if there is more than one
appointment and <Partial content> if just one. Moving the mouse cursor over the multiple
content will display a tool tip showing the appointment times and the associated client.
Changing the scale will show the full information for the appointment.

Time| Locaion | Department |Hospital no.|NHS no.| Name L|v|s]
0300 | Al All <Multiple content=

20 Al All -

40 Al All

09:00 Al All

20 Al All

40 Al All

10:00 Al All <Multiple content>

200 Al All <Multiple content=

40 Al All -

11:00 Al All T126063 MISS FIRSTNAME26063 LASTNAME26063 X C
20 Al All T128594 MST FIRSTNAME28504 LASTNAME28594 X C
40 Al All <Multiple content>

A scale that does not allow the start or end time of an appointment to be displayed will have
the start and end times highlighted in grey. The tool tip will display the full appointment times.
Changing the scale will display the full information for the appointment.

Time| Location | Department |Hospitalno.| NHS no. | Name L|v|s]
45 Al All
12:00 Al All
15 |Al Al
30 Al Al T113559 MRS FIRSTNAME 13559 LASTNAME13559 | X |C
45 Al All T15790 MRS FIRSTNAMES790 LASTNAMES790 %] |C
13:00 Al Al T11124 MR FIRSTNAME1124 LASTNAME1124 %] [C
15| All Al

Location1 | ] Department? | T18765 MR JOHMN SMITH

7
45 |1 Location1 |‘] Department T
14:00 7 Location1 |l Departmentt —~lI-
15 |“1 Location |1 Department? —ll=
30 |1 Locationt |1 Department

If a 15-minute appointment cannot be displayed fully in the resource area due to the selected
scale, a half symbol is displayed showing that the full appointment cannot be shown. Moving
the mouse cursor over the symbol will display a tool tip giving details of the appointment and
the client.
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« Choose which symbols you would like to view in the Time plan by checking the box next
to either TimeTable or Booking. Both sets of symbols can be seen by checking both

boxes.

# | Booking or Timetable
M TimeTable
MW Booking

Show in separate rows

o Resources are shown to the right of the calendar. Symbols for these resources can be
seen in separate rows by selecting Show in separate rows. This will show four rows of
symbols with Timetable at the top, then Location, then Department, with Booking
symbol at the bottom. This order is described by a tool tip that can be seen by placing
the mouse cursor over the Show in separate rows label.

Resource 0a

afafeferaregh RopopRoppen  EHEOT  DRCRDRDRC e R o e e e fo e fe e A
Res6a AR R R R AR R TR R TR R R R R R R R TR R AR AR AR TR R RTRT AR TRTATRTA AR
A AR R R TR AR TR TR TR TR TR TR TR TR TR R AR AR AR AR TR RTATR AR AR TR
Bes7l Eﬁﬁﬁ‘m‘ Eru' Emt Eru' Emt Eru' Emt Eru' Emt Eru' Emt Em'mmmmfﬁ"-ﬁ'%u' Emt Eru' Emt Eru' Emt Eru' Emt Eru' Emt Eru' Emt ==
a2 2 222272 2002 22
25555 . 25%%5 955
DRDEDRDR°y °7 77  JR17T 77 AgRgHpHg FOOm 7T MM
Res5d PP PPl e e e A B e e LT e i

g AR o AR kAl 8 R kA 12 D A8y i A R A0 4 A4 i L

Contact your System Administrator to set which symbols to view as a default in the Time
plan.

« To save the user configurations you have made, click on the menu View -> Save window
setup and your specific settings for the Time plan view as well as the symbols view will

be saved.
<)) Auditbase - [Booking]
File Edit View Functions
E O E = 00
g ®H % B8 8 Ee = | @
oA HC) & @ 74 ~
Resource plan |[Timeplan  View allday = Calendar  Symbollist = General note | Daily note  Selected zoom  |Large booking = Large grid = Booking only  All resources | Oneresource  Save window setup
Plan View Zoom Timeplan view Resources Settings

92
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6.4 Time plan, All resources

« Select View -> Time plan.
o Select View -> All resources. For fast access, use Ctrl+8 or double-click on a date.
« You can switch between the One resource and All resources views in three ways:

o using the View ribbon menu item
o using F8 or Ctrl+F8
o clicking on either a date or a Resource

« The day is shown at the top of the screen. Resource names are listed to the right in the
lower section of the screen.

o Time intervals for a selected resource are shown in the upper section of the screen. The
start and end time can be modified by the System Administrator according to the
demands of a department. The content of the table represents the appointments for the
resource

« The grid in the lower section represents timeslots with either timetable or appointment
symbols where a timetable or appointment has been created for a resource.

5) Auditbase - [Booking] = X
Hle  Edt | Vew | Functions
P 1 = aa
g B @ % B 8 B =
Resourceplan Tmeplan Viewslldsy | Clendsr | Symbollit | Generalnote | Daiynote  Selected zoom  |Large booking| Lsrge grid | Booking only | Al resources | One resource  Save window setup
Plan View Zoom Setting:
i crient 118765 MR JOHN SMITH -2 =|Eluser  SYSTEMADMINISTRATOR | Mul ~| Multiple departments
_ | | Thursday 0510472007 Res46 INo filter] MR Daily [[=2 [ | ® 15min.
£ | [FreLomion]Deparmenriospiaimo s mo] Name TCVo] Toephone | e
S Al
Z 2o
5 A Al
2 A Al T124557 DR FIRSTNAME24557 LASTNANE4Z57 | X| |S
s A Al —i-
1200 A1 Al —i-
15 Al Al
Al Al
s A Al Tizs824 1S FIRSTNAWE2882¢ LASTNANE2852¢ | X| |5 | 99999 899999 XX, X000 -XI00C 0000000 X000 00X 0K
1400 A1 Al —i-
5 AL Al —i-
N A Al —i-
s A Al Ti28463 RS r X |s
1500 A1 Al —i-
5 A Al —i-
N A Al —i-
6 AL Al T128455 1R FIRSTNAWE2B455 LASTNANE28455 | X| | D 89999 999999 XX KXKGO00X
1500 A1 Al —i-
5 A Al —i-
2 A Al —i-
5 A Al T128458 VR FIRSTNAME28458 LASTNANE28458 |X| | S 99999 099999 XX )0X00000K
17o0Al Al —i-
5 Al Al —i-
2 A Al Ti28885 RS FIRSTNAVEZ8885 LASTNAVE28885 X | S 99899 999999
s A Al ~EMMALREC APPLICATION 2000000000
| April 2007 L. |
R
T
2 27 28 29 30 31 1 |Res
2 3 4@ 6 7 8 |Res
s 10 11 12 13 14 1 [Res e
1617 18 10 20 21 22 [hew
23 24 25 26 27 28 29 |Res
B 3 4 oS
T Today: 0910112020 e
Reso:
+) Booking or Timetable o
[ fimeTable] s
 Booking i ¢
Res.
Showin separate fows

o Choose which symbols you would like to view in the Time plan by checking the box next
to either TimeTable or Booking. Both sets of symbols can be seen by checking both
boxes.
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# Booking or Timetable

M Booking

Show in separate rows

o Resources are shown to the right of the calendar. Symbols for these resources can be
seen in separate rows by selecting Show in separate rows. This will show four rows of
symbols with Timetable at the top, then Location, then Department, with Booking

symbol at the bottom.
>

Resource 0a |I:IQ
BaP PR Ma Ma g

SRR R O R AR AR RRREIY
ResG6a ARTRIRTAT R R R R B RT R R R R R R R AR R R R R R R R R R R R R R R R AR R

R es ? D m m m m Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' EI'I.IT Em'l' Em'l' m m m m | E I E | T. 3 Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Em'l' Eru'l' Em'l' Em'l'
207 000D
. 0555 55555 555
02T T 5 FAGTT mmuas: G555 0m 577 MM
Res54 s il e e e e e e ST T i e e

AR AR b Al AR A A e AL A s A AL A s Ay

Unlike the Resource view where you can alter the number of Resources shown and the width of
each column changes, the height of each Resource in Time plan is fixed. The system shows a
maximum number according to the screen resolution and the view option selected. With Time
planthere are two view options showing either 20 or 35 Resources when using the
recommended screen resolution. Your System Administrator can reduce this number, or you can
adjust the screen resolution to make Auditbase smaller, but you cannot increase it. If you use a
larger screen resolution, the number of Resources will not increase, the diary at the top will
expand.

The System Administrator has three options:

« To have faster visible performance when changing dates and slower when scrolling
through resources.

« To have a faster refresh when scrolling resources and slower when changing dates.

« To have a faster refresh when scrolling resources and faster when changing dates.
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6.5

Time plan, One resource

Select View -> Time plan.
Select View -> One resource. For fast access, use Ctrl+8 or double-click on a date.
You can switch between the One resource and All resources views in three ways:

o using the View ribbon menu item
o using F8 or Ctrl+F8
o clicking on either a date or a Resource

The resource name is shown in the toolbar at the top of the window. The dates are listed
to the right.

Time intervals for a selected resource and date are located in the upper section of the
screen. The start and end time can be modified by the System Administrator depending
on the demands of a department. The content of the table represents the appointments
for the resource.

o)) Auditbase - [Bocking]
Eile Edit WView Functions
Fo E = 00
5 Ee| @ 2 & BB = B &
Resource plan | | Timeplan View all day = Calendar | Symbollist | General note | Daily note  Selected zoom | Large booking = Large grid | Booking only  All resources | One resource | Save window setup
Plan View Zoom Timeplan view Resources Settings
E Client  T18765 MR JOHN SMITH - |R|Z B user SYSTEM ADMINISTRATOR Multiple locations. v Multiple departments... v (XX 7
_ | Thursday 05/04/2007 Resd6 | Mo filter] + | |||f5]|| ceneral || Daiy || 2|2 || & 15 min.| | M| E
é Time|Lﬂcatmn|Department Hospital no |NHS no. | Name |L‘V| Sl Telephone | Information
B EEL Al
ES
12:00 All All
15 Al All
300 (Al All T124557 DR FIRSTNAME24557 LASTNAME24557 |X| |S
45 Al All —I—
13:00 All All —Il-
15 Al All
300 (AN All
45 Al All T128824 MS FIRSTNAMEZ28824 LASTMNAME28824 |X| | S (99999 999999 | XK. JCO0CK - J0COCX00CO0C J0COC 0O 000
14:00 All All —1l-
15 Al All —Il-
30 (Al All —I—
45 Al All T128463 MRS FIRSTMAME28463 LASTMAMEZ28463 | X | S |99999999999 | XX J0CO0CO0(
15:00 All All —Il-
15 Al All —Il-
300 (Al All —Il-
45 Al All T128455 MR FIRSTNAMEZ28455 LASTNAME28455 | X | D|99999 999999 | )X XCO0CO0C
16:00 All All —Il-
15 Al All —I—
300 (AN All —Il-
45 Al All T128458 MR FIRSTNAME28458 LASTNAME28458 | X | S| 99999 999999 | )X J0CO0CO0
17:00 | All All —I—
15 Al All —Il-
30 (Al All T128885 MRS FIRSTMNAME28885 LASTNAME28885 | X |5 |99999 999999
45 Al All ~EMMALREC APPLICATION H0C 0G0
- LU = UsaeeeE.s'?.sgs.ss.ss.s'.::s.ss.ss.s'.:.:asBsas‘;szasasas‘;;uum RN T T
2620 28 29 80 = Srirdalplele R RUGIAR IR lR DD DRORORDRCADADRDADRDRD RO AD D DA M
2 3 4 48 6 7 8 |08/04/2007
9 10 1 12 13 14 15
16 17 18 19 20 21 22
23 24 25 26 27 2B 29 |07/04/2007
3 1 2 3 4 5 6
- yToday: 09/01/2020
08/04/2007
Booking or Timetable
TimeTable
Booking 09/04/2007 BB BT BT BT BT BT BT BT BT BB BB B BB BB R RO RO RO RO RO RC RO RO R B B BB B BB
«! Show in separate rows
B4 B B B B BB B B BB B B BB BB BB B BY B B BB B0 B0 BB B0 B B BB B BB B

© Auditdata - 2022, ID: 20.0040/29 95




User Guide

« The grid in the lower section represents timeslots with either timetable or appointment
symbols where a timetable or appointment is created for a resource.

« All symbols for the single resource can be seen in separate rows by selecting Show in
separate rows. This will show four rows of symbols with Timetable at the top, then
Location, then Department, with Booking symbol at the bottom.

Resource 08 09 [10 |11 hz2 13 4 5 6 |17
09/04/2007 AU RCR AR R R ROR RO BB R BTRRCBCRTR B TRORCRTRR B TROR R RR R TR BB RR R R R
BB BB BB B B BB B B BB B BB 3 By By 08:00-18:00 ANNUAL LEAVE |,
10/04/2007 [ B H BB B B B BB B B B B B e B A IR R IR [RIR IR IR R R RIRIR IR R IR
E RS 2 Re o o Ra R P EIEAEACA S AR MMM MY el el el B Rl REGEE RS R
1110412007
1210472007 K T e A S e e e S S A e T v
Ll PITRIRERRDRPRORNGR KPS FIMMR RETEHEEMMMMMMMM
1310472007
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6.6 Booking information

Information about every appointment or reservation is accessed by right-clicking the respective

appointment or reservation.

Referenced by

Reason

Qutcome status

Current outcome
Appointment not linked to referral

Linked Waiting list

Details

Hospital no. T117850; NHS no.: -
MR FIRSTNAME 17850 LASTNAME17850

99 J0000( 000(

000000

JO0O0000MK -

Booking information *
Client: MR FIRSTNAME 17850 LASTNAME 17850 Time: 03/09/2020 9:30 - 9:45 Attached actions Close
Appointment  [@  ENT NEW PATIENT MOULD~ Location All {no location) Letter:
Verbal:

Timetable Department All (no department) Video appt:
Made by: SYSTEM ADMIMISTRATOR on P3/09/2020  Aftnd. with
Resource(s) TRAVY Status

[no status] -~

* Apptarranged

Q, Cancelled

B, Being seen
Stages condition:

Stage 1 | Stage 2 | Stage 3 | Stage 4|

-

Status change Delete

*, Appt arranged 03/09/2020 14:18 [1m]
L, Arriwved 03/09/2020 14:1% SYSTEM ADMINISTRATOR

Information History of changes

FY

-

Add/Edit/Delete

Im

Delete

Obs no. | SNOMED code [ICD10 code | Date | Add. | 8| Text| Comment

Client observation or procedure | Visit charge

The window holds information about the following topics, some of which are covered in further

detail in separate sections below:

o Date and time

o Client name at the top and details, such as personal number and address at bottom left

¢ The resource who made the booking
o The user and date of appointment creation

« Timetable, Location (if enabled), Department (if enabled) and appointment symbol

o Letter printed or verbally notified; marked with X
« Video Appointment: marked with X

o Attnd. with can show the relative that attended the appointment with the client - click
the Browse button to select from a pre-defined list of relatives or add a new relative

« Referenced by such as referencing institution
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o Appointment status - see below

« Appointment Outcome - see separate section

« History of Appointment Changes

o Further Information about the appointment, e.g. special preparations to be made by the
audiologist in advance. The information can be modified in the window if required.

o Client observation or procedure

« Visit charge

In the dialogue box, a status can be associated with the appointment/reservation. The possible
statuses to be assigned to the appointment/reservation are defined by the system
administrator.

The appropriate status can be chosen from the Status list, a default status may be configured
in System Administration for when the appointment is booked. Status change history is seen in
the Status change section, showing the duration in waiting or ‘being seen’ status for instance.
When the status has been selected the window closes and the appointment status will be
updated on the booking screen.

Note: If so configured by your system administrator, when setting a status for an
appointment, Auditbase may prompt you to also set an Appointment outcome, if the
appointment is linked to a referral or waiting list. The user may or may not overrule this
mandatory action depending on settings in system administration.

If the appointment contains several stages, they are seen alongside their conditions in the
Stages condition area. The condition of each stage can be changed by right-clicking the
corresponding cell. After modifying a stage condition, the dialogue box is closed.

Outcome status can be selected in the drop-down list. The code is used to describe the
outcome of the appointment. The possible values are defined by system administrator.

Linked waiting list can be viewed from the dialog. This is a read only field.

Double-clicking any appointment symbol on the lower grid will open the Edit booking window
where any feature of the appointment can be adjusted. If changes are made, the Print letter
window will open on saving.

6.6.1 Client observation or procedure

If the appointment has an observation or procedure attached, it will appear in the lower table
on the Client observation or procedure section/tab in the bottom of the dialog. From here
you can also Add/Edit/Delete the observation or procedure. When adding an
observation/procedure, select the required one from the list and click the Add to client button.
Should further observations/procedures be required, repeat the process. Upon completion click
Save. To delete or edit an observation/procedure, select it in the lower table.

Note: When deleting an observation or procedure from Booking information, it is removed
completely from the client record and not just from the appointment.
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6.6.2 Visit charge

Visit charge features are primarily used in Sweden. If this is enabled (in System administration)

the lower part of the dialog is split in two tabs - Client observation or procedure and Visit
charge.

On the Visit charge tab, the following is shown or controlled:

« Booking code, identifying the appointment, used e.g. in connection with self-check-in

« Anonymous number, used to call patients in the waiting room without compromising the

patient’s privacy or violating privacy regulations

« Client identity verification, used to register if and how the patient’s identity has been
verified

« Waiting room, showing what waiting room will be used for the visit. It can be pre-filled
based on rules configured in System administration

« Appointment fee, can also be pre-filled based on rules configured in System
administration

« Prohibit Self-check-in, showing if self-check-in is allowed for the patient. Can be pre-
filled based on symbol or locked if the patient has protected identity.

« Print visit receipts, allows the user to select and print one or more of the following

documents
o Anonymous number
o Roadmap or route directions from present location to selected waiting room, and
o Payment receipt

Booking code 2472 Client identity verified Mot verified hd
Anonymous number

Waiting room -
Appointment fee DIAGMNOSTIC - E35.00

Prohibit self check-in Print visit receipts

Client observation or procedure | Visit charge

6.6.3 Attached actions

To view any clinical actions, documents or IMPs attached to an appointment, click the

Attached actions button in the upper right corner of the Booking information dialogue box. A

list of attached clinical and other actions will open in a separate dialogue box.
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Attached clinical and other actions b4

Client MR JOHMN SMITH Detach Close

Appointment  fif 09/01/2020, GWH 1 st, Stassy

Attached clinical and other actions Select all
|»‘«|:ti0n date|.a\|:1i0n typel Description

09/01/2020 BKB test

7/ 09/01/2020 AB Words {

[1/ 08/01/2020 SIR test

To detach an action from the appointment, select the check box beside the action, and then
click the Detach button; to select all actions attached to the appointment, click Select all. In
the warning message Do you want to detach the selected data from the appointment? click
Yes to complete the operation.

To return to the Booking information dialogue box, click Close.

NOTE: You will not be able to detach a posting from the appointment.
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©.7 Calendar and refresh

The calendar can be used to select the working date.

« In the Resource plan, the calendar can be closed or opened using the [ button on the
menu bar or by pressing Alt+C. In the Time plan, the calendar is always shown.

« Today's date is highlighted in blue and displayed at the top of the screen.

« To change the date, move the month and years along using the arrows and click on the

relevant date. This will refresh the booking screen.
« For quick access to a specific month, click on the name of the month displayed in the

calendar and a drop-down box will appear.

Calendar

X

January
February
March
April

May

June

July
August
September
October
MNovember

December

J January 2020

? 3
i) 10
6 17
5 24
0 31

7

0

4
hh
18
25

1

8

o

Calendar

X

K

F
January 2020 Z‘ A

311 2 3 4 5
8 C8H10 11 12
14 15 16 17 18 19
21 22 23 24 25 26
286 29 30 31 1

—

4 5 G 7 2

[l I e

Ty Today: 09/01/2020

o For quick access to a specific year, click on the year displayed in the calendar and two

arrows will appear, making it easier to toggle between years.

o The text at the bottom always displays the current date. If you click on this text, the

calendar will refresh to today’s date.

Contact your System Administrator to set the booking screen to auto refresh at a
configurable duration.

« To refresh the symbols and statuses on screen immediately, click on the Refresh
booking button.

= || &L 15 min.
Charlie

Refresh booking
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6.8 Booking a client directly

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
o Select the date, if required.
o Or double-click on a time slot under the time and resource you require.

If a client is selected, the Client appointment tab is automatically active. To make a
reservation, switch to the Reservation tab.

Make booking *
Advanced booking Offer declined Save Close
Client appointment | Reservation | Group appointment e

# Mo recurrence
Hospital no  T128343 Daily
MName MR FIRSTNAME28343 LASTNAMEZ28343 Weekly
Phone Mobile: abcd Monthly
Video appointments accepted Annually

Infarmation ||

Reason = Referenced by -

Location All {no location) Department All (no department)

Single resource
Symbaol Resource All locations Date Time End
72 Duration
I fram?1 Stassy )
[ to Charlie L ~
(M ENT new patient mould~ Resdf : :
3 PHAC new patient mould~ Resh8 V|d§0 Tl L
B4 SAV ENT audia Res70 Appointment stages
[m] S4Y EMT new patient mould: Resh4 Mame Descr
& ittt Res78

. Stage 1 Sample stage 1

CLEAR Res73 []Stag ple=ag
A oWH 1 st Resg2 [ Stage 2 Sample stage 2
A GWH 2nd fit~~ Res75 [~ | Stage 3 Sample stage 3
A<y i
7r GWH Audio assess~ Res71

a ) ] Stage 4 Sample stage 4
A5 GWH Audio review~ Res72 : g P g N
23 GWH Direct referral~ ¥| |[Res105 hal

« When making a booking directly, the new appointment will pick up the Location and
Department from the Booking module. The Location or Department cannot be changed in
the Make booking window as the information is gathered from the timetable.

« From the drop-down lists, select appointment Reason and referencing institution if
required. Note that if the dialog is opened from Referral or Waiting list, reason is pre-
selected.

« When a patient has been offered an appointment but has declined, before the
appointment is made, then there is the option to select “Offer Declined”. In selecting this
option the appointment will be recorded in client entries as “Offer Declined”.

Note: Your system administrator can configure the system to make Reason a mandatory
selection.
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Reasons can be outdated by your system administrator, in which case they do not appear
in the list of reasons.

« Select the appropriate appointment Symbol. Out-dated symbols and resources are not
shown in the lists. Additionally, if a location is selected in the toolbar, the system filters
out symbols and resources associated with any other location.

« Select the Resource or resources.

« If more than one resource is selected and one or more are unavailable, you will receive a
Make Booking information window stating which resource(s) have already been booked.
Selecting Yes will save the appointment for the free resources. Selecting No will return
you to the Make Booking window where you can change your choice of resources.

o You can modify the date. If you set the date to a date in the past, the same day when an
appointment is already made or if an appointment is made in the future, the system
displays a warning when you save. However, the system administrator can switch these
warnings off.

o Adjust the appointment duration if necessary. The default duration for an appointment is
set by the System Administrator. Options for the minute part of the duration are set by
the System Administrator and can be from 5 to 55 minutes.

o The start Time and End time can be entered manually in 5 minute units.

+ Check the checkbox if the appointment is to be a Video appointment. If the Video
appointments accepted is not checked, which can be set for the client either here or on
the Client Information screen, and an email address or mobile phone number are not
recorded for the client, then a warning may appear if configured by your System
Administrator.

« Select the Appointment stages, if required. The default stages setup is pre-selected.
When the client arrives, you can keep track of the appointment by viewing the conditions
for these stages in the Day view window, Workflow view. Note that if a location is
selected in the toolbar, the system filters out stages associated with any other location.

By default, the system selects the resource, the date and start time from the slot you
double-clicked to initiate the dialog. You can also select the duration of the appointment
in hours and minutes, and the system calculates end time automatically. If the duration
for the selected symbol is specified by the system administrator, this duration will be pre-

selected.

« If arecurrence is needed you can also choose Daily, Weekly, Monthly or Yearly
recurrence.

« Selecting a recurrence flips open an additional column where you can edit the recurrence
settings.

« The total number of appointments to be generated or an end date of the appointment
sequence must be specified.

o The Booking default method is Book all possible, which means booking un-booked slots
only. This is the recommended setting, but it can be changed according to your
requirements.
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# Day 9

ofevery 1 manth(s)

The First -
Thursday -
of every 1 manth(s)
Selected days V|-~

End of recurrence

# End after 1 QCCUITences
End by date 09/01/2020

Book method
Book all possible
« Book if all resources can attend

All must be available for any to be booked

« Clicking on Advanced booking will flip open an extra table in which you can add or
remove resources from the appointment.

« To add resources, select the resources in the resource list above and click Apply.

« To remove resources, select the resources in the advanced table and click Remove.

Resources Apply Remove
Resource Time Duration Symbol

=Mare resources=

Trawy 12:45-12:00 Oh 18m E@PHAC new patient mould~

Stassy 12:45-12:00|0h 15m E@PHAC new patient mould~
« Click Save.

« When making, copying or editing an appointment, if the selected slot is not the client’s
default Location or Department, you will be warned.

Make booking

Location Location3 is not this client’s prefemed location. Are you sure you want to save 7

Yes Mo
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o If the appointment is made that is split over two different Locations, you will not be able
to save the appointment. You cannot book an appointment in a timeslot with a different
Location or with Resources in different Locations as the same appointment cannot take

place in more than one location. If you attempt to do this, an error message will be
displayed.

Make booking it

Timeslots for the appointment have been scheduled for
. different locations: Location2, Location3.
Cannot save.

o There is no restriction on making an appointment across two different Departments.

o A default appointment status may be applied, configured by your System Administrator,
when the appointment is booked.

« The Print letter window appears - fill in the relevant fields and click Print or click Verbal
appointment. The time and date fields can be edited if configured by your System
Administrator.

Print letter *
Verbal appointment Client list Print labels Open in Word Preview Send | .. Close
User USER MAMEES ~  Location for letter |-3 Location3 Dept. for letter 3 Department3
Client MR JOHN SMITH 1 letter selected Date ofvisit  09/01/2020 Time 1315

L etter name Type Letter-specific additional information, editable for single letter selection only

| £/| 11-03-19_test_template WS Word
19/02/2015 all variables M3 Word

B 23/06/2016 all variables M3 Word

B 29/10/2015 all variables M3 Word

B DMA- PAEDIATRIC Booking defined

B DMA- PAEDIATRIC Booking defined

B EST_TEST MS Word

 New WS Ward

_Testtemplate 22/0R/2018 M3 Word Additional information for all selected letters

_Testtemplate 28/02/2019 MS Word

B TEST_04/06/2018 MS Word

: User letter test Admin defined

Highlighted letter
Name 11-03-19_test_template Letter recipients Add Remave

Tl N
Type MS Word ype ame
MR JOHM SMITH

Saving to Documents

General Practice DR JP RING

Save letter after printing or emailing Save letter read-only

Appointment Address

On emailing to multiple recipients  Send single email -
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Recurrent booking

For a recurrent booking, if the selected slot is not the client’s default Location or Department,

you will get a warning to that effect and will be asked if you are sure you want to save the
appointment.

Make booking

Location Location3 is not this client’s prefered location. Are you sure you want to save?

4 l L

Yes Mo

If there are further conflicts, you will be shown the appointments that conflict and will have a

choice to either Save only appointments matching the client’s preference or to Save all
appointments anyway.

If the Location or Department of some instances of a recurrent appointment is different from

the initial instance, then you will be prompted to create them all or just the ones matching the
initial instance.

X

For the following appointments the location or department is
A notthis client's preferred location or department:

10/01/2020
110112020
1200112020

# Save only appointments matching the client's preference

Save all appointments

QK Cancel

© Auditdata - 2022, ID: 20.0040/29 106



User Guide

6.9 Making a reservation

To create a Reservation, select the Reservation tab. Note that the system selects this
tab automatically if no client has been selected.

Enter a title for the reservation and phone number, if required.

Enter information, select appointment symbol, reason, booking resource, appointment
symbol, date and time range in the same way as for client appointment.

Press Save to save the reservation.

Reservations are shown in purple on the Booking screen.

Stages are not supported for reservations.

To search for a reservation, select a resource and type part of the name of the reservation.
When hitting Search all reservations matching resource and name of reservation are
listed and can be selected and shown by hitting Show in appt. book or by highlighting
and double clicking.
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6.10 Making a group appointment

To create a Group appointment, select the Group appointment tab.

« Enter the client group name.

« To specify the clients to be included in the group, click Edit group.

o The selected client, if any, will be present in the list.

o To add more clients to the list, press Add. The system opens the Client search dialog,
where clients can be searched and selected for the list. When you select a client, the
system will prompt you to enter an appointment reason and information.

o Toremove a client from the list, press Remove.

« Tochange the appointment reason and information for a highlighted client, press Edit.
Note that by highlighting a client in the list, you force the system to change the global
selected client.

e To print the list, press Print.

o Back in the Group appointment tab, enter information, select appointment symbol,
reason, booking resource, appointment symbol, date and time range in the same way as
for client appointment.

« Press Save to save the appointment. After saving, the system displays the Print letter
dialog, where you can print appointment letters for all (or selected) clients.

« Group appointments are shown in green on the Booking screen.

Stages are not supported for group appointments.
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6.11 Booking clients using 'Search for new booking'

When free time for a resource cannot easily be found, the system can search for available time
from the Search for new booking item.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Click Edit -> Search for new booking. This will open the Search for booking dialog.

Search for booking x
« Client appointment Reservation Graup appointment | 5 Close
MName MR FIRSTNAME17850 LASTNAME17850 Information
Hospital no T117850 Reason -
Phone Home: 99999 999999 Referenced by -
Video appointments accepted
Waiting -~ Appointment fee -
room
Prohibit self check-in
¢! Resource Group Timetable symbol Booking symbol )
Duration
Travy | |ANY SYMBOL - 11 _ Search
Stassy NO SYMBOL 2 0 |~ hours 15 ~ min.
Charlie 11 I fram1 ) )
Res109 2 3 |' to1 Video appointment
Resdf = NTS M ENT new patient mould~ Date range
Res68 SLENT CLINIC 3 PHAC new patient mould~ From To
ResT0 [ 54V - C&B - Dref/ AGR B4 54V ENT audio
Res54 [Mtest [m 54V ENT new patient moul 0210912020 [} 031102020 [}
Res78 B COMMUNITY PAEDIATRIC | * titit1 e
Res73 G PAED Assisting "CLEAR
Resd2 {l PAED Hearing Aid Clinic B GWH 1 st 4] 4 S
Res75 PAED Transition fif GWH 2nd fit~—~
ResT1 fll SAVERNAKE PAEDS 77 GWH Audio assess~
Res72 W TIDWORTH ¥|  B2GWH Audio review~ Resource search method
Res105 0% GWH Direct referral~ All resources are available
Res63 Location ER GWH Earmould " ) i
Res95 : EF GWH Earmould fit * Anyresource Is avaliable
All locations - e
Res106 fif GWH Exchange
Res102 ZEEET £d GWH Follow up el e
Res98 ¥| 2 Department2 | A GWH Follow up ad-hoc -
Resaurce After Before | Duration (hours) | Duration (min ) | Timetable| Location | Departme| Found loci Found deg Date Day ¢
=MNew criteria=
< >

« Select the Reason for the appointment.
« The Video appointments accepted setting for the client can be seen and set from this

screen.

o Select the Resource (or resources) you want to book for the client from the Resource

list. Alternatively, select from a resource Group to search for the first available
appointment for a resource from the group.
« A Resource search method should be selected. Choosing All resources are available

will search for all selected resources and only display slots where all the resources are

available. Choosing Any resource is available will display an available appointment
where any of the selected resources are available.
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« Select the appropriate Timetable symbol or symbols, more than one symbol can be
selected. Select ANY SYMBOL if a specific timetable symbol is not required or NO
SYMBOL if the time is not covered by the timetable to be searched.

« Select a Booking symbol for the appointment to be created.

o Adjust the appointment Duration if necessary. The default duration for an appointment
is set by the System Administrator. Minute options for Duration are set by the System
Administrator.

« Change the Date range as required. Dates can be entered manually, or the calendar at
the right of the From and To fields can be used.

o Enter number of 15-minute Units to be booked.

o A Location and /or a Department can be selected from the drop-down menus when
searching for a new appointment. If a specific Location or Department is not required,
All locations or All departments can be used. The patient’s default Location and
Department will be automatically selected when a new search is started, but his can be
overwritten by selecting from the drop-down menus. The Location and Department is
shown in the search results.

« Click Search.

« The system fills the table with the selected criteria and performs the search.

« Clicking Apply fills the table without performing a search. Use Apply when you want to
review and/or change criteria before searching.

o Inthetable, you can do the following, if required:

« Verify or modify the time After and time Before as required.

« Verify or modify the Duration of the appointment.

o Click Search.

o Verify the found time slot. If the first slot displayed is not appropriate, click on the
Navigation arrows to show the next available time. The rightmost and leftmost buttons
shows the first available timeslot for the next and previous dates respectively, whereas
inner buttons “scroll” through timeslots in the current date.

« Verify or modify the found From and To time.

« Click Save.

o Click appointment Letter and either send the letter or click Verbal appointment.

If Visit charge features are enabled in System administration (Invoice definitions/Preferences)
some additional functions will be available in the dialog:

« Waiting room, showing what waiting room to be used

« Appointment fee, can be pre-filled based on rules configured in System administration

« Prohibit self-check-in, shows if self-check-in is allowed for the patient. Can be pre-filled
based on symbol or locked if the patient has protected identity.
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6.12 Booking an appointment from waiting list

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Waiting list.

« Select the relevant waiting list from the drop-down list or click on Clients entries and
select the required entry.

o Select the client's entry on the waiting list and click Book. The selection may be done by
clicking the grey area at the beginning of the row.

Client's entries Journal | Referral | Export Book  Search and book | Letter | To Clientlist |Addt0 list Edit Delete Print | Mew outcome status || 2
Waiting list Registration period Selection
Selectall Clear all
TGW - AUDIO ASSESSMENT +1 - to electa
1 entry selected 4| »
Appointments Qutcome status and Clock action

Waiting li Apply defaults
Mext Previous Outcome Al ¥ Clock Counting+Suspended - 2 lfrom _V_a_leg = Y

Date Active wait Waittime | Outcome status | Clock acti{ Hospital no. Name Postcode DOB MNo.
£/ ? -587 20b, Cancelled - Counting | T12278 MRS FIRSTMNAMEZ2278 LASTHNAMEZ PC:4541 12/05/1959 1
. 19/01/2011 |468 w, 1d -416 203, Decision to| Counting MR FIRSTNAME468687 LASTNAME4E PC:208 01/10/1998 2109075 G.P. letter- FF

007 | 630

« The cursor changes appearance in the booking screen to indicate that you are in the
process of making a booking for the client.

« Use the Calendar to select the date for the appointment.

o Click under the resource column at the time of the appointment you want to book.

o Select the appropriate appointment Symbol.

o Adjust the appointment Duration if necessary. The default duration for an appointment
is set by the System Administrator. Minute options for Duration are set by the System
Administrator.

« Select Appointment stages, if required.

« Click Save.

« Click appointment Letter and either Print the letter or click Verbal appointment.

o The system will then return you to the Waiting list module so that another appointment
can be booked.
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6.13 Search and Book from the waiting list

It is possible to search for available appointment slots and book appointments directly from the
Waiting list.

To do so:

1. Navigate to the Waiting list module
2. From the dropdown, select a relevant Waiting list
3. Choose a Client for whom the appointment will be booked

O Client <X>T130763 MISS FIRSTNAME30763 LASTNAME30 - | & |5 | Buser SYSTEM ADMINISTRATOR L3 Location3 v Al departments ~| x| 2
Navigation Clients entries Journal | Referral | Export Book | Search and book  Letter | To Client list | Add to list Edit
B Favourites — — -
é;\ Referral Waiting list Registration period
£ Booking TGW - PHAC Permanent loss e - to
@ Documents a attachments
\Waiting list 6 Appointments Outcome status and Clock action
AB Audiogram Mext - Previous v Outcome Al ¥ Clock Mot closed or nullified |«
£ NOAH module selection
/iy Aftention list Date Active wait Wait time | Outcome status | Clock acti{ Hospital no. Mame
£ NOAH session browser
16/03/2010 520w, 0 d -468 Counting | T190100 | FIRST EXTRAMORE LAST
Individual client | |231032010| 519w, 0 d 467 Counting | T129779 | MST FIRSTNAME29779 LASTNAME29779
-2 Glientinformation : 06/04/2010 | 517w, 0 d -465 Counting |T112441 | MISS FIRSTNAME12441 LASTNAME1244
- Paediatric | |190412010(515w, 14 -463 Counting |T123116 | MST FIRSTNAME23116 LASTNAME23116
-£=] Joumnal 23/04)2010 | 514w, 4 d -462 Counting |T112842 | MST FIRSTNAME12842 LASTNAME12842
0] Documents and attachments | |241052010| 510w, 14 -458 Counting |T125237 | MISS FIRSTNAME25237 LASTNAME2523
55, Referral | | 04062010/ 508w, 4. -456 Counting | T11632 MST FIRSTNAME1632 LASTNAME1632
A Clients entries | [11/0612010 | 507 w, 4 d -455 Counting | T141108 | MISS FIRSTNAME41108 LASTNAME4110
DB | [141062010 507w, 1 d 455 Counting | T121523 | MISS FIRSTNAME21523 LASTNAME2152
. ng;omj::;m and procedures || 1810612010| 506w, 4 d 454 Counting | T11629 | MST FIRSTNAME 1620 LASTNAME1620
') Hearing Therapist | |1a/06i2010 /506w 4 d -454 Counting |T17289 | MISS FIRSTNAMET289 LASTNAMET289
%] Medical history | |21108i2010 /506w, 14 -454 Counting |T141406 | MST FIRSTNAMEA41406 LASTNAME4140§
55 Direct referral HA(adult) | |25/06i2010|505w, 4 d -453 Counting |T124407 | MST FIRSTNAME24407 LASTNAMEZ4407
-.{a) Tinnitus 25/06/2010 | 505w, 4 d -469 Counting |T119655 | MISS FIRSTNAME19655 LASTNAME1965
.. # surgery | |o2i07r2010| 504w, 4.0 -452 Counting [T110119 | MST FIRSTNAME10119 LASTNAME10119
fi] HI Satisfaction Questionnaire <

In the “Search for booking” pop-up window:

1. Specify the search criteria

2. Click Search

3. Verify the appointment time slot

4. Save for the appointment to be recorded in the Office timetable
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Search for booking 4
* Client appointment Resenvation Group appointment e Save Close
Mame MISS FIRSTNAME30T63 LASTNAME307T63 Information 1y FU - Feb 1192542 - 12 month fu92452aid not working
Hospital noT130763 Reason ++Patient self referral -
Phone Home: 99999 999999, Mobile: 99999 999999 Referenced by -
¢/ Resource Group Timetable symbol Booking symbol n _—
uration
Travy PRI ANY SYMBOL i Py _ Search
Stassy |NO SYMBOL J2 —~0 [vrhours 15 |~ -min.
Charlie 11 Il from1 Date range
Res100 22 [ to1 From To
Resdb = MNTS [M ENT new patient mould~
Resfa EFENT CLIMNIC ittt 23M212019 230112020
Res70 B COMMUNITY PAEDIATRIC "CLEAR Navigation
Res54 G PAED Assisting i BWH 1 st g
Res78 {fll PAED Hearing Aid Clinic ff GWH 2nd fit~~
Res73 PAED Transition 77 GWH Audio assess~ 4 4 23122019 4
Res8?2 A SAVERMAKE PAEDS A3 GWH Audio review~
Res75 B TIDWORTH DR GWH Direct referral~ Resource search method
Res71 Wiltshire PHAC Ef GWH Earmould :
- 2l = All labl
Res72 123 €2 GWH Earmould fit resources are avarianie
Res105 fif BWH Exchange Any resource is available
Resf3 Location Fil GWH Follow up
Res95 1 Location1 A GWH Follow up ad-hoc
Res106 } L% GWH Lost aid Apply | | Remove
Res102 Depariment L£ GWH Lost aid impression
Res98 ¥ All departments R GWH Repair s
Timetable symbol| Location |Department|Found location |Found depatment Date Day ofweek| Starttime | From | To |Resource|Bool
ANY SYMBOL || Locationd | All ‘| Location ‘| Departmentd 23M2/2019 | Monday 08:30-16:00 0830 0845 Trawy 11
< >
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6.14 Export to MS Outlook

It is possible to export bookings for a single resource for a user specified period to Microsoft
Outlook (version 97 or later). All existing appointments in Outlook will be deleted for this
period.

The prerequisites for performing this action are:

« The logged on user must be defined as a resource
« The booking screen must be active

With the Auditbase System appointment book displayed on screen, select File->Export to MS
Outlook and the system will now start communication with Microsoft Outlook.

A window will appear notifying the user if Outlook was successfully initialized or with an error
message if not.

Copying appointments/reservations is done for a user specified period (default 30 days back in
time-180 days ahead) with selection of which resource's appointments/reservations to be
exported.

Click OK to open a dialog for the user to answer if all previous appointments in Outlook for the
selected period should be erased/overwritten or if Auditbase System
appointments/reservations should be added and maybe overlap existing
appointments/reservations.

Once finished, a status of the export will be shown if successful or not.

The operation can be performed whether or not Outlook is open. The installed version must be
97 or later and it must be configured for the workstation.

The following will appear for exported appointments in the MS Outlook calendar:

o Subject: Client Appointment [patient ID from Auditbase appointment]
o Start- & end-time: [Time from Auditbase appointment]

o Reminder: Switched off

e Show time as: Busy

Note:

o« PHONE:
not displaying
o INFORMATION:
[Information from Auditbase appointment]

The following will appear for exported reservations in the MS Outlook calendar:

e Subject: [Reservation name from Auditbase reservation]
o Start- & end-time: [Time from Auditbase reservation]
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Reminder: Switched off
Show time as: Busy

Note:
« PHONE:
[Phone number from Auditbase reservation]
o INFORMATION:

[Information from Auditbase reservation]
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6.15 Moving an appointment

« Select the appointment you wish to change from the main booking screen. The client’s
name will now be highlighted on the screen.

« Select Edit -> Move or Edit -> Search and Move.

o The cursor changes appearance in the booking screen and the start time of the
appointment is highlighted to indicate that you are in the process of changing a booking
for the client.

o The symbols for the existing length of the appointment are maintained until the new
appointment has been made but the client name is not shown.

o Click on a new date in the Calendar.The Search for New option can also be selected if a
suitable date is not known.

« If the Search and Move option has been chosen, the Search for new booking window
opens and can be used in the usual way.

o Click on the appropriate time slot and resource on the date.

« Click on the appointment Symbol; adjust the appointment Duration if necessary. The
default duration for an appointment is set by the System Administrator. Minute options
for Duration are set by the System Administrator.

« Click OK.

o If a moved appointment breaches the target date for a referral, a breach warning will be
displayed.

« Click appointment Letter and either Send the letter or click Verbal appointment.

You can also delete and copy appointments from the Edit menu.

4} Audithase - [Booking]

File Edit WView Functions
|IQI |l,|1~ |I‘_+I_. %l |I_—|."'+"’ E.% |.]EI |-- I |- @ E“%
» + + @
Make new | Search for new Edit Move | Search and move | Bulk move = Copy | Cancel | Delete  Make | Schedule | Copy

Booking Tirnetable

Note: When saving or modifying an appointment, the current date and time will be
recorded with the appointment, if so configured in the system administration.
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6.16 Changing the Appointment Status and Outcome Code

« Highlight an appointment you want to change the status or outcome code for on the
main booking screen and right-click it.

« Select Qutcome status in the drop-down list. The Current outcome can be seen in the
Booking information dialogue box. This is taken from the referral attached to the
appointment. This is always today's current outcome, regardless of whether the
appointment itself is in the future or past.

« Select the appropriate appointment Status. The Status change list will show the
duration that the appointment has been in each status.

« The status letter is now seen in the main booking screen next to the appointment.

Booking information *
Client MR JOHN SMITH Time: 09/01/2020  12:45-13:00 Attached actions Close
Appointment @ PHAC NEW PATIENT MOULD~ Location All (no location) Letter:
Timetable Department All (no department) Verbal:
Made by SYSTEMADMINISTRATOR on 09/01/2020  Atind. with
Resource(s). TRAVY Status
3 12:45 Stassy [no status] -
* Apptarranged
0, Cancelled
B, Being seen i
Referenced by Stages condition:
Reason
Status change elete
Outcome status g Delete
= %, Bppt arranged 0970172020 17:34 [13m]
SUSP - Suspended T |, nrrived 09/01/2020 17:51 SYSTEM ADMINISTRATOR
Current outcome
Appointment not linked to referral
Linked Waiting list
Details
Hospital no.: T18765; NHS no.: 86888588 -
MR JOHN SMITH ; i
History of changes
99 Information ry g
XOO00K -
JOCOOO00XK - -

Note: When saving or modifying an appointment, the current date and time will be
recorded with the appointment, if so configured in the system administration.

An appointment status can be deleted if it has been set in error. Highlight the status and the
Delete button becomes active. Select this and the status will be removed from the list.

Status change Delete

*, Appt arranged 08/01/72020 17:34 [18m]
09/01/2020 17:51 SYSTEM ADMINISTRATOR
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6.17 Changing who the client attended with

On the Booking Information screen, details of whom the client attended with can be added.

Right click on an appointment.

Select the [ icon at the end of the Attnd. with row. You will be presented with three
options:

Create New - Will enable you to add a relative or other contact. Fill in the relevant fields
and click Save.

Select from list - If a client has relatives or other contacts attached to their client
information, by selecting this option you will see a list which you can select from and
attach to the appointment. Highlight the required contact and click Select. If the contact
does not appear in the list, a new one can be added by selecting Add. Contacts can be
edited by highlighting the contact and selecting Edit. A contact can be removed from the
list using the Delete button.

o Clear field - This will clear any entry in the Attnd. with field.
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Booking information =
Client: MR JOHN SMITH Time: 09/01/2020  12:45-13:00 Attached actions Close
Appointment @ PHAC NEW PATIENT MOULD~ Location All {no location) Letter:
Timetable Department All (no department) Verbal: ﬁ
Made by: SYSTEMADMINISTRATOR on  09/01/2020 Attnd. with E‘
Resource(s) TRAVY Status Create new
3@ 12:45 Stassy [no status] 2 Select from list
* Apptarranged Clear field
0, Cancelled
B, Being seen i
Referenced by Stages condition:
4
§
Reason =%j
| 4
Status change Delete 4
Outcome status E
*, Bppt arranged 09/01/2020 17:34 [18m] B4
SUSP - Suspended - 09/01/2020 17:51 SYSTEM ADMINISTRATOR .%é
Current outcome BMEZ3026 e ]
Appointment not linked to referral "“% %l
Linked Waiting list *%%
23
Details :%%
Hospital no.: T18765; NHS no.: 88888888 s et
MR JOHN SMITH - " 23
History of changes
09 Information ry a ]
. . 5
JOOOOO00X - > 33
=33
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6.18 Locating and viewing a previous appointment

Use this function to locate or examine a previous appointment in the appointment book.

» Press F3 to search for the client or Ctrl+F3 to make a quick search.

o Select Functions -> Client’s entries to open the client's appointments and waiting lists
window.

« Highlight the appointment you need to view.

o The list of appointments includes Date, Time, appointment Symbol and Status, booked
Resource and appointment Reason.

« Select Show in appt. book. The system will display the Booking screen for that date with
the appointment highlighted. You can then edit the appointment if required.

« Toview any clinical actions, documents or IMPs attached to the appointment, click the
Attached actions button. A list of attached clinical and other actions will open in a
separate dialogue box where you can detach them from the appointment if needed.

« To delete cancelled actions—they appear in grey—from the history, select them in the list
and click the Delete from history button.

« When you right-click on an appointment, you can see the Appointment Information for
an appointment, including information for an outdated resource.

Client's appointments and waiting lists x

Client MR JOHN SMITH Close

Appointments list- 42 item(s) History of changes Aftached actions e fro Show in appt book
Date | Time |Loc.| Dept.| Appt. |Status| Resource Reason |SMS1 | sr\-182| Declined offer Symbo ~

13/01/2020 | 11:15 I Resdf from1

20 09:00 Charlie

09:00 1 = | Charlie 1

09/01/2020 | 16:30 f A | Stassy GWH 1 st
09/01/2020 | 13:45 E]| * Stassy PHAC new patieni
09/01/2020 1215 3 | 3 1 * |ResB4 1

09/01/2020 (1215 32 3 3 Res109 |++GP direct referral PHAC new patieni
09/01/2020 | 12:45 E]| A Travy PHAC new patienl «»
< *
Waiting list entries - 7 item(s) Add Edit W

Wait time| Date| Waiting list| Information A

18
8
-4
21
9
13

an

] 18/0§ TGW - PHA
06/03 TGW -AUD
06/03 TGW - CALY
16/0§ TGW - Audii
16/0§ TGW - CALY
09/01 TGW - DON

AN TEGRE Al

o This window also displays the appointments and waiting list entries for the selected
client.

« The list of waiting list entries includes Wait time, Date, Waiting list type and
Information.
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« A waiting list entry can only become active if selected from the Waiting list module. Click
Show in waiting list to make the entry active in the main Waiting list, so that the entry
can be reviewed and edited. There an entry can be created or edited by clicking Add or
Edit, respectively.

« If you select an appointment from the Appointments list and Show in appt book but
either the Location/Department or Clinic filter does not show the selected appointment,
you will see an information message letting you know which needs to be adjusted.

Message

The appointment you are trying to view in Booking is not available because:

%

- The Clinic fiter you have applied does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

Message

The appointment you are trying to view in Booking is not available because:

l -.\'

- The location(s)/department(s) you have selected to show does not include this resource.

Would you like to go to that date in the Booking screen to change your view settings?

Yes Mo

« You will need to select Yes to go to the appropriate date and then change the filter
settings. No will take you back to Client’s entries.
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6.19 Cancelling an appointment

Client's appointments display any appointments in the appointment book. When a client
cancels an appointment, you can cancel it in the system and still keep a record of the
appointment on the screen using this procedure:

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

o Select Functions -> Client's entries, to view details of forthcoming and previous
appointments

« Highlight the appointment you wish to cancel.

o Click on Show in appointment book. This will display the diary screen for that date. You
can now select the resource for the appointment.

o Highlight the client.

« Select Edit -> Copy booking.

« The cursor changes appearance in the booking screen to indicate that you are in the
process of making a booking for the client.

« From the drop-down list of resources, select Cancelled or the name of the resource used
to mark cancelled appointments.

o Click in the Cancelled column and click OK.

o The cancelled appointment is now listed in the Cancelled column as an appointment
made with the resource Cancelled.

o Right-click on the client in the Cancelled column and change the appointment status to
Cancelled.

« Highlight the original appointment again on screen and select Edit -> Move booking or
Delete booking and return the client to the waiting list if required.

Appointment cancellation can also be supported by moving an appointment to a historical view
in the Client’s Entries. This can be configured in two ways; by setting appointment statuses
that will activate the process or by configuring the appointment move action to activate the
process.

An appointment status can be set to prompt a user to remove an appointment to a historical
view so it is not viewed on the Booking screen. Cancelled appointments are viewed on Client's
entries and Referrals and are shown in grey text and read-only to differentiate them from
active appointments.

Appointments can be cancelled and still be seen in Client entries and Referrals (but not
Waiting lists), so they no longer need to be copied into a “Cancelled” resource column to retain
details of the cancelled appointment. There are two processes for cancelling an appointment.

6.19.1 Changing the appointment status

On changing the appointment status of a booked appointment to a cancelled status, a booking
information message will indicate if the appointment has clinical actions attached to it and
that the appointment has been cancelled and enquire if the user wishes to continue with the
appointment move procedure.
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Booking information

[ = 2
L ¢ Do you want to continue ?

Press 'es to create a read-only record in Client’s Entries.

Press Mo to keep the appointment on the main Booking screen.
Press Cancel to cancel changing the status.

Yes Mo

@™%  You have assigned a status Q, Cancelled associated with cancellation to this appointment, this means the appointment will move from the Booking screen to a read-only record in Client’s Entries.

*

o Select Cancel to cancel assigning the status and keep the appointment at the original

date and time slot

o Select No to retain the cancelled appointment in its original appointment date and time

slot

o Select Yes to create a read only record in Client’s entries.

In case of any attached clinical or other actions the following screen opens:

Detach clinical and other actions

This appointment is referenced by the following clinical data:

et

Action date| Action type |Descripti0n

09/01/2020 | BKB test

09/01/2020  AB Words test
09/01/2020  SIR test

This appointment is referenced by the following other data:

Date| Data ‘q.rpe| Description

Press OK if you want to detach the clinical actions and individual
managament plans and delete the appointment

oK

Cancel

Once you have selected OK, a further information box appears to allow you to add to a waiting

list.

The appointment has been moved to the history. Do you want
to rebook the appointment to another slot or put the client on
Waiting list?

# Rebookthe appointment

Put the client on Waiting list

Cancel

x
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+ Rebook the appointment - Takes you back to the booking screen so that the

appointment can be re-booked. If the re-book option is selected, a letter sent to a patient

may include the date and time of the cancelled appointment.

« Put the client on Waiting list - Opens the Add to waiting list dialogue box. If a client has

been booked from a waiting list, Auditbase will remember the original settings.

It is possible to enable an Automatic journal entry, which can define/insert a combination of

variables of the cancelled appointment into the Journal automatically.

Journal events X

Selected event

1407
Appointment moved to Canceled storage

Keywaord

APPOINTMENTS -

Prampt for user input Allow 10 cancel event Save unsigned

Appointment PHAC NEW PATIENT MOULD~ with TRAVY on 09/01/2020 12:45 - 13:00 was moved to ~
cancellation history having a status of Q/ Cancelled

W

Bl z][v] E=I= HEM [2][=][=
Client's appointments and waiting lists >
Client MR JOHN SMITH Close

Appointments list- 42 item(s) History of changes Aftached actions Delete from history Show in appt.book

Date |Time|Loc.|Dept.| Appt. |Status|Resource| Reason |SMS1|SMSQ|DecIined 01Ter| Symba &
10/01/2020 | 09:00 1 * Charlie 1
B

09/01/2020 | 13:45 3 * Stassy PHAC new patieni
09/01/2020 1315 3 | 3 1 *  |Res54 1

09/01/2020 (1315 2 3 3 * Res109 | ++GP direct referral PHAC new patieni
089/01/2020 | 12:45 3 Q | Travy PHAC new patient
09/01/2020 (12:45 3 Q  |Stassy AC atient
09/01/2020 | 09:00 1 * Res46 1 W
< >
Waiting list entries - 7 item(s) Add Ed Wi

Wait ime | Date| Waiting list| Information A
-186 18/06 TGW - PHA

8 06/03 TGW -AUD

-14 06/03 TGW - CALY

-21 16/08 TGW - Audiy

9 16/08 TGW - CALY

13 09/07 TGW - DON

an AoIN< TOWE Al v
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If the entry needs to be removed from this list for any reason, then the Delete from history
button can be selected once an entry has been highlighted.

N.B. Cancelled appointments appear in grey on the patient’s Client entries list. Right
mouse-click on the relevant appointment to open the Booking information screen, which
shows historical details of the cancelled appointment.

6.19.2 Highlight, Edit & Move appointment

Highlight an appointment and navigate to Edit and Move booking.

Booking

I@I Are you moving appointment due to patient cancellation? f so, would you like to record the original appointment in the Client’s Entries” historny?
-

Yes Mo

Select No

« Select appointment symbol and length, then click OK.
o Appointment will be moved to a new slot after the Letter print screen has been OK'd.
o No record of the cancelled appointment will be recorded in the client entry.

Select Yes

If there is only one appointment status associated with cancellation that status will be applied

automatically. If more than one status is associated with cancellation, you will be offered a
choice.

Highlight and select (or double click) the appointment cancellation status from the list of
potential statuses, as defined by the system administrator.

Select cancellation status *
Select
Code Description
K Kate completed
a Statusa

o Select appointment symbol and length, then OK.
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o The appointment will be moved to a new slot after the required action has been taken on
the Letter print screen. A letter sent to a patient may include the date and time of the

cancelled appointment.

o A record of the original appointment is saved in client entries.

N.B. Cancelled appointments appear in grey on the patient’s Client entries list. Right
mouse click on the relevant appointment to open the Booking information screen to show
historical details of the cancelled appointment. These details cannot be changed.

6.19.3 History of appointment changes

This will need to be activated within System administration.

In the appointment dialog box, pressing the History of changes button will open a pop up box.
The pop up box will contain a logged history of changes made to the selected appointment.
The text log will include appointment creation date, time and user creating the appointment,
appointment start date/time and its duration. It will also include the appointment symbol,
information and outcome status if one has been selected. These will be listed by date and
under username of the person logged in at the time of creation or change. The log can be

cleared in Administration.

Appointment change history

Client MR JOHM SMITH

Close

15

Attached actions Close

t2020-01-10 10:56:28 SYSTEM ADMINISTRATOR
Start date and time:

Old: 2020-01-10 13:15:00

MNew: 2020-01-10 14:00:00

Duration:

Old: 0 hours 15 minutes

MNew: 1 hours 15 minutes

Resource(s):

Old: Res109

MNew: Charlie

2020-01-10 10:52:31 SYSTEM ADMINISTRATOR
Start date and time:

Old: 2020-01-09 13:15:00

New: 2020-01-10 13:15:00

2020-01-09 17:39:22 SYSTEM ADMINISTRATOR
Appointment created

Letter.
Verbal

History of changes

-

-
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6.20 Viewing a resource’s schedule

Select File -> Print schedule.
Select the Resource.

« Enter the date range.

Select Print or printing Preview.

Print schedule >
Preview Print Close

Fesource

From 01012020 | To | 19/01/2020

MU SCRL

Schedule - Charlie

01 January 2020 - 19 Januvary 2020

9, January 2020 - Thursday
Time Hosp No NHS No Subject Duration
200 - 8:30 T18765 EEEERREES MR JOHN SMITH (1) 0:30
Home: 03099 900009
13:00 - 14:30 T123026 MR FIRSTNAME23026 LASTNAME23026 (1) 1:30
Home: 99999 999909
10. January 2020 - Friday
Time Hosp Ne NHS No Subject Duration
9:00 - 10:30 T18765 88888888 MR JOHN SMITH (1) 1:30
Home: 98999 999999
14:00 -15:15 T18763 EEEERREES MR JOHN SMITH (PHAC new patient mould-) 1:15
Home: 999990 000000
11. January 2020 - Saturday
Time Hosp No NHS No Subject Duration
8-00- 8-15 Ti110 MRS FIRSTNAME110 LASTNAME110 (PHAC new patient n 0:15
Home: 99999 090000 Mob: +1232323
9-45 - 11:15 Ti110 MRS FIRSTNAME110 LASTNAME110 (1) 1:30
Home: 99009 000000 Nob: +1232323
12. January 2020 - Sunday
Time Hosp No NHS No Subiject Duration
10:30 -12:00 Ti110 MRS FIRSTNAME110 LASTNAME110 (tol ) 1:30
Home: 99090 000000 Mob: +1232323
13. January 2020 - Monday
Time Hosp No NHS No Subject Durati on
9-:00 - 9:15 T18765 88888888 MR JOHN SMITH (2) 0:15
Home: 99990 000000
Print date: 10 January 2020, AuditBase user: ST SADM Page 1 of 1
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6.21 Booking statistics

This is a simple count of the number of appointments for a selected Resource or all

Resources over a specified date range.

Booking statistics >
Erint Close
Resource Charlie ~ From 01/01/2019 to  10/01/2020
Procedure Time Amount

1 23h 0m 22

2 1h 30m 3

EMT new patient mould~ Th Om 1

GWH 1 st 2h 30m 2

GWH 2nd fit~~ 1h 0m 2

GWH Earmould 15m 1

GWH Follow up 30m 1

PHAC new patient mould~ 2h 45m ]

SAY ENT audio 45m 3

SAV ENT new patient mould~ 15m 1

from 30m 1

to 1h 0m 1

unngl 15m 1

Go to Functions -> Booking statistics in Booking.
Enter the Date from and to and select a Resource.
Select Show and a list will be displayed showing the Resource, Procedure, Time (in 15
minute blocks) and Amount or number of procedures.

Print will send the list to the default printer.

6.21.1 Appointment ordinary statistics

« The Appointment ordinary statistics show time used for appointments per date and

statuses.
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To open the Appointment ordinary statistics dialog, select Functions -> Appointment
statistics -> Ordinary statistics from Booking.

Enter a date interval to show statistics for a required period of time.

Select Resource in the drop-down list if statistics on a single booking resource are
required. Default is All resources.

Select a symbol in the drop-down list if statistics on a single appointment symbol are
required. Default is All symbols.

Select statuses: initial in the From drop-down list, intermediate in the Via list (optional),
final in the To list.

Click Refresh to calculate the statistics.

Click Print to print the calculated results.

Click Export to file to export the result.

6.21.2 Appointment advanced statistics

The Appointment statistics advanced window is accessed via Functions-> Appointment
statistics -> Advanced statistics from Booking.

Here you can calculate advanced appointment statistics using specified criteria.

You can calculate the total number of client appointments grouped by different
appointment attributes.

Grouping by the following appointment attributes is possible: Resource, Reason, Symbol,
and Status. Calculation of subtotals is also possible.

Use the Grouping section to specify how to sort the statistics and which total and
subtotals are required. The attribute selected in the first drop-down list gives the first
sorting criteria of the statistics, the selected attributes in the second and subsequent
drop-down lists are the next sorting criteria.

The Subtotal check box near the first drop-down list means that the first-level subtotal
will be calculated by the attribute selected in the first drop-down list. The check boxes
near the second and subsequent drop-down lists mean subtotals in the first-level total
calculated by the attributes selected in the corresponding drop-down list.

For example, assume that Reason is selected in the first drop-down list, Resource in the
second, Symbol in the third, Status in the fourth and the Subtotal boxes are checked for
first and second drop-down lists. In this case, the statistics will be sorted first by reason,
then by resource, symbol and status. Statistics will include totals by reason and subtotals
by resource for each specific reason.

Check the Show detailed rows check box if you want to include the client appointments
the statistics is based on, in the statistics.

All other options in the Calculation criteria are filtering the criteria for the statistics calculation:

Resource: you can specify which appointment resources should be included in the
statistics. At least one resource must be selected. Select all selects all resources.

Symbol: you can specify which appointment symbols should be included in the statistics.
At least one symbol must be selected. Select all selects all symbols.
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o Reason: you can to specify which appointment reasons should be included in the
statistics. At least one reason must be selected. To include appointments without reason,
select [No reason specified]. Select all selects all reasons.

o Status: you can specify the status for the appointments to be included in the statistics. At
least one status must be selected. To include appointments without status, select [No
status specified]. Select all selects all statuses.

o Date range: use this to include only appointments in a specified date range. Empty date
in the range means unlimited interval.

« Time range: appointments with start time within a specified time range will be included.

« Age interval: appointments for clients with age within a specified interval will be included
in the statistics. Empty value in the range means unlimited interval.

When all criteria have been specified, press Calculate to calculate the statistics. The result is
shown in the Result table below. Detailed rows are shown in black and (sub) total rows are
shown in blue.

Press Print to print the results.

You can export the results to a comma-separated (CSV) file by pressing Export to file and
selecting a target file in the opened dialog to get results exported into the selected file.
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6.22 Printing/Emailing a letter

TLS1.2 security level is supported for emailing.

» Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Highlight the appointment.
o Click Letter.

o Select a letter name or names if you want to print multiple letters, by checking the box in

the left-hand column.

« In the case of a letter for a group appointment, addressees must be selected by entering

check marks in the table activated by clicking on the Client list button. Note that the

system automatically selects all clients in the group.

EST_TEST M3 Word
MS Word

Testtemplate 22/06/2018 MS Word Additional information for all selected letters
N Testtemplate 28/02/2019 MS Word
- TEST_04/06/2018 M3 Word
: User letter test Admin defined

Highlighted letter

Mame Mew Letter recipients Add Remaove
Type Name
Type NS Word i —
MR JOHN SMITH
Saving to Documents
General Practice DR JP RING
W Save letter after printing or emailing Save letter read-only
B Save letter content Documenttype  client letters -
Save as text
Date sent Address
Save in RTF format Appointment :
# Save as Word document 10/01/2020, PHAC new patient mould~
On emailing to multiple recipients  Send single email -

Print letter x
Verbal appointment Client list Print labels Open in Word Preview Send | Close
User USER NAMETE ~  Location for letter | 2 Location2 - Dept. for letter 3 Department3 -
Client MR JOHM SMITH 1 letter selected Date ofvisit  10/01/2020 Time 14:00

Letter name Type Letter-specific additional information, editable for single letter selection only
| |11-03-19_test_template MS Word

- 19/02/2015 all variables M3 Word

23/06/2016 all variables M35 Word

29/10/2015 all variables MS Word

DMA- PAEDIATRIC Booking defined
| |DNA-PAEDIATRIC Booking defined

o Select the User to sign the letter. If only one resource is booked for the current
appointment and this resource has an association with a user, this user will be pre-
selected in the list.

« Whether date and time are automatically set and cannot be changed depends on the

setting in Administration chosen by your System Administrator.

« If you are printing/emailing a single letter, a part of the pre-configured letter text can be

changed in the Letter-specific additional information field.
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o The name of the employee or further information for all letters can be added in the
Additional information for all letters textbox. The additional information will be printed
at the bottom of the standard letter.

o If the letter is a Word template, you can edit the letter in Word by clicking Open in Word.

« Default settings on how to save and letter recipients for each letter template can be set
up in the Letters dialogue, which you access from the Booking module -> Functions ->
Settings -> Letters. More on this in the following chapter.

« Edit the saving settings under Saving to Documents if necessary.

o The saving settings allow you to save the letter to the Documents and attachments
module after you have printed it.

o If you save the letter with content, saving in RTF (available for Booking defined
templates) or Word format (available for Word templates) will take up more space on the
server than if you save as text, which does not include images etc. Unless you really need
to save images and formatting from documents, you should choose a plain text format.
Text documents will lose all formatting but are still easy to read and edit.

« Check Save letter read-only if you do not want the letter to be editable after you have
saved it. However, users can be granted the extended user right of “Documents: Remove
read-only flag” by the system administrator.

« The Document type will only show the document types set up as patient letter document
types.

« Date sent may be configured in the letter template to automatically be filled out as the
current date. This date will be shown in the Documents module. You can change the date
manually, if you are not sending the letter on today’s date.

« Name and address values can appear in upper case or mixed case according to a setting
in Administration

« The Appointment which the letter is about will automatically be displayed.

« Edit Letter recipients by clicking Add if necessary.

« Select a recipient and click Remove if necessary.

« If emailing a letter, it will, by default, place itself in the body of the email as opposed to
becoming an attachment to the email. This can be altered by using the browser button

next to Send on the floating box = =&"¢

« If emailing the letter to multiple recipients, select whether to send as a single email or as
multiple emails in the On mailing to multiple recipients drop down. If sending as
multiple emails, you can decide to change for each if you wish to send as body text or an
attachment using the browse button above. If sending as body text you can amend the
text for each individual recipient. In this case you also alter the subject of the email by
clicking into the subject field on the table for each recipient.
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Send single email

Customize print and/or email X

OK Cancel

m [ Select all B Update contacts with email address modifications

[ 4@ Type Mame Email address

uditdata.com

B Send as attachment with following body text Subject
Text

Send separate emails

Customize print and/or email

OK Cancel

Select all B Update contacts with email address modifications

Type Mame Email address

son a
O General Pract| DR JP RING oleksandrp@auditdata.com

B Send as attachment with following body text Subject
Text

« Click Preview if you want to preview the letter before printing/emailing. If you are
previewing a Word letter, Microsoft Word will open and a floating window will appear.
The letter can be adjusted as required and can then be printed/emailed by selecting
Send or the single Print icon at the top of the floating box. In the case of Send the
appropriate number of letters will be printed/emailed. Select the browser button next to
Send to make changes to the default send setup. Recipient email address can also be
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added or amended here and any amendment can be pulled through to the related
contact.

« If the letter needs to be saved without printing, Save and close will save the letter as a
document and close both the floating window and Word.

« If previewing is not required, click Send to print the letter on the default printer as
defined by the system administrator or to email as defined by the default settings.
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6.23 Designing a letter

Letters *

Mew booking defined template Mew WS Word template Edit Save Delete Close

Letter list | Edit booking defined template

Letter template name Type | Eluoking| WL | Referral| Save after printing |Atlach letter to appt.| Set sent date to currt. | Document type | Save content | Save read onl »
01AudVars MsWord |[] O client letters
06.06.2018 MS Word |[] O O O O O O
1 Booking de[] O O O O
1 Address MsWord |[] O O client letters
11-03-19_test_template MS Word O O O O client letters O
123 MS Word |[] O O O O O O
19/02/2015 all variables MS Word client letters Word doc O
1Separate letter MsWord |[] client letters Word doc [l
1Single letter MS Word  |[] client letters Word doc [l
23/06/2016 all variables MS Word client letters Word doc [l
23423 Ms Word |[] OO O O O O
291002015 all variables MS Word [ 1 1A fA M FA client letters Waord doc I s
< >

Selected template

Name Location ~|  Department All departments -
M Available in Booking B Available in Waiting list W Available for Referral receipt

Saving lefter Default recipients Add Remove

By default, save letters of this template after printing or emailing Type MName

Saving letter content

save lefters read-only On emailing to multiple recipients Send single email

You can design a letter by going to Functions -> Settings -> Letters in Booking. The dialog
gives you a flexible layout, variables in fixed format and complete flexibility when editing
letters in Word.

« The Letter list contains all letter templates that are currently available.

e You need an extended user right given by your system administrator to modify existing
letter templates.

« You can either define a New booking defined template or a New MS Word template.
The booking defined templates are templates created in Auditbase, with already defined
building blocks set up by your system administrator. The Word templates are created in
Word, which gives you complete flexibility when it comes to the layout.

e The Location and/or Department where an appointment takes place can be added to a
letter as a variable in the Letter specific information folder. This is shown on the
Location and Department fields on the Letter dialog. These replace the Hearing Centre
variable which will be read-only when an appointment has a Location on the Booking
screen. The old Hearing Centre variable will still work. If an appointment does not have a
Location and/or Department it can be added here.
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« If the Location and Department Filtering option is installed, Letters can be filtered by
Location and/or Department with Location groups and multiple locations options. This
filtering is made on the main Toolbar.

« Click Save to save a new or changed letter in the database.

o The Delete function will remove a letter from the database.

6.23.1 New booking defined template

« Booking defined letter templates are defined in Auditbase and available from the
Booking module and from waiting lists.

« Click on New booking defined template and start out by entering name, location,
department, availability, default saving settings and default recipients of the letter under
Selected template (marked by red square in above screen shot).

« To edit a booking defined template, choose the letter in the list and make your changes
under Selected template and the tab Edit booking defined template.

e You can choose whether or not the letter should be Available in the Booking module
and/or Available in the Waiting list module.

« The saving settings allow you to save a record of any letter sent with or without content,
along with a record of to whom and when it was sent.

« If you uncheck By default, attach letter to appointment, the letter is attached to the
appointment that the letter is about.

« If you choose not to uncheck By default, set date of sending to the current date, the
date field will be left empty on the letter.

« If the template contains the audiogram graph variable, a window will open to allow the
user to select which audiogram is to be used. The number for the audiogram variable
(there can be up to four) will appear at the top of the Audiogram List dialog. A variable is
available to show a combined audiogram or split audiogram with separate right and left
graphs.

« If you save the letter with content, saving in RTF (available for Booking defined
templates) or Word format (available for Word templates) will take up more space on the
server than if you save as text, which does not include images etc. Unless you really need
to save images and formatting from documents, you should choose a plain text format.
Text documents will lose all formatting but are still easy to read and edit. RTF will keep
all formatting, but increase the file size, and is harder to edit later because of a frame
setup.

« Uncheck By default, save letters read-only if you do not want the letter to be editable
after you have saved it. However, users can be granted the extended user right of
“Documents: Remove read-only flag” by the system administrator.

« Enter text and variables on the tab Edit booking defined letter.
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Letters *

Mew booking defined template Mew M3 Word template Edit Save Delete Close

Letter list | Edit booking defined template

‘ariable name Insertvariable | Template name |,lkpp0intmem— general - GWH Print test

|1 Appointment data ~

-Appointment Booking code
-Appointment Referenced by attribute
-Appointment anonym. number

Appointment date Hosp Mo. #Primary identification code#  NHS No. #NHS number# -
Appointment date (long format)

Appointment duration Date: #Current date (long formati#
-Appointment duration number of hours

-Appointment duration number of minutes

Appointmentinformation #ames

-Appointment outcome code #Streatt

-Appointment outcome description #Client Postcode#

-Appointment outcome name

-Appointment outcome reporting code -
-Appointment reason ) i

Appointment resource name Date: #Appointment week day##Appointment date (long format)# at
-Appointment resource user full name H H

Appointment resource user phone #Appointment time (AM/PM format) #

-Appointment resource user title =
-Appointment symbaol name

-Appointmenttime

-Appointment time (AM/PM format) The appointment will last approximately #Appointment duration number of hours# hour
Appointment type text #Appointment duration number of minutes# minutes and you will be seen by the

-Appointment week day . X X X . .
Replaced appointment date #Appointment resource user title#. You are welcome to bring a friend or relative to this

Replaced appointment date (long format) appointment with you.

Replaced appointment resource name

Replaced appointment resource user full name There are pay and display car parks at the hospital, please allow time to park your
Replaced appointment resource user phone vehicle. On arrival please report to the Audiology Department in the North Wing on the

Replaced appointment resource user title - - -
Replaced appointment symbol name 3rd floor, where every effort will be made to see you as near to your appointment time as

Replaced appointment time

Replaced appointment time (AM/PM format)
[ Client data

[* Currentissued accessories -
[ Currentissued devices -
[ DHI questionnaire results

[ General information v -

-

-

o A series of predetermined variables are available for you to enter.
o Once a variable has been selected, place the cursor at the required position and click the
button Insert variable. The name of the variable will appear with # marks at either side.

It is important that you do not edit the variable words inside the # marks, or the variable
will not function correctly.

e You can insert variables in 3 ways:

« Place the cursor at the required position inside the building block/text field and double-
click on the variable.

« Place the cursor inside the building block/text field at the position you wish to insert a
variable and click on Insert variable.

« Click and drag the variable into the required position inside the building block/text field
- it is important that you hold the mouse still above the variable before you click and
drag the variable into the required position.

« The different text boxes in Booking defined templates can be formatted with the Report
Builder. For more information on this, contact the Auditdata support office.
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« To look at the layout, select Print test and a letter will be printed with the variable names
displayed.
o The letter can then be saved and a new letter defined.

6.23.2 New MS Word template

o Click on New MS Word template, which will open Word and you can create the Word
template as you need.

-0 = Document2 - Word Andrey Shustov
. . L ] . lew document *
File Home Insert Design Layout References Mailings Review View Help jel nts
Not related to any activi =
’E_r‘| [=] Outline IE [ Ruler q [‘5‘ E T New Wit ¥ ity [ =]
. @ =] Draft <_|"' —' —— | [ Gridlines = Arrange| Name / Comments
Read ' Print Web Learning | Vertical Side o Zoom 100% -
Mode Layout Layout Tools toSide | [ Navigation Pane <= | EHsplit | Resultstemplate -
Views Immersive | Page Movement Show Zoom = A
|
| Save as new document of type
%Leﬂertemplates -
Send .. | Saveandclose Cancel =
#Appointment date (long format)# Variables
#Appointment duration# [ Appointment data ~
-Appointment Booking code
-Appointment Referenced by attribute
Appointment anonym. number
Appointment date

-Appointment date {long format)
-Appointment duration

-Appointment duration number of hours
-Appointment duration number of minutes
-Appointment information
-Appointment outcome code
-Appointment outcome description
-Appointment outcome name
-Appointment outcome reporting code
-Appointment reason

-Appointment resource name
-Appointment resource user full name
-Appointment resource user phone
-Appointment resource user title
-Appointment symbal name
-Appointment time

-Appointment time (AM/PM format)
-Appointment type text

Annnintmant weak dav &7
Insertvariable Insertvalue -
Page 1 of 1 6words [[¥ English [United States) T = | | + 1005

« The variables will remain hidden until you expand them using the arrows, keeping them
hidden by default will make this dialog open faster.
« Variables can be nested in folders to help reduce the initial list.
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Variables

[ General infarmation

[ Implant data

[ Letter specific information
[ Measurement

[* Latest audiogram data

- [ Latesttympanometry data
rTympanometer |0
rTympanometry ECY L
rTympanometry ECY R
rTympanametry MEP L
rTympanametry MEF R
rTympanametry SCISA label L
rTympanaometry SCISA label R
rTympanaometry SCISA unit L
rTympanaometry SCISA unit R
rTympanometry SCISAvalue L
FTympanometry SCISAvalue R
rTympanametry audiogram date
FTympanametry audiogram number
rTympanametry audiogram type

FTympanametry date
rTympanametry frequency L

FTvrmnannmeatre frennenrey B

You can insert variables in the Word template in 3 ways:

o Place the cursor at the required position in the document and double-click on the
variable.

o Place the cursor inside the document and click on Insert variable.

o Click and drag the variable into the required position in the document - it is
important that you hold the mouse still above the variable before you click and
drag the variable into the required position.

If the template contains the audiogram graph variable, a window will open to allow the
user to select which audiogram is to be used. The number for the audiogram variable
(there can be up to four) will appear at the top of the Audiogram List dialog.

Name and address values can appear in upper case or mixed case according to a setting
in the Administration tool.

When finished with your document, click on Save and close.

To close without saving, click on Cancel.

Back in Auditbase, you can now edit the name, availability, saving settings and default
recipients under Selected template.

You can choose whether or not the letter should be Available in the booking module,
Available in the Waiting list module or Available as a Referral receipt.

The saving settings allow you to save a record of any letter sent with or without content,
along with a record of to whom and when it was sent.

If you check By default, attach letter to appointment, the letter will be attached to the
appointment that the letter is about.

If you choose not to uncheck By default, set date of sending to the current date, the
date field will be left empty on the letter.
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« If you save the letter with content, saving in RTF (available for Booking defined
templates) or Word format (available for Word templates) will take up more space on the
server than if you save as text, which does not include images etc. Unless you really need
to save images and formatting from documents, you should choose a plain text format.
Text documents will lose all formatting but are still easy to read and edit. RTF will keep

all formatting, but increase the file size, and is harder to edit later because of a frame
setup.

« Uncheck By default, save letters read-only if you do not want the letter to be editable
after you have saved it. However, users can be granted the extended user right of
“Documents: Remove read-only flag” by the system administrator.

« Word templates are editable in Word by choosing the letter in the list and clicking Edit.

6.23.3 Default recipients
It is easy to add or remove default recipients of letters.

o Choose the letter in the list.
« To remove recipients, choose the recipient you want to remove and click Remove.

Diefault recipients Add Remaove

Type Mame

All rels. and other contacts marked as

o To add default recipients, click on Add to select which group or specific recipients you
want to add as default recipients of the letter.

Add default recipient to letter template *

Add Cancel

Select recipient

M Referral referring agent

All relatives and other contacts marked as CC

All professional contacts
B Specific professional contact type Registered Practice -
B Specific referring agent

Specific relative or other contact Mother
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« You can add the selected Client.

« You can choose to add All relatives and other contacts marked as CC in the Client
information module under the tab Contacts.

o You can add All professional contacts.

« You can add just a Specific professional contact type.

« You can add a Specific referring agent.

« And you can add a Specific relative or other contacts, even if they have not been
marked as CC in the Client information module.

« The changes you have made are automatically saved to Auditbase.

« The full list of recipients can be added to the letter by using the variable List of recipients
under Letter specific information either when editing a booking defined template in
Auditbase or when adding variables in an MS Word template.
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6.24 Making timetable

Timetable functionality can be restricted to line managers by the system administrator.

Timetables now consist of not just the Timetable symbol representing the clinic type but also
the Location and Department symbols if these are used. All locations(No Location) and All
departments(No department) can be used if Location and Department Filtering has not been
set up. If there is to be no change in Location or Department, the [No Change] option can be
selected. This will not overwrite any existing Locations or Departments.

As the Location of an appointment can be used in a Letter, if the Location of an existing
appointment is changed when making the Timetable, the user will be requested to generate
new appointment letters for all affected clients.

Timetable symbols have a default Location and Department set up in the System
Administration tool. When making a timetable, if Location filtering is licensed, the default
Location or Department for the selected symbol can be taken as the default or, by checking
Select location/department from Booking screen as default, the default Location and
Department is taken from the toolbar in the Booking screen.

If part of the timespan selected is occupied with appointments having a different Location or
Department then the new selection will not be applied.

Timetable details can be entered via one of the following three functions:

o Direct editing
« Scheduling
o Copying

Direct editing
Select a date in the Calendar.

o Select Edit -> Make timetable or press F9.

Select timetable, location, department and length X
Duration Select location/department from Booking screen as default
1 |~/hours 30 ~ min. *) Only enabled for single location and department selection

Symbaol Location Department

MO SYMBOL FS All (no location) All (no department)
11 (MO CHAMGE] (MO CHAMGE]
22 [+ Test group123 Department1

- NTS L 2 Location3 2 Department2

St ENT CLINIC '+ Test group 2 3 Department3

[ SAV - C&B - Dref/ AGR 4 Testd

. Taw Hill

BB COMMUNITY PAEDIATRICS 2 Location2

Gl PAED Assisting 4 Testd

[ PAED Hearing Aid Clinic

PAED Transition

A SAVERNAKE PAEDS

M TIDWORTH

% Wiltshire PHAC v
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o Select a symbol in the list and enter the number of 15 minute time slots.

o If activated, select a Location the appointment relates to. The location symbol will display
next to the timetable symbol on the booking page.

« If activated, select a Department the appointment relates to. The department symbol will
display next to the location symbol on the booking page.

« If you are in Resource plan, click the timeslot on the resource you want to create.

« If you are in Time plan, click a timeslot on the resource/time grid.

o In both cases, the system marks the requested number of timetable slots by the selected
symbol.

« When in Time plan the system automatically defaults to showing only Timetable symbols.
However, you can check the box next to Booking under Display symbols to see Booking
symbols as well.

« Once you click to make the specific timetable, you are prompted to turn off Booking
symbols again for the system to be able to enter the Timetable symbol.

Warning x

TimeTable symbols cannot be applied unless the ‘Display
symbols'is setto TimeTable’. Change the symbol view and
apply the new TimeTable symbols?

Diont show this message again

Cancel

« Click OK and the booking symbols are automatically turned off and your new Timetable
symbol is visible in the time grid.
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6.25 Scheduling timetable

o Select Edit -> Schedule timetable.

Schedule timetable *
Apply Save Close
X Select location/depariment from Booking screen as default Date
Resource Timetable symbol . . .
*)Only enabled for single location and department selection 10/01/2020
LETH - | | NO SYMBOL ~ .
Charlie 11 Location Department )
Duration
Res109 22 All (no location) All (no department)
Res46 = NTS MO CHAMGE] [NO CHANGE] Starttime End time
Res68 kY ENT CLINIC [+ Test group123 - Departmenti
Res70 B SAV - C&B - Dref/ AGR 2 Department2
Res54 [T test [+ Testgroup 2 3 Department3
Res78 B COMMUNITY PAEDIATRICS tf] Location 4 Testd )
Res73 [l PAED Assisting . Taw Hill Hours Minutes
Resg2 @ PAED Hearing Aid Clinic 2 Location2 1 - 0 -
Res75 @l PAED Transition 2 Testd
Res71 A SAVERNAKE PAEDS
Res72 B TIDWORTH
Res105 B wiltshire PHAC
Resd3 123
Resd5 v FAIRFORD ENT
Recurrence Schedule method
. Do not overwrite existing timetable, location and
Daily | Weekly | Monthly | Annually department symbols
#| Every 1 day(s) Overwrite existing symbols only where appointment
is not booked
Every weekday . -~ ) ; )
Overwrite existing symbols even if appointment is
booked and re-generate letter
*) Overwritting timetable symbol only does not
End of recurrence re-generate letter
# End after 1 OCCUITences # Prompt for each conflict
*) Location will not be saved to appointment slots ifit
End by date 10/01/2020 causes the appointment to appear in different

locations

+ Select Resources in the list.
o Select a Timetable symbol. Note that outdated symbols are not shown in the list.
« If activated, select a Location the schedule will relate to.

« If activated, select a Department the schedule will relate to.

o Select Date and enter Duration.

« Set Recurrence if required. If the Monthly tab is chosen, you use the arrow buttons to
add multiple criteria.

« Choose the desired Schedule method - the default is ‘Prompt for each conflict’.

o Apply to create timetable and leave the window opened.

« Save to create timetable and close the window.

As the Location of an appointment can be used in a Letter, if the Location of an existing
appointment is changed when rescheduling the Timetable, the user will be requested to
generate new appointment letters for all affected clients.

When scheduling a Timetable there are options to control whether symbols that are already in
Booking should be overwritten or not. Any appointments that have already been created will
not be split between more than one Location or Department.

The list of options is the following (including comments):
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+ Do not overwrite existing timetable, location and department symbols - Any existing

timetable symbols will not be overwritten and there will be no warning; if part of the
timespan selected is occupied with appointments having a different Location or
Department, then only the part of the timespan that is available will be updated with
timetable, location and department symbols.

« Overwrite existing symbols only where appointment is not booked - Any existing

timetable, location and department symbols will be overwritten only where there is no

appointment booked;
« Overwrite existing symbols even if appointment is booked and re-generate letter.
*) Overwriting of timetable symbol only does not re-generate letter - If an

appointment has been booked next to a timetable symbol, the symbol will be overwritten

but you will be asked if you want to send a new letter to the client if the Location is
changed;

« Prompt for each conflict.
*) Location/department will not be saved to slots with appointments if that causes
appearing the same appointment in different locations/departments - If there is a

conflict between the timetable you are scheduling and the existing timetable symbols,

you will be asked to confirm the change. Appointments will not be booked if the

appointment location and department clashes with the timetable location or department.

Timetable symbols have a default Location and Department set up in the System
Administration tool. When scheduling a timetable, if Location and Department Filtering is
licensed, the default Location or Department for the selected symbol can be taken as the
default or, by checking Select location/department from Booking screen as default, the
default Location and Department is taken from the toolbar in the Booking screen.
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6.26 Copying timetable

« This facility may be used for duplicating the timetable to further days or weeks.
« Select Edit -> Copy timetable.

|
i If any changes to appointment Locations are found, requiring new Lefters to be created:

Apply Save I # Wam before copying timetable Moiify after changes are made, for faster processing | Closs

Copy from resource Copy to resource(s)
Trawy - All
| &) Saleciion Begin | 25/12/2019
Copy from Travy -
52 = [2019 & Stassy | Occurrences 1
Week 192 []20%9 15 Charlie Dateinterval  25/12/2019
Date interval ~ 23/12/2019 - 2911212019 Res109
Resds
Res6g
W Monday Res70 * Copy to weeks
W Tuesday FRQES‘?; Selection of weeks
es
B Wednesday ResT2 Begin wee End week Every
W Thursday Resg2 v |52 |2019 & |52 [ | 2019 [ 1
(N Overwrite existing timetable Dateinterval 2311212019 - 29/12/2019
B Saturday
B Sunday M All days *) Location/department will not be saved to slots with appointments ifthat causes

appearing the same appointment in different locations/departments
*) Change of location/department for all booked times|ots will cause re-generation of
booking letter

« Now you can choose when to get notified if changes to appointment Locations are found,

which requires new letters to be created
o If necessary to speed up the process of Copying timetable, use the option “Notify
after changes are made...”

« In Copy from resource drop-down list, select a resource the timetable is created for,
which is to be copied to another resource. Select [duplicate] in that list where the
timetable is to be duplicated for a resource or resources.

« In Copy to resource(s), select resources the timetable should be created (copied) for.

+ When copying a timetable, you have the option to overwrite or not overwrite the
Timetable, Location and Department symbols (Overwrite existing timetable).

o If you choose to overwrite the timetable and if the Location or Department of an
existing appointment is changed, when copying the Timetable, you will be
requested to generate new appointment letters for all affected clients.

o If you choose not to overwrite the timetable then only if all four symbols are empty
will the Copy action take place for a particular timeslot.

« In Copy from, specify source days’ timetable should be copied from.

« In Copy to days or Copy to weeks, specify target date range If two or more weekdays are
selected, only Copy to weeks is available.

« When you select the Copy to days option, you can specify the days when the timetable
should be copied to.
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« Click Edit pattern. The system opens the Recurrence window where recurring days can
be specified on a Daily, Weekly, Monthly or Yearly basis.

« If you select Copy to weeks, you can specify copying on weekly basis. Week number
range and sequence of week numbers can be specified.

« Apply to copy timetable and leave the window opened.

« Save to copy timetable and close the window.
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6.27 Bulk move from Resource to Resource

When a resource is going to be unavailable and you need to move appointments in bulk from
one resource to another, the Bulk move facility can be used.

Edit -> Bulk move.

Select the From resource and the To resource from the drop down lists of resources. By
default, the active Resource will be selected.

Select the from Date and the to Date using the calendar icon or by entering a date.

By default, the active date will be selected.

The appointments that can be moved will be highlighted in yellow. If an appointment
cannot be moved, the appointment will stay in its original position and will not be
highlighted.

If a highlighted appointment is not to be moved, click on the appointment and it will
move to left in its original position.

The left and right arrows can also be used to move all appointments from one resource to
the other.

You can decide if letters should be printed Never, If location or department is changed
or For all moved appointments.

Once you have made your selections, Save will move the appointments to the selected
resource.

Once this has been done, the appointments cannot be moved back except by restarting
the bulk move option.

If all the appointments could not be moved from the From resource, the Bulk move
appointments window will stay open so that further moves can be made.

Close will shut down the Bulk move appointments window.

Bulk move appointments X

Travy A To Res109 - Click on a highlighted yellow appointment to
exclude it from bulk move, or to include it again
1000112011 | 7] Date 101012011 | [5]

Print letters

N N N N SN NN Y

e .k e

=

K2-2 08:00 B
08:15 ) Mever
*, FATHER FNAME221 08:45
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If an appointment is a multi-resource appointment, it can only be moved if the locations match
or there is no location set up in the To resource.

Reservations cannot be moved using this method but must be moved individually.
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6.28 Efficiency Analysis

The Booking screen can be analysed to search for empty slots, unscheduled appointments or
appointments in the timetable within a date range or slots that cannot be completely filled by
appointments types of a defined length. Clients that have multiple earmoulds can also be found here.
These are found on Booking -> Functions -> Efficiency analysis. There are several tabs which look for
specific information.

The Efficiency analysis window can be collapsed to make viewing the Booking screen easier. This is
done by using the arrows at the top right of the window. This creates a floating panel which can be
moved to anywhere on the screen that is convenient. The same arrows can then be used to expand
the windows.

Once afilter has been created it can be saved with a name. Once Save has been selected a window will
appear which will give you options depending on whether this is the first time the filter has been saved
orifit is being updated.

Save filter X

Save Close

‘Save to the current filter <Ba|ance>§

Rename the current filter
« Save as anew filter

Name Balance

Save as the default filter

« You will need to give the filter a Name and decide if this filter will be the default filter by selecting
Save as the default filter.

« Ifyou do not want to Save this filter, select Close to shut the window without saving.

« To modify a current filter, choose one from the drop-down list of Saved filters, make any required
modifications and then Save as...

« ASave filter window will appear with options to either Save to the current filter, Rename the
current filter or Save as a new filter. You can also decide if this filter will be the default filter by
selecting Save as the default filter.

6.28.1 Unbooked time

« Enterthe required date range. This can be done by entering a date in the Date: from and to
fields or by right clicking on the fields and selecting a date from the calendar.

« Timetable symbols can be selected by checking the box next to their name or by checking the
Select All box and then using the arrow to move them to the right. The ‘no symbol’ option is not
available; timetable symbols must be applied to search for gaps.

« Resources can be selected by checking the box next to their name or by checking the Select All
box and then using the arrow to move them to the right.

« Once symbols and resources have been selected, the Show result button is highlighted in yellow
to show that the analysis can be run.

o The result ofthe analysis is shown in the bottom section. To navigate to a particular time slot,
double click on it and you will be taken to the empty slot.
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Efficiency analysis - Unbooked time

Unbooked time | Unscheduled appts | Missed appts | Many earmoulds | Missed review appts

Only include time ranges which cannot be filled with
Typical appointment duration 0 hours

Filtering
Saved filters  Balance - Save Save as... Delete
Date:from | 310172018 | to  28/02/2020
Timetable symbols: Select All Selectal
| Symbol ~ [ Symbol
[ BAHARAC [O= BALANCE
[J CLEAR1
[J= NOCLNIC >
[JE OADADULT P
[JE 0AD PAED
& PAED 02
[J PAED U3 v
Resources: SelectAll SelectAl
Available resources | Selected resources A
[] George [ JAKE
[J| CHELSEA
» [/ walsh
< [ ALAN
[] ROSE
[J BRIAN
[J/ EVELYN v

appointments of the comect duration
0 min.

Result - Double click on a row to navigate to thattime interval Print

Dale |Resource| Symbol |Time interval
11/12/2018 | CHARLIE = BALANCE |09:00-17:00
18/12/2018| CHARLIE = BALANCE |09:00-17:00
2412/2018| CHARLIE = BALANCE |08:00-12:00
2512/2018| CHARLIE = BALANCE |09:00-17:00
31/12/2018| CHARLIE = BALANCE |08:00-12:00
07/01/2019| CHARLIE = BALANCE | 08:00-12:00

« If you want to see only time slots that cannot be completely filled by an appointment of a
set duration, select the check box and set the Typical appointment duration.

B Only include time ranges which cannot be filled with appointments of the correct duration

Typical appointment duration

1 '+ hours min.

o The results will now be filtered to show only slots that cannot be filled completely by the
set duration. In this example, a one hour and 15 minute empty slot will be shown
because a one hour and 15 minute appointment cannot completely fill the empty slot. A
two hour slot would not be shown as two one-hour appointments can fill the empty slot.

Result - Double click on a row to navigate to that time interval

Print

Date |Resource[ Symbol |Timeinterva|

11/12/2018 |CHARLIE |z BALANCE |09:00-17:00
18/12/2018 | CHARLIE = BALANCE |09:00-17:00
24/12/2018 CHARLIE = BALANCE 08:00-12:00
25/12/2018 CHARLIE = BALANCE 09:00-17:00
31/12/2018 | CHARLIE = BALANCE 08:00-12:00
07/01/2019  CHARLIE = BALANCE 08:00-12:00

e This panel can be further collapsed so that maximum screen can be seen without the

need to re-start the analysis.
o Appointments can now be adjusted or moved to maximise the use of the available time.
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o The results of the analysis can be sent to a printer using the Print button. The print out
will show the results by resource and then by date.

6.28.2 Unscheduled Appointments

The result of this tab will show the number appointments for client above the normal requirement for

that appointment type.

« Enterthe required date range. This can be done by entering a date in the Date: from and to
fields or by right clicking on the fields and selecting a date from the calendar.

« Appointment symbols can be selected by checking the box next to their name or by checking the
Select All box and then using the arrow to move them to the right. The ‘no symbol’ option is not
available; appointment symbols must be applied to search for appointments.

Efficiency analysis - Patients attending multiple unscheduled appt types

Unbooked time | Unscheduled appts

Filtering

Savedfilters  =Mew filter=

Date: from
Unscheduled appointment types:

30MZ72018 | to  30M272020

| Symbaol
[JE COMMASSESS/REM
[JW WALK IN REPAIR
[J/A ASSISTING PAEDS
[JTa TINNITUS ASSESS
[0% TINNITUS FU

Missed appts | Many earmoulds | Missed review appts

Save Save as . slete

Show result
H SelectAll

| Symbol A
I 1STIFNSSUE
[ P PR HAREPAIR
B IMPLANT ANNUAL RV
FIF IMPLANT FU
= swWITCH ON

[JE CLINICAL MOM PT 15 SURGERY
[/ ADMINISTRATION ¥ [ A IMPLANT ASSESSMENT v
Minimum number of appointments: 1
List of patients selected by params above (Appls total not including Group Appts) Export
Hospital no.,  NHS no. MName |.ﬁppts. total

111 111 1111 CO
T121220 FRED

OMEL CHARLIE HAR

Result - Double dick on a row to navigate to that appointment

Show All

Date Rasnurc&|

Symbol

6.28.3 Missed Appointments

Status | Time interval

24/04/2019 |CHARLIE I 1STIFISSUE D
04/01/2019 |BERTA P PRHAREPAIR

12:30-13:15
11:15-11:45

>

The result of this tab will show appointments that have a certain appointment status.
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« Enterthe required date range. This can be done by entering a date in the Date: from and to
fields or by right clicking on the fields and selecting a date from the calendar.

« Statuses indicating unattended appointments can be selected by checking the box next to their
Description or by checking the Select All box and then using the arrow to move them to the right.

« The Minimum number of appointments can be set so that patients that have missed multiple
appointments can be seen.

« Patients that need to be excluded from the result due to their alert or parameter settings, can be
excluded by selecting the Exclude patients with alerts and parameters button which willopen a
window where Alerts (with a Code) and Parameters (without a Code) can be selected.

Select alerts and parameters X

Exclude patients with alerts and parameters Apply
SelectAll SelectAll

‘ Code| Description A Code | Description

Om Moved

| Wheelchair 4

O 2 Person lift 4

] War Pensioner

arT Transport

[P Private Patient v

« If an Alert or a Parameter has been selected, then the exclusion message is shown.

|  Exclude with alerts and parameters | Alert and param. exclusion is on

« Once Show result has been selected, a List of patients selected by params above
(Appts total not including Group Appts) is shown in the window.

List of patients selected by params above (Appts total not including Group Appts) Export

Hospital no.| NHS no. Name DNA'ed appts. total| Appts. total
111 111 1111 COLONEL CHARLIE HARPER 6

« By selecting one of these patients, the appointments for the selected patient is shown in
the bottom window.
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o The Export button will open a window where the results can be saved as a CSV file so
that it can be opened in Excel.

Result - Double click on a row to navigate to that appointment Show All
Date ‘Resource Symbol ‘Status‘Time interval
13/11/2019 |BERTA |H HEARING TEST|C 10:30-10:45
13/11/2019 | CHARLIE |H HEARING TEST|C 10:30-10:45
06/11/2019 | BERTA SURGERY C 10:00-11:00
3/11/2019 | CHARLIE SURGERY 10:00-11:0C

12:15-13:00
12:30-13:15

08/10/2019 | CHARLIE [T 1ST IFASSUE
24/04/2019 | CHARLIE I 1STIFASSUE

O 0|

o Double clicking an appointment will show that appointment in the Booking screen.

6.28.4 Many Earmoulds
This tab shows patients that have a minimum number of earmould visits over a date range.

o Enterthe required date range. This can be done by entering a date in the Date: from and to
fields or by right clicking on the fields and selecting a date from the calendar.

o The Minimum number of earmould visits can be set.

« Show result will display patients that have a number of earmould visits equal to or greater than

the set number.

List of patients selected by params above (including number of earmoulds) Export

Hospital no.| NHS no. Name EMs total

111 111 1111 COLONEL CHARLIE HARPER | 2

6.28.5 Missed Review Appointments

This tab will show patients that have attended an initial appointment but not the review or follow up
appointment.

« Enterthe required date range. This can be done by entering a date in the Date: from and to
fields or by right clicking on the fields and selecting a date from the calendar.

« Initial appointments types can be selected by checking the box next to the appointment
Symbol. The right facing arrow will move the symbol to the right-hand box which is used as the
filter.

« The number of days after the initial appointment can be set using the Review appointment must
occur from, to days after the initial appt fields. This can be set to a maximum of 999 days after
the initial appointment.

« Review appointment types can be selected by checking the box next to the appointment Symbol.
The right facing arrow will move the symbol to the right-hand box which is used as the filter.
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« Patients that need to be excluded from the result due to their alert or parameter settings, can be
excluded by selecting the Exclude patients with alerts and parameters button which willopen a
window where Alerts (with a Code) and Parameters (without a Code) can be selected.

| Code| Description A

O(m Moved

Wheelchair

2 Person lift

War Pensioner

Transport

Private Patient v

o/

JgoOod

Select alerts and parameters X
Exclude patients with alerts and parameters Apply |
SelectAll SelectAll

| Code | Description

« If an Alert or a Parameter has been selected, then the exclusion message is shown.

| Exclude with alerts and parameters

] Alert and param. exclusion is on

« Once Show result has been selected, a List of patients selected by params above
(Appts total not including Group Appts) is shown in the window.
o By selecting one of these patients, the appointments for the selected patient is shown in

the bottom window.

List of patients selected by params above (Appts total notincluding Group Appts)

Export

Hospital no.| NHS no. Name

MASTER ANGUS JONES
0000022 Dr. LINDAHARRIS
T121220 FRED

Appts. total

N 1

o The Export button will open a window where the results can be saved as a CSV file so

that it can be opened in Excel.

Result - Double click on a row to navigate to that appointment ShowAll
Date | Resnurce[ Symbol ]Status]Time interval
10:30-10:45

13/11/2019 |BERTA  |H HEARING TEST|C

13/11/2019 | CHARLIE |[H HEARING TEST|C
06/11/2019 | BERTA SURGERY
06 “HARLIE SURGERY

08/10/2019 | CHARLIE [T 1ST IFAISSUE
24J04/2019 | CHARLIE I 1STIFASSUE

wENoRReoREe]

10:30

1
1

-10:45
0:00-11:0C
0:00-11:00

12:15-13:00
12:30-13:15

« Double clicking an appointment will show that appointment in the Booking screen.
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7 Referring agents

To open Referring agents go to Navigation -> Referring agents. You can also call this window
from other modules where you select a referring agent, for instance Referral and Client
information.

The system supports the following default referring agent types:

o Agency

« Audiologist

o General Practice (GP)

o An individual referring agent
e« ENT (Ear- Nose- and Throat specialist)
e School

o Health visitor

o Onward referral

o Paediatrician

e SALT

o Other

More referring agent types can be defined by the System Administrator.

Referring agents *
MNew Edit Select Close
Search
Paostcode GP Code Practice Code Type - Include outdated
CCG + CCGCode + Mame Surname = Part of full name Search
Type |CCG | Title |First‘ Surname/Mame Address Postcode Infon ~
General Pract 50H DR M AITCHISON HILARY COTTAGE SURGERY, KEBLE LAWNS, F PC:6373
General Pract 5QF DR |SMN |ALBERT BURDWOOD SURGERY, WHEELERS GREEM \ PC:8362
Dther ALISON STAGG
General Pract 5QE (DR A 3 VALE AVENUE, WANT PC.6376
General Pract 5555¢ DR AL | ALLIK 123 STR, SOME CITY, ABC 1234 CITY
General Pract DR |AD |AM 123 STR, HOME CITY
Other AMANDA CARROLL MERCHISTON SURGERY, HIGHWORTH ROAD, PC:3523
Other AMAESTHETIC COMSULTANT | TGW
General Pract CF AMDERSON MERCHISTON SURGERY, HIGHWORTH ROAD, SN2 4BF
General Pract 5K3 DR M AMDREWS ELM TREE SURGERY, 24AHIGH STREET, SHRIPC:5392
Health visitor AMN SEYMOUR
General Pract 5K3 DR K APPLEGATE HAWTHORMN MEDICAL CENTRE, MAY CLOSE, ( PC:6406
General Pract 5K3 DR ASH KINGSWOOD SURGERY, KINGSWOOD AVENUE PC:3336
Other ATTOTI COMNSULTANT PHYSICIAM, DOME v
7 P T PPy ——— -
Address: 3 VALE AVENUE, WANTAGE, OXON Postcode: PC:6376 City:
CCG: OXCCG CCG code: 50QE Practice code:  K84074

MNUM SCRL

You can search for Referring agents by the following criteria:
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o Postcode

o CCG (Clinical commissioning group) code
e CCG name

e GP code

o GP practice code

o Agent type

o Surname or part of full name

Your System Administrator can configure which field the cursor should default to for faster
access to searching.

Your system administrator configures if the different referring agent types are an individual or
an organisation.

By default, the system does not include outdated agents in the search result. To include
outdated agents, check the corresponding box.

When you have specified the relevant search criteria, click on Search. Agents meeting the
search criteria will be listed in the table.

You may also use the ‘Word wheel’ functionality to search, see the section on ‘Sorting and
saving listing screens’.
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7.1 Edit or add a referring agent

« Toadd a new referring agent, click New. If you wish to edit a referring agent, highlight
the referring agent and click Edit.

Phone number:
Fax number:
Email

Preferred comm.
method

Edit referring agent ot
Delete 0 Close
Agenttype 7] mawigua
Title DR Organization
First name A
Last name ALLEM
Full name DR AALLEM
Compose full name Decompose full name
Address 3 VALE AVENUE -
WANTAGE
OHOM
w
Postcode PC.B376

olepus@auditdata.com

Site default (Only email, past if email is not avai| -

Information

GP Code 3453544441

Practice Code Ke4074

LiE OX CCG -

CCG Code 5QE v Outdated agent
External systemid 5444

« Select an Agent type.

« Each agent can be either an Individual or an Organization. This is defined by selecting
the corresponding option.

« If Individual is chosen, enter the title, first name or initials and last name in the
appropriate fields, or enter the full name in the Full name field and use the Decompose
full name to break it down according the name format in Auditbase Administration.
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« Compose full name and Decompose full name allow names made suitable for
addresses after they come from PAS and to be shown in different ways according to
need, specifically as ‘Dr A Adams’ in addresses and as ‘Adams A’ when sorting in a list.

o To automatically fill in the full name with the information entered in the other fields, click
on the Compose full name button.

o To extract the information from the full name field, click on the Decompose full name
button. The system decomposes the full agent name as defined by the system
administrator.

« An agent can be marked as Outdated by selecting the relevant check box. The system
will not include this agent in search results unless required by the user.

o Enter an email address for the agent then from the drop-down list below this, select the
agent’s preferred method of receiving letters and documents

o Enter other relevant information for the agent, and click OK to save the Referring agent
with the new or altered information.

« Depending on the settings in the System Administration tool, a referring agent can exist
more than once at the same practice with different postcodes.

« Click Delete button to delete an agent from list.

« Click Close button to end the session with no action.
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8 Measurements

Click the button below to access our training materials.

The Measurements menu contains commands for accessing audiometry measurements:

o AB Audiogram starts a new audiometry measurement session. For more information refer
to Entering a pure tone audiogram

« ABR and OAE screening and diagnostics opens a new window for entering ABR
(Auditory Brainstem Response) and OAE (Otoacoustic Emissions) screening and
diagnostic data. Please refer to the ABR and OAE screening and diagnostics topic for
details.

+« Noah module selection opens Noah4Auditbase, an Auditbase subsystem that interacts
with Noah 4, and displays the list of Noah modules available. For more details on
Noah4Auditbase, please refer to Noah4Auditbase subsystem.

« Noah session browser opens the Sessions and actions panel of the Noah4Auditbase
subsystem.

« Open latest fitting action to open the appropriate fitting module if installed.

o Shortcuts to installed measurement modules are also available if required, for instance
Aurical Audiogram.

-7 Measurements
-] AB Audiogram
ABR and OAE screening and diagnostics
& NOAH module selection
----- [=] Other speech test
&) NOAH session browser
@ Cpen latest fitting action
= @ MOAH measurement modules
-4 Moah 4 Audiogram Module
-3 Primus Module

Auditbase stores audiograms by the date entered by the user, but Noah stores audiograms by
the date entered onto the system. To avoid old audiograms being used by Noah, any
audiograms entered into Auditbase with a date other than the current date will not be linked
into Noah. This will prevent Noah pulling an outdated audiogram through to other modules.
For further details please contact your local Auditdata support.

If an audiogram is saved in a Noah measurement module with a date before today, Auditbase
will save this and it will be linked to Noah.
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An audiogram saved from Noah Aud with a “Date of evaluation” in the past will be listed in the
Auditbase Audiogram list with a text like this: “Transcription of 10/07/2006 Audiogram Data”.
The date in the Auditbase audiogram list and the Noah session list will be the current date.

Audiograms with historical dates

If an audiogram is saved from Auditbase with a past date, the text in the Auditbase Audiogram
list will be Audiogram not linked to Noah (it is not available from the Noah environment). The
date in the list of audiograms will be the past date.

Noah Audiogram formats 100, 200 and 500 can be read, depending on settings in the System
Administration tool. Auditbase saves in 200 format, Auditbase cannot edit a 500 format even if
saved by Noah Aud.

Audiometer

The correct communication protocol is necessary to be able to configure audiometers. The
correct protocol can be selected in System Administration. Core audiogram data made by a
Noah module or panel cannot be edited in Auditbase except when created by the Noah Aud
module in format 200. The following data can be updated:

« Weber - on the main audiogram graph and on the separate tab;

o Setting notes for thresholds using right click menu;

« Information (notes, ear drum status etc.).

« If there was a note on a threshold, and users continue measurement and remove
the threshold, the note must be removed too;

« Referral;

« Vestibular;

« Speech in noise;

o Others;Surgery;

« Symbols which can be added to the audiogram using Import tymp;

o Simultaneous run of measurement and tymp is NOT needed.

o Entering tympanometry data manually on the Tymp tab;

o Import tymp data;

o Tympanometry reflexes - it is possible to add these using the mouse as well as by
using Import tymp and Measure tymp;

« Symbols which are allowed to be added to the audiogram include “Forehead bone
measurements”. These symbols are not included in the public part of Noah. The list of
symbols is included below:

o Bone / Other / Unmasked Left;

o Bone / Other / Unmasked Right;

o Bone/ Other / Unmasked Left Not reached;

« Bone / Other / Unmasked Right Not reached;
« Compare tab

Tympanometry data

New Tympanometry algorithm for extracting data from Noah.
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8.1 ABR and OAE screening and diagnostics

« From the Navigation area, select Measurements -> ABR and OAE screening and
diagnostics.

« Toview and edit existing tests for the patient, choose a test from the drop-down list.

o Click on New, if you want to fill in a new test.

« You can edit the Date of test if needed.

« Age at test is calculated and fixed when saving.

« A special button is available for attaching the measurement to or detaching it from an
appointment. The button has a picture which reflects the state of the measurement:

iy +
either attached ( == ) or not attached (©7). In addition, the button has a tooltip that

displays detailed information about the measurement linking.

Attach appointment et
Attach Close
Diate | S].rmtml| Description Resource Status "
130162020 | IF fromd Res46 *
13/01/2020 7 2 Charlie *
1000112020 E| PHAC new p Charlie *
1040172020 1 1 Charlie *
090112020 3 PHAC new p Stassy *
09/01/2020 1 1 Reshd * o

« If the appointment is linked to a referral, then the Referral stage, where the
appointment took place, will be shown here.

+ Test type can be selected from the drop-down menu.

« Machine can be selected from the drop-down menu. This list will be defined by your
System Administrator. Yes, No or N/A can be selected to show the In-patient status.

« Transducer type can be selected from the drop-down menu. TDH or Insert phones can
be selected from the hard-coded options.

« Protocol can be selected from the drop-down menu.

« Outcome can be selected from the drop-down menu.

« The name of the Screener can be shown by clicking on the = button and selecting

either a user or a referring agent.
o Fill in the test and click Save.
« Print will send a copy of the report to the printer.

Please note that everything is measured in dBnHL.
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ABR and OAE screening and diagnostics X
Client MR JOHN SMITH Print New Save Delete Close
Tests - Created by SYSTEM ADMINISTRATOR M
Date oftest 10/01/2020 Age attest 79y &5 Referral stage Mot linked to appointment
Test type ~ Screener .| Machine ~ Transducer type I:I
In-patient  N/A - Protocol » Qutcome -
— RIGHT —LEFT
- OAE TE/DP - OAE TE/IDP
Automated ABR - - - - R -
Click ABR - dBnHL - - dBnHL
0.5kHz Tone Pip - dBnHL - - dBnHL
1kHz Tone Pip - dBnHL - - dBnHL
2kHz Tone Pip - dBnHL - - dBnHL
3kHz Tone Pip - dBnHL - - dBnHL
4kHz Tone Pip - dBnHL - - dBnHL
Bone conduction - dBnHL - - dBnHL
Cochlear microphonics - at dBnHL - at dBnHL
0.5kHz CERA - dBnHL - - dBnHL
1kHz CERA - dBnHL - - dBnHL
2kHz CERA - dBnHL - - dBnHL
3kHz CERA - dBnHL - - dBnHL
4kHz CERA - dBnHL - - dBnHL

Hearing Screening responses and key referral info can be recorded and then audited with a set
of Crystal Reports. These are found with other reports in Navigation -> User Reports ->

Hearing Screening and include the following:

« In and Out Patients screened

« Number of screening sessions per patient

o Patients referred for diagnostic assessment
« Patients referred for targeted follow up
o Patients screened before some age

o Patients screened by particular screener
« Patients screened.
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8.2 Entering a pure tone audiogram

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Select Navigation -> Measurements -> AB Audiogram.

« If configured by system administrator, the system opens the last audiogram. Select File -
> New to create a new audiogram.

o The audiogram can be shown in either split, single, large or custom format where custom
has a default zoom size that can be varied under the Zoom menu. The default mode is
defined by the system administrator. See How to toggle between split, single, large or
custom audiogram formats.

o Select the appropriate measurement symbol found in the centre of the screen for split
mode or right part of the screen for large mode.

« Enter the audiogram by clicking on the required threshold point.

« Right-clicking on a point will bring up a window where you can change the status of the
point to Not Reached etc.

« You can input information for right and left ear, comments to the measurements result
and in general and choose an audiogram type that are set up by your system
administrator.

o The audiogram type can be set as a mandatory field for saving a record.

o Select the Show in Viewer checkbox if you want the audiogram to be accessible from the
Auditbase Viewer.

« Select File menu, then Save.

« Check date and Audiologist (Made by), change if necessary.

o Click OK.
Py HE— = x
File View Functions
0 Cllent_T18765 MR JORN SMITH 2 SEUser  SYSTEMADMINISTRATOR | Muliplslocations.___ = Wultple departments.__ ~ 2| 2
e
NORIAL .
10125 250 500 1000 2000 4000 8000 SRT DS DSN Gl ems 1o/ o 125 250 500 1000 2000 4000 8000 SRT DS  DSN
R = .
@ AC MASKED X
0 100 |, O 100
|A/NOTREACHED A
10 90 [cluneemmn | 10 90
< CROSSOVER X
20 80  |Cecuasken 1 20 80
L ucLum J
30 a 70 [Euocu 2 30 P 70
B 4 et un M a.
4 Bty 60 oL m 40 J—N 60
: % s a n
50 [ - 50 |s sEm - 50 A 50
DLyl £ & A
60 40 |2 apor 2 60 ey 40
CRoowmA ¥
70 30 70 30
80 20 80 20
90 10 90 10
100 0 100 0
110 110
120 120
130 130
140 140
g et
Trestodnot cammens 10 IER] [ vasvatoss B
B Siow e Ar Bone 50| | Ar Bone |48
3 1
T o s
Created by
D) o
Information | Referral | Speech | Speechinnoise | Tymp | Compare | Graphical Speech | Others | Vestibular | Surgery

NUM SCRL
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If you enter audiograms via the device interface, the measuring points will automatically
be transferred from the audiometer used for measuring.

o To enter the measurements via the device interface, select the menu item Functions ->
Measure or click Measure.

« The button Measure turns yellow when active. Press Measure again to finish the
measurement.

Measure

NORMAL

@| Symbaol
O AC

@ AC MASKED
FAY BC UNMASKED
A MOT REACHED
| UNCERTAIN
. CROSSOVER
C BC MASKED

L ucLum

UCL M

4 MCL UM

B mcLm

S sF

® SFM

® RIPSY

= RIPSYM

e R CONTRA

¥, on B o TPLYY VDX XD

« When using the Primus audiometer with insert headphones, measurement symbols will
be displayed using air conduction symbols. Right click on the curve to see if the
audiogram was carried out using TDH or Insert transducers.

o Select whether the audiogram is reliable from the drop-down list. If No is selected,
Unreliable will display across the audiogram. This will also show in any printed copies.
The message will not display on an audiogram in Noah. If showing the audiogram to a
client and not wanting them to see the Unreliable message, select the View tab and click
Do not display unreliable. The message will no longer be displayed on the audiogram.

Eile | Yiew | Functions

S Masking levels [0 Weber % . .
@ E 5 E.". F'@L & Masking cursor =] Speech banana 3 World sounds 5' .

Split | Single Llsrge  Custom  Selected zoom

Tend graphs | Tympscale | Mean values | |Domnot display unreliable
B Bxtended range | @) Phoneme sounds rendgrep S i =

Views Zoom Graph Options Other
| Client  T18765 MR JOHN SMITH - |8 = Euser  SYSTEMADMINISTRATOR | Multiple locations ~ Multiple departme‘ Temporarily switch off displaying the audi as unreli L
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In addition to pure tone graphs, an audiogram can contain results of the following
measurements as part of the audiogram:

Speech measurements.

Extended speech measurements in graphical representation.
Vestibular measurements.

Other measurements.

8.2.1 Saving Audiograms

Once the audiogram has been completed, select Save from the File menu to store the
audiogram.

When saving an audiogram, a dialog with client's name, system date and signature of
logged on Auditbase System user is presented.

If you want to have a Noah representation of the audiogram, select the check box Save
audiogram in Noah. This can be unchecked if you do not want to save to Noah. If the
audiogram has been saved using Measure, this must be deactivated before Save to
Noah can be unchecked. Save audiogram in Noah cannot be unchecked if a
measurement with the Noah audiogram module launch protocol v1 is in progress but it
can be unchecked for Protocol vl and Protocol v2 measurements if the full screen mode
was not used. These protocols are set by the System Administrator.

If you want to sign the audiogram after saving it, select the check box Sign audiogram
now.

As default, Auditbase System will suggest the audiogram to be saved - and identified - by
the system date which may be altered by right clicking in the Date field to open

calendar. Change of sighature - Auditbase System user - is done via El and selecting from
list.

If another staff member performs the client hearing level investigation, you can select
this person as Examined by user on the Information tab. The system administrator
defines whether this field is visible.

When more audiograms are saved by the same date, they are numbered consecutively;
DDMMYYYY1, DDMMYYYY2.

There are no limits to the number of audiograms for a client.

Click OK to save the audiogram with the suggested or changed parameters or press
Ctri+S.

Retrieving saved audiograms from database is done via the File menu, Open.

A dialog with lists of audiograms saved for a selected client is presented. The audiograms
are displayed with audiogram name, date, no., whether or not it is signed, audiogram
type and comments. A Preview option is also available. This will open the selected
audiogram in a separate window so that it can be previewed before being opened.

To retrieve the client’s most recent audiogram without selecting in the list, select File ->
Open latest, or press Ctrl+L.

In the Administration tool, the system can be configured to open the client’'s most recent
audiogram automatically.
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8.2.2 Signing audiograms
You can sign an audiogram when you save the audiogram.

o This functionality can be switched on or off by the system administrator.

« You can also sign an existing audiogram from Functions -> Sign audiogram.

+ You are reminded to link the Audiogram to an appointment when signing.

Previously signed audiograms can be linked to an appointment if required.

You can see whether an audiogram is signed, in the main window of the audiogram, in
the Open audiogram dialog and in the Noah browser.

Note: If you sign an audiogram, the audiogram cannot be edited.

If a signed audiogram is edited or deleted in Noah, the link to the Auditbase audiogram
will be broken.

8.2.3 Deleting audiograms

Deleting an Auditbase audiogram can be done from the Functions menu but only by a user
that has been granted the extended user right Delete Audiogram or linked Noah audiogram
by the System Administrator. By selecting the Delete audiogram button, a window opens and
the audiogram can be chosen from the list and Delete can be used to delete the audiogram.
Close will close the window without deleting an audiogram.

Another button on the Functions ribbon to Delete linked Noah audiogram will delete the
Noah action associated with the selected audiogram, but this is an extended user right that
must be granted by the System Administrator. This action will be refused if a Noah fitting is
based on Noah action.
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8.3 How to toggle between split, single, large or custom
audiogram formats

« In the audiogram screen, select View -> Split audiogram, Single audiogram, Large
audiogram or Custom audiogram as required.

File View Functions

E Masking levels Il Weber
SIS i T O
o I EIQ @ Masking cursor Speech banana %K World sounds Ei

Split Single | Large @ Custom | Selected zoom Trend graphs = Tymp scale Mean values
o E = - %E}(tended range  [ah Phoneme sounds - grap v pv

Views | 100% Graph Options Other
| Client T18765 MR JOHN SMITH 90% -[|R = |B|user SYSTEM ADMINISTRATOR Multiple locations... * Multiple departme
80%
7 NORMAL
125 250 B0% 000 2000 4000 8000 SRT DS DSN
10, i . N Sl

« Custom audiogram has a default zoom size that can be varied from the Zoom menu,
which is only available when Custom is the selected view. The percentage of zoom refers
to the audiogram only and is based on how large the audiogram would look on a
1024x768 screen resolution. It defaults to the zoom level set by your system
administrator. This view is intended particularly for working with a device interface.
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8.4 Other view options

In the View ribbon choose to display Masking levels, Masking cursor, extended range up to
140dB, Speech banana, phoneme sounds and world sounds. The content of the latter two can
be configured by your system administrator who also can set up if the Masking cursor should
be turned on by default.

9}) Auditbase - [AB Audiogram - 11/3/1988, no. 1 [READ ONLY]]

File View Functions
== El ) Masking levels [l Weber —
BB El 5 » S T 3¢ world sounds =]
— - & Masking cursor =] Speech banana [ A Z
BR Bxtended range [ Phoneme sounds [ Norm-cunve
Views Zoom Graph Options

Split | Single |[Large| Custom  Selected zoom Age/Gender percentile curves | Trend graphs | Tympscale | Meanvalues | Do not display unreliable

None Other

\% Booking 7 A
According to gender
-] Documens and atacaments 125 250 50 4000 8000 SRT DS  DSN
~FL Waiting list N Female
i AB Audiogram Male
i /iy, Attention list L S S 100
10 80
20 a0
Individual client
pye= - 30 70
- Clientinformation e
--{fff Paediatric
-$=] Journal 40 60
--{fF] Documents and altachments
55 Referral
=9 Clients entries 50 50
2 Device list RRN
Observations and procedures
=) Earmoulds 60 N 40
[ti] Medical history
.01 Hearing Therapist
&
-5, Direct referral HA (adult) 70 30

Audiogram static norm curves can also be shown from the View menu. Such curves are defined
in Auditbase Administration: a specific curve can be selected for a specific workstation. This
type of curve cannot be changed from Auditbase, it can only be modified from Auditbase
Administration.

Based on data from ISO 7029 users can now display age and gender specific dynamic hearing
loss distribution percentile curves. The percentile value used can be chosen in Auditbase
Administration on a site level. The curves can be enabled or disabled on a Workstation level in
Administration.

Special considerations:

« If the patient has no DoB (date of birth) or the age is out of range of the IS 7029 standard
there will be no percentile curves. Curves are generated for ages 18-80.

o If the patient gender is not set to 'Male' or 'Female', there can be no curve generated
since there is no ISO 7029 data.

« If the clinician wishes, they can override the automated gender-based curves and view
curves from the ISO standard for another gender for a particular patient’s audiograms.

« If the clinician wishes, they can turn off the curves during review of a particular patient’s
audiograms.
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8.5 How to view previous audiograms

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Measurements -> AB Audiogram.

o Select File -> Open.

« The audiograms are displayed with audiogram name, date, no., whether or not it is
signed, audiogram type and comments.

o The audiogram list is a configurable list where column position width and multiple
sort order can be saved for the logged-on user or for a site when saved by the
SYSADM user.

o The Audiogram list is resizeable by dragging any of the four borders to the
required size.

« Make the changes you wish to the table and right-click anywhere in the table.

« Select Save user view.

o Click on the audiogram to be viewed.

o Click Select. Alternatively, click on the required audiogram and it will be selected in the
background module. Double clicking an audiogram will select it and close the window
automatically.

Audiogram list X
Select Close
. | Audiogram Date |N|:|.| 5igned| Type |C.|:|mment5| F'r&view| Surge &
= Auditbase audiogram 100142020 1 Preview
E| AuditBaze audiogram MOHZ2019 1 =signed Aided Preview
= AuditBase audiogram 2110208 2 Preview
=] AuditBasze audiogram 2110520158 1 Preview
= AuditBase audiogram 2900802015 1 Preview
E| Audiogram changed in AB 25/09/2015 & signed Preview
= Mew Audiogram 250082015 7 Preview
E| OTOsuite Audiometry - Audiogram 25/08/2015 & Preview
= Mew Audiogram 2500802015 5 Preview
=] Mew Audiogram 2500802015 4 Preview
= Mew Audiogram 2500802015 3 Preview
=] AC440 measurement 2510802018 2 Preview
= Audiogram 2500802015 1 Preview
=] Mew Audiogram 2410802015 2 Preview
= AuditBase audiogram 2410802015 1 Preview
=] Audiogram not linked to NOAH 22082015 1 Preview
= AuditBase audiogram 18/06/2015 9 Preview
=] Audiogram not linked to NOAH 18/06/2015 8 Preview v
< >
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« The Audiogram list can be left open when changing clients and the list of audiograms for
the newly selected client will be displayed. The Audiogram list will remain in the same
position when clients are changed including after Auditbase is restarted.

To open the latest audiogram:

« Select File -> Open latest or click the button Client’s latest audiogram in the tool bar
from anywhere in Auditbase B,

Bing
4o 125 2@ 500 1000 2000 4000 8000  SRT DS DSN
0 100 | HEllY
10 50
0 a0 Rinne
20 O 70
0 & FATWATN en | WWeber
50 O a“. A =
80 m&& 40
70 20
80 20
50 10
100 0
110
120
120
140

« The audiogram title bar includes client identifier code, client name, date, number and
audiogram type.
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8.6 Viewing more than one audiogram at a time in the same
graph

To view up to 4 audiograms superimposed on top of each other.

o From the audiogram screen, select File -> Open.

o Select the first audiogram to be viewed and click OK.

o Select the Compare tab.

» Select up to 3 audiograms from the drop-down lists which display the audiogram date,
number and type.

« Click on each colour box and choose the colour required by clicking on it.

« Click Refresh to display the selected audiograms.

« To close the screen and return to the original audiogram, click Clear all.

Add in

Audiogram Colour
1010112020, 1 - [ ]
1103/2019, 1, Aided v -
- I

Refresh Clear all

View side by side

To view up to 4 audiograms side by side:

« With the Compare tab active, click View side by side.

« Select an audiogram in the drop-down list for each of the 4 audiograms. The last 4 of the
client’'s audiograms are pre-selected by default.

o Click Preview or Print as required.

4 audiograms view *
Client T18785 MR JOHN SMITH Preview Erint Close
SYSTEMADMINISTRATOR YULIAMAKUKHA
10/01/2020, 1 - “I‘IJUEJ‘ZU‘IQ. 1, Aided -
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8.7 Adding notes and comments to an audiogram

To add comments to an audiogram:

» Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Measurements -> AB Audiogram.

« Select File -> Open or add an audiogram.

« On Information tab, select Edit or Alt+R.

« A Comments window opens. Comments can be added to the audiogram and they will be
displayed when printed.

« OK to save the comments.

To add a note to an audiogram:

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Select Measurements -> AB Audiogram.

« Select File -> Open or add an audiogram.

« Right click on the threshold you wish to add a note to.

« One of the options is Set note.

« Select from the drop-down list which note is to be added. These notes are defined by

your System Administrator.
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8.8 Tympanometric tab

Discrete tympanograms and reflex thresholds can be entered for the Tympanometric
measurement or data can be transferred directly from: the Zodiac 901 connected to a COM port
or from Noah sessions created by any module using the Noah Tymp 100, 500 or 501 data
format, e.g. Otoflex module, Otowave, Titan, GSI Suite, Capella module or the Zodilink module.
Data from any module that stores tympanometry in the standard Noah 100 or 500 format can
be measured or imported see below.

One of the 3 tymp curves imported from Noah sessions or direct from Zodiac can be set as
default for printing and Audiological Summary Reports. If none is set, the system will default to
the highest number of curve sets available.

Since no Noah standard exists for Tympanometric data no other Noah modules can be used
unless the manufacturers work with Auditdata to define a standard protocol.

Import of data can only be done when not in an audiogram measurement mode.

« Use Measure button to open the Tymp module configured in Administration which will
automatically import into Auditbase on saving.

« Use the button Import tymp to import data from the instrument or a Noah session. Up to
three tymp curve sets can be represented. Choose between curves in the drop-down box
Selected curve.

+ The date of the measurement can be changed manually when importing from a Noah
session.

« If reflex thresholds have been measured, these thresholds will be drawn as thresholds in
the pure tone audiogram.

« The scale factor for the tymp curves is read from the default setting in Administration
settings -> Workstation -> Audiogram. To overrule this default setting, select View ->
Tymp scale. The scaling is reset to default when selecting a new audiogram or a new
client.

« You can print the pure tone audiogram and tymp information in one report. Select File ->
Print and choose Audiological Datasheet. Either split or binaural audiograms can be
printed.

« Imported tymp data can be reset in Functions -> Reset tymp data.

Note: It is not possible to create reflex thresholds with the Capella module.

When importing data directly from the Zodiac instrument the Zodiac should be connected to
the PC via a COM port.

The following parameters will be imported along with the tympanograms if they are available:

o ECV = Ear Canal Volume: volume unit
o SC = Static Compliance (mmho)
« MEP = Middle Ear Pressure (daPa)
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Gradient: (daPa)

Tymp Width = Tympanometric Width: daPa
Frequency (Hz)

Type =A, Ad, As, B, C, D, (E)

Detailed information on the interpretation of impedance data in Auditbase.
Reflex thresholds imported to Auditbase.

The reflex thresholds that are imported directly from the Zodiac or from a Noah session created
by Otoflex, Capella or Zodilink are all interpreted using the following algorithm:

Example: Zodiac, 500 Hz stimulus, Ipsilateral:

Intensity dB HL 70 75 80 85 90

Actual deflection mmho or ml/cc/ecm3 | -0.01 0.45 -0.01 -0.03 -0.08

Reflex result bit False True False True True

Example: ODS/Otoflex, 500 Hz stimulus, Ipsilateral:

Intensity dB HL 70 75 80 85 90

Actual deflection mmho or ml/cc/cm3 | -0.01 0.45 -0.01 -0.03 -0.08

Reflex result bit False False False True False

The way to identify the threshold value is:

If there is one and only one curve with both test Type = 'reflex' (i.e. manually measured) and
the result bit set, this is taken as a manual indication of the threshold and is thus considered
the final result. The procedure then ends here.

Otherwise:

Search all curves of test Type = 'reflex' or 'autoThresholdSearch' (can be mixed) from the
highest stimulus intensity presented and downwards for the lowest intensity curve with an
absolute positive or negative deflection value > = 0.02 or the result bit set, i.e. the last in the
search direction that is not preceded by another curve fulfilling this criterion.

Now change search direction to increasing intensities and search for the first curve that has the
result bit set. If a curve is found with the bit set, this curve (stimulus intensity) represents the
threshold. If no curve is found with the bit set, the result must be indicated as 'no threshold
found at xxx dB HL' where xxx is the highest stimulus intensity that was presented, i.e. the
highest intensity recorded in the curves.
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This procedure will identify 85 dB HL as the threshold in both examples above. Note that 75
dB would not be considered a threshold in the Zodiac example even if the result bits for 85
and 90 dB were not set as the downward search would still stop at 85 dB.

Imported tympanograms

The tympanograms that are imported directly from the Zodiac or from a Noah session created
by Otoflex, Capella or Zodilink are all interpreted in the following way:

The tymp curve is displayed using the unit from Noah. However, if a volume unit is indicated in
Noah and the probe tone used is not 226 Hz, the tymp curve (every point of the curve) is
recalculated as:

Actual tymp = Noah_tymp * probetone / 226
and the actual unit is mmho.

Tymp baseline compensation:

Where a Noah Tymp module requires it, curve compensation can be applied even when it is
declared as already applied in the measurement.

The tymp curves are displayed baseline compensated when possible.
The curve may have been stored baseline compensated in Noah (recordMode=Compensated').

If the curve was stored 'non Compensated', the ear canal volume * probetone / 226 is
subtracted from the curve (every point of the curve) values to calculate the baseline
compensated curve. If the ear canal volume is undefined, the curve is displayed as non-
compensated.

Tymp ID can be edited manually when a tympanogram is imported from Noah or measured in
Auditbase, to make it possible to record the Tympanometer details when using different
tympanometers in the same room.

If several tymps are present and must be displayed together, all of them will be displayed as
non-compensated if one or more of them cannot be displayed compensated (if stored non-
compensated and the ear canal volume is undefined). Measurements at different frequencies
are grouped according to frequency on the same ear.

The parameters belonging to the tympanograms are determined in the following way.
Derived parameters:

The height of the peak from the baseline is denoted either Static Compliance (SC) or Static
Admittance (SA). The term SA is used for all cases except for 226 Hz tympanograms with a
volume unit (ml, cc, cm3). SA (= SC) = maxCompl - canalVolume * probetone / 226

TPP = Tympanometric Peak Pressure

TW = Tympanometric Width: daPa
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Gradient: mmho/daPa or volume_unit/daPa
ECV = Ear Canal Volume
Type =A, Ad, As, B, C, D, (E)
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8.9 Tabbed pages for other types of measurements

In addition to pure tone measurements, you can register, store and print a variety of other data.
The following data may be processed:

« For speech measurement results, select the Speech or Speech in noise tab.

o Fortympanometry results, select the Tymp tab.

« For speech measurement results in extended graphical form, select the Graphical
speech tab.

o For Bing, Rinne, Jelly and Weber measurement results, select the Others tab.

o For vestibular measurement results, select the Vestibular tab.

@ |nformation | @ Beferral | Speech | Speechinnoize | Tump | Compare | Graphical Speech | Others | Yestibular | Surgen

Once a tab has been selected, changing the audiogram or client will not change the selected
tab. When Auditbase is re-started, the default tab is selected. If information has been stored on
any of the tabs, a green circle will indicate this.

NOTE: the number of tabs to appear in the Audiogram module can be configured by the
System Administrator. Any tab (except 'Information’) can be set to be hidden from view.
Information tab

The Information tab is for storing general data for each measurement; for instance, notes,
comments, audiometer number.

Notes can be added to a particular threshold by selecting the threshold, right-clicking and
choosing Set note. These notes are defined by the system administrator and will appear on the
audiogram when it is printed.

Comments can be added to an audiogram by selecting the Edit button and inserting free text
notes. These are displayed on the audiogram when it is printed out.

Mean values, calculated for Air and Bone conduction as the average of frequencies defined by
the system administrator, for instance 500, 1000 and 2000 Hz thresholds.

Referral tab

The Referral tab is for storing data about a referral, referring agent, and observations or
procedures. The appointment which the Audiogram is related to is shown here and can be
changed by using the Attach and Detach buttons. The referral in which the appointment takes
part is also shown.

Speech tab
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The Speech tab is for storing numerical speech audiograms, including, SRT, UCL, recognition
percentages and masking levels. The following results can be entered:

o Type of measurement. Select from the drop-down list between Normal, Aided, Tube,
Noise or Insert phone.

o SRT (Speech Recognition Threshold).

« Mask. (Masking level). For masked speech recognition measurement.

o UCL (Uncomfortable level).

« Max recognition 1, 2, and 3: For each type of measurement, Recognition %, dB level and
masking level can be entered.

You can choose to display the speech measurement results graphically as an extension of the
pure tone audiogram. The system administrator configures this extension and its content.

The values displayed in the speech extension are the following:

e TC (Mean value of pure tone measurement)

o SRT (Speech Recognition Threshold)

o DS (Discrimination Score) or DL (Discrimination Loss). Max recognition 1 is shown as DS
or DL.

o DSN or DLN (Discrimination Score in Noise or Discrimination Loss in Noise). Max
recognition 2 is shown as DSN or DLN.

« DS, DL, DSN and DLN are treated as masked when a corresponding masking level is
specified. The following symbols are used to show values in the speech extension graph:

e For TC: air normal unmasked

o For DS and DL: air normal unmasked or masked

o For DSN and DLN: sound field normal unmasked or masked

o For DS, DSN, DL and DLN: free-field aided masked and unmasked.

Note: Masking is not used for SRT

For both pure tone measurement and speech extension the results of speech measurement
can be obtained using the Aurical module.

The data entered in the Speech tab is part of the audiogram and can be saved with the entire
audiogram.

Speech in noise

Under Speech in noise you can register measurements of speech tests in noise with headsets.

Base calculation of Expected result and High frequency mean 10/01/2020, 1 -
Right Left

Result, % Level, dB Masking, dB Expected, % Result, % Level, dB Masking, dB Expected, %

Test1 = v 23 50 Test 1 = |12

Test2 = |- Test2 = |-

PTA4 High frequency mean value PTA4 High frequency mean value
Comment Comment
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First choose which audiogram to base the expected result and the high frequency mean value
on. Choose the current audiogram or a previous one.

The values from the selected audiogram will be stored under PTA4 and High frequency mean
value.

You can make two tests, where you register the result in percentage, the level in dB and the
masking in dB. If you perform the test with an audiometer with control panel for Auditbase, the
result fields will be populated automatically. Your System Administrator can set the system up
to do this.

Use the drop-down list to qualify the result by either choosing the equal to sign (certain of the
test’s accurateness), the less than sign (the result is probably not accurate) or the more than
sign (the result is probably not accurate).

The Expected result is calculated based on the test results and the PTA4 and High frequency
mean value numbers.

Compare

The Compare tab is for viewing previous audiograms simultaneously, either together on the
main screen or side-by-side on the screen that opens when pressing ‘View side-by-side’.

Graphical Speech tab

Extended results of speech measurements can be registered in the form of a graphical speech
audiogram in the Graphical Speech tab.

« As for pure tone audiograms, a symbol must be selected.

« The symbols for the following speech measurement types are defined by the system
administrator, by default different symbols are set up according to country. The default
can be selected and then the default mappings will be used when the word list is blank
from the Noah module or when there is no mapping for the specific word list being used.

o

single phoneme
double phoneme
triple phoneme
three-digit words

o

[e]

o

« Additionally, different symbols can be defined for the following measurement conditions:

o normal
o aided

o free-field
o binaural

« Different symbols can also be defined for masked and unmasked measurements.
o The condition is selected in the drop-down list above the symbols list.
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o The symbols can be placed into the required position (determined by dB level and
recognition percentage) on the left or right ear graph by clicking.

« Show norm-curves will, if ticked, overlay the graphs with norm-curves. Up to 3 norm-
curves can be shown on each graph. The norm-curves are defined and selected in the
System Administration tool.

« Comments can be added to a Speech Audiogram. Selecting the right button below the
Symbol table will open a window where comments can be added. OK will save the
comment; Cancel will close the window without saving the comments. Once the
comment has been saved, hovering the mouse over the Comments button will show a
tool tip with the comment displayed.

« To see more details and edit it more precise, you can get an enlarged speech audiogram
by clicking the left button below the symbol table.

o The graphs on the Graphical speech tab will be updated when you Close the window.

« As for pure tone measurement, the results of the speech measurements can be obtained
using the Aurical module. The Max. discrim. 1 and Max. discrim. 2 measurement types in
Aurical are treated as single-phoneme and double-phoneme by Auditbase. To register
results of other measurements, the symbol must be defined in Auditbase first.

« Data entered in the Graphical Speech tab is part of an audiogram and saved with the
entire audiogram.

« To print a graphical speech audiogram, select the File -> Print audiogram menu item
and select one of the options for printing the graphical speech data in the Print
audiogram window.

o If using the Primus audiometer and your System Administrator has carried out the
necessary setup in administration, the graphical speech test curves will appear in AB
audiogram on the Graphical speech tab. If Graphical speech is not licensed then the
results will still show but only on the Speech tab as summary totals.

« Using the button on the ribbon users can override the Site and Workstation options for
import Graphical Speech from Otosuite Module full screen into either Graphical Speech
tab or numerical Speech tab.

NOTE: Auditbase Audiogram module does not handle binaural speech thresholds coming from
Noah.

Others tab

Results of Bing, Jelly, Rinne and Weber measurements can be registered in the Others tab.

All Bing, Jelly, Rinne results are entered as blank, +, -, F+, F-for both right and left ear.

« + Positive
o - Negative
o F+ False Positive
« F- False Negative

To change the value, click in the corresponding field to see the next possible value.
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The Weber result is entered in the same way. The possible values are:
Not measured (blank), R (Right), L (Left), C (Centred), Uncertain, Not reached.

The values are represented by the Weber audiogram symbols defined by the system
administrator.

Data entered in the Others tab is part of an audiogram and saved with the entire audiogram.
The Bing, Jelly, Rinne and Weber results are printed on the 4 Audiograms printout.

Vestibular tab
Results of vestibular measurements can be registered in the Vestibular tab.
The following data can be entered:

« The name of the audiologist performing the measurements: Select the from drop-down
list of registered Auditbase users.

o Were goggles used: Select Yes or No.

« Spontaneous nystagmus and Positional nystagmus characteristics: Enter text up to
250 characters.

o For both left and right eye, reaction time in seconds for either 30 degrees or 44 degrees:
Enter values from O through 240 manually or use the slider.

« Comments: Enter text up to 250 characters.

« Data entered in the Vestibular tab is part of an audiogram and saved with the entire
audiogram.

« The results of vestibular measurements can be printed by selecting the menu item File ->
Print audiogram. Select the Vestibular measurements option in the Print audiogram
window.
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8.10 Printing an audiogram

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Select Measurements -> AB Audiogram.
o Select File -> Open.

o Select the required audiogram and highlight it.

« Select File -> Print Audiogram.

+ Choose the required formats by checkmark and the amount of copies and click Print.
o Or, click Preview to preview printout on the screen before sending to printer.

Print

Preview Print Close

s

Printer
Microsoft Print to PDF

Print type
| | |1_|§ Large audiogram printout
L] |‘I—|§ Split audiogram printout
|‘I—|§ Small audiogram printout

1 & Split small audiogram printout

-

1 B Audiological summary printout

-

1 & Audiological data sheet printout

-

1 & Audiological split data sheet printout

-

1 & Vestibular measurements

-

1 & Speech audiogram with large pure-tone printout

1 IZ: Speech audiogram with split pure-tone printout
1 & Speechin noise printout

-

| | 1 IZ: Large speech audiogram with split pure-tone printout

1=

-

Place client and user identification on clipboard

If the box labelled Place client and user identification in clipboard is checked then when
printing to a PDF printer, the Audiogram date, username and client Primary code are saved to
the clipboard. If the report is to be saved electronically using a PDF printer, rather than printing
to paper, the clipboard can be pasted into the ‘Save’ dialog generated by the PDF printer to

provide a descriptive filename when saving.

This check is maintained for the user for subsequent logins until unchecked.
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8.11 How to enter into Noah

Noah can be entered from Navigation -> Measurements menu or from the Client Pathway
Overview.

B2 Measurements

=] AB Audiogram

ABR and OAE screening and diagnostic
{2 NOAH module selection

""" =l O e Chrlx M
| NOH Shift Crrke M

{2 Open latest fitting action
EEI--@ MOAH measurement modules

When the client is specified, go to the Auditbase Measurements menu and do either one of
the following:

o Click Noah module selection to open Noah with the Modules panel expanded.

o Click Noah session browser to open Noah with the Sessions and actions panel of
expanded to view a list of the client's previous Noah sessions.

« Click Open latest fitting action to open the most recent fitting action if the fitting
module is installed.

o Click the links at the bottom of the menu representing any installed measurement
module to open that module.

« On slower PCs Auditbase may be logged in before Noah is fully running and usable. In
this case you will receive an information message and should wait a few more seconds.
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8.12 Using Noah

In Noah, there are three sections: Client details, Modules and Sessions and actions.

'; NoahdAudithase - Business System
File Setup Help

@ ;Name: LASTNAME120, FIRSTMAME120 (MRS) Birth date: 19-Aug-1929 Gender: Female NHS no.: Hospital no: TT1120 e B
All | Measurement | Fitting | Other
g Audiogram . OTOsuite ||{&» Titan & 2 Journal & Questionnaire —
Module () Prl mus . ‘e otometrics "’bylntelacoustis / Module —ﬁ Module m @

On the "All" tab right click on the bar to configure modules order

-

[ Sert in Ascending order

@ SAMPLE

4 11/12/2020
= Auditbase audiogram | ANDSHU | 15:21 K Delete Action

= Nyt audiogram | ANDSHU | 11:59 K Delete Action @ Fast Data view

4 01/12/2020
Ef su bj1 | ANDSHU | 12:01 K Delete Action @ Fast Data view

4 30/08/2013
= AuditBase audiogram | TESTS | 16:56 ¥ Delete Action

A 10/03/2013 (R) - 0o_10032013_1825.APX | TESTS | 16:14 K Delete Action

A 10/03/2013 (L) - 0e_10032013_1825.APX | TESTS | 16:14 ¥ Delete Action

I 23/08/2002
' 01/12/2001

The basic client identifying information is shown at the top of the Noah4Auditbase window. To

view additional client information within the Noah4Auditbase subsystem, click the button (®)
beside the title of the Client details panel. This will show the client's address and create date
and user.

Note: By default, client details for sites in UK are displayed to follow NHS CUI
requirements which assume applying a number of rules and formatting options; client
details for sites outside UK are displayed by default without meeting NHS requirements.
This setting is configurable with the System Administration tool for any country.

In the Modules panel of Noah4Auditbase the following commands are available:

« Click the corresponding module in the module list to start a new fitting or measurement
session.

o To customize your Module order right-click the module list and choose Arrange Module
Order to open the Module Bar Configuration dialogue box. This order is saved per user
into the database so will be available from any workstation.

« On the corresponding tab, view the Noah modules of the following types if available:

o All modules
o Measurement modules
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o Fitting modules

o Other modules

« Any Noah module opens in a separate window and is represented by a button in the

Windows taskbar.

o If you want to open a Noah module when another one is running, you must return to the
Noah4Auditbase window and click the corresponding item on the Modules panel.

o All Noah modules opened under Windows 7 are grouped under a single taskbar button.
Click this taskbar button to open a menu listing all the Noah modules running.

File Help

[ se
41

Yo otometrics
Right-click to configure module arder

= AuditBase audiogram | TESTS | 12:56

® Name: LASTNAME46153, FIRSTNAME46153 (MST) Birth date: 30-Nov-2010 Gender:. Male NHS no.: Hospital no.: T146-153 & =
All | Measurement | Fitting | Other
OTOsuite
%o otomgtrics
On thl OTOsuite

Delete Action
K Delete Action
Delete Action

K Delete Action

Current user: System User

Select the Sort in Ascending order checkbox above the session list to switch to the ascending
ordering of sessions. BSA shadow masking symbols are not included in the Noah standard:
therefore, they will not be transferred to Auditbase on saving the audiogram in Noah.

e ———

[] sort in Acsending order

4 12/12/2013

=, AuditBase audiogram | SYSADM | 15:52
= Audiogram changed in AB | SESADM | 15:51
= AuditBase audiogram signed | TESTS | 13:52
=, Audiogram changed in AB | TESTS | 13:47

= AuditBase audiogram | TESTS | 12:56

--------------------------------

K Delete Action
K Delete Action
K Delete Action

K Delete Action
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Be aware: BSA shadow masking symbols are now included in the Noah standard 502:
therefore, they will only be transferred to and from Auditbase on saving the audiogram in
Noah if the module supports this.

For the Serial number issue from Noah dialog see Section 12.4.

On the Sessions and actions panel of Noah4Auditbase you can view a list of clients' previous
Noah sessions. The following commands are available on the Sessions and actions panel:

« Click on the arrow or plus icon (depending on Windows version) to the left of the session
date to view the actions. Referenced actions such as the audiogram a fitting is based on
are nested underneath.

« Click any action to open it with the corresponding module if installed.

« Click the Delete Action button to the right of the action description to delete it.

« Noah alerts can be opened from the Noah Session Browser.

o The audiogram that a fitting session is based on can be opened from that fitting session
in the Session Browser.

8.12.1 Deleting Noah actions

If you do not have the correct extended right issued, you will see an error message like the
following:

. You have not been granted the extended right 'NOAH: Delete actions’
‘_IA by your system administrator. Cannot delete Noah actions

In this case, contact your System Administrator to grant extended rights for deleting Noah
actions.

If an attempt is made to delete an audiogram that has a later fitting based on it, a message will
appear denying deletion of the action.

P4, Cannot delete the action.
il This action is referenced by some other action(s). Cannot delete.
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Note: If you don’t have will need both an extended user right and a specific table right rights to
delete Noah actions. When the extended right is assigned the table rights are automatically
set, but table ‘delete’ rights could erroneously be removed later. If you do not have the correct
table right issued, an error occurs within Noah which cannot be caught by Auditbase and
processed correctly.

Therefore, you will see an error message from Noah like the following:

I.-"-_-'\-. Cannot delete the action.
‘S Security violation attempting to access

In this case, contact your System Administrator to reassign the extended right grant table rights
for deleting Noah actions which will correct this.

8.12.2 Fast Data View

If the Noah module supports it, a summary of the Noah action can be shown in a pop-up image

@ Fast Data vi
or PDF by clicking on the |ﬂ| icon. The icon will only appear if the module supports

Fast Data View. A local copy of this image or document will be created and you must close the
preview of the image or document for Auditbase to delete it. If you do not close the image or
document, it will remain open when changing patient and could lead to confusion.

[] Sort in Ascending order

4 16/05/2017
E{ test for today | SYSADM | 10:39 K Delete Action |fl‘> Fast Data view

4 07/11/2009
=y New Audiogram | SYSADM | 17:21 ¥ Delete Action

QWARNING: Do not forget to close the Fast Data View document manually since
Auditbase cannot close it automatically.

Be careful with patient content, Auditbase cannot warn users that a Fast Data View
document is still opened for a client when users select a second client.
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8.12.3 Noah alerts Dashboard

On the right-hand side of the Noah toolbar the globe icon B opens the Noah Alerts
Dashboard. Noah alerts could be created when a hearing instrument wearer activates one
using the mobile App supplied to them by their hearing instrument manufacturer and when
the Noah Mobile APl is enabled in your Auditbase by your System Administrator.

?;3 Noah4Auditbase - Business System
File Setup Help

@ ¢ Mame: LASTNAME120, FIRSTNAME120 (MRS) Birth date: 19-Aug-1929 NHS no.: Hospital no: TT1120 - |

@Iﬂ—

Gender: Female

When the Globe has a red element I@'that indicates that there are one or more unread Alerts in the
Dashboard. When every Alert has been viewed by any user then the red element is removed from the
icon.

Opening the Noah Alerts Dashboard reveals the list of Alerts for all patients who the Auditbase
user has permission to view. They will not see any Alerts linked to patients who they are not
allowed to access, either due to the patient belonging to a Location that the user has no rights
to access or due to the patient having only limited named users allowed to access them.

« Unread Alerts are shown in bold. Alerts with the Priority flag set have a red flag next to
them.

« When an Alert is selected the detail appears in the right-hand panel showing the
description from the patient. A specific Noah user can be assigned using the Assign

button.
) Noah4Auditbase - Business System — O =
Alert Dashboard
Sort by; Most recent | From:| All alerts > | Alert Details] |_'Sessw:3n Llst]
|’ l;l] Patient @ FIRSTNAME20194 LASTNAMEZ20194
FIRSTNAME20087 LASTNAME20087  Hearing Performance 03/12/2020 |»
FIRSTNAME20620 LASTNAME20620  Hearing Performance 03/12/2020 |* Noah User :  Unassigned
FIRSTNAME20057 LASTNAME20057  Hearing Performance 03/12/2020 |* Priority * |>
FIRSTNAME20271 LASTNAME20271 Hearing Performance 03/12/2020 [* .
Category : Hearing Performance
FIRSTNAME20623 LASTNAME20623 Hearing Performance 03/12/2020 [*
FIRSTNAME20332 LASTNAME20332  Hearing Performance 03/12/2020 | Received :  03/12/2020 14:13:46
FIRSTNAME20604 LASTNAME20604  Hearing Performance 03/12/2020 |» o
FIRSTNAME20363 LASTNAME20363  Hearing Performance 03/12/2020 |* Description :
FIRSTNAME20336 LASTNAME20336  Hearing Performance 03/12/2020 [*
FIRSTNAME19865 LASTNAME19865  Hearing Performance 03/12/2020 |»
FIRSTNAME20293 LASTMAME20293 Hearing Performance 03/12/2020 [*
FIRSTNAME19936 LASTNAME19936 Hearing Performance 03/12/2020 |’
FIRSTNAME19979 LASTNAME19979 Hearing Performance 03/12/2020 >
FIRSTNAME19975 LASTNAME19975 Hearing Performance 03/12/2020 |’
FIRSTNAME19859 LASTNAME19859  Hearing Performance 03/12/2020 |» €7 Jouna
FIRSTNAME20647 LASTNAME20647  Hearing Performance 03/12/2020 |» Module
FIRSTNAME20313 LASTMAMEZ20313 Hearing Performance 03/12/2020 [*
FIRSTNAME19838 LASTNAME19838 Hearing Performance 03/12/2020 > [~]
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Patient :

Nosh User i JULIE TYAS
Priority * |>

Category : Hearing Performance

Received :  30/11/2020 13:55:15

Description :

Problems hearing the TV.

FIRSTNAME120 LASTNAME120

Remove Alert|

Session List

11/12/2020 :
= ANDSHU Auditbase audiogram
= ANDSHU Nyt audiogram

01/12/2020:
@[Ef ANDSHU Subj1
30/08/2013 :
= TESTS:HIMSA - Noah 4 Audiogram Module
A TESTS:Amplivox Ltd
A TESTS:Amplivox Ltd
23/08/2002 :
= HILLHIMSA - Noah 4 Audiogram Module
01/12/2001 :

= LCAVILLA:HIMSA - Noah 4 Audiogram Moedule

Above the Alerts list the ‘From’ dropdown allows the user to filter on only the Alerts assigned to
them as well as to filter on unassigned Alerts.

!‘Q MeoahdAuditbase - Business System

Alert Dashboard

Sort by: Most recent ¥ | From:| All alerts ~

FIRSTNAME20450 LASTNAME:All alerts |Performance 03/12/2020 [» [-]
FIRSTNAME20284 LASTNAM]| My alerts Performance 03/12/2020 [*
FIRSTNAME20286 LASTNAMI nassigned alerts [ oo o nance 03/12/2020
FIRSTMAMEZ20200 LASTNAME20200 Hearing Performance 03/12/2020 |
FIRSTNAME20134 LASTNAME20134  Hearing Performance 03/12/2020 [»
FIRSTNAME20379 LASTNAME20379  Hearing Performance 03/12/2020 [
FIRSTNAME20677 LASTNAME20677  Hearing Performance 03/12/2020 |
FIRSTNAME19915 LASTNAME19915  Hearing Performance 03/12/2020 |»
FIRSTNAME20518 LASTNAME20518  Hearing Performance 03/12/2020 |»
FIRSTNAME20657 LASTNAME20657  Hearing Performance 03/12/2020 |»
FIRSTNAME19907 LASTNAME19907  Hearing Performance 03/12/2020 |»
FIRSTNAME20402 LASTNAME20402  Hearing Performance 03/12/2020 |»
FIRSTNAME20436 LASTNAME20436  Hearing Performance 03/12/2020 |»
FIRSTNAME20499 LASTNAME20499  Hearing Performance 03/12/2020 |
FIRSTNAME20247 LASTNAME20247  Hearing Performance 03/12/2020 [»
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If the window is maximized then visible to the far right is the patient’s Session List to help put
the Alert in context.

Sort by| Most recent * | From: All alerts
Session List
11/12/2020:
Noah User : JULIETYAS Assign| = ANDSHU Auditbase audiogra
= ANDSHU Nyt audi
Priority |> - sudo
01/12/2020:
Category : Hearing Performance @ ANDSHU Subj1

03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
ce  03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
03/12/2020
e 03/12/2020
30/11/2020
sistance 27/11/2020

= Patient ¢ FIRSTNAMET20 LASTNAME120

Received ©  30/11/2020 135515 30/08/2013 :
= TESTSHIMSA - Noah 4 Audiogram Module
A TESTS:Amplivox Ltd
A TESTS:Amplivox Ltd
23/08/2002 :
= HILLHIMSA - Noah 4 Audiogram Module
01/12/2001:
= LCAVILLAHIMSA - Noah 4 Audiogram Module

Description :

Problems hearing the TV.

7
FIRSTNAME20274 LASTNAME20274

751 75

FIRSTNAME20593  LASTNAME20593
[v.

FIRSTNAME120  LASTNAME120

A AAAAAREEEEEEEEEEEEEEEEEEEEEEE R RSl

[T

Remove Alert

Underneath the description is an ‘eye’ button which could open a webpage associated with
the manufacturer's module. The Journal module icon would open the Noah Journal module if
installed.

& . Journal
@ ::‘/ Module

Beneath that at the bottom is the ‘Remove Alert’ button. Be sure to remove Alerts that have
been acted on to avoid the Alert dashboard becoming slow to load over time as the number of
Alerts increases.

& & Journal
@ :’/ Module

Remove Alert
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8.13 Changing clients with Noah running

When taking a busy fitting clinic, you can close open Noah modules but leave Noah active and
change client in Auditbase.

« Todo this, without closing Noah, select the Auditbase icon from the taskbar at the base
of the desktop. The global Client can now be changed.

o To return to Noah simply use the Noah module selection or Noah session browser
shortcuts from the Measurements menu in Auditbase and that part of Noah will become
the focus. On slower PCs, a Noah splash screen will be shown while Noah changes the
client.

&-f7 Measurements

=] AB Audiogram

ABR and OAE screening and diagnostics
{4 NOAH module selection

----- [=] Other speech test

{2 NOAH session browser

£ Open latest fitting action

@-&2 NOAH measurement modules

o If there is any module currently left open you will be told that a session is already open
and you should select the Noah Module icon on the taskbar to close it. If you were in the
process of deleting a Noah action you will also be informed that a session is open.

AB Audiogram - 10/01/2020, no. 1 x

You are not allowed to change client while you have an open NOAH session.

! ..\'

+ While Noah is minimized the icon is hidden in the Systray (the area in the bottom right
corner where the clock is).

o Theicon in the Systray is not really needed as the Auditbase Measurements menu
should be all you need.

« If you do want to use the icon in the Systray, reveal it by clicking the small up arrow to
show all icons. You can configure Windows to always show the Noah icon by clicking the
up arrow choosing 'Customize'.
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O Client pathway overview

To open the Client pathway overview, select from the Auditbase Navigation area — Client
pathway overview.

Planned and completed actions in a referral pathway can be seen, whether you're using
referrals and appointments or not. The initial view that is displayed can be set by default.

There is an easy to use but highly flexible configuration for site and user favourite views. You
can create new actions and easily see an overview or the detail of most standard actionsin a
journey.

Client pathway view
[ Full pathway - # g =) E

- 22/08/2019 ++TINMITUS

- 22/06/2015 ++DIRECT REFERRAL /Audio assessment
- 18/06/2015 ++AUDIO REVIEW reassessment

- 1000442015 ++AUDIO REVIEW reassessment

- 24/032015 ++AUDIO REVIEW reassessment

- 12M10/2001 ++DIRECT REFERRAL /Audio assessment
=] <No referral=

Navigation around the pathway view can be performed by using the keyboard arrow and tab
keys as well as using the mouse.

Each of the stages has two dates adjacent to the title. Stages that have already been
completed will show the stage start date and the stage end date respectively. The following
stage will show the date of the completion of the previous stage as the start date.

Referral breach warnings will be displayed as part of each stage.

=15 26/06/2007 ++AUDIO REVIEW reassessment
11{@] Assessment (26/06/2007-06/08/2007; Has been breached, status not ‘cor
#{®] Treatment (06/08/2007-25/09/2007; Has been breached. No appt)
#{®] Follow up (25/09/2007-08/06/2008)
#[@] Complsted (09/06/2008-Current}

Expanding one of the stages will display all the tests and/or forms that have been completed
for this stage.
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You will also see a list of the Planned clinical actions, which are the tests and/or forms that are
appropriate for this stage as set by the System Administrator. Any completed appointments are

also shown with any associated clinical actions.

Client pathway view
[E Full pathway - # e ==

EI- 15/06/2018 ++FITTING - from previous referral
[®] <No stage defined=
El- 15/06/2018 +AUDIO REVIEW reassessment
EID Assessment (15/06/2018-15/06/2018)
i fa] 15/06/2018 £ GWH 2nd fit~~, Res109
Y 15/06/2018
=Planned clinical actions=
E| Treatment (15/06/2018-14/09/2018)
E| Follow up (14/09/2018-15/06/2018)
E| Completed (15/06/2018-Current)
=[] =No referral=

Right clicking on any action or appointment will show a series of options.

+ Refresh - Will refresh the entire pathway.
« Expand selected level - Will open the items in the levels below the selected one.

« View - Any of the pathway views can be selected by selecting View and then the relevant

pathway.

Client pathway view
T My view - a g 5| |

B8] Assessment (15/06/2018-15/06/2018)
¢ EHfr] 15/06/2018 B GWH 2nd fit~~, Res109

Refresh

t, 11-03-19_test_template
Expand selected level t testing docdf
View > Implant data stages

—— TIORGOS T
H —

. -g7 1510612018, Docum
E| =Planned clinical actions=
“-[1i] + BKB test w
=i{F] Treatment (15/06/2018-14/0¢

=-E5] <Planned clinical actions= ) Without stages
: +MNOAH action Ii:lj] Without stages and appts/dates

=|  Full pathway
1} Action types only

~
L
T

1 Actions only
My view

[ I TR e
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9.1 Changing the size of the viewing pane

Selecting an action or appointment will display the relevant information on the right hand-side
of the screen.

o)) Auditbase - [Referral] — [m] X

File View Functions

A& B 8 B A 4

Detsiled = Quick  Save | Printlist |mportdata Exportdata | ExporttoNoah Logoff | Exit Auditbase

Search Refertal Import/Export Client data Exit
r Client T146738 MRS FIRSTNAME46738 LASTNAME46738 - 8 & Bl User USER NAME35 All locations ~ All departments - a ?
Navigation Referral ov Client's referral | Referral answer | Clinical aclions
- Favourites
Referrals 108858, 05/01/2011, ++DIRECT REFERRAL / Audio assess Client name MRS FIRSTNAME4G738 LASTNAME46738 Refresh Cancel
Client pa‘thway view Book Search and book Add to list Add observation Print referral Print receipt Print answer New Save Delete
(,:@. Full pathway - ‘ Selected referral
PathwaylD | 0002-1644-8953 Edit Waiting list entries Aftach Detach Edit Show in waiting list
RTT start date 05/01/2011 Age atstart 65y Waittime 0 Wait time Date Waiting list Informati
@[&] Assessment (05101/2011-15102/21 | Referal date 10112/2010 Other date 06/01/201
 [E] Treatment (15/02/2011-06/041201" | Treaiment ype ++DIRECT REFERRAL / Audio assessment =
EI Follow up (06/04/2011-21/01/2011 Reason
[@] Completed (31/01/2011-Current) "GP airectreferral -
Customer SWINDON PCT MEA >
Referred by DR JFROST, WESTROF SURGERY, HOME FARM, H Appointments Attach Detach Edit ing
Refering agent ref. Date | Time | Symbol [ Statug Resource
Medical priority - 31012011 1615 Dk S |ResB8 ++GP direct refe
Referral handling -
Information Put on waiting list Booked directly Edit
108858 -gp C & bref - < >
-
Observations and procedures Detach Edit
Interview SEL@TIER Obsno. | SNOMED code | Date  [Add]S] Text
-
-
< >
Registered by USER NAME11 a >
O individual client ST ERE
~ Outcome  100a, Referral closed Clock  Closed Referral stages
- : i Adive length: | 3w 5d
% Client pathway view since 31/01/2011 17:19:15 Addnew | | History Name |Target date andwamlngsl Current  ~ af
Auto assigned as default successor for the status 34b, Referr Assessmen 150212011 o RIT end date i2om
é Clinic management Comment 9 : Treatment | 06/04/2011 ] RTT end date set by outcome status
. New outcome status 100a, Referral closed - Followup | 05i10/2011 O v | 34b, Referred to consultant (ENT)
E Stock management
;r:J User tasks
e
opp  PPPIist

-]
]
-

The size of the left and right-hand panes can be changed. Drag the Navigation area left or right
from its right border edge. Click and drag the border using the mouse to re-size the viewing
panes. Increasing the size of the Navigation area will allow complete viewing of available icons.
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9.2 Icons
9.2.1 Stages

Each stage has an icon which are coloured differently depending on if the stage has been
completed or is the current stage.

. |:| - Incomplete stage
. El - Complete stage
o EI - Current stage

9.2.2 Actions

Each type of action has an icon. These icons are coloured if an action has been completed.

Client pathway view
Al:tiontypes only v| Q g =5

&[] Audiogram

E-£2) NOAH action

(':]:. Earmould impression
-6 Document

They are uncoloured if the action has not been completed.
9.2.3 Appointments

An appointment icon will change depending on if the appointment has an action linked to it or
not

o Lu] 12/27/2013 R VS Test Follow Up, ResS5 _ ppgaintment does not have a linked action

HE
uf 11212014 wm Test Follow Up, Res48 _ Apnaintment does have a linked action
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9.3 Actions linking to appointments

On several types of actions, auto-linking to appointments can be provided. Examples include
such action types:

SalT tests
Documents
Questionnaires
o Stock actions
Earmoulds

Auto-linking settings are defined in the system administration tool.

If such a clinical action is created, the most relevant appointment will be attached. If only one
appointment occurs for the client that day, and the appointment start time is earlier than the
current time, then the action will be attached to that appointment. If it is not clear which is the
most relevant, for instance if there is more than one appointment on the same day or none at
all that day, a dialogue box will open asking you to attach the most appropriate appointment.

Each dialogue box for such action has a special button for attaching the action to or detaching

it from an appointment. The button is equipped with a symbol which reflects the state of the
iy +

action: either attached ( == ) or not attached (=7). In addition, the button has a tooltip that

displays detailed information about the action linking.

To attach an appointment, click this button and an information dialogue box will open where
you can Attach the correct appointment to link to the action. The button icon now changes to
show an appointment is attached.

Attach appointment >
Attach Close
Date | Symbnll Description Resource Status L]
13012020 | I |from1 Resdf *
130112020 7 2 Charlie *
1000112020 3 PHAC new p Charlie *
1000112020 1 1 Charlie *
09/01/2020 3 PHAC new p Stassy *
090112020 1 1 Resad * W

If the appointment is linked to a referral, then the Referral stage, where the appointment took
place, will be shown here.
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9)) Auditbase - [Client pathway view]
File

A& 8 8 B A

Detailed Quick Import data  Exportdsta | ExporttoNoah Logoff | Exit Auditbase

Search Import/Export Client data Exit
|E Client <T>T18765 MR JOHN SMITH -l & Z||H|user SYSTEM ADMINISTRATOR Multiple locations: ~  Multiple departments_. |« Q ‘7
N.a\ngatnon aon Client MR JOHN SMITH Compare results Mew Delete
= Favourites -
&5, Referral
] Documents and attachments Tests 09/01/2020, 1, L: HAT, R: HA1, +10 dB1 ~  Created by SYSTEM ADMINISTRATOR -
FL Waiting list Date oftest 09/01/2020 Age attest 79y oo Referral stage  Assessment
] AB Audiogram —
A\ Attention list : 107017, -
’ Appointment attached: *, 1040172020, PHAC new patient mould~
5, User reports Not administered 0
£ Booking
% i Left ear HA1 - Right ear HA1 -
NOAH b
H @ sesslor.l row;er Presentation level T0dBSPL - Test condition Audition + lipreading122 -
@ Open |atest fitting action -
Client pathway view :I:\Ss:)leva\ (signal=  +10 dB1 - Moise type
Full pathway - @ g = Lists Used

MNumber of Sentences Presented 16 E

Optional calculation of results

22/08/2019 ++TINMITUS

2210612015 ++DIRECT REFERRAL /Audia assessment Number of Key Words Presented 9 E % of Key Words Correct 56
E-@ 18/06/2015 ++AUDIO REVIEW reassessment Number of Key Words Correct |5_E
E{&] <No stage defined=
- rﬂ 10/01/2020 @ PHAC new patient mould~, Charlie Motes
£ [i] BKB test

E] 18/06/2015 ENT new patient mould~, Travy
[£% 1810612015
10/04/2015 ++AUDIO REVIEW reassessment
24/03/2015 ++AUDIO REVIEW reassessment -
12/10/2001 ++DIRECT REFERRAL /Audio assessment
[ <Mo referral>

o) - .
S Individual client

& Client pathway view

{2) Clinic management
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9.4 Pathway views

At the top of the Client pathway overview, you can choose the type of View from a drop-down
list and save that view as your default. These views have icons showing if they are a global view

#Th O
1 a site view , Or user view /.

Client pathway view

Full pathway - ¢ g =) E
Implant data stages
Full pathway

S Wy view
.;]:;;. sment
(T} Actions only

() without stages

-:]:3:- Without stages and appts/dates

# - Configure View (Shortcut = F4). See the details of the selected view and configure
your own.

i

=/ - Refresh View (Shortcut = F5). When an action is added to or moved on the pathway
you can refresh using this button and your view of any expanded sections will be
maintained.

o - Save defaults (Shortcut = F6). Save the position of the vertical bar and the current
view as default.

o = view missing actions in a pathway. Run a crystal report displaying user defined
missing actions for selected Treatment types.

If changes are made to any element of the overview outside of the Client pathway overview, a
message window will appear advising you of this and whether you want to refresh the overview
or not.

Client pathway view

I@I The client pathway overview was modified outside. Would you like to refresh?
k. *

Yes No
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9.4.1 System default views

There are a number of system default views set by Auditbase System which can be used as
templates for site default views or user specific views. You can view in detail how each

template view is made using the Configure Q button mentioned below.

« Implant data stages - For use with Implant module licenses only.

« Full pathway - Displays all referrals, clinical actions and appointments in Stages
including planned actions.

« Action types only - Displays the action types with actions attached showing the date of
the action.

Client pathway view
(3 Action types only it - IS A=

®-] Audiogram
=[] BKB test
1] 09/01/2020, BKB test, L: HA1, R: HA1
~[£1] 0110412015, BKB test, L: HA1, R:
=[] AB Words test

5 Pre-Op assessment form
#-[:i] Glasgow questionnaire, part 1
=[] Glasgow questionnaire, part 2
[ i] Medical history
-2 NOAH action
#{ia] Stock: Issue article
@ Stock: External aricle registered
#{ia] Stock: Return article to stock
@ Stock: Return aricle to repair
#-65] Document
- 4 OtoSurgery Pre-op
- 4 OtoSurgery PostOp 2-5m

Switch on / Review session

< >

« Actions only - Displays all actions grouped by action then in date order, newest action at
the top.
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Client pathway view

(5 Actions only - Q E o) =

5 10/0142020, 1, Audiogram changed in AB

@ 10012020, NOAH action, Audiogram changed in AB
g_d 10/0142020, Document, Mew

[i] 09/01/2020, SIR test

[i] 09/01/2020, AB Words test, L: HA1, R: HA1

[i] 09/01/2020, BKB test, L: HA1, R: HAT

) 2210512019, Pre-0p assessment form

5 110312019, 1, Aided, AuditBase audiogram

@ 110372019, MOAH action, AuditBase audiogram
,Q;_“J 11032019, Document, 11-03-19_test_template
@ 08/03/2019, Document, Test_PCT

[i] 28/02/2019, Medical history

[i] 28/02/2019, Glasgow questionnaire, part 2

[i] 27/02/2019, Glasgow questionnaire, part 1

[i] 2010212019, Glasgow questionnaire, part 1

5 211012015, 2, AuditBase audiogram

@ 21102015, NOAH action, AuditBase audiogram
5 211012015, 1, AuditBase audiogram

@ 21102015, NOAH action, AuditBase audiogram

< >

« Without stages - Displays referrals with attached actions and appointments but no
referral stages.

Client pathway view
[E] without stages - Q E o) | =

- 03/04/2008 ++PAEDIATRIC ASSESSMENT
- 310142008 ++PAEDIATRIC ASSESSMENT
- 02/01/2008 ++PAEDIATRIC ASSESSMENT
- 211112007 ++PAEDIATRIC ASSESSMENT
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« Without stages and appts/dates - Displays referrals and actions but does not shows
stages or appointments.

Client pathway view
] without stages and appts/dates o E ==

- 032/04/2008 ++PAEDIATRIC ASSESSMENT
- 310112008 ,++PAEDIATRIC ASSESSMENT
- 21112007 ++PAEDIATRIC ASSESSMENT

9.4.2 Configure Views

By selecting the Configure button o , views can be configured and saved. A Configure view
window will open.

Configure view

Preview Save Site view Delete view Close

MName |Fu|l pathway
Grouping level options

| | Referrals | | D Show planned actions
|—I [®] Referral stages
|—I fi] Appointmentsidates
|—l [] Action types
L [] Clinical actions
Advanced filtering options

M Show stages containing no data
- Current stage will be shown even with no data

M Show appointments not attached to referrals (and their attached actions)
- Referral selection will be based on start date

B Show actions not attached to appointments group by date
- Referral selection will be based on start date

The global views cannot be changed. The view must be saved as a site or user view. Making
any adjustments to the view will cause the name to be changed to remind you to save as site or

user view.

201
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Name |Mndiﬂed. rename to save | |

Grouping level options can be chosen by checking or unchecking the relevant boxes. Planned
actions which have not been completed can be shown by checking the Show planned actions
box.

There are additional filtering options which are shown in the section titled Advanced filtering
options. The filter will be active if the relevant box is checked.

Advanced filtering options
B Show stages containing no data
- Current stage will be shown even with no data

B Show appointments not attached to referrals (and their attached actions)
- Referral selection will be based on start date

M Show actions not attached to appointments group by date
- Referral selection will be based on start date

« Show stages containing no data - Stages will be shown even if there is no data
associated with the stage.

« Show appointments not attached to referrals (and their attached actions) - If there
are appointments which are not attached to a referral, the appointment will still be
shown.

« Show actions not attached to appointments group by date - Actions which are not
attached to appointments will be grouped by the date of the appointment.

Once you have made changes to the view, you can preview it before saving by selecting the
Preview button. Once you are happy with the correct layout, you can give the view a Name and
Save site view. The view will then be saved in the list in alphabetical order.

9.4.3 Missing Actions Reports

Selecting the printer symbol P from the Client pathway view pane will open a choice of two
system reports.

« Planned clinical actions by specialist
« Planned clinical actions by planned stage end date

— Planned clinical actions by specialist

— Planned clinical actions by planned stage end date
|

Using these reports will allow you to identify incomplete actions within an individual client
pathway or multiple clients’ pathways.

Multi selection fields
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To report on multiple values from multi-selection fields, each value is clicked on and moved to
the Selected items box using the arrows adjacent to the box. When a value is transferred to
the Selected items box that value will be reported on and anything left in the Available items
box will not be reported on.

Missing actions in pathways X
Current filter ~
=New filter= - Save Save as .. Deleta
Missing actions in pathways
Run report
Filtering clinical actions
Specialist gnored
Available items: Selected items:
Audiology tests and measurements
SalTtests
ToD tests
General
»
4
AddAll Remaove All
Additional clinical action types gnored
Available items: Selected items:
Audiogram -~
BKB test
BKB Sentences test (Adaptive or Mon adaptive)
AB Waords test
CUNY test [ 3
VEAtest
Commaon phrases test 4
Mr. Potato test
CAP test
CEPS test
SIR test v
Add All Remove All
Treatment type |I|
Available items: Selected items:
++AUDIO REVIEW reassessment -
++DIRECT REFERRAL /Audio assessment
++FITTING - from previous refarral
++NEOMNATAL ASSESSMENT
++PAEDIATRIC ASSESSMENT [ 2
++TINMNITUS
ENT Hearing aid referral 4
PAEDIATRIC hearing aid journey (PHAC)
SPECIALISED TEST REFERRAL
Testtreatment type
% DO NOT USE -AUDIO ASSESSMENT v
AddAll Remove All v

Above each Selected items box is a check box titled Ignored. This remains checked until a
value is moved into the box. If values are not moved across to a Selected items box and that
box remains empty, no filtering will be done on that selection and all parameter values will be
included in the report.
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Selected items:

Remaove All

Lists

If there is a list of possible values which could be used in multiple reports (such as Assessment
appointment symbols) these can be defined in Lists set up in System Administration -> Other
definitions -> Lists for report parameters.

Show List ltems

When a parameter is a list of items, you can view the items by clicking on the Show list items
button. The button will only appear when you have selected a value containing a list.

Although the list items will be shown, you cannot make changes to the list from here. This
must be done from within System Administration since the same list may be being used in
other reports and to make changes will affect all the reports it is used in.

Report Filters

To save report value selections you have made, click Save. You will be asked to give the
selections a Filter name.

Save report filter >

Save Close

Save to the current filter <1=
Rename the current filter

# Save as a new filter

Mame

W Save as the default filter

Once you have done this, the report selections are saved as a named Filter and can be
accessed from the Current filter drop down list.
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Multiple Report Filters

You can create differing versions of the same report and save them as Filters. To do this, open
the report you wish to adjust the parameters on. Change the values and click Save as. Give the
filter a name.

Save report filter >

Save Close

Fename the current filter

#| Save as a new filter
Mame Planned Report

Save as the default filter

This will now be available in the Current filter drop down box along with your original report
set-up. Saving each report change as a filter will mean they are all there to be re-used in the
future. There is no need to keep re-building reports with varying values.

You can also direct Auditbase as to which report should be the default.

Save report filter *

Save Close

Fename the current filter

# Save as a new filter
Mame Default

Save as the default filter

The report will always open the default report as standard.

If you have made changes to report parameters but have not saved them, you will be asked if
you wish to save them if you re-open the User reports list or exit Auditbase.

Run and refresh

The Run report button will highlight yellow as soon as a parameter is changed. This will alert
the user to the need for refreshing the existing report output. Clicking on the Run report
button will generate a new output for CSV reports.
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Missing actions in pathways

Current filter
1 [Defauli] hd Save Save as .. Delete
Missing actions in pathways

The white space to the right of the parameter lists will display the running dialogue and its
progress. If the report data is short, the dialogue will only flash onto the white area before
disappearing. A Stop button will display along with the report dialogue in order that the
process can be brought to a halt if it is taking too long to complete.

A LOG file isincluded in the output file in case there were errors which can be reported to
Support. If the report ran without errors, then it does not need to be retained and can be
deleted.

The reports consist of several parameters which you will need to populate with variables in
order for a report outcome to be achieved.

The two reports have different groupings in the output layout, specialist or planned stage end

date;

o Planned clinical actions by specialist
« Planned clinical actions by planned stage end date

Report Parameters

« Filtering Clinical Actions - Specialist - Variables available here consist of tests and
measurements grouped into specialist areas according to the standard Tests menu
grouping.

« Additional clinical action types - Variables here allow you to add additional
measurements and tests not included in the first Parameter.

« Client Professional Contacts - Referring agents who are linked to at least one patient on

the Additional Professional Contacts on the details tab.

o Treatment Type (Mandatory field - Must be populated) - Select the treatment type(s)

you wish to report on.
o Other variables allow you to look at patients with only certain alerts, GP’s, PCT’s and
Customers

The report outcome layout uses Crystal Reports. If required a custom version of this layout can

be produced by the support office at the normal rate.
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Printed: 05/03/2020

o) Auditbase

Planned clinical actions by specialist

Full name Hospital no. NHS no. Patient Patient RTT start Current Treatment type Treatment stage Stage status Stage Stage Stage Planned Action
keyworker age date outcome end date end date end date clinicalaction completion
status planned planned in fact date
year
meonth

Audiology tests and measurements

FIRSTNAMES25 LASTNAMER2S T1825 Unknown 28 2010212020 10a, Awaiting ++AUDIO Assessment Cument 01/04/2020 April 2020 BKB test
keyworksr frst ACTIVITY REVIEW
reasssssment
FIRSTNAME3364 Ti3gB4  11nmnInIn DRGJ 20 D2/07/2018 1002, Referral  ++AUDIO Asssszment Gompleted 18/03/2020 Warch 08/02/2020 BKE test
LASTNAME3R64 BARRON closed REVIEW 2020
reassessment
FIRSTNAME3ZG4 Ti13g64 1111111111 DRGJ 20 02/07/2019 100a, Referral ++AUDIO Treatment Current 07/08/2020 May2020 NQAH action
LASTMAME3864 EARRON closed REVIEW
reassessment
FIRSTNAMESZ5 LASTNAMES25 T1625 Unknown 28 200212020 10z, Awaiting  ++AUDIO Treatment Not started 21/05/2020 May2020 NOAH action
keyworker frst ACTIVITY REVIEW
reassessment

9.4.4 No referral

If an action or appointment is not linked to a referral, possibly because the department is not
using referrals, the action or appointment will be added to <No referral> and will be grouped
by appointment date under <No stage defined>.

=] =No referral=

El{___| =Mo stage defined=
~[7] 25/03/2003 B BATTERIES 3, Res73
~[¥] 1112/2002 R GWH Repair, Res73
2 2810/2002
~[¥] 12/07/2002 R GWH Repair, * Res56
~[¥] 27/06/2002 Em GWH Earmould, * Res65
FHET 27/06/2002
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10 Earmoulds

Click the button below to access our training materials.

To access the Earmoulds window, enter Shift+Ctrl+E or go to the Navigation area ->

Earmoulds.
Earmoulds - MISS, FIRSTMAME41844 LASTMAME41844 X
Search Print Label Earmould list Waiting lists entries Print stat Open with latest Close
Client
Hospital no.  T141844 Mame MISS. FIRSTNAME41844 LASTNAME41844 Comments on client -
Transport -
Moulds
Wanufacturer Adult Paediatric Re-mould Date of impr. Sentto manu.  Ready Issued
- 04082021 |5
Copy right to left
RIGHT LEFT
Mould +* Mo Mould + No
Eardrum Eardrum
Material -+ Vent Waterial -~ \Vent
Sound channel width length Sound channel width length
Currently worn Manuf. ID Currently worn Manuf. ID
Comments on mould(s) Allocated aid Hold for
Action
- -
Waiting list
Booking
Post
- - Priority
History
Customer SWINDON PCT - A
User SYSTEM ADMINISTRATOR -
Audiogram -

Delivery location  Default EM name
Address line 1 Default EM line 1

Address line 2 Default EM line 2

Centre number EM_C1

Postcode EM PO

Any activity regarding earmoulds for a client is listed by date and on-going number when more

earmoulds are entered for a client on the same date.

The following functions are available:

Label
information entered.

workstation with a different centre number.

Produces an earmould label which automatically contains all the

Centre number will be stored with the earmould ONLY when the earmould
label is printed. If the Centre number comes from Workstation settings the
stored value will be changed if the label is printed a second time from a
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New

Clears all details so a new earmould can be entered.

Save

Saves the earmould details.

Delete

Removes the earmould from the client.

Print

Produces an earmould report including the attached audiogram.

Print stat.

To extract statistics from the Earmould module, press Print stat. There is
also the option to export these statistics to .csv files.

Waiting list
entries

Click this button to display the Client's appointments and waiting list
entries window where you can review, create, or edit Waiting list entries.

Search

Click this button to open the Search earmoulds window. Enter the mould
number in the Earmould number field, select Search and either double
click the required mould or choose Select.

The search dialog will show the centre number and can be filtered on the
centre number for easier searching over multiple locations. The default
number for the filter comes from the centre number used on that
workstation but can be changed here.

The delivery address is taken from Location where specified. If Location is
not specified then the default address in the System Administration ->
Earmould settings is used.

Earmould
list

Opens the Earmould list, which displays a list of earmoulds, either
Paediatric or Adult, filtered within a date range, either Date of impression,
Date ready or Date Issued. Earmoulds that are Not Ready or Not issued can
be shown by checking the appropriate box allowing you to narrow the
results to earmoulds that were Ready or Issued in a certain period or have
yet to be ready or issued out.. To view the lists, select Show. To select an
earmould, highlight the mould and click Select or double click the mould. To
print the list, click Print.

The client’s Location can be shown in addition to the Delivery Location. This
must be enabled using the Show client location check box above the table.
The state of this check box will be saved for the user including after
restarting Auditbase. Note the warning that showing Client Location can
cause a reduction in the speed of popluating the Earmould List.

Open with
latest

Check this box to have the Earmould dialog open with the latest earmould
order displayed automatically.

The following information can be viewed and edited in the window:

Manufacturer

When a manufacturer is selected the Earmould Types and Materials
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available can be restricted if a relationship between Types, Materials
and Manufacturers is configured in System Administration by your
System Administrator. This allows users to be selecting only from the
Types and Materials supplied by the chosen Manufacturer.

Hospital no. These are added from Client information (see Client information).
and Transport

Earmoulds Lists the selected client's previous earmoulds.

Eardrum right A free text box to enter details about the ear canal and eardrum.
and Eardrum
left

Mould right and | Select the required earmould(s) from the dropdown lists.
Mould left

Material A specific earmould material can be selected from the drop-down menu.

Vent Enter the vent size

Sound channel | Width of sound channel
width

Sound channel | Length of sound channel
length

Currently worn | If a previous earmould is the client's preferred one this can be recorded
as Currently worn. On the Client Information page, the most recent
Currently worn is shown rather than latest issued.

Manuf. ID The Manufacturer ID as they use it can be recorded with the mould.
Copy right to Check box to copy Mould, Material and Eardrum information from right
left to left ear.
User The logged in user, but can be changed manually if required.
Date of impr. The date of the impression. Entered automatically by Auditbase but can
be manually changed. An appointment can be linked to the earmould
DCrate of impr.

10/01/2020 | 5
by selecting the link button to the right of the date

The client’s previous appointments will be shown and the approprlate
appointment can be attached by double-clicking it or selecting and
clicking on Attach.

Appointment With this button, you can attach the earmould to or detach it from an
attachment appointment. The button has a picture which reflects the state of the
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earmould: either attached (=) or not attached (<=). In addition, the

button has a tooltip that displays detailed information about the
earmould linking.

Sent to manu

The date the impression was sent to the manufacturer.

Ready The date the mould returns from the manufacturer.
Issued The date the mould was issued to the client.

Paediatric Check box to identify a paediatric earmould.

Adult Check box to identify an adult earmould.

Action Waiting list, Booking, Post and Priority check boxes.
Re-mould Identifies an earmould that is being re-issued to a client.

Comments on
mould(s)

Comments in this free text box will be printed onto the earmould label.

Comments on
client

Can be used to add comments about the client.

Allocated aid Enter details about hearing instruments that need to be allocated to
this particular client or mould.

Hold for Enter details about special instructions regarding who the mould must
be given to when the mould returns.

History Enter details about the earmould’s history, for instance date of
earmould repair.

Customer A customer, usually a Trust or CCG, can be selected from the drop-down
menu.

User The user creating the earmould is pre-selected but can be chosen from
the drop-down menu if the appropriate rights have been awarded by
the System Administrator.

Audiogram The drop-down list contains the selected client's audiograms. You can

select an audiogram in this list and it will be printed with the earmould
report. Click Show to activate a window for the audiogram review.

Centre Number

The Centre number is editable and is filled by default with the
workstation value. This value is saved when the earmold is first saved.

Post Code

The Post code is taken from the delivery address which is usually only
used in conjunction with the Repair module.
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10.1 Entering Earmould details

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation area-> Earmoulds.
o Click on New.

Address line 2 Default EM line 2

Earmoulds - MISS, FIRSTMNAME41844 LASTMAME41844 *
Search Prin Label Earmould list Waiting lists entries Print stat. Open with latest Close
Client
Hospitalno.  T141844 Mame MISS. FIRSTNAME41844 LASTNAME41844 Comments on client
Transport
Earmoulds w| | Delete MNew Save
Moulds
Manufacturer Adult Paediatric Re-mould Date of impr. Sentto manu.  Ready Issued
MINERVA -~ 04072021 | S5 070712021
Copy rightto left
RIGHT LEFT
Mould EM 2101 - SOLID~ACRYLIC HARD ~ Mo Mould EM 2101 - SOLID~ACRYLIC HARD ~ No.
Eardrum Eardrum
Waterial * \Vent Material ~ \ent
Sound channel width length Sound channel width length
Currently worn Manuf. ID Currently worn Manuf. ID
Commenis on mould(s) Allocated aid Hold for Action
Waiting list
Booking
Post
Priority
History
Customer SWINDON PCT -
User SYSTEM ADMINISTRATOR A
Audiogram -
Delivery location  Default EM name Centre number EM_C1
Address line 1 Default EM line 1 Postcode EM PO

« Inthe Eardrum right and left fields you can write about the condition of the eardrums

and ear canals.
o Select earmould type from the earmould right and/or left lists.

o Check that the correct username is displayed in the User field. Use the drop-down list to

modify, if necessary.
o Select the Manufacturer from the drop-down list.
« If applicable check one or both boxes Post and Priority.
o If applicable check one of the boxes Adult or Paediatric.

« If enabled by the system administrator and the earmould requires a letter to be sent to

the client when it is returned, check the Re-mould box
« If necessary, enter comments in any of the 4 comment fields.

Comments on mould(s) box will be printed
on the earmould label.
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« If required, enter Ventilation channel characteristics, and Sound channel width and
length

« If left mould is the same as right mould, check Copy right to left to copy all
characteristics of the right mould to the left mould.

« Click Save.

« An automatic identification number for the earmould will now be added by the system.
This feature can be disabled by the system administrator, and manual identification
numbers can be added.

« If there is a need to review client’s waiting list entries while filling earmould details, click
Waiting list entries button.
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10.2 Entering information to show the earmould has been sent
to the manufacturer

This can be done when entering earmould details:

o Enter the date in the Sent to manu box.

o Click Save.
Drate of impr. Sent to manu. Ready lssued
100012020 | 25
LEFT
’;duuld * Mo,

If this is done at a later date, for instance if the moulds are sent off in batches:

Navigation -> Earmoulds.
Click the Earmould list button.
Enter the required date range.

o Click Show.
Earmould list >
Paediatric Adult Print Close
Date of impression; 10/01/2018 to  10/01/2020 Earmould centre number:
Date ready: to Mot ready Filter on code
Select all Select Fill ready date
Right No. | Left No.| Date of imp. | Sentto manu.| Date ready | Hospital no.| NHSno. | Client name
09/01/2020 09/01/2020 | 09/01/2020 4084432 Ms. 11
09/01/2020 T1120 MRS FIRSTMAME120 LASTNAME120
111002019 | 09/01/2020 | 09/01/2020 | 4084432 M. 11
MAN2019 | 1M/10/2019 09/01/2020 4084432 M1
21/08/2019 Q222222 Father Test firstname Test surname
29/07/2019 T15825 MRS FIRSTMAMESE25 LASTMAMESE25
125 126 | 13/03/2019 | 13/03/2019 R897596 9589544444 | Mr. J0CC0CCO0CCO0CO0NCO0G0OGCNI CL
789 03/07/2018 03/07/2018 | 03/07/2018 D568978 5555555555 Mr testdf_1
14/06/2018 T146087 MRS FIRSTMNAME46087 LASTNAME4G0
14/06/2018 T111190 MR FIRSTMAME11190 LASTMAME1119(
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMNAME120 LASTNAME120
2 22 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTNAME120
14/03/2018  14/03/2018 * CLIENT PERMANENTLY DELETED *
4 >

« Double-click on the appropriate client.
« Click on Sent to manu. and enter the date.
o Click Save.
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10.3 Entering information that the mould has been returned
from the manufacturer

Navigation -> Earmoulds and click Search.

Enter the earmould number from the earmould label.

Click Search.

Highlight the appropriate client name.

Click Select.

Double-click on the Ready box. The current date is automatically entered. If set up by the
System Administrator, an Automatic Journal Entry will be entered into the Journal.

If the Re-mould box was checked, the send letter window box automatically opens and
you can select the appropriate letter to send to the client.

If the Re-mould box was not checked, click on Save.

If you want to put the client on a waiting list, use the Waiting list button at the top of the
screen.

Or you can close the earmould page and book an appointment for the client in the
booking screen.

10.3.1 Booking back multiple Earmoulds

e Open the Earmould List and run the search based on earmoulds which have not been

marked as Ready. This is done by selecting the Not Ready box and then clicking Show.

« Select the earmoulds which are to be returned by clicking to the left of the Right No.

« Select Fill Ready date

Earmould list X
Paediatric Adult Print Close
Date of impression: to  10/0142020 Earmould centre number:
Date ready: to Mot ready M Filter on code
Select all Fill ready date
RightNo.lLeﬂ N0.|Date of imp.|Sentto manu. | Date ready |Hospital no.| MNHS no. | ~
09/01/2020 | 09/01/2020 | 09/01/2020 4084432 Ms. 11
] 09/01/2020 T1120 MRS FIRSTMAME120 LASTNAME12(
B 1M 0/2019 | 09/01/2020 | 09/01/2020 | 4084432 MS. 11
B TM02019 | 1110/2018 09/01/2020 | 4084432 Ms. 11
] 21/08/2019 Q222222 Father Test firstname Test surname
B 29/07/2019 T15825 MRS FIRSTMAMES825 LASTNAMES!
B 125 126 |13/03/2019 [13/03/2019 R897596 9589544444 | Mr. X00CO0000CGCOOCOO00CCON0N
B 789 03/07/2018 (03/07/2018 03/07/2018 | D568978 5555555555 | Mr. test df_1
B 14/06/2018 T146087 MRS FIRSTMAME46087 LASTNAME:
B 14/06/2018 T111190 MR FIRSTNAME11190 LASTMNAMET
B 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
B 2 22 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHAME12(
B 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTHNAME12(
: 14/03/2018 | 14/03/2018 * CLIENT PERMANENTLY DELETED .,
< >
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Paediatric Adult Print Close
Date of impression: to | 10/01/2020 Earmould centre number:
Date ready: to Mot ready M Filter on code
Select all Show Select Fill ready date
Right N0.| Left N0.| Diate of imp. | Sentto manu.| Date ready | Hospital no.| NHS no. ~
09/01/2020 |09/01/2020 4 M3. 11
{ 0 Enter 'Ready’ date |
11/10/2019 | 09/01/202 MS.11 |
] 1111062019 | 111107201 e | G MS. 11 '
7 21/08/2019 Father Test firstname Test surname
7 29/07/2019 ‘Ready date: MRS FIRSTMAMESE25 LASTNAMESE
| 425 126 |13/03/2019 | 13/03/201 444 | Mr. 2000C0000C0000C000000000C0
| 730 03/07/2018 | 03/07/2018 | 03/07/2018 | D568978 | 5555555555 | Mr. test df_1
B 14/06/2018 T146087 MRS FIRSTMAME4G6087 LASTMNAME:
B 14/06/2018 T111190 MR FIRSTNAME 11190 LASTNAMET
] 14/06/2018 | 14/06/2018 | 14/06/2018 T1120 MRS FIRSTMAME120 LASTMAME12(
] 2 22 |14/06/2018 |14/06/2018 | 14/06/2018 | T1120 MRS FIRSTMAME120 LASTMAME12(
] 14/06/2018 |14/06/2018 | 14/06/2018 | T1120 MRS FIRSTMAME120 LASTMAME12(
] 14/06/2018 |14/06/2018 | 14/06/2018 T1120 MRS FIRSTNAME120 LASTMAME12(
: 14/03/2018 | 14/03/2018 * CLIENT PERMANENTLY DELETED ,
< >

o Insert the date you wish to identify as the date earmoulds were ready and then select
Save. Note: The date will automatically populate with the date on the PC calendar.
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10.4 Viewing a client's previous earmould impressions

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Earmoulds.
o From the Earmoulds drop-down list, select the date of impression you want to view from

the list.
o All details of this earmould will now appear on screen.

Earmoulds - MRS FIRSTNAME2278 LASTNAME2272 x
Search Print Label Earmould list Waiting lists entries Print stat. Open with |atest Close
Client
Hospital no. T12278 Mame MRS FIRSTNAME2278 LASTNAME2278 Comments on client -

Transport -

Earmoulds - Delete New Save
Moulds G, 15/06/2009

5, 30M2/2008 Date of impr. Sentto manu.  Ready lssued
Copyr 4, 26/06/2007 Re-mould  10/01/2020 ||t
3, 06/04/2004

[R'GHT 2, 27/06/2002 | LEFT

Mould 1, 11/04/2000 Mo. Mould -~ Mo,
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10.5 Attaching audiograms to printouts

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Earmoulds.

« Select the appropriate earmould by selecting date from the earmoulds drop-down list at
the top of the page.

o Select an audiogram in the drop-down list.

« Click Save.

o Select Print.
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10.6 Earmould barcodes

In the Earmould module you can search for an earmould either by user input or with a barcode
scanner. When using the barcode scanner, a unique earmould barcode is needed. This barcode

can be printed out from Auditbase, if so set up in Auditbase system administration.

« Click on Label in the Earmould module.
o A label will be printed followed by a barcode if so configured by your system
administrator.

Client name: MRS FIRSTNAME1966 LASTNAME1966
Hosp No: T11966 NHS No:

Impression date: 10/18/2010

Barcode (not transformed): &!101018-7724

Barcode (transformed):

« The label contains information concerning the patient’s earmoulds such as the earmould
numbers, type of earmoulds, as well as a hospital number and the audiologist who has

worked on the patient. Comments and notes can also be added to the label.
« Once the barcode has been printed, use a barcode scanner to find the earmould in

Auditbase System.

Search earmoulds >

Search Select Close

Earmould number. 123 Earmould centre number: |

Clients found: M Filter on code

Hospital no.| MNHS no. Mame |Date of im
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
T14438 MRS FIRSTMAME4438 LASTNAME4438 30/0320°
To99444  |1233211233 | Father Tname Fname 28/03/20- ¥
< >
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11 Paediatric Module

Click the button below to access our training materials.

The module contains information related to a client defined as a child or young person. The
module is only accessible when you have selected a client whose age corresponds to the limits
set up by the system administrator.

To access the module, go to Navigation area -> Paediatric or press Ctrl+Shift+P.

When either Client search (F3) or Client quick search (Ctrl+F3) is activated from the Paediatric
module, it is only possible to create a new paediatric case for a person below the age limit
defined by the system administrator.

If a client aged below the limit is selected, you can add or modify paediatric information. If the
client does not have an existing paediatric record, the paediatric module is left empty and you
cannot enter or save data.

When merging clients that have a Paediatric Module record, only the record belonging to the

master will be retained after merging. Please ensure you have copied all important data from
the Paediatric Module record of the client, to be merged into the Paediatric Module record of

the master client, before merging.
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11.1 Entering data in the Paediatric module

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Navigation -> Paediatric, or press Shift+Ctrl+P.

To create a new Paediatric record for a client the client must be aged below the limit set
by the system administrator.

« Using the tabs at the top of the screen enter the data required in each field.
o Thetab to be presented at start-up is defined by the system administrator.
o Auditbase will prompt you to save information as you leave each tab or the module.

11.1.1 Contact Information

The information in the Contact tab is meant to give a quick overview of relevant contacts for
the child.

Contact information | Referral information | Audiogram | Risk analysis | Consultations and Onward referrals | PCHI | Clinical inf.
Consent to share information with education GP
Yes Mo Withdrawn Refused
GP comment
Consent to share information with social senices Comments FY
Yes Mo Withdrawn Refused -
Consent comments ENT consultant
Comments -
TOHI
- -
HV i SHMN Head of TOHI service
-
HV / SHM comments School contact
Comments Fs Comments -
-
- Child development centre
Key worker Comments -
- -
e Play group
Key worker comments Comments -
- -
- Mursery school
Audiologist Comments Fs
- -
Community paediatrician School
SALT School type

The information on this tab is a combination of drop-down lists and free text. The content of
the drop-down lists can be edited in the following way.
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« Right-click on the drop-down arrow of the fields you want to edit.

o Click New.

o Add the required name for the Text box.

o Click Apply.

o Click Close.

« The required name will now appear in the drop-down list and can be selected via
clicking.

The fields that are edited in this way are: TOHI (Teacher of the Hearing Impaired), Head of
TOHI, SALT (Speech and Language Therapist), Community Paediatrician.

o Audiologist is a drop-down list of the users on the system.

o ENT Consultants and School Information are added from lists.

« The ENT Consultant may be transferred from the Client Information screen if configured
to do so by your System Administrator. Any change here may affect the ENT Consultant in
the Client Information module.

« Click on the button at the end of the field and select the required option:

« Create new allows you to add a new referring agent, for instance a school, doctor or
health visitor. Fill in the referring agent screen as required.

« Select all opens the search window, where you can enter search criteria. Highlight the
referring agent you wish to select and double-click or select to add them to the client
record.

« Select from list opens the search window and automatically displays all agents.
Highlight the referring agent you wish to select and double-click or select to add them to
the client record.

« Clear field removes the currently selected referring agent from the client record.

« Change to the information is saved to the database by clicking Save from the File menu
or pressing Ctrl+S.

11.1.2 Referral information

A dynamic overview of referrals through time is obtained from this tab listing date, agent,
reason(s) and notes.
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Contactinformation | Referral information | Audiogram | Risk analysis | Consultations and Onward referrals | PCHI | Clinical inf.

Previous referrals

Date Agent Agency Reason [

10/01/2020 AUDIOLOGY referral

02M0/2001 DRRING J P G,

22/06/2015 DR JP RING ++GP direct referral

24/03/2015 DR JP RING ++Patient self referral

11/04/2015 | DR JP RING ++Patient self referral o
Date of referral - 02/10/2001 Reason for beginning

Referring agent h
DRRING J P G, Reason for ending

Referring agency hd

Episodic conclusion

Referral reason Some conclusion

v
Information

GP LETTER

The drop-down lists for Reason for beginning and Reason for ending are defined by the
system administrator.

Previous referrals are listed in the box. Click on the referral to see the information. This tab is a
combination of drop-down lists and free text.

« Select the reason from the Referral reason drop-down list.

« Select other referral reasons from the Reason for beginning and Reason for ending
drop-down lists.

o Enter further information in the text boxes.

« Referring agent and Referring agency are added from lists.

o Click on the button at the end of the field and choose the option required, see Contact
information for further information on how to enter data.

« Selecting New referral from the Functions menu and entering information in the fields
followed by saving, will store a new referral to the database.

« Selecting a referral from the list of previous referrals followed by selecting Delete
referral from the Functions menu removes the referral from the database.

« Changes to the information are saved to the database by clicking Save from the File
menu or pressing Ctri+S.

11.1.3 Audiogram

Audiograms entered in the system are displayed in the Audiogram list box.
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Contact information = Referral information | Audiogram | Risk analysis | Consultations and Onward referrals = PCHI | Clinical inf.

Audiogram list

10/01/2020, nr: 1 -

11/03/2019, nr; 1, Aided

S HL ()SPL () dBiA) EEE || DEEE

2110/2015. nr- 2 Audiogram | 125 | 250 | 500 | 750 | 1000 1500 | 2000 3000 4000 | 6000 | 8OO0

2110/2015, nr: 1 10/01/2020, no. 1

29/09/2013, nr: 1 BONE MORMAL, RIGHT 30
BONE NORMAL, LEFT 30

4

25/09/2015, nr. &
NORMAL

ﬁf‘| symbol
O AC

@ AC MASKED
/% BC UNMASKED
C BC MASKED
L ucLum
UCLM

M MCL UM

B McL M

% sF

® SFM

#® RIPSY

= RIPSY M

& R CONTRA

% s ®Ea eMEHLYD X XY

Comments

To view an audiogram, click on the date to display it numerically.

To enter a new audiogram, click on the symbol required on the left-hand side of the
screen and type the numeric values in the audiogram table.

Various tests, VRA, ABR, SSEP and Distraction can be entered.

These tests result in audiogram thresholds for the frequencies using HL, SPL or dB(A)
calibration.

Each special test (with a set of thresholds) will be interpreted as an audiogram curve with
its own corresponding symbol set in the audiogram module. Before a curve can be
entered as new, calibration must be selected.

All values are converted into HL before they are stored in the database structure.

The curve type Estimated audiogram is a type that does not refer to a specific test. The
intention is that the audiologist determines the thresholds for the estimated audiogram
by viewing the values from the obtained special tests.

The values for the estimated audiogram can then be entered as HL, SPL or dB(A)
calibrated thresholds. All thresholds must be entered using the same calibration.

When an estimated audiogram is saved, it is stored in the database structure as a pure-
tone normal audiogram with a hard-coded note (10) on each threshold. This results in an
audiogram that can be used in Noah for hearing instrument fitting, see How to enter into
Noah

The audiogram information can be viewed in Table or Graph mode so instead of entering
thresholds as numerical values, the graphical display can be used as well. Choose the
mode from View -> Table mode or Graph mode. The functionality is similar to the
Audiogram module. By highlighting the dates in the Audiogram list box, you can decide
which audiograms to view in both modes.

Values can be entered in HL, SPL or dB(A).
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« In both the tabular and graphical view, the audiogram can be viewed from the audiogram
module and all other places where the audiogram is present.

« In both layouts, the mean values for 500, 1k, 2k Hz or 500, 1k, 2k, 4k Hz are displayed.

o Changes to the information are saved to the database by clicking Save on the screen,
from the File menu or pressing Ctrl+S.

Note: If a new audiogram is chosen the client cannot change the audiogram mode to
graph. If the client is on graph mode then selecting a new audiogram is not possible.

11.1.4 Risk Analysis

From the Risk Analysis tab, the user can enter risk parameters from observations about the
child explaining the hearing problem.

Contactinformation | Referral information = Audiogram | Risk analysis | Consultations and Onward referrals | PCHI | Clinical inf.
Last updated Confirmed syndromes
10/01/2020 Add/Remove
Mewborn hearing screening test Mame
M Passed Referred Mot done Progressive unknown
Health visitor distraction test
Passed B Referred Mot done
Parental concern Risk factors
Add/Remaove
Mame
Rubella
Hearing status
Weight at birth (kg)  Date of birth Gestation in weeks
3.00 30/01/2010 39 ) )
— Progressive Congenitalineonatal
Family history B Ves Mo Yes |:|N0
Postnatal cause
Date of post natal cause
SEEDTIEL Age of post natal cause

Where some of the fields require predefined input, the date fields are automatically filled with
dates retrieved from the database. Each saving of risk information retrieves the system date
from the database to update the Last updated field. The Date of birth field is retrieved

from Client information/Date of birth.

Newborn hearing screening test and Health visitor distraction test can be unchecked or
checked to indicate whether the child passed the test, has been referred for further or testing
has not been performed at all.

Information to be filled is the child's Weight at birth in kilograms, Hearing status, Operations,
Family history, Parental concern. Both Risk factors and Confirmed syndromes can be
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added by clicking Add/Remove and selecting appropriate items in the lists of those defined
via the System Administration tool -> Paediatric definitions -> Risk factors -> Syndromes.

All selections and texts can be corrected and updated to the database reflected in the Last
updated field.

Changes to the information are saved to the database by clicking Save from the File menu or
pressing Ctrl+S.

The drop-down lists for Syndromes and Risk factors are defined by the System Administrator.
11.1.5 Consultation and Onward referrals

This tab is used to write information related to each of the child's visits at the clinic. The child
can have several consultations, so with all the information on these tabs referring to a
consultation, the user can enter information about future consultations and also view
information from past consultations.

Contact information | Referral information | Audiogram | Risk analysis || Consultations and Onward referrals | PCHI | Clinical inf.
Visits Otalgia: Onward referrals
Date Time | Symbol | Status Resource ~ Existing Onward referrals Selected onward referrals
13/01/2020 | 09:00 * Charlie
13001/2020 (1115 | P |+ Res46 NEUROLOGY
10/01/2020 0800 1 |* Charlie Otorrhoea:
10/01/2020 | 14:00 E] * Charlie v
ETRIEEAEEEE a : P -
—>
General development
Aetiology:
Mormal Delayed Mot ascertained 2 <—
Speechflanguage development
Marmal Delayed Mot ascertained
SHorerfmotibreafer mcost Select additional referral
Colds: Operation:
School advice given
Yes No
Information to family Care plan - post consultation

Date and Time of each consultation is automatically transferred from the appointment book,
with the name of the resource with whom the appointment is scheduled.

Updating the information of a consultation is done by selecting the appropriate date and time
from the list which enables the fields to be filled with information on the tab.

Free text can be added to respective fields:
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e Snorer/mouth breather

« Colds

« Otalgia

o Otorrhea

« Actiology

o Otoscopy

e Operation

o Information to family

o Care plan - post consultation

o The appointment is booked by selecting this in the Functions menu and filling in
information in the appointment dialog (Booking).

Also from the Functions menu, a consultation can be deleted once it has been selected from
the list.

Changes to the information are saved to the database by clicking Save from the File menu or
pressing Ctrl+S.

11.1.6 PCHI (Permanent Childhood Hearing Impairment)

By entering the date of the first appointment, observations and procedures and hearing
instrument issue in the date boxes and pressing TAB, Auditbase will calculate the Age in
months at these stages for you. Auditbase uses the date of birth entered in the client
information module to make these calculations.

Contactinformation | Referral information | Audiogram | Risk analysis | Consultations and Onward referrals | PCHI | Clinical inf.

First audiology professional Average 0f.5,1,2,4 kHz befter ear

Date 10/0142020

Age 9 Year(s) 11 Month(s) 11 Day(s) Motes
Diagnosis

Date 10/0142020

Age 9 Year(s) 11 Month(s) 11 Day(s)

Hearing aid issue

Date 1000142020

Age 9 Year(s) 11 Month(s) 11 Day(s)

Free text can be filled in for the average of .5, 1, 2, 4 kHz in the better ear and notes.

Changes to the information are saved to the database by clicking Save from the File menu or
pressing Ctrl+S. Changes to any of the fields are made by correcting dates or text and saving to
the database.
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11.1.7 Clinical information

This tab presents an overview of the client’s clinical status. Sorted by date, the medical
condition, investigations and immunisations are listed in the three tables.

Contactinformation | Referral information | Audiogram | Risk analysis | Consultations and Onward referrals | PCHI | Clinical inf.

Significant medical conditions /illnesses

Diate 1CO 10 Description
28/04/2015 (127 Test observation

241032015 [127 Test observation

Investigations

Date Investigation Result
10/0142020 | High Freq Tymp

Vaccinations & Immunisations

Date Immunisation

« Toadd information, double-click a row in the table.

« Enter new clinical information or delete existing information in the window box.

+ The system date is given to the date field by default and from the drop-down box you can
select between the clinical information defined by the system administrator in the
Administration tool.

« Changes to the information are saved to the database by clicking Save from the File
menu or pressing Ctri+S.

o Information is deleted by double-clicking the respective entry in the table and pressing
Delete in the dialog box.

11.1.8 Deleting Paediatric information

When paediatric information for a client needs to be deleted from the database, Delete from
the Edit menu holds this function and the user is warned that carrying out this action cannot
be undone.

Pressing Yes to the security question erases all paediatric information for the client from the
database.

Pressing No ends the deleting session without erasing paediatric information for the client
from the database.
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11.2 Paediatric review report

To access this report in the Paediatric module:

Select View -> Paediatric review report.

Select unaided audiogram.

Select aided audiogram.

o Hearing instrument information is taken automatically from the client's device list.
o Enter hearing instrument details.

o Click Print.
Paediatric review report / MR JOHN SMITH (T18763) x
Print Close
Mumber of copies to print 3
Select unaided audiogram 1000172020, 1
Select aided audiogram 110032019, 1
Hearing Aids
Type right NHS SUPPLIES, ITE10MR
Type left BERMAFOM, test
Right Left
Uservolume 23 20
Settings
Serial number 1234432 1234433
Audiologist  SYSTEM ADMINISTRATOR -
Conclusion
-
-
TOHI [W] :Community Paediatrician:
B ENT SALT
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11.3 Printing

You can preview or print a full report of the information you have entered in the Paediatric
Module.

o Select File -> Print or press Ctrl+P.

« Select which pages to print:

e Printall

o General paediatric information (Family + Contact information)
o Referral information

o Audiogram

o Consultation

o Significant medical conditions/illnesses

« Investigation

o Immunisation

o A printout will be sent to the default printer.

OR

« Select Print preview. A copy of the report will be displayed on screen.

« When Preview is presented on screen, the file can be exported to Format and
Destination selected in the Export dialog followed by OK to carry out selection or return
to Preview by hitting Cancel.
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12 Stock

Click the button below to access our training materials.

All articles, such as hearing instruments, spare parts and services, can be managed in the

Stock module.

The Stock module has relations to invoicing and other additional facilities for purchasing,

ordering, repairing, etc.

To open the Stock module, select Navigation -> Stock or use Ctrl+Shift+S.

OZEI Auditbase - [Stock]

- O X
File Edit Functions Statistics Settings
@] o) =
¥ [+
Qo+ > 9 -
Detailed = Quick Importdata | Exportdata | Exportto Noah Logoff | Exit Auditbase
Search Import/Export Client data Exit
| Client  <T>T18765 MR JOHN SMITH -8 =|B|user SYSTEM ADMINISTRATOR | Multiple locations... ~ Wultiple departments... ~ £x| 2
Search Mew status Device List Invoice Reguisitions Verification
Supplier Model Stock types
(1)Testmanu [ test group A [STOCK - GWH (In stock) -
(2)Testmanu BE102H BATTERIES IN STOCK (Batter
MHS HEARING AID (Serial No.) [l el¥[i==lelNNa) ITE1OML FITTED/EXCHANGED (Issued
SPECIAL TECH. AIDS (Quantity,  |123456789 ITE1IMR POSTAL BATTERIES (Issued
BATTERIES (Quantity-Accessor,  [RIgERE0I NI ==F ITET1ML LOAN (Lent out to client)
PROCEDURES (Service) (3)TestManufacturer BE101 EACHERS OF THE DEAF (Lt
Sernvice-Accessory BE101B SENT FOR REPAIR (Repair)
COMMERCIAL HEARING AID (S BE101G DAMAGED (Lost)
EARMOULD ACCESSORIES BE102HF LosT
ELBOWS BE103 OBSOLETE (Lost)
LEADS, RECEIVERS & SHOES + BE105 v |Louisa's sorting (In stock) v
Show discontinued Show discontinued Show discontinued
Article information Serial number | 444
Article 1D: 50144 Modified date: 21/04/2015 -
Mo ordered: 0 Receiver: T106
Aricle type: MODULAR ITE Version
Wersion Colour: Order by:
MHS price £ Type: Dat
Internal art. no.: Label: a_e
NHS art. no.: Item no.: o) Serial no.
Basic purch. price: £ 58.14 Recycled: Mo § i
Discount: % Sales price: £0.00 Filter serial numbers
Basic sales price: £ 58.14 Warranty expires:
Supplier: MHS SUPFPLIES Purchase price: £58.14
Supp. article no.: GHE 008M Purchase date: 21/04i2015
Battery: CP41
Return date: Edititem
\Warranty code: 25
b
4 ltem 1 out of: 3 |

NUM SCRL

In the upper section the Stock module lists the Group, Manufacturer, Article, and Stock type

that are used for selecting the specific item to work with.

Selections are made from left to right over the available lists:
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Group

Contains definitions of for example hearing instruments, spare parts, accessories and services.
Groups are defined by the System Administrator. Each group is managed and identified by
Serial no. or as Quantity or Service.

Depending on the group selected in the list, the displayed information in the lower part of the
screen will change. For example, selection of a serial number controlled group will show Article
Information, Order by and Search. Selection of a quantity controlled group will show Article
Information and Items found. Selection of any group identified as service shows Service
Information.

Manufacturer

Shows the manufacturers of articles of the group selected in Groups. For example, for the
Hearing instruments group, the list can contain manufacturers as Auditdata, Widex, and
Oticon etc. A new manufacturer can be added or existing manufacturers modified, when the
group is selected, from the menu Functions -> Settings -> Manufacturers.

Article

Lists the sub-category of Manufacturer. For example, for Hearing instruments, the Auditdata
manufacturer, the Article list contains stock articles produced by Auditdata. Articles are
defined in Functions -> Settings -> Articles.

Stock type

Identifies the physical location or current status of an item. For example, when a supply of
articles is delivered, the new purchased items should be registered as In stock.

Changing a stock type for an article implies that an article has moved from being In stock to
being Issued to client or maybe temporarily For repair from the status Issued to client. The
same applies to other stock types for example Spare parts.

NOTE: Changes in the status of items create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

Stock types are defined by the System Administrator.
For a quantity controlled group, items can be deleted no matter which stock type status they

have.

Miscellaneous
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The headings for Manufacturer and Article can be defined by the System Administrator. For
example, you can see that for Spare parts, the heading for the lists changes to Type and
Series.

Any selected article shows Article information with product ID, quantity ordered, type, codes,
prices and discount, supplier and supplier article number and if you have selected a group
identified serial number, you will also see a version number.

Information about external and internal product codes, lowest stock level, lowest stock level at
bulk buy or collective purchasing, type, version, etc. can be attached to an article.

If an HI has the status Lent by employee, you will see the employee’s name under the Article
information, when the article is selected in the main Stock window.

Read more about the Stock module in the following chapters.
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12.1 New status

To change the status of an item, select a group, manufacturer, article and stock type. Find the
item and click New status. In the opened New Status dialog, select the new stock type, specify
the required details and press Save.

Note: The status of devices and accessories can also be changed from the Devices tab of
the Client Information module.

Mew status for senal number: 1231112, WHS SUPPLIES, ITET0ME x
Client MR JOHN SMITH Print Settings OK Cancel
From stock type Article name Ear Date

STOCK - GWH (In stock) ITETOMR HR L WA 1000142020 Recycled
Location S0

. X SYSTEM ADMINISTRATOR - HI Satisfaction questionnaire wanted
Multiple locations ... - _
History comment Price Invoice type

To stock type

£66.28 Invoice type 1 -

POSTAL BATTERIES (Issued batte Reasontoissue
LOAM (Lent out to client) -
EACHERS OF THE DEAF (Lento

SENT FOR REPAIR (Repair) [tern information Invoice
DAMAGED (Lost) 33 to customer
L
o clent

Show discontinued

If the change of stock type is the issuing of an instrument, the instrument will be given the
status Issued and this will be registered for the selected client. Simultaneously the issue is
registered for invoicing.

If so configured by your System Administrator, it might be mandatory to select the Reason to
issue (used especially in Denmark). The reasons are listed by a four-digit code using letters
and numbers. They are sorted alphabetically in order to make the selection easier. No other
priority sorting is supported. You can select the code by using number and letter keys on your
keyboard, when the drop-down list is selected. Each key press will select the next character in
the code. Once selected, the Reason to issue code will then be shown on each posting related
to this type of issue and inside the invoices.

All changes of status will be registered in the history of the item which is displayed via the
menu Functions -> History.

In addition, changes of status automatically create clinical actions, namely:

« When the new stock type of a device is of the Issued category and its current stock type is
not of the Repair or Lost category, a clinical action of the Issue article type will be
created, meaning that the device is issued to the client.
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+« When the new stock type of a device is of the Issued category and its current stock type
is of the Repair category, a clinical action of the Issue article from repair type will be
created.

« When the new stock type of a device is of the Issued category and its current stock type
is of Lost category, a clinical action of the Issue article from lost type will be created.

« When the new stock type of a device is of the Lent out to client category, a clinical action
of the Lend out article type will be created.

« When the new stock type of a device is of the In stock category, and the device is
associated with the client before this transaction meaning that the current stock type is
either of the Issued or Lent out to client category, a clinical action of the type Return
article to stock will be created.

NOTE: A device can be moved to stock directly from another stock type, or from a stock
type of the Lent out to other category, or from the Repair category. However, in such
cases there is no client associated with the device, and a transaction like this will not be
a clinical action.

« When the new stock type of a device is of the Repair category, and the device is
associated with the client before this transaction meaning that the current stock type is
either of the Issued or Lent out to client category, a clinical action of the Return article
to repair type will be created.

NOTE: A device can be sent to repair directly from stock. In such a case, the current stock
type is of the In stock category and there is no client associated with the device.
Therefore, a transaction like this will not be a clinical action.

« When the new stock type of a device is of the Lost category, and the device is associated
with the client before this transaction which means that the current stock type is either of
the Issued or Lent out to client category, a clinical action of the type Record lost article
will be created.

NOTE: A device can be registered as Lost if it is currently not associated with a client. A
transaction like this will not be a clinical action.

The New Status dialog can also be called by scanning a barcode of a device already registered
in the system.

When a new status is selected you can change the Print settings for each status.
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Default print setting for 'FITTED/EXCHAMNGED (|ssued)’ >
Clear Print Preview oK Cancel
Headline text
Print addressee
|iesthead|ine .
# | Client
B Frint article price Number of copies 4 Supplier
M Print supplier data
Body text
Test2 Fs
-
Lower body text
Test3 Fs
-

NOTE: If you have attached clinical actions to appropriate appointments, such clinical
actions can be seen on the Clinical actions tab of the Referral module.
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12.2 Issuing a quantity controlled hearing instrument from
stock

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Select Navigation -> Stock or press Shift+Ctrl+S.

o Select Group.

« Select Supplier.

o Select article/instrument type.

« Select the current stock type for the instrument, for instance Stock existing users.
o Click New status.

o Select the new stock type, for instance Issued.

o Select right or left if required.

« Click OK.
) Auditbase - [Steck] — O *
File Edit Functions Statistics Settings
° & B 8 B A A
ok ¥ = s
Detailed | Quick Importdata | Export data | Exportto Noah  Legoff | Exit Auditbase
Search Import/Export Client data Exit
[J| Client T11605 MISS FIRSTNAME1605 LASTNAME1605 - 8= B |user SYSTEM ADMINISTRATOR All locations
Search Mew status Device List Invoice Requisitions Verification
Group Manufacture Article Stock types
51 A |(3)Testmanu TELE COIL, CHAIR STOCK - GWH (In stock)
Qi antity 2 (4)Testmanu TRAMSETT MIMI INKL. MIK. BATTERIES IN STOCK (Batter

MHS HEARING AID (Serial MNo.)

SPECIAL TECH. AIDS (Quantity
BATTERIES (Qluantity-Accessor
PROCEDURES (Service)

LEADS, RECEIVERS & SHOES w

Show discontinued

AB TRAMSISTOR

TRANSETT MINI SCART

Show discontinued

FITTED/IEXCHAMGED (Issuec

FPOSTAL BATTERIES (Issued

LOAM (Lent out to client)
EACHERS OF THE DEAF (L¢

Service-Accessory SENT FOR REPAIR (Repair)
COMMERCIAL HEARING AID (S DAMAGED (Lost)
EARMOULD ACCESSORIES LOST

ELBOWS OBSOLETE (Lost)

Louisa's sorting (In stock)

Show dizcontinued

W

Article information

lterms found

Aricle infarmation

Reduce quantity

NUM &
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12.3 Issuing a serial number controlled hearing instrument

from stock

o Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation -> Stock or press Shift+Ctrl+S.
o Select the device to be issued by scanning the barcode.

OR

« Select Group, for instance, Commercial hearing aid.
o Select Supplier, for instance, GN Resound.
« Select article/instrument type, for instance, Danalogic 283D.
o Select the current stock type for the instrument, for instance, New Stock.

o Enter the serial number of the instrument in the Filter serial numbers box.

It is important that you enter the serial number of the instrument you are going to issue in
the Filter serial numbers box before you issue the instrument. This will enable tracking of
serial number controlled instruments in the system.

o)) Auditbase - [Stock]

Show discontinued

Show discontinued

— [m] X
File Edit Functions Statistics Settings
o] o) =
(7 =]
Q&+ > @ c -
Detailed | Quick Importdata | Expertdata Exportto Noah Logoff | Exit Auditbase
Search Import/Export Client data Exit
| Client  <T>T18765 MR JOHN SMITH - 2= B user SYSTEM ADMINISTRATOR Multiple locations ~ Multiple departments... |+ £ ?
Search MNew status Device List Invoice Reguisitions Verification
Supplier Model Stock types
(1)Testmanu [ test group ~ |LOAM (Lent outto client) ~
(2)Testmanu UTE10MR TEACHERS OF THE DEAF (L¢
MHS HEARING AID (Serial No.) GMNRESOUND BE102H SENT FOR REPAIR (Repair)
SPECIAL TECH AIDS [Quantity, (123456789 ITE10ML DAMAGED (Lost)
BATTERIES (Quantity-Accessor  (NEEICNRN=e ITE11MR LosT
PROCEDURES (Service) (3 TestManufacturer ITET1ML OBSOLETE (Lost)
Senvice-Accessory BE101 lLouisa's sorting (In stock)
COMMERCIAL HEARING AID (8 BE101B RECONDITIONED (Issued,
EARMOULD ACCESSORIES BE101G REPLACEMENT (Issued)
ELBOWS BE102HF STAFF DEMO'S (Lent out to ot
LEADS, RECEIVERS & SHOES w BE103 v [STOCK-PAEDS (In stock-*15 »

Show discontinued

Article information Serial numper  MBG10068
Aricle [D: 50220 Modified date: 25/09/2006 -
Mo ordered 0 Receiver.
Article type: Version:
Version: Colour: Order by:
MNHS price: £ Type: -
Internal art. no.: Label: A
NHS art. no.: 5577 ltemn no.: ¢ Serial no.
Basic purch. price: £ 43.54 Recycled: Mo i
Discount: % Sales price: £4354 Filter serial numbers
Basic sales price: £ 43.54 Warranty expires:  31/05/2002
Supplier: NHS SUPPLIES Purchase price £4354
Supp. aricle no. GHBO59 Furchase date: 06/06/2000

Battery: CP48

Return date: Edititem

Warranty code:

-
4 ltem 1 out of 2 » |

NUM SCRL

« When the serial number of the device is found, click New status.
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POSTAL BATTERIES (Issued batte

LOAN (Lent out to client)
EACHERS OF THE DEAF (Lent o

SENT FOR REPAIR (Repair)

Show discontinued

Mew status for zerial number: NBGOS238. MNHS SUPPLIES, BE101 X
Client MR JOHMN SMITH Print Settings oK Cancel
From stock type Article name Ear Date
STOCK - GWH (In stock) BE101 R L W ms 10/01/2020 Recycled

Location User

) i SYSTEM ADMINISTRATOR HI Satisfaction questionnaire wanted
Multiple locations. .. - -
. History comment Price TR

£4354 Invoice type 1 -

Item information

Reasontoissue

Invoice

to customer

« Select the new stock type, for instance Damaged - your System Administrator can create
a default ‘next stock type’ for each Stock type to speed this up.

o Select the right or left ear. N/A can be used for articles that are not assigned to a
particular side. If N/A is selected, it will appear as - in the Device list.

o Select the Invoice type - your System Administrator can create a default Invoice type for
the whole site and for an individual workstation to speed this up.

o Select who to invoice to - your System Administrator can save a default invoice for the
whole site and for an individual workstation to speed this up.

o OK.

« If configured by the System Administrator, the system shows a confirmation request.

Stock transaction confirmation

NHS SUPPLIES, BE101, NBG09858|

ta the following client:
T18765 MR JOHN SMITH

Details are the following:

Return date:

Iz the above information correct?

Click Abort to cancel stock transaction

Commit

You are going to issue (lent out - in case of lending out) the following stock article:

Date: 10/01/2020

Invoice to:  Client: T18765 MR JOHN SMITH

Mew stock type: FITTEDVEXCHANGED (lssued)
Side: NiA

Invoice type: Invoice type 2

Price: £43.54

Click Commit to issue (system will make stock transaction)

Click Edit to return to "Mew status” dialog and change some information

Edit

pod

« Commit to issue, Edit to edit data, Abort to interrupt.
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12.4 Issuing devices from Stock after fitting in Noah

In order for devices to be issued from Noah once you have properly programmed and fitted the hearing
instrument, it is important that you have:

« Correctly selected the new instrument you wish to fit.
« Savedthe Noah action.
« Closed the fitting software.

The process reacts on a new or updated saved Hearing Instrument selection action.
In order for the Stock transaction confirmation window to open successfully, you should:

o Ensure Auditbase is NOT minimised to the task bar.
¢ Ensure Noah is NOT minimised to the task bar.

If Auditbase is minimised and you have already saved the fitting process and closed the fitting software,
maximise Auditbase again and the confirmation window will appear.

If Noah is minimised, you have already saved the fitting process and closed the fitting software, click on
the Audit Base screen and the confirmation window will appear.

If you close the Serial numbers found in Noah dialog without issuing, the dialog will not be displayed by
simply connecting to that aid again in the Noah module, a change must be made to the hearing
instrument selection in the fitting module and that change saved before the dialog can reappear.

A pop up box willappear when pressing Close without having completed the stock transaction when
issuing a hearing aid via Noah within Auditbase.

The warning will ask:

Serial numbers found in NOAH

I/_\I Are you sure you want to close the issue dialog without making the suggested stock transaction(z)? This dialog will not appear again for this saved Moah action.
k. * 4

Yes Mo

If you confirm that you wish to close the issue by selecting Yes, an Automatic Journal Event will be fired
asking you to provide a reason why the event is being cancelled. This can be configured by your System
Administrator.
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Journal events

Selected event
1464

Users rejected issuing device after fitting in NOAH

Keyword
ADULT REHABILITATION -

Prompt for user input Allow to cancel event Save unsigned

Issue after fitting in NOAH was activated but rejected by the user SYSTEM ADMINISTRATOR. The devices »
found in NOAH were the following: Serial number: 32423423423EW, Manufacturer: Not found, Article: Not
found, Ear side: R; Serial number: 23423423, Manufacturer: Not found, Article: Not found, Ear side: L;
PLEASE PROVIDE A REASON FOR CANCELLING THE ISSUE

. -

e
il
4
I

o
L]
g
I
(il
]

After closing down Noah, the system may check whether any fitting actions were performed, if
so configured by your System Administrator. A list of the articles found will be displayed.

Serial numbers found in NOAH >
Client MR JOHN SMITH Proceed Close
B Open ‘Accessory issue’ automatically B Open Device list' if another current device is found

Serial number Manufacturer Article |Ear side| Stock type Patient Hospital no. Action
5345345 R ==hot found== Reqgister for stock, then Mew status
64554654654 L ==Mot found== Register for stock, then Mew st
234234934 R ==Not found=>= Register for stock, then Mew statug|
23423423423 L ==Mot found== gsi%mter external ftem

« In the column called Action, you can choose what to do with the articles. Place your
mouse in the cell and an arrow appears, from where you can choose an action in a drop-

down list.

« Once you have chosen actions for all articles found, press ‘Proceed’, where after all
articles are processed one by one.

« The article being processed is now highlighted in the background.

241
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| Client

B Open‘Accessory issue’ automatically
L

MR JOHM SMITH

Proceed

Close

Serial number
5345345
64654654654
234234234
23423423423

3 4 5 6

T Today: 10/01/202

Manufacturer
GNRESOUND | CS61

Article

STOCK - GWH (In stock)

Action

Mew status for serial number: 5345345, GNRESOUMND, CS61

, then Mew status

, then Mew status
. then Mew status

SENT FOR REPAIR (Repair)
DAMAGED (Lost)
LoST v

Show discontinued

Client MR JOHN SMITH Print Settings oK Cancel
" From stock type Article name Ear Date
STOCK - GWH (In stock) CS561 HR L na 1000172020 Recycled
Location ez
. ; SYSTEM ADMINISTRATOR h HI Satisfaction questionnaire wanted
Multiple locations... - i G = -
ToCmIaTE = rice - n\fm.ce type
FITTEDEXCHANGED (lssued) 100007 [Invoice type 1 -
POSTAL BATTERIES (Issued batte Reason to issue
LOAN (Lent outto client) - -
EACHERS OF THE DEAF (Lento e T

to customer

o The above is an example of an article needing a new status.

« The second article in the example is issued to the wrong patient and needs to be issued
to the correct patient. This will be done in two steps: return the article to stock and issue
the article to the new patient.

« If you try to cancel creating a new status for the article in order to return it to stock, you
will be warned that you cannot issue the device without returning it to stock.

« The third article in the example has been set to SKip (duplicate) as it is a duplicate of
another article.

« The fifth article in the example has been set to Register for stock, then New status,

since the stock type was Not found, and therefore the Register for stock window is
opened.
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| Client MR JOHN SMITH Proceed Close

B Open ‘Accessory issue’ automatically B Open Device list if another current device is found
Serial number Manufacturer Article |Ear side| Stock type Patient Hospital no. Action
5345345 GMRESOUND €561 R FITTEDVEXCHANGED (lss JOHN SMITH T18765 Processed

64654654654 L <=Not found==
234234234 tock, then New status
23423423423 Register for stock -, % Jtock, then New status
Sler ev v oow Save Cancel
| 3 4 5 B
E)Today: 10/01/2020| Group Manufacturer Aricles Stock types Serial no.
G STOCK - GWH (In stock) [I¥ R GIRTLEN -
M ! BATTERIES IN STOCK (B
Senvice-Accessory Louisa's sorting (In stock
COMMERCIAL HEARIT STOCK - PAEDS (In stock
EARMOULD ACCESS( Sentto manufacturer (In <
ELBOWS UNTRACEABLE (In Stock

LEADS, RECEIVERS £
MISC. HA ACCESSOR
SERVICES hd Show discontinued hd

Use alphabetic characters in the sequence for this manufacturer, B, |, O, @, S and Z will be skipped

Warranty Item information
Purchase date -
Article 1D
Warranty months
o Itern number
Batt
Warranty code: - By
Colour
Price Version
Purchase price Discounton purchase MNet. purchase price Label
Type
Basic profit 1.23% w
Calc. Sales price

Interface connection

o The serial number is filled in automatically.

o Press OK and the New status window appears.

o Fill out the new status and the article is issued to stock.

o If the patient already has a current serial controlled device for a particular ear, when
issuing from Noah, a setting in System Administration may open the device list for
returning the old device. This can be set per workstation so should be disabled if a user
regularly issues more than one serial controlled device per ear.

Note: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.
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12.5 Edit item

To change details for an item, open the Edit item dialog by selecting Edit -> Edit item or
clicking Edit item.

Edit itemn - serial no. '444', NHS HEARIMG AID (Serial Mo.), MHS SUPPLIES, ITETTME ot
Save Delete Cancel

Serial no. ||4-4-4 ltem number
Purchase price £58.14 Battery CP41
Sales price £0.00 Colour
Purchase date 2110412015 Type

Warranty Expires Label

Version

Article has been recycled Warranty code; 25 Interface connection

[tem infarmation
Bar code

Product ID - App. 1D

User full name tests?97?

The following item details can be changed:

o Serial number; in this case the system changes the serial number in postings if any for
the item. Invoiced postings can also be modified if configured in the Administration tool

o Purchase date if the user has the corresponding right granted

o Purchase and sales prices

o Warranty checkmark and expiration date

o Recycled flag (it is possible to mark a serial number controlled article as Recycled. This
means that the article has been invoiced already and can be reused for another client.
You can mark an article recycled from Item information or when changing the article’s
status in the New status-dialogue.

« Warranty code (Danish)

« Battery

« Colour

o Version

o Label

o Type

o Interface connection flag

o Item information

o Barcode: select Product ID from a Product ID barcode list specified for the article. This ID
is used by the system to identify the item by scanning an item barcode.
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At the bottom of the dialog, name of the user is seen in read only mode. This is a user who
recently performed an action with the item.

o Click Save to save the changes.
« Click Delete to delete the item from the database. Note that this in only possible for
items in stock.
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12.6 Reduce quantity

When you have selected a stock group and related manufacturer, article and stock type, the
number in that stock type can be reduced. Go to Edit -> Reduce quantity.

« The dialog window shows the number of items for the selected article available in
selected stock type.

o Enter the relevant number and press OK to reduce the number of items.

o Deletion must be confirmed before it is complete.

« The stock group must be defined as Quantity type from the Administration tool -> Stock
definitions -> Stock group for this option to be enabled.
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12.7 Add external item

The Add external item window is initiated by selecting Functions -> Add external items ->
Add serial numbers or Add amount controlled articles.

Register external articles *
MR JOHM SMITH Save Cancel
Group Manufacturer Articles Stock types Serial no.

G1 a | (1)Testmanu BE102H Pl FITTED/EXCHANGED (|5 {filia| -
NHS HEARING AID (3 (2)Testmanu ITE10MR POSTAL BATTERIES (I5=1

Senvice-Accessory GMRESOUND ITE10ML LOAN (Lent outto client)

COMMERCIAL HEARII | 123456789 RECOMDITIOMNED (Issue

EARMOULD ACCESSY | |RlgER=ill g siNl == ITET1ML REPLACEMENT (lssued)

ELBOWS (3 TestManufacturer BE101

LEADS, RECEIVERS & BE101B W

MISC. HA ACCESSOR

SERVICES i Show discontinued -

U=se alphabetic characters in the sequence for this manufacturer, B, |, O, @, S and Z will be skipped

Warranty Item infarmation
Ear R L IEA
Purchase date  10/01/2020 P
Article D 50144
Warranty maonths
B [tem number
o Batt CP41
Warranty code: 10 - el
Colour |Ellackj
Price Version
Purchase price Discount on purchase Met purchase price Label
£58.14 - - £58.14 ane
Type
Basic profit 1.23% »
Calc. Sales price £58.86

Interface connection

The dialog is used to register on stock issued items, for instance when a client brings a device,
which is purchased elsewhere, for repair.

You can register Warranty information, Price information, Item information, side of Ear, etc.

For serial numbers, the functionality of the dialog is the same as for the Register for Stock
dialog, with the exception that in this dialog, you register devices directly to stock types of the
Issued category.

For quantity controlled articles, the functionality of the dialog is the same as for the New
Status dialog.

NOTE: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.
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12.8 Moving single articles of stock

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Stock or press Shift+Ctrl+S.

o Select Group.

« Select Supplier.

« Select the article/instrument type.

« Select the current location of Stock type.

o Enter the serial number in Filter for serial numbers box, if required.
o Click New status.

« Select the new stock type.

o Check the number to be moved and click OK.
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12.9 Moving single articles of stock using a Barcode reader

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

Navigation -> Stock or press Shift+Ctrl+S.

« Scan the hearing instrument barcode.

If the hearing instrument is already registered in stock the New status window will open.
Select the new stock type and click OK.

The system will read either the European standard barcodes known as EHIMA bar codes, GS1 long
barcodes or GS1 2D barcodes known as Matrix or QR codes (providing the barcode scanner supports
this type of barcode).

Note: Some barcode scanners will not activate if the mouse cursor is in a read-only text field.
If you find the scanner does not seem to action a barcode, try moving the mouse cursor to an
editable field or list box.
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12.10 Barcode scanning functionality

The system will read either the European standard barcodes known as EHIMA bar codes, GS1
long barcodes, or GS1 2D barcodes known as Matrix or QR codes (providing the barcode
scanner supports this type of barcode).

The typical EHIMA barcode device label looks like the one below. Please note that it consists
of 2 barcodes, both of which must be scanned:

4 GN ReSound A/S o~ <
B2 Cavagaion R IIIIIIIIIIIIII NN 3
DK~ 2750 Ballerup 8 (01) 05704819243966 é
GTIN. (01) 03704818243965 PN ﬂ II
SN: (21) 1686672298 i é
HI,IFCSE1~ DIW,0PEN,MBL (21) 1686672298

The typical 2D barcode device label can look like this:

Issue: 012
2409591

The typical 1D long barcode device label can look like this:

i~

Technical principles of scanning barcodes

The barcode scanner attached to a PC simulates typing on the keyboard. Text input from the
scanner contains a sequence of symbols encoded in the barcode.

To let the system distinguish between the users’ typing and the typing emulated by the
scanner, the scanner must be configured to produce the prefix and suffix strings. These strings
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must be further specified in the Auditbase Administration tool (For details, see Auditbase
Admin Guide, section on ‘Bar code settings’).

Information the system gets from the barcodes

After the barcode scanning is recognized, the system takes the following information for
processing:

« Manufacturer code
o Device model (article) code
e Device serial number

IMPORTANT note for EHIMA device barcodes:

« Both barcodes contain important product-identifying information, so both must be
scanned for the intended processing.

« The 2" parcode contains the device serial number prefixed by the ‘21’string. This
‘21'string is an integral barcode part, and that is how Auditbase recognizes the serial
number. Therefore, ‘21’ is only removed by the system when both barcodes have been
scanned.

o The existing functionality in Auditbase is NOT intended for scanning only the
barcode part of the EHIMA full barcode.

If the content of the recognized string of symbols cannot be interpreted properly (e.g., the
format is wrong), the system displays an error message about the wrong barcode detected at
scanning.

Processing the recognized data

Manufacturer code, article code and the device serial number are processed by the system in
the following way:

« The system will search for the manufacturer using the manufacturer code. If the code is
not found, manual selection will be suggested. After the selection, the code will be saved
to the selected manufacturer (the system will use the saved manufacturer code for all
subsequent searches).

« Then, the system will search for an article within the manufacturer. If the article is not
found, it will suggest manual selection. After the selection, the article code will be saved
to the selected article (the system will use the saved article code for all subsequent
searches).

« Finally, the system will search for the recognized serial number. If the device with that
serial number is found in Stock, the system will assign a New status for that device.
Otherwise, it will initiate Registering to Stock.
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12.11 Bulk transfers of stock

Large numbers of serial controlled articles can be moved from one stock type to another by
using the Bulk transfer option. Articles can only be moved from a stock type with an In stock
category to another type of the same category.

« Navigation -> Stock or press Shift+Ctrl+S.

o Choose Group, Supplier, Article and Stock type to move the stock from.
« Functions

o Bulk Transfer

Stock bulk transfer K
Source stock type STOCK - GWH (In stock) Close
Select serial numbers (Step 1) Transfer selected devices (Step2)
Group Supplier Model Location
G1 (1)Testmanu [ test aroup ~ } Location1 M
NHS HEARING AID (Serial No.) (2)Testmanu BE102H
Senice-Accessory GNRESOUND ITE10ML New stock type
COMMERCIAL HEARING AID (Seri 123456789 ITE11MR Sent to manufacturer (In stock)  JRd
EARMOULD ACCESSORIES MNHS SUPPLIES
ITE11ML User
ELBOWS (3)Testhanufacturer BE101
LEADS, RECEIVERS & SHOES BE101E SYSTEM ADMINISTRATOR -
MISC. HA ACCESSORIES BE101G i
History comment
SERVICES BE102HF ¥
TINNITLS DEVICES BE103 -
BE105 v

Devices in stock Select all Selected devices | Select all

w

|Seria| numeer ~ | Device
[1/NBG41775 NBG27965, BE101, NHS SUPPLIES Add te item information
[ NBG41776 MBG27955, BE101, NHS SUPPLIES -
[ NBG41777 » MBG27959 BE101, NHS SUPPLIES
1/ NBG41778 MBG27960, BE101, NHS SUPPLIES
[0/ NBG41764 4 MBG27964, BE101, NHS SUPPLIES -
[ NBG41765 MBG41774, BE101, NHS SUPPLIES
MNBG41766

0 Transfer
[ NBG41767 Y]

o Select Group, Supplier and Article and the serial numbers for the articles that are in
stock will appear in the Devices in stock window.

o Select the required articles to transfer by checking the box next to the serial number.
Select all can be chosen.

o Once the articles have been chosen, use the arrow to move them to the Selected
devices window.

« At this stage, articles can still be moved back to Devices in stock by unchecking Select
all, checking the required serial number and use the back arrow to de-select an item.

« Select Location (only an option if your site has the appropriate license).

o Select New stock type from the drop-down menu. Only stock types with the stock
category of In stock will be displayed.

« Information can be added to the History comment and Add to item information boxes.

o Transfer

« A confirmation message will appear letting you know how many articles were transferred.
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Stock bulk transfer X

& stock tems have been successfully transfemed

—

« OK the information message.
o Further articles can then be transferred or Close the transfer window.
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12.12 F10 Fast battery issue

Iltems in one stock group can be set up as a quick stock issue group by the System
Administrator. If this is set up, use the following procedure:

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

o Press F10.

o Select Manufacturer.

o Select Article.

« Manufacturer and Article will depend on the Group which has been selected for Fast
battery issue when the Groups were set up.

« The Date and Signature are automatically filled in but can be manually changed if
required.

« The Invoice type is optional and is not generally used.

o The Customer must be selected.

o The client's name is displayed. If this is not required, check the Invoice without client
reference box, and the client's name will disappear.

« Choose the number of items that are having their status changed and enter the New
NHS serial number if required.

NOTE: Changes in article status create clinical actions. If you have attached them to
appropriate appointments, they can be seen in the Clinical actions tab of the Referral
module.

o Click on OK and the information will be saved and the window will close.
« If you want to close the window without saving, select Cancel.

Battery issue x
Client MRS FIRSTMNAME10T LASTMNAME107 Print Settings QK Cancel
Manufacturer Article Date User
{5)Testmanu 13 10/01/2020 full name tests?77? hd
(B)Testmanu 675
NHS SUPPLIES 675 COCHLEAR IMPLANT ) )
312 Mo. ofitems Invoice type
10 1 Invoice type 1 -
AATMMNAE00)
AAAIMMNZ400) )
Invoice
Customer
*) to customer v
to client Invaice without client reference
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12.13 Search for a serial number

« Navigation -> Stock or press Shift+Ctrl+S.
o Click Search.

Search for serial no. >

Search | Searchin NOAH — Close

Serial no. | 234 |

Cluantity found 5

Found items
Serial no. 234 4 Previous || Next P
Group MHS HEARIMG AID (Serial Mew status History
Manufacturer MHS SUPPLIES Select
Article ITET1ML

Stock type FITTED/EXCHAMGED (155U
Location All

Recycled No

Client
Hospital no. T1106 Change to
Mame MRS FIRSTMAME106 LASTHNAME106

o Enter the serial number.

« Click Search.

« Note that the complete serial number is not required to search. As with a client search, if
the first part of a serial number, for instance F412, is entered, Auditbase will display all
serial numbers beginning with F412.

« The system shows the number of found items in Quantity found. You can scroll through
them by clicking the arrow buttons.

« When you select an item, you can click New Status to open the New Status dialog.

« The History button initiates the History dialog for the item selected.

« Click Select to show in the main Stock screen.

o Another way to search for a serial number is to select the relevant Group, Supplier,
Article and Stock type, then enter the serial number in the Filter serial numbers field.
The information for this item will appear in the box below.

« You can also search by entering the first part of a serial number. If more than one item is
found, the system shows the number of found items below the item information box and
arrow buttons scroll over the items.
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12.14 Search for serial number in Noah

« Navigation -> Stock or press Shift+Ctrl+S.

o Click Search.

Search for senal no.

Search

Search in MOAH | Close

*

Serial no. 234

Cluantity found
Found items
Serial no.

Group
Manufacturer
Article

Stock type
Location

Recycled

Client
Haospital no.

Mame

4 Previous Mext
Mew status History
Select

Change to

»

o Enter the serial number.
o Click Search in Noah.

« Now you can search for the serial number in Noah fitting actions.
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Search NOAH for serial number >

Search in MOAH fitting actions Close

MOAH fitting actions

Search

Serial number: 234 | M Suspend search on most recent occurrence found
Date from: 130112019 to;  13/0142020
Client Hospital no. | MHS nao. Action date\time Action description Username

« The Date from field is automatically set to a year since today’s date and the to field is set
to today’s date.

o Check the box Suspend search on most recent occurrence found to stop the search at
the most recent match.

« Click Find next to continue the search.

« Select a fitting action and click Close to return to the Search window, where you can
enter a New status, see the History or Select the article to show it in the main Stock
module. The client will also change in Auditbase, if different from the previously selected
client.
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12.15 Item and article information

« Select Functions -> Item information to open a window to enter information about an
item, for instance settings and special conditions.

« Select Functions -> Article information to open a window to enter information about an
article, for instance settings and special conditions.
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12.16 Register for Stock

Registering items to increase stock is done manually or by using a bar code reader.

Navigation -> Stock or press Shift+Ctrl+S.

Select Group and Manufacturer.

Select Functions.

Select Register for stock manually and add the relevant items.

Save Cancel
' Group Manufacturer Articles Stock types Serial no.
ey A (1)Testmanu STOCK - GWH (In stock) s
W NHS HEARING AID (5 (2)Testmanu BATTERIES IM STOCK (B
| Service-Accessory 123456789 TEACHERS OF THE DEA
COMMERCIAL HEARIE NHS SUPPLIES ITET1TMR Louisa's sorting (In stock
EARMOULD ACCESSH ITE11ML STAFF DEMO'S (Lent out
| |[ELBOWS BE101 STOCK - PAEDS (In stock
| LEADS, RECEIVERS ¢ BE101B w | Sentto manufacturer {In =
MISC. HA ACCESSOR UNTRACEABLE (In Stock
| SERVICES v Show discontinued -
| Uze alphabetic characters in the sequence for this manufacturer, B, |, O, Q, 5 and Z will be skipped
Warranty Item infarmation
Purchase date  20/01/2020 -
Aricle ID 50388
W Warranty 12 months
Item number
| Expires 2000152021 3
Batte
Warranty code: 10 - .
Colour "
Price Version a3
Purchase price Discount on purchase MNet. purchase price -
£6.00 - % = £5.53 ave
Ti 22
Basic profit 0.00% ype
Employee USER MAME44 - I
Calc. Sales price £558

Interface connection | |

Your System Administrator can define whether the type is Serial number or Quantity
controlled.

+« When scanning any new item with the bar code reader the system will open the Register
for Stock dialog automatically. Once opened the Manufacturers that the manufacturer
element of the barcode has been used for before will be highlighted in blue. The user
must select either one of these or a another one if the item comes from a different
manufacturer (Note that due to HIMSA rules it is allowed for manufacturers to supply
items as OEM to other manufacturers while retaining the original manufacturer's
barcode). If only one Manufacturer has been used previously with the manufacturer
element of this barcode that Manufacturer will be preselected.

« If registering for stock using a bar code scanner, the Group and Manufacturer must be
selected before scanning bar codes as the same Manufacturer could exist in multiple
stock groups.

« When registering for stock the following fields can be filled in:
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Type: Serial number

« Available articles of the selected group/manufacturer are listed together. Select the
Article and Stock type, this is generally Stock or In Stock, depending what it has been
called and enter the Serial number of the Articles that are being registered.

o A number of articles can be entered by separating the numbers with a comma, i.e. FG6
453678,BH1 678125 to register these two articles. Ensure that there are no spaces after
the comma or it will be taken as a character.

« A series of numbers can be entered by separating the first number in the series and the
last number in the series with a semicolon, i.e. 100;120 will add all serial numbers
between 100 and 120. Ensure that there are no spaces after the semicolon or it will be
taken as a character. Certain letters can also be used in the sequence if enabled for that
manufacturer, see the text on the dialog for details.

« The Warranty date can be added by selecting the Warranty check box and adding the
number.

o The Purchase price incl. vat and Sales price incl. vat is automatically entered from the
Article information. If the window is initiated by barcode scanning, the purchase price is
taken from the barcode. These are manually adjustable if required. Battery and Colour
are also automatically entered if they have been set up and can be changed.

« When registering a Serial Number controlled device to Stock, Users can select the Stock
Category “Lent out to other” and register a device to the Employee’s name.

« Save the entry, and more can be added.

Type: Quantity

Add articles to stock - BATTERIES (Quantity-Accessory), MHS SUPPLIES X

Close
Article Stock type Aricle ID
10 STOCK - GWH (In stoc/a
13 BATTERIES IN STOCK
312 HOLDING STOCK Quantity
G675 Louisa's sorting (In st
675 COCHLEAR IMPL STOCHK - PAEDS (In st
A4 (MM1500) Sentto manufacturer
AAA (MBM2400) UNTRACEABLE (In St Furchase date
STOCK - DV BOX
STOCK - OUTREACH 13/01/2020
STOCK - SAVERMAKE
From repair sample
Auto created - 1
Show discontinued Auto created - 14 -

o The Stock registration window is opened and a list of available Articles is displayed.
Select the Article and Stock type, this is generally Stock or In Stock, depending what it
has been called and enter the number of Articles that are being registered. When
registering for stock it is now possible to hide the discontinued stock; if you wish to show
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the discontinued stock then the button should be selected and the discontinued items
will be shown.

« The Purchase date is automatically entered as the current date but can be changed
manually if the user has the corresponding right granted.
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12.17 Stock verification using a barcode reader

« Navigation -> Stock verification or press Shift+Ctrl+V.

« Specify the parameters needed in the Session list tab; choose which stock you would

like to verify based on Locations, on categories of In stock, Repair and Lost, and on Stock
Groups, Manufacturers, Articles and Stock types. Either one or all of each criterion must

be selected. Selected criteria appear in the lower boxes.

Comments Created by
- SYSTEMADMINISTRATOR

-
Stock to be verified
M All locations Categories All stock groups All manufacturers All articles
& Test group 2 B In stock G1 Y
Location MHS HEARING AIC
Taw Hill B Repair Service-Accessory
Location2 COMMERCIAL HE
Testd M Lost EARMOULD ACCE™
All locations a In stock - - - -
Repair
Lost
- w b w -
Lock stock for verification
Complete session Completed by

Cancel and discard session

Summary of conditions

Verified Mot in Auditbase Other stock Mot verified

0)) Auditbase - [Stock verification] - O x
Eile Functions
c A BREB B 8 B A 4
o, | &8 = > e U =
Detailed | Quick  Sawe | Printlist |mportdata = Export data  Exportto Moah Logoff | Exit Auditbase
Search Stock verification Import/Export Client data Excit
LI| Client <T>T18765 MR JOHN SMITH -2 = |Bl|user SYSTEM ADMINISTRATOR All locations A
Session list | Session details
Stack verification sessions I | New Save Delete Print Export

All stock types

Auto created - 1 FY

Auto created - 14
Auto created - 16
Auto created - 17

Auto created - 21 |7

an

« Click on Lock stock for verification in order to prevent stock modification by other users

while verifying.
« Now scan the barcodes one by one.
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(1987654
[/ a76543

COMM PHOMNAK
COMM PHONAK
COMM PHONAK

[ #TEMP#1( NHS K NHS SUPPLI
[ #TEMP#1( NHS K NHS SUPPLI
[ #TEMP#1{ NHS H NHS SUPPLI
[ #TEMP#1( NHS K NHS SUPPLI
[1 #TEMP#1( NHS K NHS SUPPLI

PICO ¢ Auto creaté Mot verifie
PICO ¢ STOCK - C Mot verifie
PICO ( STOCK - C Mot verifie
BE19 | Auto creaté Mot verifie
BE34 | Auto creats Mot verifie
BE101 Auto create Mot verifie
BE38 Auto creaté Mot verifie
BE38 Auto creats Mot verifie

Oil Audithase - [Stock verification] — O =
File Functions
O O = =
5 = o
o, ok = =3 e -»
Detailed | Quick  Save | Printlist |mportdata | Export data | Exportto Neah  Logoff | Exit Auditbase
Search Stock verification Import/Expert Client data Exit
| Client <T=T18765 MR JOHN SMITH - || A | X[ Bl |User SYSTEM ADMINISTRATOR All locations -
Session list || Session details
Refresh Print
Select all 1 IS Registe C ge Delete Search in NOAH Add device
Serial Mo. | Group | Manufacturer | Article | StockType | Condition ~

[/ 123456 | COMM WIDEX LOGO| Auto create Mot verifie
[] #TEMP#1{ NHS F NHS SUPPLI BE101 Auto create Mot verifie
[/ 32032 MHS F NHS SUPPLI BWE4 | STOCK - C Mot verifie
[ 32041 MHS F NHS SUPPLI BW&4 | STOCK - C Mot verifie W
Last scanned barcoda
Stock group SN o &
Manufacturer Stock type
Aricle Condition
Summary of conditions
Verified 0 MNotinAuditbase 0 Other stock 0 Notverified 6827

« After each scan, the system recognizes the scanned barcode and searches for the
scanned serial number on stock.

« Depending on the search result, the scanned articles are given a condition.

o The following conditions are possible:

Verified - the article is on stock and has been scanned

Not in Auditbase - the article has been scanned but is not available on stock neither in the
stock that has been locked for verification nor in the stock that hasn’t been locked

Other stock - the article has been scanned but it was found in the stock that hasn’t been
locked for verification

Not verified - the article is on stock but hasn’t been scanned yet (this is the initial status for
all articles on stock)
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« During the scan, the Summary of conditions is shown.

« Once the conditions are shown, the statuses that are not satisfactory can be edited i.e. by
moving the article to a different stock type with the New status button or using the
Register for stock button to register those articles to stock that are Not in Auditbase.
Change condition can be used to change the outcome of the verification manually.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate clinical actions, they can be seen in the Clinical actions tab of the Referral
module.

« With Add device you can manually add a device, if for instance a barcode cannot be
read. Once the session is saved, the system searches for the device and changes its
condition.

« Once the verification is finalised, go back to the Session list-tab.

e You may add comments to the session, a note about the result or to a colleague who is
working with you.

e You can now export the session data to a CSV file by clicking Export. The current date will
be the 15t row, site name (which is retrieved from the system administration tool/General
settings/Database site name) is the 2"d row, the number of detailed rows is the 3" row
and headers on the table columns on the Session details-tab is the 41" row. The
destination file now contains the values that are visible on the Session details-tab.

« Click on Complete session to save the changes made and open up the stock for other
users.
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12.18 Requisition

The requisition window is for an audiologist to fill in, if a particular hearing instrument should
be ordered for a client or for keeping stock level(s).

Ordering items for stock follows one or more steps involving System requisition and Purchase
orders.

Requisitions X

Close

MNew requisition
Date 12/05/2021 M Forselected client MRS FIRSTNAMES2 LASTNAMESZ User SYSTEM ADMINISTRATOR -

Select article
Group Manufacturer Article

[ test group -

A |(1)Testmanu

MHS HEARING AID (Serial No.)
SPECIAL TECH. AIDS (Quantity)
BATTERIES (Quantity-Accessary)
Senice-Accessory

COMMERCIAL HEARING AID (Serial Mo.)
EARMOULD ACCESSORIES

ELBOWS

LEADS, RECEIVERS & SHOES

MISC. HA ACCESSORIES W

(3)TestManufacturer

Show dizcontived Filte part of article name A4
Quantity 2 Colour BEIGE\ Audiogram 12/02/2021, no. 1
Initial registration to in-house stock type Deliver by 12/07/2021 toarrive 7 days before next appointment Clear
To in stock Stock type TEACHERS OF THE DEAF (Lento 1211412021, GWH AUDIO ASSESS~ =0
# To lent out to employee Employee SYSTEM ADMINISTRATOR -
Requisition list
New purchase order e
Quantity|Amc\e ID| Model description Ordered by Stock type Date Deliver to | Deliver by | Colour |Hnspita| ne A
2 50265 |MHS SUPPLIES, BE101G | SYSTEM ADMINISTRATOR 12/05/2021 | SYSTEMADMINISTRATOR. | 1212/2021 |BLUE |T110017
2 50265 |MHS SUPPLIES, BE101G | SYSTEM ADMINISTRATOR 12/05/2021 | SYSTEM ADMINISTRATOR
2 50252 |MNHS SUPPLIES, BE105 |SYSTEMADMINISTRATOR STOCK - GWH (In stock) 12/05/2021 | STOCK - GWH (In stock) | 12/24/2021 | BLACK |T110017
2 50223 | MHS SUPPLIES, BE34 SYSTEMADMINISTRATOR 12/05/2021 | SYSTEM ADMIMNISTRATOR. BEIGE |T123
4 50220 |MHS SUPPLIES, BE101 |SYSTEMADMINISTRATOR TEACHERS OF THE DEAF (Lent outto other) | 12/05/2021 | SYSTEMADMINISTRATOR

To create a new requisition:

1. Choose whether an article(s) is due for selected client or no client using the check box
at the top.
2. Select an article from Group/Manufacturer/Article going through the hierarchy as it is
displayed in the Stock module.
3. Specify quantity (mandatory).
4. Define colour (optional).
5. Choose an Audiogram if it is needed on Order form for the manufacturer. This option is
only available for selected client and defaults to the latest audiogram.
6. Select a Stock type for the initial registration of the article (within a session, this value is
remembered inside the form). Opt for either of the following:
o Toin Stock
o To Lent out to Employee (Employee will default to the current user. When
requisitioning for yourself, use this default as a fast option).
7. Deliver by
« When selected client is chosen, the next appointment appears. The 'Deliver by'
date is set by the System Administrator for a specified number of days before the
client's next appointment. This date can be altered manually.
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o If the requisition is not created for a selected client, the 'Deliver by' date should be

entered manually.
8. Clear removes all selections.
9. On Save, the new requisition appears in the 'Requisition list' table below.
« If more articles are required from the same manufacturer, clicking Save will clear

the Article, Quantity, Colour and Deliver by fields which are then free to specify
additional articles for the Requisition list.
o Note that Group, Manufacturer and Stock type will keep the information.

On the Requisition list table, all the details of the Requisitions are shown (Stock type, Deliver
by date, Audiogram date and Patient identifier):

e« The table can be re-ordered as usual
« Yellow highlighted quantity is editable

Delete an existing order form line (done when ordered) by clicking on it and then clicking
Delete.

The New purchase order button will open a 'Purchase order' form for whichever requisition is
selected in the table.
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12.19 Purchase orders

The 'Purchase orders' dialog is used to order requested articles. To open the dialog, select
Functions -> Purchase orders from the Stock module or click on 'Purchase orders' in the

Navigation menu.

0)) Auditbase - [Stock]

File Edit Functions Statistics Settings
R = = (&6 i
Q ® 58 ? L
tern | Article | Group  Search serial no.  Register forstock  Add external items  Mew status | Bulktransfer  Batteryissue = Fast accessoriesissue  Purchase orders  Add service to order

The dialog contains:

Show orders list button that opens the list of existing orders.
'Order details' section where order information is entered.

1

2.

3. 'Order status' section designed for order tracking.

4. 'Requisitions and articles' table listing requisitions that can be included in the order. For

existing orders, the lower part of the dialog will show the 'Order details' table.
5. Print, New, Save and Cancel controls.

Purchase orders and deliveries *
Client MRS FIRSTNAMES2 LASTNAMES2 Bk New S Cancel
Create/Edit Purchase orders | Register deliveries | Delivery status overview
Show orders list
Order details
Supplier MNHS SUPPLIES - W For selected client Mote
Order 1D Order type -
Your reference Delivery week Order date 12/05/2021
Referring agent Terms of delivery VAT -
Deliver to Location1 - Packaging TP. number
Delivery time Immediate Terms of payment 30 days Special instructions
Hospital order no Tender date Number of lines
Ord Tender no. Batch no
Order fully received Printed
Requisitions and articles below orderfwarning-levels
Stock type Ordered by Req. date | Colour| Hospital no. [NHS no.| Deliver
TEACHERS OF THE DEAF (Lent outto other) SYSTEMADMINISTRATOR. | 12/05/2021 | BEIGE T192

12.19.1 Create/edit/print a purchase order

Create
To create an order:

1. Click New on the 'Purchase orders' dialog
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Purchase orders and deliveries X

Client MRS FIRSTNAMES2 LASTNAMES2 Print New Save Cancel

Create/Edit Purchase orders | Register deliveries | Delivery status overview

Show orders list
Order details

Supplier NHS SUPPLIES - For selected client Mote

Order ID Order type -

Your reference Delivery week Order date 12/05/2021

Referring agent Terms of delivery VAT -
Deliver to - Packaging TP.number

or New purchase order in the 'Requisition' form.

Requisition list

New purchase order Delete

Quantity | Article ID Model description Ordered by Stock type Date Deliver to Deliver by | Colour [Hospital ne
2 NHS SUPPLIES, BE101 | SYSTEMADMINISTRATOR | TEACHERS OF THE DEAF (Lent outto other) | 12/05/2021 | SYSTEMADMINISTRATOR. | 12/07/2021 BEIGE | T192

2 50265 | NHS SUPPLIES, BE101G | SYSTEMADMINISTRATOR 12/05/2021 | SYSTEMADMINISTRATOR | 12/12/2021 BLUE |T110017

2 50265 | NHS3 SUPPLIES, BE101G | SYSTEMADMINISTRATOR 12/05/2021 | SYSTEM ADMINISTRATOR

2 50252 | WHS SUPPLIES, BE105 | SYSTEMADMINISTRATOR | STOCK - GWH (In stock) 12/05/2021 | STOCK - GWH (In stock) 12/24/2021 BLACK | T110017

2. Select the required supplier from the drop-down list.
« Coming from the Requisition form, the supplier and requisition will be preselected.
3. Select the type of order (optional).
4. 'For selected client' filter will display requisitions for that client only.
o Thisfilter is only available if the global client has been selected on the main
screen.
5. Specify order details in the 'Order details' section.
6. Choose 'Deliver to' from the list of Locations.
7. Click Note to enter any comments for the article.
8. Highlight the requisitions to be ordered. Multiple requisitions can be highlighted by
clicking and holding down Ctrl or Shift.
9. Save. The order is now assigned a unique reference (DD-MM-YYYY, No.) and entered into
the Existing orders list.

10. On Save, the 'Order details' table is shown at the bottom of the 'Purchase orders' form. In
the 'Order details' table, fields highlighted in yellow are editable (e.g., Quantity, Received
quantity, Requisition date, Colour, Deliver by).

o Change the number of articles and colour as required.
« Changes can be made directly in the table by clicking the corresponding cell.

11. Fill 'Received' to complete the receipt of the order without triggering Stock Registration.

12. 'Order fully received' is ticked automatically when the received quantity matches the
ordered quantity.

Edit

Existing orders can be updated.

To update an order:
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1. Click the button Show orders list. This will open a separate pop-up with the list of
orders.
2. Use filters to quickly find your order:
o Choose supplier to show orders for a certain supplier.
o Select the relevant order type to display orders only of this type.
« Toview all orders, select Include fully received orders. Fully received orders are
excluded by default.
« If necessary, use additional column filtering on table columns (NOTE: All Order
columns can be pre-filtered).

Refresh = if some of the list content has changed (e.g., an order received a new
status or more orders have been added).

Use the [ icon to dock and undock the dialog within the 'Purchase orders' form.

3. Once the order has been selected and the relevant information loaded into the 'Purchase
orders' form, you can make the needed changes to your order.
« Forinstance, orders can be approved and marked as received by selecting the
Order status check boxes. When the orders are received, the received quantity can
be entered in the column next to the quantity ordered.

Print
To print an order, click Print.

You can choose a Standard printout template or you can configure a Word document template
to be used for printing purchase orders. For more information on templates, refer to Documents
and attachments.

NOTE that your order must be patient-related to use Word templates.

To add a template to the 'Print pop-up menu'

Go to the Documents and attachments module.

Select your template in Document type > All template documents.
Go to Functions > Properties.

Tick Available in module - Purchase order.

Save.

apwONRE

To apply a new template
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Go back to the Purchase order screen.
2. Select your order from the Orders list (Navigate to the list using the Show orders list

button).
3. From the Print menu, choose the newly added template.

=

If you do not need a certain template to be shown in the 'Print pop-up menu', follow steps 1-3
from the procedure above and remove the selection from Available in module - Purchase

order.

If the Purchase order has been printed out as a document, this document will be attached in
the Printed area of the 'Order details' section of the 'Purchase order' form.

« You can open this order printout to make changes, or detach if it is no longer needed.

Purchase orders and deliveries X —

Client MRS FIRSTNAME92 LASTNAWMED2 Print Mew Save Cancel

Create/Edit Purchase orders | Register deliveries | Delivery status overview

Show orders list
Order details

Supplier MNHS SUPPLIES Note
Order ID 54 Order type -
Your reference Delivery week Order date 1210512021
Referring agent Terms of delivery VAT -
Deliverto Laocation1 - Packaging TP number
Delivery time Immediate Terms of payment 30 days Special instructions
Hospital order no. Tender date Mumber of lines
Order status Tender no Batch no.
Order approved Order fully received Printed 12/08/2021, Headed letter template I-—l
Open
Order details
Detach
Quanmy‘ Supplier art. no Model description |Received|Unil price | Total price Stock type | Ordered by Req. date ‘CuluurlHUspital nu.lNHS T
2 GHB059 MHS SUPPLIES, BE101 |1 54354 | $87.08 TEACHERS OF THE DEAF (Lent outto other) | SYSTEMADMINISTRATOR | 12/05/2021 BEIGE |T192 54

12.19.2 Register deliveries

After devices have been received, they should be registered as delivered on order and
registered to stock. To do so, go to the Register deliveries tab.

There are two ways to enter device information:

« With a barcode reader
« Manually
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Purchase orders and deliveries X

Client MRS FIRSTNAMES2 LASTNAMED2 Cancel

Create/Edit Purchase orders | Register deliveries | Delivery status ovenview

Supplier NHS SUPPLIES - Requisition date from | 10/19/2021
Manufacturer NHS HEARING AID (Serial No.), NHS SUPPLIES -~ Aticle BE101 -
Reqgister to stock
Filter by Client or Order ID | T192 o =

Quantity | Supplier art. no Model description Received | Unit price | Total price Stock type Ordered by Req. date | Colour|Hospital no.| NHS no. | Order ID| Deliver by
54 12 21

NHS SUPPLIES, BE101 |1 $43.5. k TEACHERS OF THE DEA SY L M 2021 BEIGE |T192

< >
Register delivered requisition items to stock
Serial number(s)

333456 Initial registration to in-house - stock type  TEACHERS OF THE DEAF (Lent out to other) ~ Ear MR L NIA
Employee SYSTEM ADMINISTRATOR -
Lend outto patient - stock type | {MeENSN{=1,) Q001§ (e T 108 - Register to stock

To register, follow these steps:

1. Search an ordered requisition by selecting Supplier, Manufacturer and Article. When
you scan the barcode with a reader, all these fields will be filled automatically.

2. Select a requisition

« For faster selection, filter by Client or Order ID.

3. Enter a serial number of the delivered item. Several serial numbers need to be separated
by commas without additional spacing. To separate a range of numbers, use a semicolon
without additional spacing.

« Each item needs to be registered separately.
« When using a barcode reader, the serial number of the device is filled
automatically.

4. Choose 'Initial registration to in-house - stock type' and employee if registered as 'Lent
out to employee'

o For patient-related items, additionally select 'Lent out to patient - stock type' and
ear side.

5. Click Register to stock

« Each stock transaction needs to be confirmed if this is configured in the
administration tool.

« Additionally, information on delivered items can be attached to patient
appointments and registered in journal.
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Stock transaction confirmation X

You are going to issue (lent out - in case of lending out) the following stock article:
NHS SUPPLIES, BE101, 333456

to the following client:
T192 MRS FIRSTNAMES2 LASTNAME92

Details are the following:

Mew stock type: LOAN (Lent out to client)

Side: R Date: 12/06/2021
Invoice type: Invoice to:  Client: T192 MRS FIRSTHAMES2 LASTNAMES2
Price: $43.54

Return date:

Is information above correct?

Click Commit if correct (system will make stock transaction)
Click Skip to cancel the current stock transaction

Click Abort to return to "Purchase orders™ dialog and change some information

Commit Skip Abort

12.19.3 Delivery status overview

The Delivery status overview can be used to review the status of existing deliveries (e.g., partial,
missing, complete).

Users can filter results by:

Supplier

[ )
o Delivery date
o 'Delivery from ... to..." can limit the number of orders by specifying the date range
when these deliveries are expected.
+ Whether only a part or the entire order is missing
o 'Show not delivered only' check box is selected by default to limit the list to
outstanding deliveries. You may clear this selection to see old orders.
+ Requisition date
o 'Requisition date from' defaults to the date ONE month from the current date. It is
used to remove old irrelevant records from search results.
Purchase orders and deliveries *
Client MRS FIRSTNAME92 LASTNAMES2 Cancel
Create/Edit Purchase orders | Register deliveries | Delivery status overview
Supplier NHS SUPPLIES - Requisition date from | 11/06/2021
Delivery fram 13002021 to 1212212021 Show nat delivered only <)
Quantity|Supplierart.no|  Model description | Received| Unit price | Total price Stock type [ Ordered by Req. date | Colour |Hospital no. | NHS no. | Order
8 GHBO42 MHS SUPPLIES, BE103 |0 $33.53 $268.24 | TEACHERS OF THE DEAF (Lent outto other) | SYSTEMADMINISTRATOR | 11/30/2021 | BLACK 45
2 GHBO59 MHS SUPPLIES, BE101 | 2 $4354 BB7.08 STOCK - GWH (In stock) SYSTEMADMINISTRATOR | 11/29/2021 | BEIGE | T110013 41
2 MHS SUPPLIES, BE101 | 2 $ TEACHERS OF THE DEAF (Lent outto other) | SYSTEMADMINISTRATOR |12 21 |BEIGE |T192
7 GHBO03 MHS SUPPLIES, BE18 |5 $23.95 |$167.685 |STOCK- GWH (In stock) SYSTEMADMINISTRATOR | 11/30/2021 NUDE |T110013 47
6 GHBO02 MHS SUPPLIES, BE18 |6 $23.95 $14370 |STOCK-GWH (In stock) SYSTEMADMINISTRATOR | 12/02/2021 |BEIGE 49
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12.20 Purchase statistics

In this window, statistics of article purchases is retrieved. To open the dialog, select Statistics -
> Purchase statistics from the Stock module.

Purchase statistics for serial numbers

Erint Exportto C3

Close

Search parameters
Group Manufacturer

MHS HEARIMNG AID (Serial Mo.)
Senvice-Accessory
COMMERCIAL HEARING AID (£
EARMOULD ACCESSORIES
ELBOWS

LEADS, RECEIVERS & SHOES

SERVICES

G1 NHS SUPPLIES

Period
From  14/01/2019
To 1410142020

Mode

Summary of articles
# Summary of article groups

TINMITUS DEVICES

Statistics

Detailed

Manufacturer |Man. code

Article group | Aricle |»\rt. code|0uamit3t|T0taI Price

NHS SUPPLIES

BEA1 (BOOKLET) 1 £0.13

Intotal A Total price £0.13

Statistics are calculated based on registered devices in stock.

Selecting Group lists the Manufacturers defined in this group.

Selecting two and more groups selects all manufacturers of these groups and clears the
list of manufacturers. Select or deselect a group by clicking on it in the list.

If a single group is selected, one or more, or all, manufacturers from the list can be
highlighted.

Add or deselect manufacturer(s) by clicking in the list. Selecting none of the
manufacturers implies selecting all.

You can specify whether statistics should be done on Summary of articles, Summary of
article groups or Detailed. Summary calculates totals per manufacturer/device,
Detailed shows serial numbers.

Specifying a purchase period in From and To limits statistics to the selected date range.
Click Show to calculate the statistics. The results of the calculation are shown in the
Statistics table. Below the table the total number of purchased devices and the total
purchase price is shown.

When statistics are calculated, you can print the results by clicking Print.

Detailed statistics can be exported to a comma-separated (CSV) file by clicking Export to
CSv.
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12.21 Stock statistics

To open the dialog, select Statistics -> Stock Statistics from the Stock module. In this window

statistics for activities in stock are retrieved.

Stock statistics K
Statistic type  Serial numbers Export to CSV Print Show Close
Group Manufacturer Selectall  Aricle Selectall Stock type
G1 4| (1)Testmanu BE102H Y
CQuuantity 2 (2)Testmanu ITE10MR
NHS HEARING AID (Seria GMRESOUND ITE10ML FITTED/EXCHANGED (lss
SPECIAL TECH. AIDS (Qu 123456739 ITETMR POSTAL BATTERIES (Issu
BATTERIES (Quantity-Acc NHS SUPPLIES ITETIML LOAN (Lent cut to client)
PROCEDURES (Service) (3)TestManufacturer BE101 TEACHERS OF THE DEAF
Senice-Accessory BE101B SENT FOR REPAIR (Repa
COMMERCIAL HEARING BE101G DAMAGED (Lost)
EARMOULD ACCESSORI BE102HF ¥| LosT
ELBOWS hd Mo dsconEnued OBSCOLETE (Lost) hd
Options and conditions
# |n total Peritem Recycled articles only
#| Current status Transactions
« Totals on articles Totals on article groups
Mew stock type | Manufacturer Article |{1ty. | Price | Article type
STOCK - GWH (In stock) | MHS SUPPLIES | BE102H 1| £100.16 OTOSTOR
STOCK - GWH (In stock) | MHS SUPPLIES ITE10MR | 5 £303.27 MODULAR ITE
Average price £67.24 Total & Total price £403.43

The leftmost list contains stock groups. Depending on the group selected, statistics are

calculated for serial numbers, quantity-controlled articles or services.

12.21.1 Statistics for serial numbers

o Statistics for serial numbers can be calculated in total (summary statistics) or per item

(detailed statistics) by selecting the corresponding option.

« Detailed statistics can be calculated with or without mention of a client by selecting or

deselecting Client reference.

« Select Recycled articles only to calculate statistics for the recycled devices only. This can
be calculated for current stock status or on the basis of transactions by selecting this
option. If this option is selected, statistics can be restricted for a time range and user-

performed transactions.

« One or more manufacturers can be selected by clicking in the Manufacturer list.

o All manufacturers can quickly be selected by checking the Select all box.

o Statistics will be filtered for the selected manufacturers.
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« If asingle manufacturer is selected, one or more articles of this manufacturer can be
selected by clicking in the Article list.

« All articles can quickly be selected by checking the Select all box.

o Selecting more than one manufacturer implies selecting all the articles from these
manufacturers.

« For Current status statistics, one or more stock types can be selected in the Stock type
list.

o For statistics based on transactions, one or more stock types can be selected in the New
stock type and Previous stock type lists.

12.21.2 Statistics for quantity-controlled articles

o Statistics for quantity-controlled articles can be calculated for current stock status or
based on transactions by selecting the corresponding option.

« If the statistics are calculated based on transactions, statistics can be limited to time
range and user-performed transactions.

« Individual transactions with client details can be shown by selecting Per item with client
reference. The result will show the client’s details alongside article information.

« One or more manufacturers can be selected by clicking in the Manufacturer list. All
manufacturers can quickly be selected by checking the Select all box. Statistics will be
filtered for the selected manufacturers.

« If asingle manufacturer is selected, one or more articles of the manufacturer can be
selected by clicking in the Article list. All articles can quickly be selected by checking the
Select all box. Selecting more than one manufacturer implies selecting all articles from
these manufacturers.

« For Current status statistics, one or more stock types can be selected in the Stock type
list.

« For statistics based on transactions, one or more stock types can be selected in the New
stock type and Previous stock type lists.

12.21.3 Statistics for services

« Statistics for services are calculated on the basis of transactions.

« Statistics can be limited to time range and user-performed transactions.

« One or more manufacturers can be selected by clicking in the Manufacturer list. All
manufacturers can quickly be selected by checking the Select all box. Statistics will be
filtered for the selected manufacturers.

« If asingle manufacturer is selected, one or more articles of the manufacturer can be
selected by clicking in the Article list. All articles can quickly be selected by checking the
Select all box. Selecting more than one manufacturer implies selecting all the articles
from those manufacturers;

« Invoiced services only can be included by selecting this check box.

« Clicking Show activates a search in the database and a listing on screen and the totals
calculated are shown in the result table.
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o The set of totals depends on the statistics type selected. Total quantity and total price are
calculated for all statistics. For serial numbers statistics, the average device price is
calculated and if client reference is checked, the average number of devices per client is
also calculated.

e Click Print to print the listing.

12.21.4 Issue advanced statistics

This dialog is used to calculate the number of monaural and binaural hearing instrument
issues using specified criteria. Note that the binaural issue is the issuing of hearing
instruments to a client for both ears on the same day. Monaural issues are all other issues.

The dialog is called by selecting Statistics -> Issue advanced statistics from the Stock
module.

|ssue statistics advanced *

Exportio file Calculate Frint Close

Calculation criteria

lssue date: |[14/01/2019 | - 14/01/2020 Client age: -
Client gender: M Male M Female W Other lssue type: Monaural 1+ Binaural
Result
Client name | Hospital nao. Client secondary code
=Deleted client=
testpat T1200000
testpat T1200000
first name first name last name last name 5B8B8888888 0000001
first name first name last name last name 5B8B8888888 0000001
FATHER FMNAMEZ221 SMAME12 T999999 999999
MR FIRSTNAME183 LASTHAME183 T1182
MR FIRSTNAME183 LASTHAME183 T1182
MRS FIRSTMNAMES3 LASTHNAMES3 T183

Professor Test1 11111111111 1111111111111 1111111111 2 Test1111111111) E333333

TOTAL: 10

o The Calculation criteria area is used to specify the parameters for the statistical

calculation. The following parameters can be specified:

« Date range: hearing instrument issues falling into a specified range of dates will be

included in the statistics. If the field is empty the interval is unlimited.
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« Age interval: issues to clients with their age falling into a specified interval will be
included in the statistics. No value in the range means unlimited interval.

« Client gender: Male, Female or Not specified. Check the boxes to include in the
statistics, issues to a client of a chosen gender. At least one of boxes must be checked.

« Issue type: the statistics calculate Monaural and Binaural issues separately, so the
required issue type must be selected before calculation.

« When all the criteria have been specified, press Calculate to calculate the statistics. The
result is shown in the result table below and includes client name, personal number,
issue date and total number of issues.

o Press Print to print the results.

e You can also export the results to a comma-separated (CSV) file. Click Export to file and
select the target file in the file selection dialog.
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12.22 Lent out Articles

« Select Statistics -> Lent out items.
« An empty dialog will appear.
« Chose a stock type in the Stock type select box and then press Show.

Lent out items

Show Print list Print Close
Filter on
Stocktype LOAM - Price from Price to

Mumber of articles in table 0

Return date|Lent out date| Hospital no.| Client name | Stock group | Manufacturer| Model| Serial No| Price| Stock type| User| NHS no.

The view can be filtered with respect to User, Stock type and price interval.

letter.
« The total list can be printed by clicking Print list.
You can print a recall letter by selecting one item in the list and clicking Print.
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12.23 Financial stock report

« Select Statistics -> Financial Stock Report.

This report is generated and printed based on a selection of Location, Date interval, Stock
Groups and price limits.

Financial stock report ot

Generate Close

Generate report for
Location All lacations -

Date Interval fram 14/01/2019  to 140142020

|F'ri|:e limit Stock group
1
MHS HEARIMNG AID (Serial Mo.)
Senice-ACCessary
COMMERCIAL HEARIMNG AID (Serial Mo}
EARMOULD ACCESSORIES
ELBOWS
LEADS, RECEIVERS & SHOES
MISC. HA ACCESSORIES
SERVICES
TINMITUS DEVICES

OO00000oROEO

The report lists information such as:

o Issued articles in period

Issued recycled articles in period

Articles on stock

Articles lost during a period of time
Articles taken back during a period of time
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12.24 Bar code print

When you have selected an item from stock which is controlled by serial number, a label with
the item data can be printed. Go to Functions -> Print bar code.

File Edit Functions Statistics Settings
& N R o B B R B B =
® Q 2 ® > [o L D Nt o w0 B
ltem | Article | Group  Search serial no.  Registerforstock = Add external items  Newstatus Bulktransfer Batteryissue Fast accessoriesissue  Purchase orders  Add serviceto order  History  Print bar code | New task
Informaticn External items
E Client <T>T18765 MR JOHN SMITH -l &= Hlfuser SYSTEM ADMINISTRATOR All locations Al depariments - ¢ '? Print bar code

The layout of the barcode print depends on the type of barcode to be used. This is defined by
the System Administrator. The settings for type of barcode standard, prefix and suffix are also
defined by the System Administrator.
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12.25 Articles

The Articles dialogue is opened by selecting Functions -> Settings -> Articles from the Stock
module. You can also double-click an article in the list.

Articles - NHS HEARING AID (Serial No.), MHS SUPPLIES x
Order levels Mew Save Delete Close
Article list Article ITE10ML Warranty
NHS SUPPLIES ) . Warranty months EERE TR
BE102H Discontinued
. )

Article type MODULAR ITE M Ear side defaults to M/A

Supplier NHS SUPPLIES M Manufacturer ID barcode: 1234567 -

Supplier art. no. GHB 106P eEnTEE s RS -

_ Froduct ID bar code
BE101 Article ID 50143 SE0TH B 54.32-1—
BE101B NHS article no. | 111111111111123 g
BE101G Delete
BE102HF Priority 2
BE103
BE105 Battery cPa
BE18 Colour 11
BE19
BE301 Type 22
BE24 Version 33
gEggBﬁSEEF‘A Internal art. no. Price
BE37 NHS price Purchase price  Discount on purchase Net purchase price
W £70.51 = =
BESTD Article information
Basic profit 1.23%
Calc. Sales price £70.51

In this dialogue articles can be added to the list of the selected group or details of a selected
article can be changed.

o Toadd a new article, click New and enter the information for the article.

« To edit an existing article, select it in the list and modify the record.

« The following information can be entered for an article:

« Article: the name of the article.

« Article type: the type of the article should be selected from the drop-down list.

o Supplier: select the supplier of the article from the drop-down list.

« Supplier article number: this can be the catalogue or part number of the Article.

« Priority: a priority can be assigned and Auditbase will list the articles by priority and then
alphabetically.

« NHS article no, Colour, Battery, Type, Version, and Internal article no: these fields can be
entered as any symbols.

« Purchase price incl. vat, Discount on purchase, and Sales price incl. vat can be added.
This will help in stock taking if required. Sales price can be calculated based on article
profit by pressing the Calc. button.

« Warranty: check this box and specify the number of months if the article has a warranty.
A maximum of 999 months can be added.

« Discontinued: if this box is checked, the Article will not be listed.
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« Associated articles: is a list of articles associated with the current article, for instance
spare parts. Press Add” to specify a new associated article, and select it in the opened
dialogue (see Associate articles for details). Press Delete to remove the association with
an article.

« Manufacturer ID barcode: the barcode for the specific manufacturer can be chosen
here. Several barcodes might exist for the same manufacturer, if the manufacturer
produces articles in different countries.

o Product ID barcode: a list of possible barcodes for the current article can be entered in
this table. The format of the barcode is set by the system administrator. The system uses
barcodes to identify articles via scanning with a scanner attached to the computer.

« Article information: this is a free text field for entering any required information about
the Article.

« Save saves the current article.

o Delete deletes the selected article from the database.

12.25.1 Associated articles

In the Associated article dialogue, you can add a dependent article to an article being edited.
To open the dialogue, click Add in the Associated article section in the Article dialogue.

Associated article - ITE10ML >
Dk Cancel

Group Manufacturer Aricles

G1 . (1)Testmanu :

Cluantity 2 (2)Testmanu BE101

(3)TestManufacturer BE101B

SPECIAL TECH. AIDS (Cuantity 123456759 BE101G

BATTERIES (Quantity-Accessor GMNRESOUND BE102H

PROCEDURES (Service) BE102HF

Senvice-Accessary BE103

COMMERCIAL HEARING AID (£ BE105

EARMOULD ACCESSORIES BE18

ELBOWS BE18

LEADS, RECEIVERS & SHOES ™ BEZ201

4 4 BEZ01B W

« In the dialogue, select Stock type, Manufacturer, and Article.
o Click OK to add a selected article to the list of associated articles.
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12.26 Edit groups of articles

You can set up groups of articles per manufacturer. This is useful if you for instance want to
group articles with the same colour.

The dialog is opened by selecting Functions -> Settings -> Edit groups of articles from the
Stock module.

Edit groups of articles - MHS HEARIMNG AID (Serial Me.), NHS SUPPLIES X
Mew Save Delete Close
Groups of articles list Group test group Warranty M Interface connection
B Warranty 12  months . )
NHS SUPPLIES Article type - Discontinued
test group Supplier NHES SUPPLIES - Ear side defaults to MNIA
. Aszsociated articles
Supplier group. no. 1
Priority 2 260TM Add
Battery 3 HEIEE
MHS price £4.00
Group information
Testinfa| -
Price
Purchase price Discount on purchase Met purchase price
€600 _ |7.00% = £6.58
Basic profit 1.23%
- Calc. Sales price £5.63

« Give the group a name, type and supplier - mandatory in order to save.

o Enter other relevant information.

« Click Save.

o Once the group is saved it will show up in the main Stock window, when you select main
group and manufacturer.

« Right-click the group to edit it directly from the main Stock window.
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12.27 Manage articles in groups

When you have created a group of articles, you need to manage the articles in the group, which
you do by selecting Functions -> Settings -> Manage articles in groups.

Manage articles in groups - MHS HEARING AID (Serial Mo.), MHS SUPPLIES *

NHS SUPPLIES Close

Article group test group - Edit groups

Show discontinued

Articles notin groups Articles in selected group

BE10ZH ITET0MR
ITE10ML
ITET1MR

ITE11ML

BE101

BE101B

BE101G

BE10ZHF

BE103

BE105 4
BE13

BE19

BE201 4
BE34

BE34BASEEFA

BE36

BE3T

BE3TD

BE3a

BE22B

BE3AFX

BESZ

BES4

RFAR4N M

o First choose the relevant article group from the drop-down list.

« If you want to edit groups of articles, click on Edit Groups.

o The list to the left contains all articles that haven not been put into a group.

o The list to the right contains the articles that are currently in the selected group.

« Choose an article and use the arrows in the middle to move it either into a group or out of
a group.

« Changes are automatically saved.
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12.28 Creating a new or modifying a service

Select the service and the type and open the Services dialogue by selecting Functions -
> Settings -> Services from Stock.

In this dialogue services pertaining to a selected manufacturer can be defined. Services are
defined by name and prioritised for the list order. Additional attributes can also be specified.

« To create a new service, press New and enter the name of the new service.

« To edit an existing service, select a service in the list. The service number (ID) is added
automatically.

o If required, specify a priority for this service.

« Article type can be selected from the drop-down list. The entire list of types is defined in
the dialogue opened by selecting Functions -> Settings -> Article types.

o Enter a sales price for the service and a comment if required.

« Click Save to save the new or modified information to the database.

o Click Delete to delete a selected service from the database.
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12.29 Suppliers

From this menu item a window is displayed in which suppliers can be defined by name,
address, contact person, supplier number, etc. In Functions -> Settings -> Suppliers:

AUDIOMEDICAL DEVICES LTD
GMRESOUND (DAMAVOX)
LavIS

MINERWA

OTICOM SWEDEM AB

P CWERTH LTD

PHOMAK

RESOUND VIENMATOMNE LTD
SIEMEMS

STARKEY

CHESTER

Caontact person

ALISTAIR PRICE
Telephone no. Fax
Email address

External account 1D

External account

Suppliers *
Mew Save Delete Close

Supplier Supplier

RRR MHS SUPPLIES

MIRAMNDA . -

MHS SUPPLIES Priority  Supplier no.

PURETONE 1 1

t:.:l'n HEARIMG LTD i

! b J

AUDIEON MATIONAL HEARING AID PURCHASING CENT

AUDIMED

Select New and then enter the name of the supplier in Selected supplier.
A Priority can be assigned and Auditbase will list the suppliers by priority and then

alphabetically. Each supplier must have a unique Supplier no assigned to it.

o Click Save to save new or altered information to database.

Click Delete to delete a defined supplier from database.
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12.30 Manufacturers

In this dialog, you can define manufacturer with name, number and priority. To open the
dialog, select Stock -> Settings -> Manufacturers from the Stock module.

Manufacturers - MNHS HEARIMNG AID (Serial Mo.) >
Mew Save Delete Close
Manufacturer Manufacturer
(1)Testmanu MHS SUPFLIES
(2)Testmanu Priarity
(3)TestManufacturer 1
123456789
I“ M Use alphabetic characters
s = in serial numbers when registering a
sequence of items. B, 1,0, Q, 3and £
are skipped.

Manufacturer 1D
5028

EHIMA bar codes
1234567

« To add a new manufacturer, click New and enter the name. The manufacturer number is

added automatically.
« Specify a Priority for the manufacturer.

o To edit a manufacturer, click an existing manufacturer and make the required changes.

« A manufacturer can be configured to include alphabetic characters in all their serial

numbers. Certain alphabetic characters are never used, (see text warning for list of these)
this is done according to the system used by Phonak. This allows sequences of serial
numbers to be created including alphabetic characters. A text note will appear on the
Register for stock dialog when a manufacturer with this setting is selected. Even when
only numbers are used for first and last serial numbers, the alphabetic characters will be
used in between.

One or several barcodes can be specified for the manufacturer. If a manufacturer
produces articles in different countries, it is necessary to register more than one barcode
ID.

The name of the barcode depends on the barcode type used. This is defined by the
system administrator.

Auditbase uses barcodes to recognize an item via scanning with a barcode scanner
attached to the computer.
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« Click Save to save the new or modified record.
o Click Delete if you want to delete a record.
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12.31 Article types

In the Stock module, go to Stock -> Settings -> Article types. From this menu item a window is
retrieved in which types of articles can be defined.

Article types

MNew Save Delete Close

x

Article types

BATTERY -

BEDSIDE MASKER
DIAGMOSTIC

DIGITAL BTE
HAFITTING

LIBBY HORN TUBING
LOUDSPEAKER
MODULARITE
MORMAL TUBING
OTOSTOP
PRESENTATION BOX
PROGRAMMABLE BTE
REHABILITATION
STAYE DRY TUBING
SYRIMNGE

THERAPAK

TINMITUS BTE MASKER -

Article type
BATTERY
Priority
.1

Select New and then enter the name of the Article type in Selected article. A Priority

can be assigned and Auditbase will list the types by priority and then alphabetically.
« Click Save to save a new or changed article type in the database.

Click Delete to delete a defined article type from the database.
Click Cancel to close definitions of article types.
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12.32 Order levels

In the Stock module, go to Stock -> Settings -> Order levels. Select this function to type
ordering levels for defined articles. Two levels can be typed, urgent level and an ordering level
which is used at bulk purchasing or for the purchase of more than one article from the same

Save Close

>

supplier.
Crder levels - MHS HEARIMNG AID (Serial Mo.), MHS SUPPLIES
Article Stock type

4| STOCK- GWH (In stock|a
ITE10MR
ITETOML HOLDING STOCK
ITETIMR Louisa's sorting (In stoc
ITETTML STOCK - PAEDS (In stoc
BE101 Sent to manufacturer (In
BE101B UNTRACEABLE (In Stoc
BE101G STOCK - DV BOX
BE102HF STOCK - OUTREACH
BE103 STOCK - SAVERMAKE
BE105 From repair sample

BE13 ¥ Auto created -1 hd

Select article and stock location for article.

Click Save to save levels in the database.
o Click Cancel to close this function.

Article ID
50388

Article
BE102H

Enable ordering level
Paint of ordering

Paoint of warning

Type number in the fields Point of ordering and Point of warning.
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12.33 History

By activating this function all changes made in the field Stock type for a specific serial number

are displayed. Select the specific item in Stock and go to Functions -> History.

History >
Close
Article MHS SUPPLIES, ITETIMR, 444
Date Stocktype from | Stock type to | Client Note
21/04/2015 | STOCK - GWH (In stock) | FITTED/EXCHANGED (Issued) | MRS FIRSTMAME106 LASTMAME10G fi
210412015 STOCK - GWH (In stock) Register for stock -, fi
< >

Date of change, new stock type and client together with the option to add a note concerning
changes is shown.
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12.34 Fast accessories issue

The “Fast accessories issue” dialog allows users to quickly select several different accessories
(quantity-controlled articles) of any quantity and issue them in one step. To enable fast
selection of the articles we have the traditional Stock Group and Manufacturer route plus three
new fast-to-access ways that accessories are grouped together.

Lists of accessories can be created including associated articles.
12.34.1 Creating lists of accessories

The “Frequently used accessories lists” are the third option for populating articles on the “Fast
accessory issue” dialog. They enable users to select from lists of articles that you can construct
based on what you have issued in the past or on articles that you add to the list manually. You
can make different lists for different groups of users or patients such as one for Hearing Aid
users and one for Cochlear Implant users.

Lists of accessories can be added in the Stock module from Settings -> Frequently used
accessories.

Frequently used accessories n

Accessory lists a v Mew Save Delete Close

Implant accessoaories

Location 2 Location2 -
Department 2 Department2 -
Mumber of accessories 5

Accessories & v

1. (Optional) Create or recreate from recently issued items

675 COCHLEAR IMPLANT
A4 (MM1500)
675

2 (Optional) Add iterns manually

Enter a name for the new list and set a Location and/or Department if required. Select Save.
Once you have saved the list, you can add quantity-controlled items in two different ways and
combine them, from those recently issued and by manual selection. Firstly:
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1. (Optional) Create or recreate from recently issued items.

Search most issued accessories

Stock groups
Cuantity 2 Date from

BATTERIES (Quantity-Acce

Senice-ACCessory
TINMITUS DEVICES

Selection result

Maximum rows in result

to

Close

130172020

20

Populate

s

Article name | Mo. ofissues

Recreate list

Choose a Stock group or groups and a date range for the most issued accessories. By default,
the Date from is set to one year before the to date. You can choose the Maximum rows in

result, this defaults to 20. By selecting Populate, the Selection result is filled.

The list will be populated based on the most issued articles in the period you choose. The
system will scan through all issues in the period and then present the top according to how

many you limit it to, therefore a long period will take longer to populate.
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Search most issued accessories x
Stock groups Close
Cuantity 2 Date from 13012010 to 13012020

BATTERIES (Quantity-Acce
Senvice-Accessory Maximum rows in result 20

TINMITUS DEVICES

Populate

Selection result B Select all
| Article name Mo. ofissues

13 G265

312 401

675 274

675 COCHLEAR IMPLANT | 120

10 17

AATMMA500) 11

AAAMM2400) 5

Recreate list

You can either Select all articles, which is the default setting, or select articles using the check
boxes to the left of the Article name. Once you have selected the appropriate articles press the
Recreate list button in the bottom right to populate or repopulate the accessory list.
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Frequently used accessories x
Accessory lists F b 4 MNew Save Delete Close
Implant accessories Implant accessories
Test

Location 2 Location2 -

Department 2 Department2 -

Number of accessories 7
Accessories F 304
12 1. (Optional) Create or recreate from recently issued items
312
675 ) )
2. (Opt 1) Add it I
675 COCHLEAR IMPLANT (Optional) Add ftems manually
10
AA (MMNA500)
AAA (MN2400)
Remaove

Articles can also be added manually to the list using the second option.

2. (Optional) Add items manually.

This option opens a window where you can choose accessory articles from the stock module
using the standard grouping hierarchy.

Select accessories X

Add selected items Close

Stock group Supplier
Quantity 2 (5)Testmanu
BATTERIES (Quantity-Accessory) |ERER wERD]

Senvice-Accessory MHS SUPPLIES
TINMITUS DEVICES

Selected articles and article groups
675 COCHLEAR IMPLAMT

Show discontinued Show discontinued

Select a Stock group, Manufacturer and Article and use the arrow to move the article to
Selected articles and article groups. You can Show discontinued stock groups or articles by
checking the appropriate box. Add selected items will add these articles to the previously
selected list. Close will close the window without moving any articles and take you back to the
Frequently used accessories window.
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Once you have created your list, Close will close the window. Delete will remove the selected
Accessory list. Another list can be created by selecting New and re-starting the process.

The up and down arrows in Accessory list and Accessories will move the lists and the articles
in the list so that they are in your preferred order.

When articles are set as ‘Discontinued’ they will be removed from lists automatically but Article
Groups will not, so they must be removed manually.

12.34.2 Opening ‘Fast accessories issue’

Fast Accessory Issue dialog can be opened in a number of ways, the quickest is to press
Ctrl+F10 on your keyboard. There are also buttons in Stock -> Functions -> Fast accessories
issue or Device list -> Accessory issue or Client Information -> Devices tab -> Accessory
issue. Using these ways the same window will open with the same selection filter showing the
previous Accessories issued to the client, in date order.

The Issue details on the right side of the window are similar to other stock new status
functions and need to be set first. Select the From stock type; this selection will be
remembered for the next time you issue accessories. The To stock type will default to the
option selected in the stock type set up in the System Administration tool but can be changed
manually by selecting from the drop-down list. The Date will default to today’s date but can be
adjusted if required. Select an Invoice type and Reason to issue if required and choose
whether the Invoice should be assigned to client or to customer.

12.34.3 Filtering potential articles

Fast accessories issue X

Client MR JOHN SMITH DK Close
Filter articles Issue details
* Accessories issued to the client, in date order From stock type
Manufacturers of current devices and Accessories linked to current devices STOCK - GWH (In stock) -
Limit to Stock group To stock type
Frequently used accessories from list FITTED/EXCHANGED (Issued) M

Select by Stock group and Manufacturer
Stock group Manufacturer
BATTERIES (Quantity-Accessory) All

Date
13/01/2020

User

AccessoniGroup | Accessory in Group Ear Accessary |UR|at| | [ [Stock | SYSTEMADMINISTRATOR -
MHS SUPPLIES, 675 R
MHS SUPPLIES, 13 L Invoice type
MIA Invoice type 1 -
Qty. Reason toissue
1 & M
» Invoice
4 ShofalEn
<« to customer

Populating: 2 Done
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There are three other possible filters in the Filter articles area to get you to the accessories you
need as quickly as possible.

Accessories issued to the client, in date order. This will show a list of all the
accessories that have been issued to the client previously so you can quickly reissue.
Manufacturers of current devices and Accessories linked to current devices.
Selecting this option will display:

o All accessories from the Manufacturer of the client’s current articles.

o All the accessory articles which are linked, in the article set up, to devices that have

been issued to the client.

You can Limit to Stock group and select from the drop-down box which stock group the
accessory list will be limited to. Sorting results will be in the order:

o Accessories linked to articles

« Article groups from suppliers

o Articles from suppliers
Articles that have been grouped will display the group name. If the group is expanded,
the Accessory in Group is shown in the next column.

AccessonyGroup |Fu:t:essnry
=] NHS SUPPLIES, TEST BATTERY GROUP

675
Nz
MHS SUPPLIES, 13

MHS SUPPLIES, 675 COCHLEAR IMPLANT

MHS SUPPLIES, 10

MHS SUPPLIES, A8 (MMN1800)

MHS SUPPLIES, AAA (MM2400)

Frequently used accessories from list. Any lists of articles created in the Frequently
Used Articles dialog will be shown in the drop-down menu and the contents of the one
you select will be displayed in the Accessory/Group window.

Select by Stock group and Manufacturer. This selection will default to All groups for
Stock groups and All for Manufacturers. If you select one Stock group the
Manufacturer defaults to All in stock group but you can also then filter on any one
Manufacturer from that Stock Group. Sorting will be:

o Manufacturer
o Article group
o Articles

12.34.4 Selecting the accessories to issue

Once you have selected the appropriate filter for the articles, they can be selected by
highlighting the Accessory/Group or Accessory in Group, if an article has been grouped and
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expanded, and using the right facing arrow or by double clicking, move the article to the right-
hand side of the window. An Ear side can be selected before moving the article by checking
the appropriate box, otherwise it will default to N/A.

The fastest way to select accessories to issue without side is just to double-click on as
many as you need.

The number of articles can be adjusted by using the Qty selection before moving the article or
after using the plus and minus buttons.

The article can be removed using the X button.

Accessory | URl Qty. | | | | Stock
MHS SUPPLIES, 675 COCHLI- |2 + || - || X]| 25
MHS SUPPLIES, 10 - |3 +|| - || X|9
MHS SUPPLIES, AA(MMAS00) L |1 +| - || X |8

12.34.5 Stock level control

The number of articles in stock are shown in the Stock column. If there are no articles in stock,
an information window will open.

Selecting article: NHS SUPPLIES, 312

I@I There are cumerthy 0 tems in "STOCK - GWH ({In stock).
k. 4

You are attempting to mowve 1 items, which will result in a negative amourt in STOCK - GWH (In stock).
Do you want to change number of items to be moved?

Press Yes to change number of tems to move

Press Mo to proceed with moving the entered number of tems

Yes No

Selecting Yes will enable you to change the article or number of articles being issued. The
number selected will automatically change to the number of articles in stock. No will allow you
to issue the article but will result in a negative number in the stock module and will be shown
in red.

MHE SUPPLIES, 312 L |1 + || - || X|0

If Full inventory control is set for an article, an information window will warn you that the stock
article cannot go below zero.
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Selecting article: NHS SUPPLIES, 673 =

There are 0 'MHS SUPPLIES, 675" in "STOCK - GWH (In stock)'
l % The aricle has "Full inventory control’ and cannot go below zero

oK

You will only have the option to OK and return to the Fast accessories issues window and
select another article. You will need to register additional articles into the stock module before
you can issue a Full inventory control article which is at zero stock.

Using the left facing arrow will remove an article from the list to be issued to the client. The
double arrow will remove all articles in the list.

12.34.6 Completing the issue

OK will issue the selected accessories to the client with the chosen options. If an Automatic
Journal Event is set for issuing stock, a single entry will be added to the Journal which just
states Article released to client.

If Show confirmation request on stock article issue is switched on for a user, this will not
display if a number of accessories are issued to a client using Fast accessories issue.

Close will close the window without saving any articles to the client.

12.34.7 Issuing accessories from Noah

Accessories can be issued directly from the Noah stock dialogue. If Open ‘Accessory issue’
automatically is checked, once the new status for a device has been changed and any
automatic journal events have been added to the Journal, the Fast accessories issue window
will open with the filter Manufacturers of current devices and Accessories linked to current
devices.

Serial numbers found in NOAH x

Client MR JOHN SMITH Close

B OpenAccessory issue’ automatically B Open ‘Device list if another current device is found

Serial number Manufacturer Article |Ear side| Stock type Patient Hospital no | Action
0202 R ==Mot found== Register for stock, then Mew status
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13 Journal

Click the button below to access our training materials.

The Journal module is used to create and review client journal text. The main screen consists of
an upper area that shows existing records and a lower area used for entering new records.

To view the Journal a client must first be selected. Some of the Journal entries are
automatically entered and some must be entered manually.

Reading the complete Journal can be time consuming and some of the entries may not be
relevant. This is where the Search string is used. By choosing an appropriate string, only the
entries concerned with the relevant event are viewed. If all entries need to be viewed then All
should be selected. Search strings (keywords) and date is typed for every entry made in the
selected client's record to provide easy access to information and ensure that once information
has been saved it cannot be changed.

To enter text manually into the Journal, type the required text into the Input text box. This text
can then be formatted. When the text is formatted as required, click Save. Once the text has
been saved it cannot be altered or deleted from the database for medico-legal reasons. If a
mistake is made another entry explaining the mistake must be entered. The entered text will
appear in the Journal Text window and is sorted by date either ascending or descending as
required.

When entering text to the journal for a client, search strings should be selected so that the
corresponding text is displayed in the upper part of the window while the new text is in the
lower part.

Signature will indicate which employee is typing the text and can be changed here. The
default is the logged in user.

Journal text formatting options are available from the top window bar or via right mouse
clicking, when typing in text.
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13.1 Journal overview, appearance and layouts

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Toopen the module, go to Navigation -> Journal or press Shift+Ctrl+J.

The module is divided into four tabs: View, List, Treatment summary, and Individual
Management Plan.

There are two tabs for journal text:

o The View tab shows a print layout view of the journal text.

o The List tab is a list of journal records ordered with time as well as date that you can
select and edit, sign or delete. Unsigned journals will be deleted permanently. Signed
journals will be marked deleted, but you can see the deleted sighed journals by checking
the deleted box. Unsigned entries appear in red. Records marked as Deleted are shown
as crossed-out on the List tab or are marked with a text comment on the View tab.

Journal layout
In both tabs, you can toggle between the following layouts:

« Normal layout is used for viewing and editing journal text at the same time. With this
layout, a larger section of the screen is available for existing records and a smaller section
for editing.

« Edit layout is also intended for viewing and editing journal text at the same time, but
with this layout a larger section of the screen is available for editing.

o View layout is used for viewing journal text only. With this layout, the screen contains no
record editing area.

To toggle the layout, use the buttons in the upper right corner of the screen.

Zoom

The view of the journal on the screen is adjustable via the Zoom option. However, Printing the
journal produces the layout of the screen without the zoom. You can change the default
margins used for Keywords and Text in the View to limit the paper consumption when
printing journals. This can be done by the System Administrator.

Filtering
In the View and List tabs you can filter the records by checking the following boxes:

+ Unsigned
. S|gned
« Deleted

Filtering can also be done per keyword, which is explained in the next chapter.
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The Show all (F11) button on the View tab forces all journal records to be shown. The System
Administrator can define the settings for the whole site to make Auditbase limit the number of
records to be shown automatically on the View tab. This may be useful where clients have a
very large number of entries that may take some time to load. However, the user can select his
or her specific settings in the Administration tool as well. The Show all button overrules these
settings.

Sorting

By choosing the View menu item, you can sort the journal text ascending or descending by
date and time. Time can be viewed in the List tab, edit section.

o)) Auditbase - [Journal]

Eile Yiew Functions

i

sortby " Extended treatment surnmary | Save window setup

Sort by date ascending

v Sort by date descending MITH

| Sort by time ascending — )
) ) View | List | Treatr
v | Sort by time descending

Date

Auditbase automatically enters today's (system) date, but this can be manually altered if
required.

Save window setup

« Tosave the window setup, choose View -> Save window setup.
The saved settings are:

« The current keyword group or keyword

« The font on the current cursor

The zoom level
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13.2 Keywords

You can select a keyword from the keyword drop-down list to view a specific type of journal
entry. The keywords are set up by the System administrator. All entries will be linked to a
keyword and you can then view journal entries of a specific type. Keywords are linked to
different keyword groups in system settings. A keyword can be part of more than one keyword

group.

In System Administration settings, the administrator can define user rights linked to specific
keywords, for instance the right to enter journal keyword entries and read keyword entries or
the right to sign and delete specific keyword entries. If a user does not have the right to read
journal entries, the user can only see the keyword header, but not the journal text.

Yiew | List | Treatment summary | Individual management plan

MW Unsigned

Keyword All - -
YW L W Signed B Deleted O, Showall (F11) &2

SYSTEM ADMINISTRATOR

SEMSITIVE INFORMATION
WO

APPOIMTMEMTS
10/0172020|, gigiogist

/- ADULT REHABILITATION | SYSTEM ADMINISTRATOR

- ADULT DIAGNOSTIC

|- PAED HEARING AID - GNRESQUND, C561
- PAED DIAGNOSTIC
- PAED COMMUNITY

#IEST#

P Tl kPR - RISy kI s sl Il i e oA oA

SYSTEM ADMINISTRATOR
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13.3 Use of hot-keys

o Tospeed up the process of entering text into a journal, you can make use of Hotkeys.

« Hotkeys can also be used in auto journal event pop-ups.
« If the system administrator has provided you with extended rights for this, the hot-keys

are created in the Journal module for the whole site.
o Select Use hot-keys under the Functions menu.

o)) Auditbase - [Journal]

File View Functions
= = = = ooo = = _— =
8 & T BE@8 5
Add service to invoice | Show audiogram | [ssue 8 review list Uze Properties Uze Onsaving | Properties  MNew task
Hot-Key.. Spell check
« Once the feature is selected you can enter Hot-key properties.
Hot key properties *
Erint list Mew Save Delete Close

Hot keys Selected hot key

Mumber Mame L]

Mumber: 01

0z Earmould booking in Mame: Repair appt

03 Postal repair Test to inzert:

04 Inappropriate C&B referral . . ;

. General info given : went over different
05 Battery enquiry
- Lostaidf ” programs today and how to clean the
ostaldiee - pal mould/corda. talked about adaption to

o7 Replacement hearing aid ampliﬂcatiﬂn

08 Lost aid on Ward funds trans Batteries:

09 Lost aid fit Outcome: Appointment complete / Further

10 D.ref appointment required.

11 AGR

12 Fitting

13 Faollow up v B|I|UO ---

< >

« Click on New to enter a new hot-key.
o First enter a Number for the hot-key - all numbers below 10 will have a O placed before

them, i.e. 01, 02 etc.

o Enter a Name for the hot-key - not mandatory.

« Enterthe Text to insert.
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« Once you have created a whole list of hot-keys, you can print the list by clicking on Print
list - this will give you easy access to all hot-keys instead of having to look them up in
the system.

o Once back in the journal, the hot-keys are accessed by placing the cursor in the text field
and pressing Ctrl+Shift+[number].

« Example: For the hot-key created in the screen shot above, the short cut would be
Ctrl+Shift+03 (not just Ctrl+Shift+3).

o Thetextisthen displayed in the text field.
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13.4 Entering journal text

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Navigation -> Journal or press Shift+Ctrl+J.

« Select the View or List tab.

o Select an appropriate keyword from the drop-down list for the journal entry.

« Enter the required text in the text box.

« The text can be formatted to bold, italics, black, blue or red, and it can be aligned to the
right, centre or left via the formatting buttons. Text font can be changed as well.

o The Users default font settings can be saved using the View -> Save window setup -
make sure the font is selected in the Edit window beforehand.

« Click Save unsigned to save the entry unsigned. You can also lock the new record from
being sighed by checking the Lock box.

OR

« Save signedSign as user drop-down list

Edit Journal
Keyword ~  Date 13012020 Time 12:43 Sign as user: SYSTEMADMINIE v Zoom 100% v

Sample text
Sample text

Sample text

w
-
d
L}
[}
]
»
i
i
c
@
&
»
o

« The Date and Time that a journal entry is saved is locked by default unless the user has
the extended right to choose date/time of record.

Your System Administrator decides whether or not you have the right to save a journal
unsigned, so you may experience that the button Save unsigned is disabled if you do not
have the extended user right to save unsigned.

It is important to check the client’s name regularly to make sure you are working with the
correct client.

On PCs in slower networks your System Administrator can configure a checkmark to not
‘Refresh Journal view after saving’ to prevent you having to wait while the Journal
refreshes.
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13.5 Editing a journal entry

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Toopen the module, go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the List tab.

o Mark the check box for the record you wish to edit. Note that only unsigned records can
be edited.

o Edit the text in the text box at the bottom of the screen.

« Click Save unsigned to save the entry unsigned. You can also lock the new record from
being signed by checking the Lock box. If the journal record was created by another user,
the system will overwrite the value of the Created by column with your name.

OR

« Click Save signed to both save and sign the entry at the same time. You may select user
signature in Sign as user drop-down list (logged in user is selected by default). The
system will put your name to the Signed by column of the list.

0:“) Auditbase - [Journal] — O *
File View Functicns
fl §_?| = ? ooo = E;\ == =
AL 2 = © TN
Add service to invoice  Show audiogram  [ssue 8t review list Use Properties Use Onsaving | Properties  New task
Hot-Key... Spell check
IO | Client  <T>T18765 MR JOHN SMITH -2 =|Bl|user SYSTEM ADMINISTRATOR | All locations - All departments - ?
View ||List | Treatment summary | Individual management plan
B Unsigned
K d All W Deleted i i
EREEE "/ signed elete sign Delete Print EE D
| create date Keyword | Created by Signed by Lock ~
[ 13/01/2020 12:37 | ADULT REHABILITATION | SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 17:05 | ADULT REHABILITATION | SYSTEM ADMIMNISTRATOR | SYSTEM ADMINISTRATOR.
[ 10/01/2020 16:51 | ADULT REHABILITATION | SYSTEM ADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 11:25 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10/01/2020 10:56 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
10/01/2020 10:56  APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10401/2020 10:52 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 10:50 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[1]10/01/2020 10:47 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR
[ 10/01/2020 09:20 | APPOINTMENTS iryna skladana iryna skladana
[ 10/01/2020 09:13 | APPOINTMENTS iryna skladana iyna skladana
[ 10i01/2020 08:51 | APPOINTMENTS iryna skladana iryna skladana
[ 09/01/2020 17:42 | APPOINTMENTS SYSTEMADMINISTRATOR | SYSTEM ADMINISTRATOR o
Selectall 1 row selected
Edit Journal
Keyword APPOINTMENTS Date | 10/01/2020 Time | 10:56 Sign as user: SYSTEM ADMINIZ |+ Zoom 100% -
Appointment PHAC new patient mould~ with Res109 on 10/01/2020 13:15 - 13:30 was moved to cancellation history having a status of Q/ "
Cancelled

]
~
]
1]
]
-]
It
L}

‘ZE Loc Save unsigned Save signed
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13.6 Use of spell checking

Another feature of the journal is the spell checking tool, activated while typing text to the input
window. This works in a very similar manner to Word. Incorrectly spelt words will either be auto

corrected if the word is already in the dictionary or will be highlighted. It will suggest spelling
options when the highlighted word is right clicked. A window will appear giving spelling
options to choose from. The misspelt word can be ignored or added to the spell check

dictionary.

deaf
def.
serf

Add to dictionary

Ignare

Edit »
Bold

Italic

Underline

Strikeaut

~  Left alignment
Centre alignment

Right alignment

~  Black
Red
Blue
Green

Gray

Find...

« Spell checking is disabled /enabled by right clicking and choosing Disable
spelling/Enable spelling or via the Functions menu -> Spell check -> Use

oj)
File View Functions
R B T BB w =
oo E O oo ¢ @
Add service to invoice  Show audiogram  lssue & review list ze Properties Usze Properties  Mew task
Hot-Key... Spell check
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13.6.1 Customising the spell check dictionary

+ Aswell as adding words to the dictionary as you type, the dictionaries that are used by
the spell check can be adjusted by using Properties. A window opens where the default
dictionary can be edited if required. Words that have been added to the dictionary will be
displayed in the default.dic.

Spelling properties

Select folder

Customized dictionaries

{27 Internet Explt
I3 Microsoft SQ
-[:| Microsoft Vis
~aMmc

B0 Msdn

[0 Metwark
-[:| Office

(17 Outlook
{3 Paint

[ PowerPaint
(I Proof

-[:| Protect

(17 QuickStyles
-[:| Signatures
&{C3 Skype for De
-[:| Software Cer
#_] Spesch
3 Spelling

JEL=nco|

A

L

Select dictionary

default NotUtF6 (1).dic
default NotUtF6 (2).dic
default NotUtF6 (3).dic
default NotUtF6 (4).dic
default NotUtF6 (5).dic
default MotUtF6 (6).dic
default NotUtFE (7).dic
default NotUtF6 (8).dic
default MotUtF6 (9).dic

default.dic

Edit dictionary
Add from file ...

» Selecting a dictionary and then Edit dictionary will open a note pad where the words
in the dictionary can be edited or added to.
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13.7 Signing a journal entry

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Toopen the module, Navigation -> Journal or press Shift+Ctrl+J.

o Select the List tab.

« All journal records are either unsigned or signed.

« An unsigned record can be modified and is shown in red. A signed record cannot be
modified. However, you can mark it as deleted. A signed record is shown in black.

« You can view the signed records, the unsigned records or both kinds by checking the

M Unsigned

boxes Unsigned and Signed ® Sianed

Signing the record also means saving it. If a mistake is made, another entry explaining
the mistake must be entered.

« Check the boxes for the records you wish to sign. You can sign more than a single record
at atime.

o The system automatically signs with the name of the logged in user, but this can be
manually altered if required in the Sign as user drop-down list.

o Click Sign.

« The records are now shown as signed in black on the list.

o If unsigned journal text is included in a treatment summary, this text can be signed along
with the summary, if this operation is allowed by the system administrator.

Any unsigned journal record can be locked to avoid it being signed until the text is
finalized. To lock a record, check the Lock box in the edit area and save it unsigned.
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13.8 Finding unsigned journal entries

« Tofind unsigned journal entries, go to Navigation -> User Tasks -> Attention list and

choose the Unsigned journal tab.

Attention list *
Do not show awarning message  D-Alert selection method PAS alert hd Print Show in Journal Close
Referrals | Journal ||Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission
Unsigned journal records
Date Hospitalno.| MNHS no. Client name User Keyword "~

111142010 | T146023 MR FIRSTMAME46023 LASTMAME46023 | USER NAMEBS ADULT REHABILITATION

26M1/2010 | T11194 MR FIRSTMAME 1194 LASTNAME 1194 USER NAMET1.. | ADULT REHABILITATION

10M2/2010 | T134576 MR FIRSTMAME34576 LASTMAME34576 | USER NAMEBS ADULT REHABILITATION

12/01/2011 | T146604 MST FIRSTMAME46604 LASTNAME46604 USER NAME49.. | PAED DIAGNOSTIC

20/01/2011 | T13646 MR FIRSTNAME3646 LASTNAME3646 USER NAMESS ADULT REHABILITATION

25/01/2011 | T146523 MRS FIRSTNAME46523 LASTMAME46523 | Marten ADULT REHABILITATION

25/01/2011 | T145198 MRS FIRSTNAME45198 LASTMAME45198 | Marten ADULT REHABILITATION

26/01/2011 | T146646 MRS FIRSTNAME46646 LASTNAME46646 USER NAME14 ADULT REHABILITATION

26/01/2011 | T145288 MR. FIRSTNAME45288 LASTMAME45288 | USER NAMES9 ADULT REHABILITATION

26/01/2011 | T15809 MRS FIRSTNAMES809 LASTMAMES809 | USER NAMES3 ADULT REHABILITATION

2710172011 | T146183 MRS FIRSTNAME46183 LASTNAME46183  USER NAMET1 ADULT REHABILITATION

2710112011 | T146077 MRS FIRSTNAME46077 LASTNAME4G077  USER NAMESS ADULT REHABILITATION

01/02/2011 | T12569 MRS FIRSTNAME2569 LASTMNAMEZ2569 | USER NAME29. | ADULT REHABILITATION

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??? | ADULT REHABILITATION

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??7? | ADMIN

30/09/2013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME 106 full name tests??7? | ADMIN

021012013 | T1106 5555554444 | MRS FIRSTNAME106 LASTMAME106 full name tests??? | ADMIN

17/07/2014 | T999911 1112222211 | Father dz=62 dzal full name tests??? | GENERAL v

|
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13.9 Deleting a journal entry

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Toopen the module, go to Navigation -> Journal or press Shift+Ctri+J.

o Select the List tab.

« Mark the check boxes for the records you wish to delete. You can delete more than a
single record at a time.

o Click Delete.

o Deleted text is shown by date of creation, with search string and an indication in RED by
whom and the date and time when the text was deleted.

« On the List tab, signed deleted text is shown as crossed out.

« Unsigned deleted records can either be shown as crossed out, or disappear from the list.
This depends on the rights defined by the system administrator.

o If deleted records were filtered out, they are not shown in the list.

Note that only unsigned text can be physically deleted from the journal. Deletion of signed
text only marks the text as deleted. Deleted signed text can be viewed again when you
check the Deleted box.

The system will not allow deleting signed text if the text is included in a treatment
summary. To delete the text, exclude it from the summary first.
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13.10 Printing and previewing the journal

To print or preview the entire journal for the client’s:

» Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Journal or press Shift+Ctri+J.

Select the View tab.

Select File -> Print journal to print a copy of the report on the default printer.
Select File -> Print preview to display the report on the screen.

To print selected records only:

o Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the List tab.

o Check the boxes for the records you wish to print and click Print.

Crystal Reports is the program presenting the preview and from here, the journal can be
printed or exported in a selectable format and to the relevant path.

Closing down the preview on the screen is done by clicking X in the upper right corner
returning to Auditbase Journal.
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13.11 Issue & review checklist

This function displays a window where you can add more information about a fitting.

» Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation -> Journal or press Shift+Ctrl+J.
« Select Functions -> Issue & review check list.

o Click New.
« Clicking in the various fields will produce a Y, N or blank.
« Click Save.
Issue & review check list >
Mew Save Delete Cancel
Date Mould Aid Controls| Batteries | Fitting | Tubing | Maintenance | Progression| Useof | Useof

comfort | adjustment ofuse |telephone | telecoil

1310172020 Y I
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13.12 Individual Management Plan (IMP)

In the Journal module, there is a tab on which you can create an IMP for a client including
Needs, Actions and Outcomes; which can be printed out and an automatic journal event
created. A ‘snapshot’ of the IMP can be taken and stored for future reference.

Information documents can be easily printed from the IMP once they have been set up in
Documents and Attachments. You can choose to store these information documents either as
complete documents or by title only.

All columns in all of the tables on the IMP have configurable width set ups. Make adjustments
to the column and then right click and Save user view. See Section 1.7 for further information.

Your System Administrator can set up the required default fields.

IMPs: | iz 280052020, HA issue »| Cientname | COLONEL CHARLIE HARPER Rofresh || Cancel

Prind and Stone Print infarmation documents M Daleti
Selected WP
Sared on 2EME0H0 Fo AL appointmert

WP bype [ EYEETT = Crealed by SYSTEM Ademin - Audogram =
Referal 120672019, DR HAASSESS Treatment type DR HAASSESS Refemal handing
Apreed neads: - Remove

# Need [ Calagories [ Oudatea | Comment ~
1 Hear TV bether Faersanal Public
2 Hearfamily beller Putac

A= T

PRI

Agread and completed actions | v
MHesd Action Comment Compl. dale Apposntmeant sl
O+ |Fatwo hearing aids | | 26052020 |77 200052020 SWITCH ON | BERTA
Pasilion TV batter
Lise aaskssive device

~jooooipE

Mt appointmant

Cuttamss

Heed Dulcomee Soore Diate -
1 |Amsonsd 45 2652020 |

< »

Shared with palient on WP finished and pasent discharped on o
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13.12.1 To create an IMP

o Choose a Referral using the ' icon and click Attach.

Selected IMP
Started on 13012020 E At appointment
IMP type Hearing Aid - Adult - Created by
Referral 1810612015, ++ALIDIO REVIEW rue:l____I Tenotronnt b
Attach
Agreed needs: . Detach

| H# | Moo T Armrmant

« The date that the IMP was Started on will default to today's date but can be changed
manually.

« The IMP type will use the default type set by the System Administrator. This can be
changed using the drop-down list.

o Created by will show the logged-on user. This can be changed, only if the user has the
extended user right.

o An Audiogram for the IMP can be attached by selecting from the icon *I. Once the
audiogram is attached, it can be shown by selecting the preview icon.

o The appointment that the IMP was started on will be shown in the At appointment field.
If no appointment is shown in this field, one can be added in the same way as adding a
referral above. If the appointment is not attached to a referral or attached to a different
referral, you will see an information window asking if you wish to link the appointment to
the IMP rather than the selected referral.

« Agreed needs will default to those set by your System Administrator.

Aprded nesds e, |

] Mead Calagonss Outdatid Cammn A
Haar TV betlar —
Hear tamily befler I
Hear phona befer

1
F3
3
4
]
&
T
L

« Further needs can be added by either:
« Clicking in the Need column and selecting from the drop-down menu.

o Clicking in the Need column and typing in free text.

« A category for the Need can be selected from the Categories drop-down menu. Multiple
categories can be used by selecting the Multiple categories... option. A window opens
where you can Select IMP category.
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Select IMP category x

select Cancel

Mame

v Personal
v | Public

o Check the appropriate categories and then Select. The categories will be shown
separated by a comma.

Categories

Personal Public

o The Need can be outdated if it is no longer required by selecting the Outdated check
box. Outdated Needs remain in the list, but they are greyed out.

« A free text Comment can be added to Needs by clicking in the Comment column and
adding text.

« The order of Needs can be altered by highlighting an item and using the up and down
arrows to move it.

o Needs are linked to actions by clicking in the Need column of the Agreed and
completed actions table and selecting the appropriate need number.

Agreed and completed actions: Fah
| Need | Action |

] ~ | Fittwo hearing aids

Position TV better

Use assisstive device

DDD'

« Ifthe Need in the Agreed needs table is re-prioritised, then the Need in the Actions
table will automatically re-number.

« Toremove a Need, highlight the text and click Remove.

o Actions are added in same way as Needs.

« Toremove an Action, ensure the Action is highlighted with the box on the left side
checked and then click Remove.

« To complete an Action, ensure that the box on the left side of the Action is checked.
Select Complete and an information message will ask if you wish to complete the action.
Select Yes. Selecting No will cancel the operation.
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Message
I@I Do you want to complete the selected incompleted actions?
k. ® 4

Yes Ha

Once an Action has been completed, it will be highlighted in green text. The date of
completion defaults to the current date, but can be edited by clicking in the Compl. date
column and typing in the required date.

Agread and completed actions - v Altach Dratach Complete Lin-comglete Remove
Heed Acson Commant Compld dale Appoinkment -

Fil kD hpanng aids SWITCH QN BERTA
Pasilian TV beflar

LI58 a55i651he device

(] | mjfs|

o If only one appointment occurs for the client that day, and the appointment start time is
earlier than the current time, then the action will be attached to that appointment. If this
is not the correct appointment, it can be removed by checking the relevant box and
selecting the Detach button. The correct appointment can be added by selecting Attach
and choosing the correct appointment. If the appointment is attached to a referral, the
Referral field will be filled in automatically.

o If the incorrect Action was completed, select Un-complete to remove the Action from the
Completed actions table.

The next appointment can be booked using the Book or Search and Book facilities in the
same way as for Referrals. See Section 3 for further details.

If a future appointment exists, this will be shown in the Next appointment window.

Nextappointment  16/01/2020, SAV ENT audio Search and book

13.12.2 To add Outcomes to an IMP

e Choose a Need number.

Oubcames Remave
| Heed Culcome Score Duate Ll

2
3

« Input any outcome text by clicking in the Outcome column.
o Click in the Score column to add a free text score. The limits for the score are set by the
System Administrator.
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« Double-click in the Date column to add the current date. This can be edited if required.

e Click in the Need status column and select from the drop-down menu of pre-defined
need statuses.

« If an Outcome should be removed, highlight the Outcome and select Remove.

Outcomes: Remove
Need Outcome Date | Need status A
2 Bin fir 6070 14101/2020 | (EGEGED

Once the IMP has been completed, it can be printed. A snapshot of the IMP can be taken at
any time. Both of these actions are performed by selecting Print and Store.

| Printand Store | Printinformation documents
Selected IMP
Started on 130142020 E
IMP type Hearing Aid - Adult -
Referral 180662015, ++ALDIO REVIEW re; |

« Once Print and Store has been selected, a window opens giving you three options.

o Print - Will print the full IMP.

« Snapshot and AJE - Will take a snapshot of the IMP as it is on the current day. A
snapshot is a locked version of the IMP taken on that date, so that the current IMP can
be compared to what the earlier state was. The information from the snapshot can be
added to the Journal as an Automatic Journal Event (AJE) if this is set up by the System
Administrator.

« atappointment - you can attach the snapshot to an appointment by clicking the button
to the right of the field. The button will be disabled if you have not selected Snapshot
and AJE.

« IMP has been Shared with patient on (date) - This will indicate on the main IMP page
that the IMP has been shared with the client. The text for this is configurable by the
System Administrator.

Print and Store IMP >k
Ok Cancel
M Print
M Snapshot and AJE
at appointment N
EI Attach
B IMF has been Shared with patient on 2B/05/2020 E
Detach
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o Check or un-check the relevant boxes to choose which action to undertake.

o If asnapshot is taken, the IMP can be seen in the IMPs list as a folder item with the
snapshot attached to it. The folder icon indicates that an IMP has attached snapshots. If
the snapshot is attached to an appointment, it appears under the appointment it is
attached to, but not under the appointment the original IMP is linked to.

« If Print and Store is selected for a snapshot, only the Print option will be active.

[ Client T122729 MRS FIRSTNAME22729 LASTNAME22729 | ~

Wiew | List | Treatment summary | Individual management plan

IMPs: 1210312020, Hearing Aid - Adult

Print and Stgre™ AN A L

o Information documents can be printed out for the client by selecting the Print
information documents button.

« A window will open with a list of the available documents. These are set by the System
Administrator.

Print information documents >

W Selectall Erint Cancel

| Title
test letter template 02/09/2013

Cnly M3 Ward documents can be printed, so anly those are shown

« All the documents can be selected by checking the Select all box. Individual documents
can be selected by un-checking this box and checking the box of the relevant document.

o Print will send the document to your default printer.

« Cancel will close the window without printing.
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Once the IMP is completed, the date of this can be added to the IMP finished and patient
discharged on (date) field. Double clicking in the box will add the current date or the calendar
can be used to add another date.

13.12.3 Adding IMP to offline databases

IMPs are copied to the laptop database. However, referrals are not copied, and not all
appointments are copied.

An IMP appears in the offline database as not attached to a referral, and potentially not
attached to the appointment it was started at.

Similarly, IMP completed actions can be detached from appointments during copying to the
offline database.

However, for IMP snapshots copied to the laptop database, appointment information is copied
as well.
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13.13 Searching the Journal text

The text in a Journal can be searched using the Sicon in the upper window or by right
clicking in the lower window. A box will open where you can insert the text to be searched.

Find et

Findwhat: ||

Match whole words only Cancel

Match case

Depending on which are you are searching, the box will be labeled Find in upper text or Find
in lower text. There are two choices which are selected by checking the box; Match whole
words only or Match case. Find Next will search the journal and highlight the searched for
word.

APPOINTMENTS - SYSTEM ADMINISTRATOR
The appointment was movedClient appointment moved: Date: 10/01/2020; Booking resource(s). Charlie ( start time: 14:00 -
end time: 15:15; Symbal PHAC. new natient mauld~}

APPOINTMENTS - SYSTE
Appointment PHAC n€ ringwhat: | booking Find Mext tancellation history having a

status of Qf Cancelled
Match whole words anly

APPOINTMENTS - SYSTE Match case
The appointment was n Res109 ( starttime: 13:15 -
end time: 13:30; S‘_\mebl_ TIPS TISW At Friona

Cancel

Cancel will close the box.
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14 Treatment summary

Click the button below to access our training materials.

To view treatment summaries for a client, select the client, select the Journal module and click
the Treatment summary tab.

Treatment summary consists of two sections. The upper section is a list of existing client’s
summaries. The lower section is for viewing and entering details about a specific treatment
summary.

The lower section can be in either brief or extended form, i.e. showing standard or extended
data. This can be toggled on/off by the View -> Extended treatment summary menu.

As for journal text, treatment summary can be signed or unsigned. A sighed summary cannot
be changed, whereas an unsigned summary can be edited. Signed summaries are shown in
black in the upper table; unsigned summaries are shown in red.

Be aware: Before proceeding, please make sure the correct client is selected to avoid making
an incorrect summatry.
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14.1 Treatment summary overview

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Navigation -> Journal or press Shift+Ctrl+J.

o Select the Treatment summary tab.

A shortcut is available in the menu bar. This can be selected from any module =l

A treatment summary can contain links to the following data for the client:

o Observations

o Hearing instruments and earmoulds
« Journal text

o Audiogram

o Referrals

« Waiting list entries

« Appointments

o Clinical history

o Tympanometry information

Oil Auditbase - [Journal] — [} X
File View Functions
LJ| Client <T>T18765 MR JOHN SMITH - 2 % Bl User SYSTEM ADMINISTRATOR All locations ~ All departments Alt « 1
View | List || Treatment summary | Individual management plan
Create date | Mo. Type Created by Signed by Review status
[v]| 2 019 |3 Default summary type SYSTEM ADMINISTRATOR SYSTEMADMINISTRATOR
[/ 21/08/2019 |2 Default summary type SYSTEM ADMINISTRATOR SYSTEM ADMINISTRATOR Draft
[ 21/08/2019 |1 Default summary type SYSTEM ADMINISTRATOR SYSTEMADMINISTRATOR Draft
[ 22/06/2015 |1 Default summary type full name tests??7? full name tests??7? Draft
Mew Print/Send Sending status Sign Delete Save unsigned Save signe
Create date 21/08/2019  No. 3 Review status Draft Audiogram  11/03/2019, no. 1, Aided List =
Client observations Remove | Hearing test outcome
R. SRT.
| obsno. | Dale [Add s Text Comment
0127 2410312015 Test observation qo B0 wm te» mw e ew o o o L SR
o 00 X
" OM. > % % % @ = LISk
= X\I—I—EI—I—E. IE = L. DS%:
= O S S R S &1 ™
Hearing instruments / Earmoulds Re e 40 & DS Moise:
| Modified Description = 'ﬁa'éﬁ‘? &gﬁ?-)é),;p = R.:
&0 = ™ 40
: L:
[]22/06/2015 |R:A&M, SELECTRA, 23223 o SR -
= o
w© M=l d- | me sl n
100 \. S o
1o T- I - B
Journal text Show text (F7) Remove | M—H—Ml
|Create date Keyword Created by | Signed by 120
[]|16/08/2019 | GENERAL SYSTEMADMI SYSTEM ADMI "
Appointment 01/03/2019, ittt oD
Referral 22/06/2015, +DIRECT REFERRAL /Audio ¢
Standard summary

Since a summary contains only links, adding information in the summary only creates a link,
and removing information from the summary only deletes a link, but not the information itself.
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A summary can be signed or unsigned. Only unsigned summaries can be modified or deleted.

Unsighed summaries are shown in red in the upper table of the summary window; signed
summaries are shown in black.

A treatment summary cannot be signed when it contains no journal text, or unsigned
journal text, or an unsigned audiogram, or any data in extra details.

The Preview and Print buttons will take you to a selection window, where you chose which
recipient to preview or print the summary for.

The lower part of the window contains details of the summary selected using the check box.
This lower part is intended for the creation and/or editing of summary details.

The detailed part consequently consists of two further parts. The upper part stores
observations, Hearing Instruments and earmoulds, journal text and audiogram.

The extra part is visible when View -> Extended treatment summary menu is flagged from the
menu item View -> Extended treatment summary, and contains the tabs Contact history,
Clinical history and Tympanometry information.

o)} Auditbase - [Journal] — [m] X
Eile View Functions
S =

12 &

Sort by  Extended treatment summary = Save window setup
Sort
IL]| Client | Extended treatment summary ETNAMHOS | A = |Bl|user SYSTEM ADMINISTRATOR All locations * All depariments - ¢ @
22. View | List |Treatment summary | Individual management plan
a
= [ create date| No. | Type [ Created by Signed by Reviewstatus | ~
- [~ |15/06/2015 |1 Default summary type full name tests??? full name tests?7?7? Draft
[~ | 28/05/2015 |1 Default summary type full name tests??? full name tests??7? Draft
v I 51 Default summ pe full name )
r 04/2015 |1 Default summary full name tests?277? UNSIGHNED Draft v
New Print'Send Sending status Sign Delete Ins Save :
Create date 01/05/2015 No. 1 Review status Draft Audiogram  29/04/2015, no. 8 L
Client observations Add Remove | Hearing test outcome
Obsno. | Date |Adds] Text Comment A R SRT.
125 30/09/2013 |2 | R Presbyacusis LEFT Right o w0 tem aw wee e s ee e Lemz
[~ |128 30/09/2013 |1 |L | Otoscleros QCCUPATIOMNAL Left @ g e
125 16/05/2014 |2 |L | Presbyacusis LEFT Left 1AED 1 e > - R DS%:
¥ = - o - L. DS%:
g w0 o N ™
Hearing instruments / Earmoulds Add R e o Ea S @ DS Noise:
Modified Description - = R:
& “
[~ | 01M2/2014 |L: EM 2101 - SOLID~ACRYLIC HARD, R: EN - - L:
[~ |17i/07/2014 |L: EM 0350 - SPECIAL EARMOULD ~ SEE & 0 14 EY
[T 1 15/04/2014 |L: EM 2101 - SOLID~ACRYLIC HARD, R: EN = © o o
[~ | 14/04/2014 |L: EM 0350 - SPECIAL EARMOULD ~ SEE 8 e °
o
Journal text Show text (F7) Add R e .
Create date Keyword Created by | Signed by | 1
[~ |01/05/2015 | ADULT DIAGR full name test | full name test =
[~ | 01/05/2015 | ADMIN full name test | full name test
Appointment co
Standard summary

NUM e

© Auditdata - 2022, ID: 20.0040/29

325



User Guide

Under Contact history you will find referrals, waiting list entries and appointments. The
Clinical history will show medical history and questionnaires. Tympanometry includes
tympanograms with values.
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14.2 Creating a summary

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation->Journal or press Shift+Ctrl+J.

o Select the Treatment summary tab.

o Click New.

In the opened window, click either Open blank summary or Create summary of type
and select a type in the drop-down list.

Create treatrment summary *

Open blank summary
% Create summary of type

Default summary type -

OK Cancel

o Click OK.
+ The system shows a blank summary or one filled with some details independent of the

above selection.
OR

« From any module, click the 2 toolbar button. The system will create a summary pre-
filled with details as configured by the system administrator. The automatically filled
details for a new summary can be modified as required.

In the summary details area:

« In both cases the system assigns a number for a new summary and shows any pre-filled
summary details in the lower part of the screen, where the details may be modified if
required to add client observations or procedures, click Add above the table.

o To add client hearing instruments and/or earmoulds, click Add above the table.

« To add journal entries, click Add above the table.

o To add an audiogram, click List above the table.

« In the corresponding windows, select the entry to add.

o In Treatment summary, click Save unsigned.

OR

« Click Save signed to both save and sign.

Please note that lower screen section view may show standard or extended details
depending on the setting in View -> Show extended treatment summary
(checked/unchecked).

© Auditdata - 2022, ID: 20.0040/29 327



User Guide

14.3 Editing a summary

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the Treatment summary tab.

« Mark the check box for the summary you wish to edit.

In the summary details area:

Modify the summary date if required.

To add a client observation or procedure, click Add above the table. To remove an

observation or procedure, click Remove.

To add a client's hearing instruments and/or earmoulds, click Add above the table. To

remove an instrument or earmould, click Remove.

To add a journal text, click Add above the table. To remove a journal text, click Remove.

To review journal text included in a summary, select the records you want to see in the

Journal text table by checking the box, and press Show text. The system shows a dialog

where the text is seen.

« Toadd an audiogram, click List above the graph. To remove an audiogram, click
Remove.

« Toinclude referrals, check the Show referrals box.

« Toinclude waiting list entries, check the Show waiting list entries box.

o Toinclude appointments, enter Number of appointments in the past and Number of
future appointments.

« Click Save unsigned.

Or

« Click Save signed to both save and sign.

Note that only one audiogram can be included in a summary, whereas more than one
observation, hearing instrument, earmould and journal record is allowed.

Extended summary details can include the client’s referrals, waiting list entries and
appointments.

The summary contains references to already existing data for the client. Therefore, when
adding a record to a summary, for instance an observation or procedure or hearing
instrument, only a link to the existing data is established, but no new data is created.
Likewise, removing a record from a summary only removes the link.

Changes made to a summary detail remain only on the screen until the summary is
saved.
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14.4 Signing a summary

Signing means "locking" a summary and protecting it from changes.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Journal or press Shift+Ctri+J.

Select the Treatment summary tab.

Check the boxes for the unsigned summaries you wish to sign. You can sign multiple
summaries at the same time.

If defined by the system administrator, any unsigned journal text included in the
summary may be signed along with the summary.

Click Sign.

The selected summaries will become signed and show in black in the table.
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14.5 Deleting a summary

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the Treatment summary tab.

o Check the boxes for the summaries you wish to delete. You can delete multiple
summaries at the same time.

o Click Delete.

o The selected summaries will disappear from the table.
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14.6 Printing or previewing a summary

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Go to Navigation -> Journal or press Shift+Ctrl+J.

o Select the Treatment summary tab.

o There are two ways of printing a summary:

o Select one or more summaries in the upper table and press Print.

« If you just want to print one summary, press the Print button below the details area.

« Either way, the Print summary dialog opens. In the dialog you can select who the
summary should be printed for and the number of copies.

e You can preview the print layout before printing. Please note that the layout for a single
summary only can be previewed.

o To preview, select a summary by checking the mark in upper table and press Preview.
The Print summary dialog opens and you can define the recipients.

Print summary >

Add recipient Erint Preview Send electronically Close

Summary recipients

| MName Copies
P 1
DRAALLEN, 3 VALE AVENUE, WANTAGE, OXON, PC:B376 1
Client 1
CFANDERSON, MERCHISTOMN SURGERY, HIGHWORTH ROAD, STRA 1
[J/ENT 1
[]| DRASH, KINGSWOOD SURGERY, KINGSWOOD AVENUE, PARK NOR] 0
[/ Journal 2
Print to other recipient Copies 1

Please note that a summary print layout can depend on the summary type. This is
defined by the system administrator. The system administrator can also define that an
unsigned treatment summary is marked with additional text on the print layout.
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14.7 Sending status of summary review

There is a possibility of sending the status of the treatment summary electronically instead of

printing it:

Make sure that the necessary client is selected.

Open the Journal module and go to the Treatment summary tab.

In the list of treatment summaries, double-click the summary to open it.

Under the audiogram, select the appropriate summary review status.

Under the treatment summary list, click the Print button.

In the Print summary dialogue box, select the necessary recipients and click Send

electronically.

R N e

The system will collect submitted summaries and will reflect the acknowledgement status in
the treatment summary list.

To review the submission status of the treatment summary, please follow these steps:

1. In the treatment summary list, double-click the necessary summary to open it.

2. Under the treatment summary list, click the Sending status button.

3. The Treatment summary submission status dialogue box opens. Use the Edit and
Delete buttons to edit or delete the treatment summary status correspondingly.

© Auditdata - 2022, ID: 20.0040/29

332



User Guide

15 Invoice

The invoice module is divided into two tabs; Postings and Invoice. Postings are orders which
are not yet invoiced. When you open the invoice module the postings view is shown by default.

The top part of the screen is a filter. You can use a user defined filter or use filter criteria such
as date interval, customer, for instance an insurance company, or invoice type.

NUM
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o)} Auditbase - [Invoice] — [m] ped
File View Functions
@ Client  T1106 MRS FIRSTNAME106 LASTNAME106 = ,.o\ > |H|user SYSTEM ADMINISTRATOR All locations ~ All departments - Q @
= Postings | Invoice
2
=y
3
= Search
Cust. group - Invoice type -
Customer - User -
Date from to Show postings Notinvoiced -
Save Refresh
Selectall Mo rows selected Cop Edit
All
Date ‘ Serial No Group | Manufacturer Aricle |Side | Hospital no. | MNHS no.| Invoice type | Customer -
|| 10/03/2020 PROCEDURES (Senice) ADULT 1 T1106 Invoice type 1 Oleksand
10/03/2020 PROCEDURES (Service) ADULT 1 T11068 Invoice type 1 Oleksand
|| 18/02/2020 908765432101234 |NHS HEARING AID (Serial Mo.) |MHS SUPPLIES |ITE10ML L T1106 Invoice type 1 | BRISTOL PCT SYSTEM:
_2‘])’10)’2015 PROCEDURES ADULT PTAT T1106 Invoice type 1 full name
211042016 PROCEDURES ADULT 1 T11068 Invoice type 1 full name
7219’109’2018 PROCEDURES ADULT 2 T1106 Invoice type 1 full name
_2‘])’10)’2015 PROCEDURES ADULT 1 T1106 Invoice type 1 full name
18/10/2016 PROCEDURES ADULT PTA1 T11068 Invoice type 1 full name
7189’109’2018 925104 MHS HEARING AID MHS SUPPLIES |ITE10ML - T1106 Invoice type 1 | SWINDON PCT | full name
_‘IEJ"IUJ’EU‘IE PROCEDURES ADULT 2 T1106 Invoice type 1 full name
18/10/2016 PROCEDURES ADULT 1 T11068 Invoice type 1 full name
|| 18M0/2016 PROCEDURES ADULT 10 T1106 Invoice type 1 | SWINDON PCT | full name
_‘IEJ"IUJ’EU‘IE PROCEDURES ADULT 1 T1106 Invoice type 1 full name
0B6/07/2016 PROCEDURES PAEDIATRIC COMMUNITY T11068 Invoice type 1 | SWINDOMN PCT | full name
|| 05/03/2016 BATTERIES MHS SUPPLIES |13 - T1106 Invoice type 1 | UNKNOWN PCT | full nasz
05/03/2016 BATTERIES NHS SUPPLIES |13 - 7108 Invoice type 1 | UNKNOWN PCT |full name——————
< 3
Total price: 1,042.82
Fostings count: 43
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15.1 Symbols
(= Invoice, in the list
E] Credit note, in the list
~ At least one invoice has been credited
= All of the invoices have been credited
- Invoice, in the Invoice window
-

Credit note, in the Credit note window

334
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15.2 Set up filters

You can apply a filter to the list of postings or invoices.

Two filters are pre-defined for both Postings and Invoices, Client and All. These filters are
shown and accessed via buttons above the table containing the list of postings and invoices.
By default, when entering the invoice module, all postings and invoices for the selected client
are listed. If you change the client, the list is updated. If you check the All button, all postings
or invoices are listed.

You can also create more complex filtering criteria such as pre-defined date range or a specific
customer, by setting up a user-defined filter.

If you want to use an existing filter, the filter can be applied by selecting the Filter from the
drop-down list.

If you want to create a new filter, first create the filter parameters in the section Search. You
can filter the list by customer, customer group, date range, payment method, invoice type or
the user who created the posting or invoice. Note that you can leave one of the date fields
empty. If you leave the From field empty, the date interval indicates less than or equal.

Setup filters x

Mew Save Delete Close

Filters Filter info
# | Posting filter

Mame

Invoice and credit filter

Filter 1
Filter 2

For invoices, two more criteria are available. If you wish to see invoices as well as credit notes
select both in the View drop-down list. Otherwise, select either invoice or credit note. You can
also specify invoice number.
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Next, save the defined filter by pressing Save. In the opened Setup filters dialog, select a filter
type, Posting or Invoice and enter a name for the new filter. If you want to overwrite an existing
filter, select its name in the list and press Save.

From now on the new filter can be applied by selecting in the Filter drop-down list.

Alternatively, you can start by creating a name for the new filter in the Filter setup dialog.
Then, specify parameters and save the filter.
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15.3 Creating an invoice

An invoice is created from postings. A posting is a row describing a number of articles of the
same type which have been issued to a client.

)
o))

Invoice X

File View Func
IO client  <T>T18765M Invoice s -|[2x] 2
Postings | Invoice Information Sendto
Customer group Cu #| Client
Filter Filter 2 R
Search Date of invoice 13/01/2020 MName FIRSTNAME106 LASTNAME106
Cust group User SYSTEM ADMINISTRATOR |+ Address
9 200K XXX
Customer Payment account  Audiology dept - KOO0
Date from | 1 Invoice type Invoice type 1 XHXXXRK
M| Selectall 1row selected

Selectall 1 row sel

= M | [Transaction date| Article | Manufacturer |Signature|Gustomer| Hospital no.] aty[ Unit price| Discount] Total ex. vat| Tot:
e = 16/04/2014 ITE10MR | NHS SUPPLIES |tests T1106 1| 9000 0.00% 99.00 [ Total price | Refer

?,/| 16/0412014 | 212123 5| 99.00
| |16i0412014] 23222 I 0.00
| < 2>
|| Total price ex. VAT 99.00 |
| Comments Total price inc. VAT 99.99 |
I -~
<1 -

99.00

o Select Modules -> Invoice or press Shift+Ctrl+l.

« From the stock module, you can access the invoice module directly by clicking the invoice
button.

« Select the Postings tab.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Postings for the selected Client are displayed or select postings for All.

« Choose the posting(s) and click on the Invoice button. You can only select one type of
posting.

o Specify the payment accounts and submit the invoice by clicking Invoice.

« The invoice module creates and saves the invoice.

o The postings are transferred to one single line with the same invoice number and are no
longer listed in the postings tab.

« The Invoice module returns and displays the remaining postings.

o If the invoice addressee is a customer or group, the system requires customer code.

o Depending on the setting made by the System Administrator, if the customer has no
code specified, the system either show a warning or prohibits the invoice saving.
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15.4 Payment accounts

« Select Functions -> Payment accounts to view accounts listed.

Default

Payment account x
Mew S Delete Close
Accounts:
: Information

Audiology dept.

General treatment Mame: ||
Mumber:
Description: -

o Press New to initiate the creation of a new account.
o Enter Name, Number and Description of a new payment account.
« Set the default payment account by checking the default box.

« Press Save to save the account.
o To edit an account, select the account in the list and modify the details. Then press

Save.

o Press Delete to delete an account selected in list.

Note that the system does not allow for deleting an account referenced by an invoice.
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15.5 Customer groups

Creating a Customer or Customer group has now been moved to the Administration portion of
Auditbase and is now an extended right for users.

Information on how this is done can be found in the Administration User Guide.
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15.6 Creating a credit note

A credit note is created from the invoice view in the invoice module.

« Goto Navigation -> Invoice or press Shift+Ctrl+I.

« Select the Invoice tab.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Invoices for the selected client are displayed. You can also select invoices for All.

« Double-click on the invoice. If the invoice contains several postings, select the invoice(s)
you wish to credit and click on Credit note.

OR:

o Select the invoice and click Credit note from the invoice tab.
o Click Yes on the appeared warning.
o Click Print to print the credit note.

Only users who have been granted rights to create notes can create the credit notes.
You cannot cancel a credit note when you have pressed the credit note button.

Postings | Invoice

Filter -
Search
Cust. group - Invoice type - Date from to
Customer - User - View Both ~ Mo,
Save Refresh
Credit note Open Cancel invoice
All T L

Date Number|Invoice type| Receivertype| Rec Invoice X User CIL|Hospital no.| NHS no.

£ 5 15 OTHER Client . 3 Y I y lame te 7L |T18765 8
h{ nt st t ctions,
(2700312015 16|OTHER | Client SMITH /B for postings imduded i this credt note. | jametests???|L |T18765 | 28388888
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15.7 Editing postings

Sometimes you need to modify a posting before invoicing, e.g. change customer or price.

Select the Postings tab.

Highlight the posting and click Edit button.

In the opened Edit posting dialog, the following data can be modified:

« Invoice type may be selected in the drop-down list.

« Price.
« Invoice payer.

Go to Navigation -> Invoice or press Shift+Ctri+I.

Press F3 to search for the client or Ctrl+F3 to make a quick search.
Postings for the selected client are displayed or select postings for All.

o The “to customer” option must be selected along with Customer in the drop-down list if

the payer is a customer.

« An Invoice without client reference can be made by selecting the corresponding check

box.

« The “to client” option must be selected if the payer is a client.

« Click Save or Cancel to close without saving.

Edit posting: ADULT, 1 it
Receipts Label Print Save Cancel
Client MR JOHMN SMITH
Date 1310172020
Referral
Price Invoice type
£0.00 Invoice type 2 hd

Invoice

to customer

# | to client

Annual card number
Annual card date due

Preferred payment method  [{e=l{sFaE=05 =i -

Receipt 1D

Card request status

Transaction submission
status

Transaction D
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« If Visit charge features are enabled in the Administration tool there will be a section in
the bottom of the dialog referring to visit charges. Here you can read or enter Annual
card number, Annual card date due, Preferred Payment method, Receipt ID, Card
request status, Transaction submission status and Transaction ID which are options
that refer to managing visit charges, primarily used in Sweden.

In this case you will also see a Receipts key in the top part of the dialog. Receipts allows the
user to select and print one or more of the following documents: Anonymous number,
Roadmap or route directions from present location to selected waiting room, and Payment

receipt.
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15.8 Deleting postings

o Go to Navigation -> Invoice or press Shift+Ctri+l.

« Select the Postings tab.

« Press F3 to search for the client or Ctrl+F3 to make a quick search.
Postings for the selected client are displayed, or select postings for All.
Select one or more postings and click on the Delete button.

User rights to perform this action are set up by the System Administrator.
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15.9 Regenerating postings

Postings can only be regenerated if they have been created from services, not from stock
articles. This is set by the System Administrator.

« Go to Navigation -> Invoice or press Shift+Ctrl+l.

Select the Postings tab.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Postings for the selected client are displayed, or select postings for All.

Select one or more postings by clicking on the far-left hand box and click on the
Regenerate button. An information box will appear asking for permission to continue.

Inveoice

I@I Do you want to regenerate the selected 3 postings?
k. * 4

Yes No

o The postings will then be copied but one year will be added to the date of the postings.

Postings | Invoice

Filter Filter 1 -
Search
Cust. group - Invoice type -
Customer - User -
Date from to Show postings Mot invoiced -
Payment method - Save Refresh
Selectall 1 row selected Invoice Delete Copy Regenerate Edit
All

Date Serial No Group Manufacturer Article | Side|Hospital no.| NHS no. | Invoice type Cug ~

z 10/01/2022 PROCEDURES (Service) ADULT 8 8| Invoice type 1
. 1000172022 PROCEDURES (Semvice) ADULT 3 T18765 38888888 | Invoice type 2
. 10/01/2022 PROCEDURES (Semice) ADULT 3 T18765 38888888 | Invoice type 2
. 10/01/2021 PROCEDURES (Semvice) ADULT TYMP T18765 38888888 | Invoice type 1
. 1000172021 PROCEDURES (Semvice) ADULT 2 T18765 38888888 | Invoice type 2
. 10/01/2021 PROCEDURES (Semice) ADULT 2 T18765 38888888 | Invoice type 2
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15.10 Export invoices to CSV file

A list of invoices can be exported to a CSV file by selecting Functions -> Export to CSV file from
the Invoice tab.

Create CSV file X

Save Cancel

CSY file

Choose delimiter Semicaolan -
Save as..

M Include Column headers in C3V file

Open file after creation

o In the opened dialog, select a delimiter to use from the drop-down list. Semicolon is the
default setting.

« Choose a file name by pressing the ‘...” button near the Save as field or enter a file name
manually.

o Check Include column headers in CSV file if the data should be created with headers.

« Check Open file after creation if you want to view or edit the file after creation.

« Save performs the export.
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15.11 Cancelling an invoice

« Goto Navigation -> Invoice or press Shift+Ctrl+I.

o Select the Invoice tab.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Invoices for the selected client are displayed, or select invoices for All.

o Select the invoice and click on the Cancel invoice button.

o The system asks the user to confirm the invoice cancellation.

« Once an invoice has been cancelled, an Automatic Journal Event can be created if this

has been set up by your System Administrator.

oil

File

View Functions

ILJ| Client <T>T18765 MR JOHN SMITH - 8 | Z|El|user SYSTEM ADMINISTRATOR All locations +* All depariments - Q ?

Postings || Invoice

Filter -
Search
Cust. group - Invoice type - Date from to

Customer - User ~  View Both ~ Mo
Save Refresh
Creditnote || Open || Cancel invoice
Al

Date |Number\lnvoicerype‘Receivertype| Req Inveice User |Cf|_|HospitaIn0. NHS no.
@ 13/01:2020 73| OTHER Client SMITH =~ e it T S 7E|'\'|ADT{HT‘“STR.ATOR L |T18765 568588868
(2| 2710312015 15 OTHER | Client SMITH |@| YOH SurE you wart fo cancelie sERced VOIS bme tests 777 L |T1s765 | s@ssssss

16 OTHER Client

Yes No

Total price ex. VAT 0.00
Total price inc. VAT 0.00
Invoice count 3

o To view cancelled invoices, select View -> Show cancelled invoices.

Note: Only users who have been granted rights to cancel invoices can perform the cancel
action.

It is only possible to cancel one invoice at a time.
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16 Repair

The repair module keeps track of on-going and closed repair tasks in a hearing clinic. The main
screen in the repair module shows a list of on-going and closed repair tasks.

When the module is opened, the number of displayed tasks is limited by the system
administrator. Click on the More button to show all tasks. The actual task is described in a
repair task.

The repair task contains a description of the task to be conducted and elements and parts
(articles) used to fulfil the task. The repair task will automatically calculate the repair price and
update stock, based on elements and parts used. Each repair task is linked to a client or a
stock item. The repair task is identified by a unigue number, and holds information about how
it is handled in the clinic work process.

The repair task is divided into a description of the work to be done (the Order tab) and a list of
actual parts and services used to do the job (the Workflow tab).

9)) Auditbase - [Repair list] - O *
File Functions
]| Client <T>T18765 MR JOHN SMITH -] A =| Bl |user SYSTEM ADMINISTRATOR All locations ~ All departments - Q 9
MNew repair task by serial number New repair task for current client
Serial Mo. || New Selected client JOHN SMITH MNew
Quick select repair task
Order Mo Serial Mo Find
Repair task list
Filter =All active tasks> - Filter Mare Show all (F11 Open Erint
Order No.|Serial Mo.| Created |Completed Client name Postcode Order type | Status Assignedto |Additional not
12 414697 | 08/10/2015 MR33 BANG13 BENG1233 ABC 1234 | Sample order type | Assigned | USER NAME44.
15 2221 28M10/2015 MRS FIRSTMAME106 LASTNAME 106 PC:4347 | Testorder2 Assigned |USER NAME32
16 21 28/M10/2015 MRS FIRSTMNAME106 LASTNAME 106 PC:4347 | Test order Invoicing | USER NAME32
17 22/05/2018 MISS FIRSTMNAMEZ23089 LASTNAMEZ23089 PC:3192 | Sample order type | Registered
18 07/06/2018 Dr.Test 5 Test 5 M Sample order type | Registered
19 07/06/2018 MISS FIRSTMAMEZ3089 LASTNAMEZ23089 PC:3192 | Testorder2 Registered
20 07/06/2018 MISS FIRSTMNAMEZ3089 LASTNAMEZ23089 PC:3192 | Sample order type | Registered
21 07/06/2018 Dr.Test 5 Test 5 M Sample order type | Registered
22 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
23 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
24 07/06/2018 Dr. Test5 Test 5 11 Sample order type | Registered
25 11/06/2018 MRS3 BANG14 BENG1233 ABC 1234 | Sample order type | Registered
26 02/07/2018 MISS FIRSTMAMEZ23089 LASTNAMEZ23089 PC:3192 | Testorder2 Registered
27 04/07/2018 MRS FIRSTMAME106 LASTMAME106 PC:4347 |Test order 2 Registered
28 04/07/2018 MRS FIRSTMAME106 LASTNAME 106 PC:4347 | Sample ordertype Registered
29 221172018 Professor 20-111FIRSTMNAME32991 15-LASTMAMES2991 | PC:2861 | Test order 2 Registered
30 221112019 Professor 20-111FIRSTNAME32991 15-LASTNAME32991 | PC:2861 | Sample order type | Registered
< >
Total tasks: 17

.
The Repair Task list can be printed out.

o Click Print or select File -> Print list.
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16.1 Repair task list filter

You can apply afilter to the list of repair orders.

« To modify criteria of an existing filter, select the filter from the Filter drop-down list and

click Filter.

Repair task list

Filter =All active tasks=

oG ETRNE <Al active tasks=
43 Mew Filter
Mew Filter1

-1. P S LS

- Filtar

IRS3 BANG
WIRS FIRSTH

« If you need a new filter, select Functions -> Search, or with <All active tasks> selected in
the Filter drop-down list, click Filter.

M Show deleted tasks

Create date

From To

Completed date
From To

Make this filter available for:

Current user only # All users
Save as new
# Save as current Save

Filter - Mew Filter >
Mew Delete Search Close
Search parameters
Order Mo, Serial Mo.
Filter parameters
Order type Sample order type - bl
Technician - */ Customer v
User - Client
Workshop Internal workshop - Delivered by Client -
2IE Registered T After repair -
Sub-status -
) Save filter
Warranty expired? Yes -
Filter name:
B Show only the current client's tasks Mew Filter

o Enter criteria for a new filter. You can combine the filter criteria in many different ways,
using repair task status and label, date, workshop used, warranty, etc.

© Auditdata - 2022, ID: 20.0040/29

348



User Guide

o Enter afilter name and decide whether this filter should be available for all users or only
for the current user.
« Click Save.

The filter is now saved and available from the drop-down list in the Repair task list on the main
screen in the repair module.

You can then edit the user-defined repair list filter.

« Select a filter to be edited in the Filter drop-down list, and click on the Filter button or
select Functions -> Search.

o Modify the criteria you wish to use for this specific filter.

« Modify the filter name if required.

o Select the Save as current option.

« Click Save.
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16.2 Repair order

The repair module is desighed to handle different types of orders. The repair orders are defined
by the system administrator. Each order has three subcategories. Two repair order types could
be Repair and Service issue.

Repair

The order type Repair is used for physical repairs of hearing instruments and other serial
number controlled items. This repair takes place in the hearing clinic or the item is sent for
repair to an external workshop.

Service issue

The order type Service issue is used for service tasks and repairs of items without a serial
number. A Service issue could be a repair or installation of hearing accessories in the home of
the hearing impaired.
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16.3 Creating a new repair task

A new repair task is created from the main screen in the repair module. Either the repair task is

created for the selected client or the repair task will be created based on a hearing instrument
serial number.

« Go to Navigation -> Repair list or press Shift+Ctrl+R.
o Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Click on New or select Functions -> New repair task -> Create for current client.

OR:

« Create new repair task by serial number. Enter the serial number of the hearing
instrument and click on New or select Functions -> New repair task -> Create by article
s/n. To create a new repair task by serial number; the article must be on stock.

« Select order type from the drop-down list and select details in Breakages description.
Group is linked to Type in Order information (pre-defined by the administrator), whereas
Details and Second details are articles in stock.

Once you have selected Type, you cannot undo or change the record.

The Order types are defined by your System Administrator. Additionally, some types require
selection of a device to be repaired. Each order type has three sub-categories: Group, Details
and Second details.

Update repair task X

Save Close

Order | Workflow

Information

Client Test5Test5 Hospital no. §432516 Device list log
Audiogram 041/06/2018, 5, Aided, AuditBase audiogram v Show Deleted

Order information Invoice to Internal

Type Sample order type - * Customer  SWINDON PCT h User SYSTEM ADMINISTRATOR |+

Client Mo client reference

Order No 18 Workshop Internal workshop -
Customer

Create date 07/06/2018 Delivered by Client - Message

Status Invoicing - After repair Postto client -

Breakages description
Details

Show discontinued

Group Details Second details )
BATTERIES (Quantity-Accessory) (5)Testmanu 312
(6)Testmanu 10
NHS SUPPLIES AA(MNA1500)
AAA(MN2400) v
Units 4 Repair type - Note | A
Headline | Details Second details |Units‘Repairtype|Note
BATTERIES (Quantity-Accessory) | MHS SUPPLIES | 675 COCHLEAR IMPLANT | 1
BATTERIES (Quantity-Accessory) NHS SUPPLIES | 312 1
BATTERIES (Quantity-Accessory) | NHS SUPPLIES | AA(MN1500) 1

Additional notes
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« The repair task identifier number is automatically generated by the repair module. You
can type the number manually, e.g. a number that reflects the year and the month.

o Select who to send the Invoice to. The clients default customer is defined in the client
module. The customer can be a person or an organisation pre-defined by the
administrator.

o Enter Customer and Internal data or select from the drop-down lists.

« Enterthe appropriate data or select from the drop-down list Delivered by.

o Enterthe appropriate data or select from the drop-down list After repair. Note that the
content of the After repair list is defined by the system administrator.

« If you wish, select the Workshop to perform the repair and write a message to that
particular workshop, e.g. internal workshop, cleaning. The workshops are predefined by
your System Administrator, who can also configure the order they appear in the drop-
down menu and a default workshop.

o Click the Device list button. Select the device that needs to be repaired. The Device list
shows all devices restricted to a specific client divided into serial number controlled
articles, amount controlled articles and ear moulds.

« If a hearing instrument is not listed in the device list, click the Add external article
button, select the device and Save. You typically need to add a hearing instrument to the
device list if a client has been provided with the instrument from another hospital.

+« When accessing the device list outside the repair module, the list will also contain a list
of the clients pending and closed work orders.

« By default, only not discontinued articles will be shown. To also show discontinued
articles tick the Show discontinued checkbox.

o Save the repair order.

« If the warranty has expired, the warranty date will turn red.

« You can now print the repair task by clicking the Print button.

o Close the repair order.

NOTE: Creating a repair task creates a clinical action. If you attach it to an appropriate
appointment. it will be seen in the Clinical actions tab of the Referral module.
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16.4 Finding a repair task

You can find a repair task either by entering the serial no. of a hearing instrument or by
entering the task no. of the repair order.

16.4.1 Find by article

« Go to Navigation -> Repair list or press Shift+Ctrl+R.
o Enter Serial No. in the Quick select repair task field.
o Click on Find or select Functions - > Find repair task -> Find by article s/n.

16.4.2 Find by Repair task number

« Go to Navigation -> Repair list or press Shift+Ctrl+R.
o Enter Repair task no. in the Quick select repair task field.

« Click on Find or select Functions -> Find repair task -> Find by repair task number.
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16.5 Repair task status
The status of the repair task is either Registered, Assigned, Invoicing, or Completed.

Registered - When an order is created and saved, it will automatically be set to the status
Registered. You can change the status manually to Assigned or the repair task can stay as
Registered until Completed.

Assigned- If the repair cannot be performed now, you can set the status manually to Assigned.
Use a repair task status label to specify why the task is not completed, for instance waiting for
spare parts or external repair. The Assigned status is used together with a status label to detail
the repair process.

Assigned and all further statuses require a technician to be specified for order.

Invoicing - Set task status to Invoicing when the repair of a device is completed, but the task
cannot be closed yet because third parties have not yet issued invoices.

Completed - When the repair task is completed, set the status to Completed manually. An
invoice will be issued and stock will be updated. If the repair price is set to 0, the system will
ask if you wish to issue an invoice

Note: The system administrator can configure the system to automatically set the
Completed status for a task right after creation. This may be useful for tasks requiring no
action.

Repair task status label

The Repair task sub-status provides additional details for the repair task status. Each repair
task status can have different user-defined additional sub-statuses.

An assigned task could for instance have the sub-status waiting for spare parts. The repair
task sub-statuses are predefined by the system administrator.
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16.6 Handling a repair task

« Goto Navigation -> Repair list or press Shift+Ctrl+R.

o Find the repair task.

e You can use the Quick select repair task. Enter either the Repair task no. or the Serial
no. of the hearing instrument and click the Find button.

« Orfind a repair task by Article or by Repair task number - See earlier chapter Finding a

repair task.
Update repair task X
Label Print Save Close
Order | Workflow
Information
PN NHS SUPPLIES, ITE10MR] Serial No. 1121 Warranty date
Client  FIRSTNAME106 LASTNAME106 Hospital no. T1106 Order No. 16
Technician USER NAME32 hd
Order Information
Work date | 28/10/2015 Status Invoicing ~  Sub-status -
Infarmation
‘Work Order
Details
Supplier article no Article name Show discontinued Apply filter X
Component Detail

BEAT (BOOKLET)

BE1001 (PFRES BOX)

OL441 (EM BOX)

AM18805 (SPEC ADAPTORS)

Units 1 Repair type -
Unit price Mote

Articles shortcut

Type Component| Detail | Units | Repair type | Unit price|TolaI | Mote

Total price 0.00

o Choose the Workflow tab. Your system administrator can setup what tab will be default
for each work order type.

« The Technician on the Workflow tab can be filled out with the logged in user as default
- contact your System Administrator.

o Enter work date, status and sub-status. The work date is set by default to the current
date, but you can change the date if you wish. Status is set by default to Registered.

o Select the article(s) you have used to perform the repair task by clicking on Type,
Component and Detail.

« Toreduce the number of articles and faster find the one you are looking for you can also
enter part of the Supplier article no. or Article name in these two fields and press the
Apply filter button.

OR:
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o Click on the Articles shortcut button to select from a list of the 10 most often used
components. The 10 shortcuts are pre-defined by the administrator.

« Open up the article’s information by right clicking on the article under Details.

« Specify Repair type (pre-defined by system administrator) and number of units.

+ Adding a Repair type can be made mandatory by your System Administrator.

« Click on Add.

« Once the article has been added, you can also open up the article’s information by right
clicking on the article in the bottom table.

« Complete the repair task by changing the Status to Completed and click Save.
A dialog box stating the price is shown. You now have the possibility to change the price
of the invoice. If the total price of the invoice is zero, you will be prompted to accept or
reject the invoice.

« Once the repair task has been saved, stock is immediately updated.

¢ You can now Print the repair task.

o Close the repair task.

« When a repair task is completed an invoice will be generated based on the articles used
to perform the repair.

« The repair module generates postings to the invoice module.

Workflow article

Workflow articles are items used during a repair process. The article is either a part of a hearing
instrument or a device to be repaired/changed, such as a microphone or a job to be done, such
as cleaning up and final assembling of the device. Based on the workflow article used in the
repair process, stock will be updated and a repair price will be calculated automatically.

By default, only not discontinued articles will be shown. To also show discontinued articles,
tick the Show discontinued checkbox.

Repair type

The repair type details how the Workflow article will be used. This could be a used spare part
(article) to be exchanged or cleaned. The repair types are predefined by the administrator, for
instance exchange, cleaning or used part.

Each repair type can be marked under stock control, i.e. under full stock control or amount
controlled, see Repair task status. If a repair type with stock control is selected for a Workflow
article, the stock is updated (reduced) with the parts used for the repair.

The repair type factor is pre-defined by the administrator e.g. a cleaning could be defined as
30% of the full price.
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17 Questionnaires

Click the button below to access our training materials.

A number of questionnaires are available from Auditbase. They are all accessible from
anywhere in Auditbase System via Navigation -> Questionnaires. When working with
questionnaires, a client should be selected.

When the required information has been entered, you can save the questionnaire with the
client's record and view it later.
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17.1 HI satisfaction questionnaire

The HI satisfaction questionnaire window is called via Navigation -> HI satisfaction
questionnaire. The window handles and processes HI satisfaction questionnaires
automatically generated by the system.

The window consists of two parts: one for searching for a questionnaire, and one for editing the
retrieved and selected questionnaire.

17.1.1 Search

The following search criteria are available:

Label. You can search for a specific questionnaire by entering its label number.

Client. You can search for all questionnaires for a specific client by entering the Client number.

For selected client. You can mark this check box to copy the number of the current global
client into the Client number.

You can also perform a search without specifying any criteria, but the system will issue a
warning that the search result can be large.

o Press Find to search using the specified criteria. Questionnaires meeting the criteria will
be filled into the Found drop-down list.

o Once questionnaires have been retrieved, you can select any of the questionnaires in the
Found drop-down list.

o The system shows details of the selected questionnaire in the HI satisfaction
questionnaire area, and changes a global client to one the selected questionnaire
belongs to.

17.1.2 Edit
The following data can be reviewed and/or changed:

o Client name, personal number, questionnaire label number and creation date are shown
in read-only mode.

« Questionnaire sent check box and Date: Reflects whether the questionnaire is sentto a
client. You cannot check this box manually; you can un-check it if you want to resend the
questionnaire.

« Questionnaire received check box and Date: This is used to register a client’s reply to a
questionnaire.

« Questionnaire cancelled check box and Date: Used to register if a questionnaire has
been cancelled.

» Press Save to save the changes made to the questionnaire.

« Send initiates the window for storing unsent questionnaires in a file. See Send
questionnaire for details.
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Send questionnaire

Click Send from HI satisfaction questionnaire to open this window. This window
produces a list of unsent and un-cancelled questionnaires to a file according to
parameters specified in the window.

In Send questionnaire registered not later ... days ago specify the minimum age of
guestionnaire to be included into a file. Age is specified in days. The default value for
this parameter is defined by the system administrator. When creating the list, the system
calculates the questionnaire age from the creation date.

In Limited or unlimited number of questionnaires per file specify whether the file
should include an unlimited number of questionnaires, or limit the amount to a specified
number.

In File name enter the name of the file to be created.

Click Send to start the scanning of the database for questionnaires meeting the entered
age criteria and creation of the file.

For each questionnaire included in the file, the system sets a send date. Note that only
one questionnaire per client is included, and if a questionnaire for a client is included in
the file, the system cancels all other questionnaires for that client.
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17.2 Medical History Questionnaire

The Medical History questionnaire window is called via Navigation -> Medical History
questionnaire.

o For details, refer to the Section below (18. Medical History).
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17.3 Completing a Glasgow Hearing Aid Benefit Profile

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Click Navigation -> Questionnaires, and then click Glasgow Hearing Aid Benefit
Profile.

« Fillin First part date. To enter the current date, double-click.

o Fill in First part user. To enter the current user, double-click.

o Special buttons are available for attaching the questionnaire parts to or detaching them
from appointments. The buttons have a picture which reflects the state of the

questionnaire part: either attached (=) or not attached (E+D ). In addition, the buttons
have a tooltip that displays detailed information about the questionnaire linking.

« Click Before Fitting.

o If you want the client to consider additional situations, click Yes.

o Select answers to the questions.

« When the client considers his own situations, type these in and click Finish to ask about
these situations.

o Click OK when the questionnaire window is complete.

o Click Show stats.

o Toview the results, click OK and view Raw scores and Percentiles as required.
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Glasgow Hearing Aid Questionnaire - GHABP

Questionnaires

Mew Save & show stats Show stats Delete Close
First part date ok, Firstpartuser
Second part date &k, Secondpartuser
Situation | Exists |Q1|Q2|Q3|Q4|Q5|Q6

Listening to the television with other family or friends | |
when the volume is adjusted to suit other people

Having a conversation with one ather person when v
there is no background noise

Carrying on a conversation in a busy street or shop rd

Having a conversation with several people in a group | |+

=
=
=
=
Does this situation happen in your life?
Before fitting Before and after fitting After fitting

« The Glasgow Hearing Aid Questionnaire can also be used offline.
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17.4 Dizziness Handicap Inventory

The Dizziness Handicap Inventory (DHI) can be completed and saved for a client. To access the

DHI, select a client and then select Navigation -> Questionnaires -> Dizziness Handicap

Inventory.

A New DHI can be created.
o History will show all previous DHI for the selected client.
o The date the DHI was completed is shown in the Date field.

o Special buttons are available for attaching the questionnaire parts to or detaching them

from appointments. The buttons have a picture which reflects the state of the

iy +
questionnaire part: either attached ( == ) or not attached ( == ). In addition, the buttons
have a tooltip that displays detailed information about the questionnaire linking.

« Phase can be selected from the drop-down list.

o As each Answer (Yes, No, Sometimes) is selected, the Total score for questions is

completed automatically.
« The DHI can be saved or printed by selecting the appropriate button.
o Delete will remove the selected DHI from the database.
« Once changes have been made, Close will shut the page.

Dizziness Handicap Inventory X

Client FIRSTNAME106 LASTNAME106 Print New Save ete Close

History [ — - Date | 13/01/2020 | |2k Phase -
MM | Question Answer

P41 | Does looking up worsen your balance problem?

EZ2 |Because ofyour balance do you feel frustrated?

F3 | Because ofyour balance problem do you restrict travel for business or recreation?

P4 | Does walking down the aisle of a supermarket increase your balance problem?

F5 | Because of your balance problem do you have difficulty getting into or out of your bed?

FG |Does your balance problem significantly restrict your participation in social activities?

F7 | Because ofyour balance problem do you have difficulty reading?

P& |Does performing activities like sports, dancing, household chores such as sweeping or putting dishes away make your balance problem worse?
E9 | Because ofyour balance problem are you afraid to leave home without having someone accompany you?
E10 |Because of your balance problem do you feel embarrassed in front of others?

P11 | Do quick movements of your head increase your balance problem?

F12 |Because of your balance problem, do you avoid heights?

P13 | Does turning over in bed worsen your balance problem?

F14 |Because of your balance problem is it difficult for you to do strenuous work around the house or garden?
E15 |Because of your balance problem are you afraid people might think you are drunk?

F16 | Because of your balance problem, is it difficult for you to go for a walk by yourself?

P17 |Does walking down the pavement increase your balance problem?

E18 Because ofyour balance problem is it difficult to concentrate?

F19 Because of your balance problem is it difficult for you to walk around the house in the dark?

E20 |Because of your balance problem are you afraid to stay home alone?

E21 |Because of your balance problem do you feel handicapped?

E22 | Has your balance problem placed stress on your relationships with your family or friends?

EZ23 Because ofyour balance problem are you depressed?

F24 |Does your balance problem interfere with your job or household responsibilities?

P25 | Does bending over increase your balance problem?

Total score for questions

Total score for Physical (P) questions 128
Total score for Emotional (E) questions 136
Total score for Functional (F) questions 136
Total score for all questions oo
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17.5 Custom questionnaires

Auditbase users can create their own customized questionnaires using this feature found in
Auditbase rather than the System Administration tool. No additional user rights are required to
save the questionnaire for a client, but there is a required extended user right to be able to
create or edit questionnaires. The questionnaire that is created can become a clinical action
and can be seen on the Client Pathway Overview. Questionnaires that have been designed or
saved for a client can be found in Navigation -> Questionnaires -> Custom Questionnaires.
They can be moved to Favourites in the usual way.

17.5.1 Questionnaire design

Select Navigation -> Questionnaires -> Custom questionnaires -> Questionnaires design.

Questionnaires Test Questionnaire - MNew Copy Delete Export Import Preview

Selected questionnaire

MName Test Questionnaire
1D {internal} 12 Awailable for attaching to Implant forms Outdated
Attributes
Fn. + - Copy
1D {internal} Mame Type Value(s) -
Date on Pathway
130 Mew attribute2 Text
109 Mumber2 MNumber -10..10
10 slider2 Slider -10..10
111 text2 Text
12 drop-down list2 Drop-down list Mew value3;MNew value2;MNew value1
113 radio buttons2 Radio buttons MNew value1;Mew valued;New value2
114 Checkbox2 Checkbox
115 Multiselection list2 Multi-selection list MNew value1;Mew valuef;New value2;New val
116 Fixed text2 Fixed comment text
v
< T >
Selected attribute
Type Date - B Use this date in Client pathway view
Name  Date2 e | | |
=
Prompt  prompt2 ---

==

Short result name number

Previously designed questionnaires are shown in the drop-down menu labelled
Questionnaires. Selecting a previously designed will allow it to be edited.

To create a new questionnaire, select New and give the questionnaire a Name. Once the
questionnaire has been saved, an ID (internal) number will be automatically created which will
be needed when designing a Crystal Report.
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If the questionnaire is to be attached to forms in the Implant module, the Available for
attaching to implant forms box should be checked.

A questionnaire can be hidden from view by checking the Outdated box.

A copy of a current questionnaire can be made by selecting a questionnaire and then select
Copy. You will be asked if you want to make a copy of the selected questionnaire. Select Yes
and the name of the questionnaire will have - Copy added to the end of it. This can then be
edited.

Questionnaires can be saved or deleted by selecting the appropriate button. In each case you
will be asked for confirmation. Deletion is only permitted if no questionnaires have been
completed for clients, in that case outdating should be used.

The design of a particular questionnaire can be exported by selecting a questionnaire from the
drop-down menu and then Export. The Save file window will open and you can select where to
save the resultant XML file.

The design of a questionnaire can be imported from a file using the Import button. Once this
has been selected, a Save file window opens where you can navigate to where the file has
been stored. Select the File name and click Open. The new questionnaire will then be saved if
the name of the questionnaire does not match any you have already saved.

A questionnaire can be previewed at any stage by selecting the Preview button. This will show
the questionnaire as a user will see it.

The components of the questionnaire are known as Attributes and can be added, removed,
copied and re-ordered. To create a new attribute, select . ¥ ' and a New attribute will appear in

the Attributes window. To remove an attribute, select | = ' and you will be asked if you want to
save the questionnaire. Select Yes and you will then be asked to confirm that you want to
delete the selected attribute. The order that attributes appear can be changed using the up

and down arrows | | ¥ | Highlight an attribute then use these arrows to change the position
of the attribute in the questionnaire.

The Name of the attribute is displayed as well as the Type of attribute and any Value(s)
associated with that Type.

There are a number of different predefined attributes that can be added to a questionnaire.
Selecting different attributes from the Type drop down menu will show information relevant to
that attribute. The system will request you to save the design between making each attribute.

Text can be formatted using the format icons at the end of each line. Additional parameters
can be shown be selecting the double arrow icon. This will display a box labelled Height (px)
where the height of the attribute box can be changed. This is the number of pixels in height for
the attribute box. The system attempts to auto-size each control to fit the content, but you can
fine tune it with this feature.
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1=

2 NN
| ]

==

us]
—

==

Each questionnaire must have one Date attribute which is mandatory for displaying on the
Client Pathway View. One such field will be created automatically with each questionnaire

Date - This attribute will display a date and can be made mandatory by checking the box Value
is mandatory. If you want to see the date in the Client Pathway View, check the box labelled
Use this date in Client pathway view. A Name can be given to the date and text to Prompt the
user can be added.

Selected aftribute
Type Date A W Use this date in Client pathway view

u[a S

==

Prompt ---

==

Number - This attribute will display number values and can be made mandatory by checking
the box Value is mandatory. The Name for the new attribute will default to New attribute, but
this can be changed. As with the Date attribute, text can be added to Prompt the user and the
text can be formatted. A Numerical value range can be added to restrict the numbers that can
be entered. Entering the From value and the To value means that users will only be able to
enter values between these two numbers. If the result needs to be shown in the Implant
module test summary, the Include result in Implant test summary box needs to be checked.
Once a number of questionnaires have been saved for a client, you can compare the results
over a time period by selecting the box Enable ‘Compare results’ over time. This will enable a
further box where you can add a Short result name which will appear in the compare results.

Selected attribute
Type Mumber - Value is mandatory ==

=

MName Number of ears i
e

» IHNE
a NN

=

Prompt !
==
Mumerical value range
From

M Enable "Compare results’ over time
To

Short resultname| Ears| |

Slider - This attribute will display a sliding scale and can be made mandatory by checking the
box Value is mandatory. The Name for the new attribute will default to New attribute, but
this can be changed. As with the Date attribute, text can be added to Prompt the user and the
text can be formatted. A Numerical value range must be added to display the numbers that
can be entered. Entering the From value and the To value means that users will only be able to
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move the slide between these two numbers. If the result needs to be shown in the Implant
module test summary, the Include result in Implant test summary box needs to be checked.
Once a number of questionnaires have been saved for a client, you can compare the results
over a time period by selecting the box Enable ‘Compare results’ over time. This will enable a
further box where you can add a Short result name which will appear in the compare results.

Selected attribute
Type Slider - Value is mandatory

=

2 NN
A NN

MName New attribute
==

=

Prompt

==

Mumerical value range

S 10 M Include resultin Implant test summary

B Enable 'Compare results’ over time

To 10
Short result name slider

Text - This attribute will display a box where free text can be added and can be made
mandatory by checking the box Value is mandatory. The Name for the new attribute will
default to New attribute, but this can be changed. As with the Date attribute, text can be
added to Prompt the user and the text can be formatted. If the result needs to be shown in the
Implant module test summary, the Include result in Implant test summary box needs to be
checked. This will enable a further box where you can add a Short result name which will
appear in the compare results.

Selected attribute
Type Mumber - Value is mandatory =

1=

2 N m
2 NN

MName Number of ears
F

=

Prompt

==

Mumerical value range

[W) iinclude resultin Implant test summary:

From
M Enable ‘Compare results’ over time
To

Shortresultname| Ears |

Drop-down list - This attribute will display a drop-down list of items that can be added and can
be made mandatory by checking the box Value is mandatory. The Name for the new attribute
will default to New attribute, but this can be changed. As with the Date attribute, text can be
added to Prompt the user and the text can be formatted. Option values are added using +
sign and removed using -. Selecting + will create a New value which will be highlighted. This
value can be edited and more added to build up the list. The position of each value can be
adjusted using the up and down arrows. If the result needs to be shown in the Implant module
test summary, the Include result in Implant test summary box needs to be checked. This will
enable a further box where you can add a Short result name which will appear in the compare
results.
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Selected attribute
Type Drop-down list = M Value is mandatory ==

Name  New attribute HERENE | | |
s
Prompt || Lis A ---
s
Option values
Alw| [+ - W Include resultin Implant test summary

ID (internal) value

514 Red Short result name
515 White

516 Blue

Radio buttons - This attribute will display a series of radio buttons. This attribute cannot be
made mandatory as it will default to the value at the top of the list. If a negative response is
required then a list item called “Not responded” or “Not answered” can be added as the first
item in the list which will then be the default. The Name for the new attribute will default to
New attribute, but this can be changed. As with the Date attribute, text can be added to
Prompt the user and the text can be formatted. Option values are added using + sign and
removed using -. Selecting + will create a New value which will be highlighted. This value can
be edited and more added to build up the list. The position of each value can be adjusted
using the up and down arrows. If the result needs to be shown in the Implant module test
summary, the Include result in Implant test summary box needs to be checked. This will
enable a further box where you can add a Short result name which will appear in the compare
results.

Selected attribute
Type Radio buttons - ==

Mame New attribute i

==

=

2 NN
2 NN

=

Prompt ]
=

Option values

allw| [F] - B Include resultin Implant test summary

ID (internal) | Value
Left Short result name
Right
Both

Checkbox - This attribute will display a check box. Checkboxes cannot be made mandatory as
the desired option could be unchecked. The Name for the new attribute will default to New
attribute, but this can be changed. As with the Date attribute, text can be added to Prompt the
user and the text can be formatted. If the result needs to be shown in the Implant module test
summary, the Include result in Implant test summary box needs to be checked. This will
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enable a further box where you can add a Short result name which will appear in the compare
results.

Selected attribute

Type Checkbox -

Mame  New attribute RSy | | |
==

Prompt ! u A ---

==

[ include result in Implant test summary:

Short result name

Multi-selection list - This attribute will display a box from which a series of options can be
selected and can be made mandatory by checking the box Value is mandatory. The Name for
the new attribute will default to New attribute, but this can be changed. As with the Date
attribute, text can be added to Prompt the user and the text can be formatted. Option values
are added using + sign and removed using - sign. Selecting + will create a New value which
will be highlighted. This value can be edited and more added to build up the list. The position
of each value can be adjusted using the up and down arrows. If the result needs to be shown

in the Implant module test summary, the Include result in Implant test summary box needs to
be checked. This will enable a further box where you can add a Short result name which will
appear in the compare results.

Selected attribute

Type Multi-selection list - Value is mandatory ==

Mame  New attribute HERENE | | |
=

— o [a/ I HHNE
=

Option values .

allw] [+ - (W] Include resultin Implant test summary:

ID (internal) | Value ST EUEITE G Sl CRTTE

521 Mew value Short result name

522 Mew valued

523 MNew value2

524 Mew value3

525 Mew valued

526 MNew values

Fixed comment text - This attribute will display a box where fixed text is displayed and cannot
be edited by the user. The Name for the new attribute will default to New attribute, but this
can be changed and formatted as before.

Selected attribute
Type Fixed comment text -

Mame |Multiselect Ny | | |

>
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Separator line - Inserts a line into the questionnaire to separate sections. No formatting or

editing can be performed.

Once the questionnaire has been created, it can be previewed so that you can see the

attributes with their values.

Test quest

Client

New

193]
T

ave Delete

Close

Questionnaires

Date 13/01/2020 Age attest Oy Om

Created by

= Referral stage

SYSTEM ADMINISTRATOR

Mot linked to appointment

Mew attribute

Mew attribute1

Mew attribute2

@ Newvaluel
21 Mew value2
) Newvalue3
) New valued

Mew attribute 4
2 4

MNew attribute 5

Available items:

1
2
3

Add All Remaove All

This is fixed text

Mew attribute 3

A re-start of Auditbase is required to display the newly created questionnaires in the Navigation

window.
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B-[:1] Custom questionnaires

~[I]] Questionnaires design

~[i} Questionnaires exportto csv

-] AQP Satisfaction questionnaire (CHIME)
~[ti] Cl-spergeskema til barn

~[i] PPVT-4 test (Peabody)

~[t1] Sproglydtest

~[t1] Viborg test

17.5.2 Questionnaires export to csv

Once information has been entered into a questionnaire for a number of clients, the data can
be extracted by selecting Navigation -> Custom Questionnaires -> Questionnaires export to
csv. A window will open where the required Type or name of the questionnaire can be
selected. A Date range can be selected by typing in a date in the format dd/mm/yy or by right
clicking and choosing a date from the calendar. A delimiter can be chosen by selecting one of
the options from the Choose delimiter drop down menu. Semicolon or comma are commonly
used for this field. The location to save the file can be selected by typing in the path in the

Save as ... box or by using = at the end of the field. This will open a Windows explorer

window and the save location can be browsed for.

Cuestionnaires export to csv >

Save Cancel

Custom questionnaire

Type Test quest b
Date range

From 191212014 | To

CSVile

Choose delimiter Comma -
Save as..

Open file after creation

If you want to view the file that is created, check Open file after creation and Microsoft Excel

will open and will display the data from the questionnaire.

A B C D E F G H | J K L M N
Hosp Mo. NHS No. First name Last name Customer code Customer name Date Number Slider Text box A drop down Shoe side Multiselect
3 EVELYN HARPER 13/10/2014 24 51 Red Both shoes 1
T000002 KAROLINA PAC 7HG2 WEST COUNTY  13/10/2014 25 61 White Left shoe 2
TO00007 TEDDY TED 13/10/2014 67 99 White Both shoes 1;2;3
371
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18 Medical History

Medical History is now available as a separate module that may contain the current medical
data of the client and/or the client’s history of medical issues, including:

o Otoscopy, Audiometry

o Eardisease, Surgery

« Balance, Hearing

« Ext.History, Aetiology

o Tinnitus, Other history

o Lifestyle and Communication
o Outcome and Other data

The Medical History window is called from the Navigation pane. If it has been added to
Favourites, it can be accessed from the Favourites section.

The Copy option allows reusing Medical History questionnaires. An existing instance of the
Medical History can be saved with a new date.

The copied questionnaire becomes available when the Medical History window is called again.
Users can then apply and save the required changes.

o)) Auditbase -~ m]
| File | Edt  View  Functions
I
o & A B B 8 8 B A
WasWilFai ! = = 5 > @
Detailed Quick Exportto MS Qutlook  Print schedule | Print letter  |mport data | Export data | Exportto Noah Logoff | Exit Auditbase
Search Export Print Import/Export Client data Exit
E Client <X>T130763 MISS FIRSTNAME30763 LASTNAME30| - || & | = | |User SYSTEM ADMINISTRATOR All locations ~ Al departments A Q ?
| Navigation Monday 09/03/2020 | Mo fiter] ~ . |||f]| General || Daily |||/ ® 15min
| B Favourites = .
8 Clientinformation Medical history X 4[
% gefskrra\ Print - history Print - Ext. history Copy | MNew Save Delete Close
= ooking
&) Documents and attachments Date  07/02/2020 oo PatientName FIRSTNAME30763 LASTNAME30763
o Waiting list - X - X N X
5 Otoscopy, Audiometry | Ear disease, Surgery | Balance, Hearing | Ext.History, Aetiology = Tinnitus, Other history | Lifestyle and Communication | Outcome and 4 »
; ABAudiagram Y, ry gery g , ay uj tyl
| L-CA NOAH madule selecfion b’
Individual client OTOSCOPY
| Individual clien Tickifno significant problem Left
j+)
£ Chen?mf.ormanon - Right
i Paediatric
=] Journal
] Documents and attachments AUDIOMETRY
55 Referral Tick if no significant problem
o]
I _:\Che.nt's e Is there any marked ~  Specify any -
[2 Device st asymmetry? description
| +-EZ Observations and procedures -
(%) Earmoulds
Hearing Therapi Significant air-bone gap? «  Specify any -
Medical history Q description
-
-5, Direct referral HA{adult)
Tinnitus Fluctuation of hearing? « Description -
| - surgery
| =[] M satisfaction Questionnaire -
I @73 Measurements -
Other aud.comment
o o §
| = [ndividual client
I ég? Client pathway view
I b Clinic management
i Stock management
It 0 Usertasks
~
I = .
PPP 1 [
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The Medical History questionnaire can also be printed by employing the corresponding
controls.
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19 Other Features
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19.1 Client’s entries

Click the button below to access our training materials.

Client’s entries presents an overview of a client’s appointments and waiting list entries.

Client's appointments and waiting lists b
Client MR JOHN SMITH Close
Appointments list- 42 itemis) History of changes Attached actions Delete from history Show in appt.book
Diate |Time |Loc.|Dept.| Appt. |Status|Resource Reason |SI'u1S‘1|SI'u'ISE|DecIined offer Symba ~

1310112020 | 11:15 I *  |Resdf from1

13/ )| 09:00 7 Charlie 2

10/01/2020 | 09:00 1 * | Charlie 1

09/01/2020 | 16:30 fit A | Stassy GWH 1 st
09/01/2020 [ 13:45 E| * | Stassy PHAC new patient
09/01/2020 1315 3 3 1 * |Res54 1

09/01/2020(13:158| 2 3 3 * |Res109 |++GP directreferral PHAC new patient
09/01/2020 | 12:45 3 A | Trawy PHAC new patien! »
< >
Waiting list entries - 7 item(s) Add Ei W

Wait time | Date | Waiting list| Information "
-186 18/06 TGW - PHA

8 06/03 TGW - AUD

-14 06/03 TGW - CALI

-21 16/08 TGW - Audil

9 16/08 TGW - CALI

13 09/07 TGW - DO,

an non« TEIRr Al b

« Go to Navigation-> Client’s entries or press Shift+Ctrl+Q or from the Booking screen
Functions -> Client’s entries.

« If in the Booking module, click Show in appt. book to go directly to the appointment in
the appointment book.

o If aclinic view has been applied to the Booking screen and the appointment you want to
look at is not available due to this filter, you will receive a message that you will need to
change the clinic filter before you can view the appointment.
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Message

The appoirtment you are trying to view in Booking is not available because:

l.\'

- The Clinic filter you have applied does not include this resounce.

Would you like to go to that date in the Booking screen to change your view settings

Yes No

o Select Yes and you will be taken to the appropriate date. Once the clinic filter has been
changed, the required appointment will be highlighted.

o No will return you to Client’s entries

« Toview any clinical actions, documents or IMPs attached to the appointment, click the
Attached actions button. A list of attached clinical and other actions will open in a
separate dialogue box where you can detach them from the appointment if needed.

e You can Add and Edit waiting list entries directly from here and jump to the Waiting list
module by pressing Show in waiting list.

« To delete cancelled actions—they appear in grey—from the history, select them in the list
and click the Delete from history button.

+ Navigate fast between the two lists by using TAB or the keyboard shortcuts Alt+p for
Appointments and Alt+t for Waiting list entries. Use the keyboard arrows to navigate
inside the list.
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19.2 Day view

Day view represents an overview of a booking day. The default setting of the Day view is today's
date, but you can change the date manually if you wish to see a list of appointments for
another day.

« Goto Navigation -> Day view or press Shift+Ctrl+F3.

The system updates the view automatically with the timeout set by the System Administrator.
You can filter the day view by:

« View: All appointments, client bookings, reservations or workflow (see below for more
information).

o Date

« Symbol: If you only wish to view appointments with a specific symbol including outdated
symbols.

« Status: If you only wish to view appointments with a specific appointment status e.g.
DNA, Finished. The statuses can be selected by clicking on the ... icon at the end of the
field and then checking the box next to the required status. Multiple statuses can be
selected by checking multiple boxes. Select will then filter the view showing the selected
appointment statuses. The selection can be cleared by clicking on Reset. If multiple
selections are chosen, their code will display in the Status field. The full description of
the status can be seen resting the mouse cursor on the Status field and a tool tip will
display the code and description for the appointment statuses.

« Resource: If you only wish to view appointments associated with a specific resource.

« You can navigate between the filters by using the TAB button and select specific filters
by using the keyboard arrows or the mouse wheel.

e You can choose to view appointments for all locations and departments, individual
locations/departments or several specific locations/departments.

o Right-clicking on an appointment initiates the Booking information window where you
can modify e.g. the appointment Information or enter Outcome status.

« Double-clicking on an appointment initiates the Edit booking window, so you can edit
the booking directly from Day view.

« Clicking on the Save window setup button saves the currently selected view plus column
order, columns width and the table sort order. The next time you run the Day view
window, the saved table configuration will automatically be used.

« The system refreshes the Day view with the data currently present in the database. The
interval is defined by the System Administrator.

19.2.1 Appointments / Reservation view

o Select the View drop-down list.
« Select either All appointments, Client bookings, Workflow or Reservations.
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03 Auditbase - [Day view] — O *
File View Edit
| Client <T=T18765 MR JOHN SMITH - ro\ = El|user SYSTEM ADMINISTRATOR All locations ~ All departments - Q ’?
Save window setup Restore default layout Print =]
View Date Symbol Status Resource
All appointments - 10/01/2020 E] All - Al -
Time Hospital no. NHS no. | Mame Resuurcelstatus‘ Reason Infurmatlunl Symbol Referenced by| Locati
08:00-08:15|T1110 MRS FIRSTHNAME110 LASTNAME110 Res4f D 11 All
0 Charlie  |* 11
14:00 - 15:15|T18765 88888888 MR JOHN SMITH Charlie |~ ++GP direct referral @ PHAC new patient mould All
< >

o The appointments of the selected type are shown in the table.
« Select an appointment by highlighting it.

« If you right-click anywhere in the appointment, the Booking information opens up,

where you can edit appointment status and outcome status.

Booking information *
Client MR JOHN SMITH Time: 09/01/2020  16:30-17:30 Attached actions Close
Appointment  §f GWH1 ST Location All (no location) Letter:
Timetable o2 Department All (no department) Verbal:
Made by: IRYMNASKLADANA on (8/01/2020  Attnd. with
Resource(s): STASSY Status
[no status] -
* Appt arranged
Q, Cancelled
B, Being seen -
Referenced by Stages condition:
Stage 1| Stage 2| Stage 3| Stage 4|
Reason ] ] ] [ ]
Status change Jelete
Outcome status 2 DL
* Appt arranged 090172020 16:57 [17m]
M L, Arriwved 09/01/2020 17:13 SYSTEM RDMINISTRATOR
Current outcome
Appointment not linked to referral
Linked Waiting list
Details
Hospital no.: T18765; NHS no.. 88888888 -
MR JOHMN SMITH . i
History of changes
99 Information J g
00000 -
JOCO0CO0 - -
Client observation or procedure Add ! Edit/ Delete Edit Delete
Obs no.| SNOMED code|ICD10 code| Date|Add.| S| Text| Comment
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« If you double click on the appointment, the Edit booking window opens up, so you can
edit the appointment directly from Day view.

Edit booking X
Offer declinec Save Close
) . N I Recurrence
Client appointment | Reservation | Group appointment
Mo recurrence
Hospital no T18765 Daily
Mame MR JOHN SMITH Eekh
Phone Home: 99999 999999 Manthly
Annually
Information |
Reason = | Referenced by -
Location All (no location) Department All (no department)
Single resource
Symbaol Resource All locations Date Time  End
1“ ~  Travy - 1000172020 09:00  10:30
22 Stassy Duration
Il from ; .
I to1 Res100 * hours 30 = min.
(M EMT new patient mould~ Resdf -
Appointment stages
3 PHAC new patient mould~ ReshE — g
B8 SAV ENT audio Res70 | Name Descr
(M SAV ENT new patient mould- Rest4 Stage 1 Sample stage 1
ittt Res7&
CLEAR ResT3 Stage 2 Sample stage 2
fit GWH 1 st Resg2 Stage 3 Sample stage 3
fif GWH 2nd fit~~ Res75 Stg
=T ged Sample stage 4
A4 GWH Audio assess~ Res71 &
A2 GWH Audio review~ Res72 < N
07 GWH Direct referral~ v Res105 hd

19.2.2 Workflow view

o Select the View drop-down list.
o Select Workflow.

This view is used for tracking client appointments flow via observation and changing of
appointment stage conditions.

The table shows client appointments and their stages.

o A grey square means that the appointment does not include a specific stage.

« Red square means that the appointment includes a stage but no condition has been set
yet.

o Right-click on the stage cell to set a condition for the stage.
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OZEI Auditbase - [Day view]

— O X
File View Edit
[O| Client <T>T18765 MR JOHN SMITH -2 Z B |user SYSTEM ADMINISTRATOR | All locations - All departments - x| ?
Save window setup Restore default layout Frint =
View Date Symbol Status Resource
Workflow - 10/01/2020 ﬁ All - - All -

Information|Time|
15:471 1

Symbol

Stage 2 ‘ Stage 3 | Stage 4 |Referenced by| Location |Departm|Elooking cocH Waiting room

® Pending

93 PHAC new patient mould

In Process
Completed

Clear stage condition
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19.3 Device list

Use this module to review devices, accessories, earmoulds and repair tasks for a client.

Press F3 to search for the client or Ctrl+F3 to make a quick search.

Go to Navigation -> Device list or press Shift+Ctrl+D.

Only Serial number controlled articles are shown on the Devices tab. Quantity controlled
articles can be shown on the Accessories tab, if configured so by your System
Administrator.

For Devices and Accessories the current situation or the historical situation can be
shown by clicking Present or History.

Devices are listed with stock type, the date when the device entered this stock type, the
name of the device, quantity, status of left/right along with the signature of the user
logged in to the system when the new status was given to the device. Left/right status is
presented by symbols defined by the system administrator.

Accessories are listed with Created date (the date the article was first added to the
client's device list), Latest issue date (showing the last time one of these articles were
added to the device list), Stock type and Stock Group, the Article name, status of
left/right and quantity along with the signature of the user logged in to the system when
the new status was given to the accessory. When this information is viewed in Client
Information, Devices tab, only the Created date is shown NOT the Latest issue date.
This is for performance reasons.

Devices and accessories can be attached to or detached from an appointment by clicking
Attach or Detach, respectively.

The Device tab also shows the serial number of the device and a version number.

ltem information is shown where it has been added for a particular article.

You can change the status of an item marked in the listing by clicking New status or
Alt+N.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

For devices, you can view the selected device in the Stock module by pressing Show in
stock, or Alt+S, or show information for a device by pressing Information or Alt+1. You
can view the History of a particular Serial number controlled article by pressing the
History button or pressing Alt+T.

Earmoulds list shows the date of impression, date of sending to manufacturer, ready
date, types of left and right mould and comments.

Repair list shows which devices are being repaired. The information shown is the
information from the Order tab in the Repair module. Depending on how the Order type
has been set up by the System Administrator, breakage details can be shown over
several lines.

Double-click on a post to open the post.

Click Print to get the listing on paper.
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« You can print a receipt from the Device list by selecting one or more articles and pressing
Print receipt.

Device list *

MNew status Infarmation Show in stock Histary Print receipt Client MR JOHM SMITH Print Close

Devices | Accessories | Repairlist | Earmoulds

%) Prasent History Accessory issue Attach Dietach , en?r?é?;::lemed

| [wodified date Stock type to | Article |LR| User Serial number|ltem information | Version|R
FITTED/EXCHANGED (Issued)| NHS SUPPLIES, BE101 |- | SYSTEMADMINISTRATOR NBGUG858

FITTED/EXCHANGED (Issued)| GNRESOUND, CS61 x| SYSTEMADMINISTRATOR | 5345345

O FITTED/EXCHANGED (Issued)| NHS SUPPLIES, ITE10MR|R | full name tests?7? 1234432 3
0| |25/09/2015 |RECONDITIONED (ssued) | BERNAFON, test L |full name tests??? 1234433 aa
[0 |22106/2015 |RECONDITIONED (Issued) | A8M, SELECTRA R |full name tests??? 23223
< >

« An appointment associated with when an article was modified can be attached to the
Device list by selecting Attach. This will display all the client’s appointments. The
appropriate appointment can be selected by highlighting it and selecting Attach. Close
will shut the window without selecting. If the clinical action for issuing an article is set up
by your System Administrator, an appointment on the same day as a modified article
event will automatically link the event with that appointment, if the appointment start
time is earlier than the current time. The appointment can be unlinked from the event by
selecting the article in the list and choosing Detach.

Attach appointment to stock transaction et

Attach Close

Symbal | Description Resource Status ~
W ENT aui Charlie
13012020 | I from1 Res46 *
13/01/2020 g 2 Charlie *
1000112020 @ | PHAC new p Charlie *
1040112020 1 1 Charlie *
090112020 3 PHAC new p Stassy * W
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Device list 4

MNew status Infarmation Show in stock History Print receipt Client MR JOHM SMITH Print Close

Devices | Accessories | Repairlist | Earmoulds

s Bresent History AcCcessoryissue Detach St_elel:tall
2 entries selected
| |Modifieddate|  Stocktypeto | Article |LR| User |serial number|item| Version| Red Appointment
10/01/2020 | FITTED/EXCHANGEL NHS SUPPLIES, BE101 |- | SYSTEM/NBG09858 1+, 100012020, 1
"1 NT audio
| |25/00/2015 |FITTEDIEXCHANGEL NHS SUPPLIES, ITE10MR R [full name 1234432 3 B& *,24/09/2015, GWH Audio review~
(1| |25/09/2015 |RECONDITIONED (I BERNAFON, test L |full name 1234433 aa F& *,24/09/2015, GWH Audio review~
[ |22/0612015 |RECONDITIONED (1 ABM, SELECTRA R |full name 23223 [T *, 18/06/2015, ENT new patient mc
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19.4 Client observations and procedures

Click the button below to access our training materials.

Use this function to add a predefined observation or procedure to a client.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.
« Go to Navigation -> Observations and procedures.

Observations and procedures *

Add to client Delete Close

Observation list In location and department: = All B Observations M Procedures

0bs no.|ICD10 code | SNOMED code | Add. Text

Presbyacusis

126 126 Otoscleros
127 127 Testobservation
128 128 Test procedure
Client observations Attach appointment
Obs ne.|ICD10 code|SNOMED code| Date  |Add.[ S| Side | Text Comment A
127 127 09/01/2020 Test observation
02 Presbyacusis
127 127 09/01/2020 Test observation
_125 125 01/05/2015 1 r |Right|Presbyacusis OCCUPATIONAL Right |123abc#5%123abcl123abc# 5% 123abcl123abcl#5%123abcl123abck
_125 125 2110412015 1 L Left |Presbyacusis OCCUPATIONAL Left 2
(_ 120 129 NNINARA R | hilat | Taet nraradira rada nn A hilat :\hré\mrrl')QI"I(B\#G:MM?.*((\':\hrémm'I')QI"I(;hiiﬂ:MJ\J?.*((\':hrémrrl')QI"I(;-‘H)N 2

« Select the Current or All location to filter the observations.

« Select Observations and/or Procedures to filter the observations.

« To add an observation or procedure to a client record, highlight the observation or
procedure in the upper table and click Add to client or double-click. Repeat this process
until all required observations/procedures are displayed in the lower table. Click Save.

Be aware: Be careful when adding observations and procedures; ensure the Client is
correct. Entering an incorrect observation or procedure can cause incorrect treatment.

« Toremove an observation or procedure from a client record, highlight it in the lower table
and click Delete.

« Inthe lower table, you can type in a number in the Add. column (Additional code) and a
preconfigured text created by your system administrator is added to the Text field.

e« EnterL, Ror B intheS column for left, right and bilateral or use the Side box to select it.

« To edit the Comment column, double-click in the lower table and the Edit client’s
observations and procedures window appears.
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Edit client's observations and procedures

Mew Save Delete

*

Cancel

Date 09/01/2020

Observation or procedure 125, Presbyacusis

ICD10 code 125

Add. code

Side hd
Comments Some comments

o Enter your comments and click Save.

« You can also add a comment to the observation directly in the list by clicking in the

Comment’s field and entering your comment.

Observations and procedures

Add to client

Delete Close

Observation list In location and depariment: Curren = All M Observations

M Procedures

0bs no.|ICD10 code | SNOMED code| Add.

Otoscleros

126 126
127 127 Test observation
128 128 Test procedure

Client observations

Attach appointment

Comment

Some comments

Appt. Appt.date| Apptname

o Once saved, you can also attach the observation or procedure to an appointment by
selecting the observation or procedure in the lower table and click Attach appointment.

Attach chservation or procedure to appointment X
Attach Close
Date Symbol | Description Resource Status ~
81212018 MALMESBUF Alan *
281212018 i MALMESBUFR Charlie *
281212018 3 MALMESBUF Res70 *
101212018 2] SAY ENT aut Charlie *
101212018 3 PHAC new p Alan *
05/07/2018 1 1 Travy * v
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+ Choose an appointment from the list of appointments and click Attach.
o If you wish to detach the observation or procedure from an appointment, you simply

select the observation or procedure in the lower table and click Detach appointment.

If you choose to detach the observation or procedure from the appointment, it will still

remain on the client’s record.

« Once an observation or procedure is attached to an appointment, it will show up on the
Booking information dialogue box, from where an observation or procedure can also be

attached, edited or deleted.

Resource(s).  ALAN

Status

¥ 08:00 Charlie

¥ 08:00 Res70

Referenced by

Reason

Outcome status

Current outcome
Appointment not linked to referral

Linked Waiting list

Details

Hospital no.: T1106; NHS no.: 5555554444
MRS FIRSTMAME106 LASTNAME106

[no status]

Booking information *
Client: MRS FIRSTNAME106 LASTNAME108 Time: 281212018 08:00-08:30 Attached actions Close
Appointment 5% MALMESBURY ENTAUDIO Location All (no location) Letter:
Timetable 2 2 Department All (no department) Verbal: X
Made by: YULIA MAKUKHA on 28M2/2018  Attnd. with

rFs

* Appt arranged

Q, Cancelled

A, Arrived

B, Being seen
Stages condition:

Status change

¥, Appt arranged 28/12/2018 14:38

5is | Some comments

i History of changes
03000 00000 Information y g
0000000
HOOOGOK -
Client observation or procedure Add [ Edit/ Delete Edit Delete
Comment

o Back in the Observations and procedures window, everything from the observation or
procedure will be written to the journal when you save, including full text and comments
as well as appointment information if the observation or procedure was attached to an

appointment.

o You will also find the observation or procedure in the Referral module with the option of

editing the observation or procedure from the Referral module.
o Further, all changes are reflected in the Paediatric module on the Clinical information

tab.

© Auditdata - 2022, ID: 20.0040/29

386



User Guide

19.5 Hearing Therapist

The Hearing Therapist module contains a number of check boxes and free text fields used to
store specific Hearing Therapy data for the selected client.

o Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Goto Navigation -> Hearing Therapist.

o Previous reports can be viewed by selecting the required date from the Therapist
Reports drop-down list.

« When a previous report is selected, the button Progress report becomes active and brief
comments on specific areas of Therapy can be added such as date and note to training,
visits, etc., to get an overview of the client’s progress.

« Comments can be added and saved with the signature of the Auditbase System user
logged in at the time.

« New clears the details so a new report can be added.

« Click Save.

o Print the report if required.

Progress report Mew Save Delete Print Close

Therapistreports 1, 04/07/2016 -

Client MRS FIRSTHMAME106 LASTHNAME106
g Progress report ot
Save Cancel
Signature full name tests 777 -
Date Mote
Hearing instrument adj. 04/0712016
Functional training 04/0712016 | 2
Training 04/07/2016 | 344
Hearing damage treatment
Intensive course
Education
Home visit
FI
Comments
A Comments - |
n
-
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Hearing Therapist x
Progress report Mew Save Delete Print Close
Therapist reports |1, 04/07/2016 -
Client MRS FIRSTMAME106 LASTHNAME106
Date 04/07/2016 User full name tests??7? -
Pocket BTE ITE Canal Previous hearing aid? Yes Mo
Difficulty walking Sight damage Manufacturer
: S Work/phone no.
Technical aids:
Acoustic signal door phone
Optic signal doar phone atTv
TWiradio telecail room telecoil chair HP-zet
Other wake up call other
Technical aids at work # Yes Mo
Mould handling #| Good Medium Bad
Previous contact with therapist Yag | Mo Advised
Audiologist's -
notes
-,
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19.6 Direct Referral HI (adult)

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Go to Navigation -> Direct referral HA (adult).

o GP and ENT are selected from lists using the button at the end of the fields.

o Choose reason for ENT referral from the drop-down lists if required.

e You can right-click on the drop-down boxes to edit the list of reasons for ENT referral.
o Choose Priority of referral from the drop-down list.

« Click Save.

When this referral page is completed the Direct Referral box in the Details tab of the Client
Information module is automatically checked.

This referral form is a shorter version of the Direct Referral - Medical/audiological history -
DR-Med questionnaire covering the TTSA guidelines for Direct Referral.

Direct Referral HA (Adult) o

Delete Save Cancel
GP DR 5 RATMAMDAM, NORTHLAMDS SURGERY, I
ENT MRS AMMAM, 222 STR, HOME CITY

Date referral received

Referral correct? W Yes Mo

Date of DR clinic visit

Clear of wax? Yesz W Mo
ENT referral advised? Yes [ iNo:

Ifyes, reason(s) -
Priority of referral? -
Impression(s) for hearing
aid provision? Yes No
Referral for

Yes Mo

advicelcounselling?
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19.7 Tinnitus

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Go to Navigation -> Tinnitus.

« Fill in the required details using the tabs to view each screen.

o The Audiogram list will show a list of the client's audiograms. Double-click the date of
the audiogram to view it; no adjustments can be made to the audiogram.

« Click New to create a new form for tinnitus analysis and type in the relevant information.

o Save the report when finished.

The Tinnitus Analysis drop-down field lists any previous tinnitus reports for the selected client.

You can also delete a tinnitus report and print the reports using the buttons at the top of the
page.

Tinnitus >
Audiogram list MNew Save Delete Print Close

Client: MRS FIRSTNAME106 LASTMNAME 106

Date of onset Tinnitus analysis -

Doctor

Aetiology Analysis date  13/01/2020

Remark User SYSTEM ADMIMISTRAT +

Site/Character | Inventory | Patient Description of MTT | Exposure to Moise | Health Problems | Effect of Lifestyle | Tests | Analysis 4 »

Date Phase Grade
Pre Tinnitus Handicap Inventory Score % ..
Tinnitus Handicap Inventary Score % I__|
Post Tinnitus Handicap Inventory Score % e
) . Detach
Categories Emotional %
Functional %%
%

Catastrophic

« Under Inventory, you can either manually enter the percentage score from a pre, post or
current Tinnitus Handicap Inventory questionnaire or you can attach a score from a
guestionnaire by clicking the Browse button next to the percentage field and choosing
from a list of questionnaires.
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19.8 Run an external application

+ Go to Navigation->Run an external application.

The external application configured by your Administrator will be launched with the parameters
configured.
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19.9 Attention list

Click the button below to access our training materials.

When opening the Attention list the system will check the database for issues requiring special
attention. The Attention list consists of several lists, including - Referrals, Journal, Unsigned
journal, Unsigned summaries and Deceased alert. Each time you open the Attention list,
the system automatically generates the list. Progress is shown at the bottom of the window.
You can start to work on the top rows while others are populating. To cancel this, just select
another tab. The text below the tab names describes the reason why clients are shown.

If a user has a Location or Multiple locations selected, the results will be further filtered by
the client’s Location and they will not see all records.

When location is selected globally, a corresponding message will appear informing that "The
List is filtered by Client's Location" .

Attention list *
Do not show awarning message D-Alert selection method PAS alert - Print Show in Journa Close
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission
Active referrals (not Closed or Mullified) that have not been booked or put on the Waiting list - The listis filtered by clients® location

Date |Number|HospitaI no. | MHS n0.| Client name Treatment type -
07/03/2000 | 30700 |T12639 MISS FIRSTNAME2639 LASTNAMEZ2639 SWINDON EARLY SUPPO
08/03/2000 | 282 T19296 MR FIRSTNAME9296 LASTNAMES296 | ++DIRECT REFERRAL /Audio assessment | DR MILEUSNIC Z, THE K
17/04/2000 |30701 |T13758 MISS FIRSTNAME3T58 LASTNAME3T53
19/05/2000 |30704 |T14118 FIRSTNAME4118 LASTNAME4118
19/05/2000 | 30705 |T14119 FIRSTNAME4119 LASTNAME4119
19/05/2000 | 30706 |T14109 MISS FIRSTNAME4109 LASTNAME4109 HASSAN
23/05/2000 | 30707 |T14132 FIRSTNAME4132 LASTNAME4132 SWINDON EARLY SUPPO
23/05/2000 |30708 |T14131 FIRSTNAME4131 LASTNAME4131 SWINDON EARLY SUPPO
02/06/2000 |30709 |T12094 MST FIRSTNAMEZ2094 LASTNAMEZ094 HASSAN
02/06/2000 | 30710 |T14179 FIRSTNAME4179 LASTNAME4179 Health Visitor
14/06/2000 |30711 | T14405 MISS FIRSTNAME4405 LASTNAME4405 DR ZENGEYA
14/06/2000 |30712 |T14116 FIRSTNAME4116 LASTNAME4 116 DR ZENGEYA
14/06/2000 |30714 |T14389 MISS FIRSTNAME4389 LASTNAME4389 SWINDON EARLY SUPPO
14/06/2000 |30715 |T14628 MISS FIRSTNAME4G28 LASTNAME4628 SWINDON EARLY SUPPO
16/06/2000 |30716 |T14441 MISS FIRSTMAME4441 LASTNAME4441 DR ZENGEYA
16/06/2000 | 30718 | T1466 MISS FIRSTNAME4GE LASTNAME466
16/06/2000 |30719 |T14470 MST FIRSTNAME4470 LASTNAME4470 PAEDIATRICS 9
< >

Populating: - /234 A\ The list is filtered by clients' location

If they want to see all clients, they should change to All Locations. There will be a message to
users on the first time they do this which they can then check to prevent it showing again.
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Attention list x

Do notshow awarning message  D-Alert selection method PAS alert - Print Show in Journal Close

Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings

Appointments dated in the preceding month which are not followed by a journal entry

Date |Time|HospitaI n0.|NHS n0.| Client name Resource
11/01/2020 |08:00 R76434 edrc resdvold Stassy
11/01/2020 |09:30 R76434 edrc resdvo0 Stassy
12/01/2020 | 10:30 T1110 MRS FIRSTMAME 110 LASTNAME110 | Charlie

Referrals

Lists all clients with a referral which has not been followed up by an appointment or put on a
waiting list from the referral page. This list makes sure that no referred clients are left without
attention. It is possible to see the Referral Treatment Type on the list of Referrals:

Attention list >
Do not show awarmning message D-Alert selection method PAS alert - Print Show in Journal Close
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings
}ﬁc{ive referrals (not Closed or Nullified) that have not been booked or put on the Waiting list
Date |Number| Hospital n0.| MNHS n0.| Client name Treatment type "~
07/03/2000 30700 |T12639 MISS FIRSTNAMEZ2639 LASTNAME2639 SWINDON EARLY SUPPOR
08/03/2000 282 T19296 MR FIRSTNAME9296 LASTNAMES296 | ++DIRECT REFERRAL /Audio assessment| DR MILEUSNIC Z, THE KN
17/04/2000 30701 |T13758 MISS FIRSTNAME3T58 LASTNAME3758
19/05/2000 30702 |T14181 MST FIRSTNAME4181 LASTNAME4181
19/05/2000 30704 |T14118 FIRSTNAME4118 LASTNAME4118
19/05/2000 30705 |T14119 FIRSTNAME4119 LASTNAME4119
19/05/2000 | 30706 |T14109 MISS FIRSTNAME4109 LASTNAME4109 HASSAN
23/05/2000 | 30707 | T14132 FIRSTNAME4132 LASTNAME4132 SWINDON EARLY SUPPOR
23/05/2000 | 30708 |T14131 FIRSTNAME4131 LASTNAME4131 SWINDON EARLY SUPPOR
02/06/2000 30709 |T12094 MST FIRSTNAMEZ094 LASTNAMEZ2094 HASSAN
02/06/2000 | 30710 |T14179 FIRSTNAME4179 LASTNAME4179 Health Visitor
14/06/2000 | 30711 | T14405 MISS FIRSTNAME4405 LASTNAME4405 DR ZENGEYA
14/06/2000 30712 |T14116 FIRSTMNAME4116 LASTNAME4116 DR ZENGEYA
14/06/2000 30713 |T14122 MISS FIRSTNAME4122 LASTNAME4122 SWINDON EARLY SUPPOR
14/06/2000 | 30714 |T14389 MISS FIRSTNAME4389 LASTNAME4389 SWINDON EARLY SUPPOR
14/06/2000 | 30715 | T14628 MISS FIRSTNAME4E28 LASTNAME4628 SWINDON EARLY SUPPOR
16/06/2000 | 30716 | T14441 MISS FIRSTNAME4441 LASTNAME4441 DR ZENGEYA N
< >

Populating: - /1
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Journal

Lists all client appointments which have not been followed up by journal entries during the last
month. This list makes sure that there is a journal entry for each appointment.

Unsigned journal

Lists all clients with journal texts which have been saved unsigned. This list makes sure that no
journal text is left unsigned.

To select a client, click on the row in the list. The client now becomes the global selected client.
When you have taken care of the issue, the client is automatically removed from the list.

The columns in the list can be sorted by clicking on the column header.

Unsigned summaries

Lists all clients with unsigned treatment summaries. This list makes sure that no summary is
left unsigned.

« To select a client, click on the row in the list. The client now becomes the global selected
client.
When you have taken care of the summary, the client is automatically removed from the
list.

The columns in the list can be sorted by clicking on the column header.

Deceased alert

Lists uncompleted activities for clients with Deceased alert. Separate tabs show each kind of
open record that a deceased client could have. The text below the tabs describes why a client
is shown on that particular tab.

« To select a client, click on the row in the list. The client now becomes the global selected
client.

When you have taken care of the issue, the client is automatically removed from the list.

The columns in the list can be sorted by clicking on the column header.

Deceased alerts can be searched for in two separate places to make the results populate
quicker. The user must select either PAS alert or Alert in the D-Alert Selection method drop
down list depending how deceased alerts are normally entered.

Auditbase will retain the D-Alert Selection method chosen by the user for any future lists to be
populated. Any subsequent change to the selection method will be retained for the user.
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Do not show a warning message D-Alert selection method PAS alert - Print Show in Journa Close

Referrals | Journal | Unsigned journal | Unsigned summaries  Deceased alerts | Electronic submission  Unsubmitted postings

D-Referrals | D-Waiting lists | D-Appointments | D-Unsigned journals | D-Unsigned summaries

Clients with Deceased alert and Referrals that are not closed

Hospital no.[NHS no.| Client name| Date] Information

Warning X

Populating may take leng time. There are 7232 rows to show.

[ Dont show this msg again; oK Cancel

A warning is shown when there are a lot of deceased records. If the user does not wish to see
the message each time the Deceased attention tab is selected the box Don’t show this
message again can be checked to disable the message.

Within the Deceased attention tab there are further tabs to identify clients with a Deceased
alert whose Referrals are not closed, are still on a Waiting list, have Appointments booked in
the future, have unsigned journal entries and have unsigned treatment summaries.

In the bottom left corner of the Attention list is an indication the current state of the search and
once populated will indicate how many records are specific to the tab selected.

Electronic submission

This is intended for reviewing all Electronic Submission events and for dealing with
Treatment Summary submissions. These could be for optional interfaces of clinical
documents with Hospital Electronic Patient Record Systems or of appointment details for
patient arrival or Hospital appointment systems.

Depending on the option set in Administration under Event Settings-> General settings some
of the controls may not be available. If the option is checked to not show Treatment Summary
submission controls then only the Data type filter will be available and should be set to All or
to one of the configured event types. In the case of event driven automatic Electronic
Submission events will only be shown in the list between the action being performed on the
client and the regular scanning work of the server components. Users have the ability to Show
data to show a Treatment Summary, Audiogram or Document (document Properties dialog)
whose submission was rejected. The Delete button can be used with supporter assistance in
the case of serious failure but the event will not then be resent.
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Treatment Summary electronic submissions will remain in the list after they are actively
submitted by a user. The following filtering options are available for displaying Treatment

Summary electronic submissions:

o Data type
o Detail type - shows the sub-type of the event

« Ready for submission

o Submitted
« Rejected

o Signed not submitted

o Status date. A range of dates can be added. Double clicking in the field will add today’s
date. The Status date is only relevant for Treatment Summaries where the record of
Submitted is kept.

When an option changes, you have to press the Refresh button to update the list of electronic
submissions.

Populating: 140 / 51 ]

Unsubmitted postings

Attention list
Do not show a warning message D-Alert selection method PAS alert ~ || Edit recipient Edit Print Show data Close
Referrals | Journal | Unsigned journal | Unsigned summaries | Deceased alerts | Electronic submission | Unsubmitted postings

List of electronically submitted documents

Filter

Data type All ~ W Ready for submission B Rejected Status date:
Detail type: a1l B Submitted Signed not submitted 13/01/2019] | 13/01/2020
Date created| Datatype | Detall type [Hospital no Client name Status | status aatertir
2511112019 Appointments | S T12701 MRS FIRSTMAMEZ701 LASTNAMEZ701 Ready for submission | 09/12/207 Click to sort «
251112019 Appointments | S 5222222 Test patient Ready for submission | 09/12/2019 16
261112019 Appointments |S 5222222 Test patient Ready for submission | 09/12/2019 16
26M1/2019 | Appointments | S 5222222 Test patient Ready for submission | 09M12/2019 16
211112019 | Audiogram 3222222 Test patient Ready for submission | 09M12/2019 18
211112019 | Audiogram 5222222 Test patient Ready for submission | 09M12/2019 18
12M12/2019 |Document client letters | T12701 MRS FIRSTMAMEZ701 LASTNAMEZ2701 Ready for submission | 12/12/2019 12
12M2/2019 | Document client letters | 712701 MRS FIRSTMAMEZ701 LASTNAMEZ701 Ready for submission | 12/12/2019 13
121212019 | Document client letters | T12701 MRS FIRSTMAMEZ701 LASTNAMEZ701 Ready for submission | 1212/2019 13
121212019  Appointments |B T999911 11122222711 | Father 32 d@e1 Ready for submission | 12112/2019 15
12M2/2019 | Appointments B T999911 1112222271 | Father 32 d=e1 Ready for submission | 1212/2019 15
12M12/2019 | Appointments B T999911 1112222211 | Father dze?2 d=e1 Ready for submission | 1212/2019 16
12M12/2018 | Appointments B T999911 1112222211 | Father 3z=a2 dze1 Ready for submission | 1212/2019 16
1212/2019 |Appointments |B T999911 1112222211 | Father dzes2 a1 Ready for submission | 1212/2019 16 ¥
< >

This list is shown if Visit charge features are enabled in System administration. It shows the
postings which should have been submitted to the Swedish online reimbursement system

eFrikort, but have not been.

The list can be filtered by creation date to e.g. only show those created this week. After editing

the date range, press the Refresh button to update the list.
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Attention list

Do not show a warning v

D-Alert sel

1 method PAS alert

-

e

Print || Show in Journal || Close |

Filter

Referrals | Journal

Date created:

Unsigned journal

06/01/2019 |- 1310112020 | [Z]

Unsigned summaries Deceased alerts | Electronic submission

List of postings which had or potentially had to be submitted to the eFreeCard program, but have not been

Unsubmitted postings

Reset error

Date created

Hospital no.

NHS no.

Client name

Service|

Cost

Getting status

Registering transaction
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19.10 Location and Department handling
Location and Department are found in the upper right part of the toolbar.
Filter information

You can use locations to filter information in Auditbase. The Location and Department can be
seen and selected in the upper right part of the toolbar.

The selected location will filter:

« Resources, symbols and appointment stages in Appointment book
o Day view in Appointment book

o Letters in Appointment book

o Document types

o Waiting lists

o Stock types in Stock

« Earmould delivery address on the printout

Location

A location can be a physical location, such as a satellite clinic or a department. It could also be
a separate functional area within the clinic, such as an ENT clinic, Paediatric services.
Department

Departments are virtual groupings such as Adult, Paediatric or Implant which could have
activity at more than one location.

Creation of Location and Department

Locations are created in the System Administration tool.

Default Location and Department

A user or a workstation can be assigned to a specific location i.e. this location will be selected
by default when logging in.

Resources

Resources can be associated with more than one location so that they can be seen and booked
from any of their associated locations.

Locations that the user is allowed to access are shown in black on the drop-down lists;
Locations that the user has restricted access to are greyed out. If a user selects a greyed-out
location, it won't select, but will return the user to the last selected one. If a user has the
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extended user right of overruling the client access restriction, they can move a patient from a
Location they are not allowed to normally access, but that action is logged in the Security log.
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19.11 Visit charge management

In Sweden, everyone is entitled to receive financial aid once you have surpassed a specific
amount used on hospital, dentist and doctor bills for the year. This makes you eligible for an
annual card on which the rest of the health care visits will be charged. As a patient, your visits
are free of charge for the remainder of the year.

In Auditbase, you can register details such as the annual card number, payment method and
whether or not the client is eligible for free of charge visits. In order for these functions to be
enabled, your System Administrator needs to do the following settings in the System
administration tool:

« Under Invoice definitions -> Preferences, check the box Enable visit charge features on
invoice events and postings.

« Under Event definitions -> Event settings, make sure the event number 1921, Add
services on appointment status change, is enabled (checked) and set up correctly
(choose the service associated with visit charges and check the box Prompt for user
input).

« Under Appointment definitions -> Appointment statuses, make sure the appropriate
status (usually Arrived) is associated with invoice event 1921 (choose the status in the
list and check Associate with invoice event 1921).

With these settings in place, you will see the following invoice event after having changed a
client’s status to the status defined in System administration associated with visit charges
(usually Arrived):

Services to be invoiced ®

Date 13/01/2020 ﬁ Referral

Annual card number 43454546 Date due 13/01/2020 Payment method  |nvaice

M Selectall Print full page receipt Printvisit receipts

|Sewice|lnvoice| Invoice type |Units|F'rice| %o |T0ta|price Customer
1 Client | Invoice type 1)1 0 1000

Total price: 0

o Here you can enter the client’s Annual card number, Date due, Payment method and
whether or not the visit is Free of charge.
e You have two options for printing:
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o Full page receipt (size A4)

o Receipt as label (only possible if you have a label printer set up to your computer)

« The selection you choose for printing will be saved per workstation.

o The Free of charge option will not take effect, if the Date due has been surpassed and
therefore the client is not eligible for the visit to be free of charge. Change the date in
order for the Free of charge option to take effect again (the Total price will be zero
when the visit is free of charge).

« If the visit is not free of charge, choose the Payment method being either Cash or Credit
card.

« If Visit charge features are enabled in System administration it is possible to let the
system automatically set the patient to free of charge status depending on age (e.g. if
younger than 19 or older than 85).

« All this information will be saved on the Client information screen, under the tab Visit
charge. The data on the Client information screen is always the most recent.

Contacts | Details | Lists/Photo | Devices | Implant | Visit charge | Paediatric | PFFP 4 »

Annual card number ||

Annual card date due

Preferred payment method -

Free of charge
Protected identity Prohibit self check-in

e You can also change the default information for the client here.
« Free of charge, shows if the patient receives services free of charge.
« Protected identity, shows if the patient has protected identity.
o Prohibit Self-check-in, shows if self-check-in is allowed for the patient. Can be pre-
filled based on symbol or locked if the patient has protected identity.
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20 Documents and attachments

Click the button below to access our training materials.

You can write and store ad hoc documents, general letters and reports or set up templates for
these documents. The documents can be saved in the database under the client's registration
number instead of in separate files.

There is an optional extended licence for this module called File attachments, which enables
you to create file types as well as upload and download documents of any format.

The user access to the document types is defined by the settings for the individual user in the
system administration. The rights are Read, Create and Update/Delete.

A separate document database can be specified by the System Administrator.
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20.1 How to handle Documents and attachments

« Press F3 to search for the client or Ctrl+F3 to make a quick search.

« Go to Navigation -> Documents and attachments or use the shortcut Shift+Ctr|+U.

« Your System Administrator configures what rights you have within this module. You
either have rights to Read, Create and/or Update/Delete per document type. For that
reason, some of the features might not be available to you.

« While you have a document open, you are still able to browse through other Auditbase
screens.

« When editing only one document can be open at a time.

Note: with the extended license File attachments, you are able to upload documents of
any format type such as .jpg, .pdf and .bmp files, and you will be able to filter documents

on File type.
o) Auditbase - [Documents and letters] — O x
File Functions
LJ| Client <T>T18765 MR JOHN SMITH - 2 = B user SYSTEM ADMINISTRATOR All locations ~ All departments - ?
Document type: %‘Leﬁertemplales - Al A Save filter =
File type: All - Upload Download
| = a | Created |Sent|Mo.| Wodified Mame / Comments File type Appointment| Recipients| Site name ~
113 ard d

02 Expedite enguiry reply

E=] 23M212014 1 | 16M2/2019 testtemplate MS Word document
EE 231212014 2 test template2 MS Word document

HE G 19/02/2015 1 |21/04/2015|19/02/2015 all variables MS Word document
E=] 05/03/2015 1 | 05/03/2015 Monitoring report MS Word document
= 01/04/2015 1 Sample.pdf Adobe PDF

HE G 2710412015 1 test template 27/04/2015 MS Word document

HER 30/04/2015 1 test 30/04/2015 MS Word document
EE 22/06/2015 1 testr MS Word document
B E 28I09/2015 1 01AudVars MS Word document
E=] 29/09/2015 1 Postcode and Location address MS Word document
EE 29/09/2015 2 1 Address MS Word document
B E 20/09/2015 3 2address MS Word document
E=] 221012015 1 | 22M10/2015 audiograms and address MS Word document ™

Recipients of the highlighted document

Type Mame

Client

All rels. and other contacts marked as CC

All professional contacts

Document types

All documents are divided into Patient related documents or Templates. The specific document
types are set up in System Administration. A document can also be saved with a patient record.
Patient related document types can be a letter type or a document and attachment type.
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Templates can also be either a letter template or a document and attachment template. All of
this is set up by your system administrator.

If the Location and Department Filtering option is licensed then Document Types can be
filtered by Location and/or Department with Location groups and the multiple locations
options.

A Document Template can have a Location and/or Department which is used for filtering
only in the Letters dialog.

Document types are identified by an icon:

%Leﬁertemplates -
o=IP-NR

[22] STANDARD

o< client letters

N

Letter templates
[22] IMP information
C':-Z'Dnctype 3

L)

@ Doctype 4
g’zlmpnrted

All clients” documents
All template documents

g7

~ Patient related documents

Letter templates

@ Document templates, not letters

Filters

o The documents listed are the currently available templates or patient related documents
and saved letters.

« You can filter on Document type (patient related or template) and on Letters or Docs
and attachments.

« You can also filter on File type if you have the extended license for File attachments.

e You can save a default filter, so you only view the documents relevant to you when
opening the module. Choose relevant Document type, whether to view Docs and
attachments, Letters or All, File type, if applicable, and press Save filter. This will be
your default view when opening Documents and attachments in the future.

o Filters are included to view All client's documents or All template documents,
regardless of their Document Type.
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Icons and columns in the document list table

Indicates if the document is a letter.
Indicates if the document has content.
Indicates if the document can be edited.

& fd g [

Indicates if the document is read-only.
Date created The date on which the document was first saved

Will be filled automatically for letters with the date sent where the
sent date is recorded. For documents that are generated in the
Documents module and not as a letter, this can be added to the
document by opening Properties and entering a date.

Date modified The date on which the document was last changed.

If the document was saved from a letter about an appointment,

that appointment is the one that appears here.

If the document was saved from the Documents module, then any

appointment that happened that same day is the one that

appears here.

If only one appointment occurs for the client that day, and the
Appointment appointment start time is earlier than the current time, then the

action will be attached to that appointment.

If the doc was saved from the Documents module but no

appointment happened that day, then no appointment will

appear here. You can link the document to an appointment by

opening its properties and selecting the browse button and

Attach.

Enter name and/or comments directly in the table by clicking in
the field, which will open up an editable text area

Date sent

Name/Comments

Recipients

You can see who have received the highlighted document in the lower table. Highlight a letter
or document in the selected patient’s letters and the table ‘Recipients of highlighted
document’ at the bottom of the screen will display all those recipients the letter/document was
sent to. The relevant icon will be marked, denoting whether the letter/document was posted or
emailed.

Edit the properties of a document.

20.1.1 Create and edit document templates

o To create a new document template, first select a template document type as your filter
and click on New.
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« To edit atemplate, choose the document in the list and click on Edit template. Enter a
Name and/or add Comments for your template.

o Set up the document as you need with variables and layout.

e You can insert variables in the Word template in 3 ways:

o Place the cursor at the required position in the document and double-click on the
variable

o Place the cursor inside the document and click on Insert variable

« Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position

« If the Clinical action for documents has been activated by your System Administrator
and there is only one appointment on that day, the attachment will be made
automatically. If there is no appointment or more than one then a box will appear asking
you to Attach the document to an appointment. Select the required appointment and
click Attach. If it is not relevant to attach an appointment, click Close to close the
window without attaching.
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ME JOHM SMITH

1300142020, 2 E

g

Mame f Comments

Expedite enquiry reply

[y ]

av

(57}

as new document of type
@ .
o= client letters
Send | .. || Save and close Cancel

Variables

g

[ Appointment data

[* Client data

[ Currentissued accessories

[ Currentissued devices

[F1 DHI questionnaire results

[*1 General information

[ Implant data

[F] Latest audiogram data

[ Latest tympanometry data

[*] Letter specific information

[ Multi-resurs avtal

[F] Relevant referral data

[ Selected AB Words test 1 data
[ Selected AB Words test 2 data
[ Selected AB Words test 3 data
[ Selected AB Words test 4 data
[ Selected AB Words test 5 data
[ Selected AB Words test 6 data
[ Selected Audiogram&Tymp 1 data
[ Selected Audiogram&Tymp2 data

Insert variable Insertvalue

This box can be minimized or maximised by two levels if the

oy
-

button is selected.

o When finished with your document, click on Save and close and the file will appear in

the list of documents.

« To close without saving, click on Cancel.

« You will be prevented from saving the document if the size exceeds that allowed by your

system administrator.

¢ You can also edit the name of your document directly in the list of documents in the

Name/Comments field.
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« Decide or change the default template document type for the document to save to when
applied to a patient. Highlight the document template in the template list. Click
Properties. Select the Default type for client document from the drop-down list. Click
Save. When you now apply this document template to a patient, the document type it
saves to will default to the one you have selected.

o After a new client document or template is created, the Document list will refresh to show

the new document according to the sort order.

Note: Occasionally you may have a Word dialogue box open in the background. If the floating
dialogue box does not close after you think Word has closed, check your Windows task bar to
see if a Word dialogue has been left open. If it has, close this, the dialogue will then close
correctly.

20.1.2 Turn templates into patient related documents

o To edit atemplate for a client and attach the document to the client, choose the template
in the list and click on Open for client or double click on a template. This will open the
template for the active client only.

« If the Clinical action for documents has been activated by your System Administrator
and there is only one appointment on that day, the attachment will be made
automatically. If there is no appointment or more than one, then a box will appear asking
you to Attach the document to an appointment. Select the required appointment and
click Attach. If it is not relevant to attach an appointment, click Close to close the
window without attaching. This set up will be required if appointment variables are to be
used in documents.

Attach appointment to document *
Aftach Close
Diate | Symbnl| Description Resource Status -
16/01/2020 £ SAY EMT auq Charlie *
130142020 [m] EMT new pa) Stassy *
13012020 | IF | fromi Res46 *
13/01/2020 J |2 Charlie +
1000142020 E| PHAC new p Charlie *
1000142020 1 1 Charlie * v

« If the variable is linked to a selected clinical action e.g. BKB test, Audiogram or
Tympanogram, then the document will request the Auditbase user to select the correct
action for the variable being inserted. A selection dialog for this will appear on screen (if
opened for a patient) with the list of related actions:
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Select audiogram 1 d
Select Close
. | Audiogram Date |N|J.| Signed| Type |Cumrnents| Previewl Su A
E Audiogram changed in AB 1040142020 1 Preview
E AuditBaze audiogram 1032019 1 =igned Aided Preview
= AuditBaze audiogram 210205 2 Preview
= AuditBase audiogram 2102015 1 Prewview
= AuditBaze audiogram 20092015 1 Preview
E Audiogram changed in AB 25/0%2015 &  signed Preview
El Hew Audiogram 250082015 7 Prewview
E OTCO=uite Audiemetry - Audiogram 25032015 & Preview
E New Audiogram 25/092015 5 Preview
El New Audiogram 250082015 4 Prewview
= Hew Audiogram 250%2015 3 Previgw
= AC440 measurement 250802015 2 Preview
El Audiogram 250082015 1 Prewview
= Hew Audiogram 24/0W201% 2 Preview
= AuditBase audiogram 240802015 1 Preview
= Audiogram not linked to NOAH 22062015 1 Prewview
= AuditBase audiogram 18/08/2015 9 Preview
= Audiogram not linked to NOAH 18062015 8 Prewview
= Audiogram not linked to NOAH 18062015 7 Prewview
E Audiegram changed in AB 180642015 & Preview
E Audiogram changed in AB 18/06/2015 5 Preview
E Audiogram changed in AB 18/06/2015 4 Preview v
= A e e e e i s -
< >

The above box will appear for Audiogram and Tympanogram information.

Select tests for attachments

Test | [Dateoftest| | Details | Result|Test Condition

= BKB test|[]
[/ 01/04/2015 | | L: HAT, R: 0%
[/ 09/01/2020 | L:HA1, R: HA1 56% |Audition +lipre

The above box will appear for BKB tests.
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« The Type has now changed to a Patient related type, which you can edit to other Patient
related document types, and you will see the client name at the top of the floating
dialogue.

« The variables within the floating dialog are hidden unless expanded. To expand click the
down arrow and a list of available variables will appear. Keeping them hidden by default
will make this dialog open quicker, the system will remember the previous state.

o Enter a Name and/or add Comments for your document.

« Make changes to the layout of the document as you need.

e You can insert values in the Word document in 3 ways:

« Place the cursor at the required position in the document and double-click on the
variable

o Place the cursor inside the document and click on Insert value

« Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position.

« If the template contains the audiogram graph variable or tympanometry graph, a window
will open to allow the user to select which audiogram is to be used. The number for the
audiogram variable (there can be up to four) will appear at the top of the Audiogram List
dialog.

» Click Send and the document will print according to the options set by the System
Administrator or email to recipient's dependent on your preferences as set in system
administration or on the recipient.

« The document will either be sent to the default Windows printer or a message will appear
where you can choose printers, number of copies etc. This depends on the setting for the
workstation in Auditbase Administration.

Print x
Prirter
Name: | _ Propeties..
Status: Ready

Type: Microsoft Software Printer Driver
Where:  Microsoft Office OneMate_16001.12527 20128.0_x64_ Bwelkyb3d8bby

Comment: [ Prirt to file
Prirt range Copies

&+ Al Mumber of copies: m
" Pages from: |1 to:

~
' 114 22l 313

QK | Cancel
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To change the preferences for this document as a one off, click the browse box next to
Send. In the pop up that has now opened, change settings between email or print as
needed. Select or de-select available recipients and change whether document should be
sent as an attachment or in the body of the email.

If creating a patient document from Letter, the document will go into the body of the
email whereas if creating from the Document module, the information goes into an
attachment.

Use the printer icon at the top of the floating box to print just one copy of the document.
When finished with your document, click on Save and close and the file will appear in
the list of documents.

To close without saving, click on Cancel.

If you close Word without saving, you will be asked whether you want to save the
document or not.

Microsoft Word

Want to save your changes to AB[7]?

- —

If you dick "Don’t Save’, a recent copy of this file will be temporarily available.
Learn maore

Save Don't Save Cancel

s

Select Save or Don't Save as appropriate. Either of these options will close the
document. If you want to go back to the document, select Cancel

To print a single copy of a document without opening the document, highlight the
document in the table and click the Print once icon on the ribbon (Functions tab).

To print and/or email a document according to recipient option or to display dialog for
print and/or email, highlight the document in the table and click the Send icon on the
ribbon (Functions tab).

20.1.3 Turn document templates into letter templates and vice versa

You can convert an existing document template into a template that can be used for letters
with a CC list and variables pertaining to a future appointment.

First an existing or a new document template type needs to be defined in System
Administration as Letter templates. In the Documents and attachments module, select
the template type that the document template is in.

Choose it and click Edit template.

Check the box in the MS Word assistant floating dialog to Save as a new document.

If a new Template type is being used for letter templates then choose that from the
Template drop down list.

Save and close the document.

The new letter template will now be available in the Letter module from Booking ->
Functions -> Letters where CCs can be added.
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You can also build a Word letter template in Booking -> Functions -> Letters and save that
letter template to Documents.

Note that a CC list cannot be used on Templates in the Documents module; in Documents, you
can neither add CCs to Templates nor see Recipient types in Templates saved from the Letters
module.

If you need to have CCs in the Documents module you can do the following:

o A CCllist can be built for a Client letter in Booking -> Letters, either from the pre-set
recipients in a letter template or by adding named recipients to the letter. If this letter is
saved to the Documents module the recipients are seen there and can be printed from
the floating Word dialog using the Print to all CCs button at the bottom. The letter can
be further edited in Documents and then If Read only is set it must be removed in order
to add further recipients.

« Alternatively, a Document can be made either from a Document template or from scratch
and specific recipients added to that individual document for printing by opening the
Properties window for that doc.

Note that unlike the Letter module there is no facility to print address labels for recipients in
the Documents module.

20.1.4 Edit patient related documents

Edit

o Chose a patient related document in the document list.

« Click on Open for client or double click on a document to edit it.

o Edit Name and/or add Comments for your document.

o Set up the document as you need with variables and layout.

« You can insert variables in the Word document in 3 ways:

o Place the cursor at the required position in the document and double-click on the
variable

« Place the cursor inside the document and click on Insert variable

« Click and drag the variable into the required position in the document - it is important
that you hold the mouse still above the variable before you click and drag the variable
into the required position

« Instead of inserting variables you can insert the current values of the selected client.
Either chose a variable in the list of variables and click on Insert value or click on
Replace all variables with values to edit the whole document at once.

« When finished with your document, click on Save and close and the file will appear in
the list of documents.

« To close without saving, click on Cancel.
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20.1.5 Edit the properties of a document

« When you have a document selected in the list, select Functions -> Letter Properties.

Document, attachment and Letter properties >
Cancel
Read only The documentis a letter B Contentis available File type Word document
Description audiograms and address26 -
v
Type P-MR Date 261072015

+ | When a letter is generated from Booking, it is automatically linked to the appointment it
refers to. Adocument is automatically linked to an appointment which occured on the

same day the document was first saved. Date sent
Recipients Add Remaove
Type Mame Address Postcode |Z
Client FATHER FMAMEZ221 SNAME12 TESTADDRESS 1231111111 111111 111111112, 12, 4, 5 |EM POST
Mather MMame testAddress1 12
Father FrAME 3 2
Father 1 1 1

<

Highlighted recipient

Mame Postcode

Address

o Here you can see different information about the document such as file type, if the
document has content, creation date etc.

¢ You can also set if the document should be Read only, which means other users cannot
make changes to the document. A user can only remove this flag, if he or she has the
extended user right “Documents: Remove ‘read only’ flag”, configurable by your System
Administrator.

« You can choose if The document is a letter. In the document list, a letter icon with a tool
tip to the left will reveal that the document is a letter.

« You can enter a Description of the document, if it is not Read only.

« A special button is available for attaching the document to or detaching it from an
appointment. The button has a symbol which reflects the state of the document: either

iy +
attached ( == ) or not attached ((=)). In addition, the button has a tooltip that displays

detailed information about the document linking.
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NOTE: The document is automatically attached to an appointment, if the document was
saved from a letter about the appointment. If the document was saved from the
Documents module, then any appointment that happened that same day that has the
appointment start time earlier than the current time is the one that the document
automatically attaches to. If the document was saved from the Documents module but no
appointment happened that day, then no appointment will appear here.

o Date is the date the document or letter was first saved.

« If the document or letter is a patient related document or letter, you will see a Date sent
field. This is the date the document or letter was printed and thereby sent. You can
manually add a date, if the document has not been sent.

Recipients
Note: You can only add recipients to patient related documents and attachments.

To edit an existing letter, you need the extended user right given by your system
administrator to add or remove letter recipients after creation.

o To add recipients, click on Add.

Add recipient >

Add Cancel

Select recipient
B Client
M Referral referring agent
W All relatives and other contacts marked as CC
M All professional contacts
B Specific professional contact type Registered Practice -

M Specific referring agent

(W] Specific relative or other contact: Mother -

e You can add the selected Client.

« You can choose to add All relatives and other contacts marked as CC in the Client
information module under the tab Contacts.

e You can add All professional contacts.

« You can add just a Specific professional contact type.

« You can add a Specific referring agent.

« And you can add a Specific relative or other contacts, even if they have not been
marked as CC in the Client information module.

o Back in Properties, you can remove a recipient or recipient group by choosing the
recipients in the list and click on Remove.

« Highlight a letter or document in the selected patient’s letters and the table at the
bottom of the screen will display all those recipients the letter/document was sent to.
The relevant icon will be marked, denoting whether the letter/document was posted or
emailed.
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20.2 Importing and exporting documents

Word documents created outside Auditbase can be pasted into Auditbase as templates or ad
hoc documents.

« Open a new document in Auditbase under the document type required.

+ Go back to the start menu on your desktop and open your normal word-processing
document.

« Choose Edit and Select all.

« Choose Edit and Copy.

« Click on the minimised Auditbase document at the bottom of the screen.

« Choose Edit and Paste.

« Select File and Exit and click Yes to save.

o Type the letter name in the Name/Comment field.

« Close your other word-processing document.

Extended license: File attachments

If you have the extended licence called File attachments, you can upload documents in any
kind of format, like .jpg, .pdf etc., by simply using the Upload button.

« Open Documents and attachments from Navigation -> Documents and attachments or
use the shortcut Shift+Ctri+U.

o Select Upload.

o Choose files you wish to import in the file directory. Multiple files can be selected.

« The Files chosen for upload are shown in the window.

« The Document type where the chosen files will be stored to, can be selected from the
drop-down list.

o There are two further options to Attach to appointment and to Delete file(s) after
upload. These are check boxes which can be selected.

« Once the choices have been made, OK will then close the window.

o The document is now imported into Auditbase and attached to the current patient.
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Select files and options for uploading x

Files chosen for uploading Choose files...

Cilsers\ANDSHUNDesktop\DocumentTemplate.bd
ChilUsers\ANDSHU\Desktop\Formats02AudSample.nhax
Cilsers\WNDEHU\Desktopimpedance Standard format 100 pdf

Document type ,Q.El P-MNR -
M Attach to appointment 28M2/2018, 08:00-08:30, *, MALMESBURY ENT a1

Delete file(s) after upload
Ok Cancel

With the File attachments extended licence, you can also download documents from Auditbase

to your computer.

« Open Documents and attachments from Navigation -> Documents and attachments or

use the shortcut Shift+Ctri+U.
« Highlight a file in the list.
+ Select Download.
o Choose where to save the file.
o Enter afile name.
e The document is now exported from Auditbase.
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20.3 Password protected documents

You can limit access to a word-processing document:

o Type the document.

« Select Tools -> Options -> Security.

o Set a password to avoid unauthorised access to the document or edition of the
document.
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21 Tests

Creating a new test
A new test can be created in one of two ways:

« From Navigation, select Tests and then select the required test.

« From the Auditory Implant module - Expand the referral then expand a stage. The
predefined tests will be displayed. Select the required test. The order of the tests is
based on the priority order in the System Administration tool -> Client Scheduling ->
Client pathway overview settings -> Auto-linking settings and ordering.

Each test has a similar header comprising of:

« Compare results - Select to enable a comparison of test results. Tests with scores which
are available for comparison over time can be selected according to the date they were
performed and the score type in use on each test can be selected for plotting. Only one
test from any one day can be used since the comparison is always over time.

o A number of variables can be selected and a graph displayed. This option is for the
following tests only:

o« BKB test

« BKB Sentences (Adaptive or Standard)

o AB words test

o CUNY test

o« New - Select to create a new test.

o Save - To save the current test.

« Delete - Will remove the selected test from the database.

o Close - Will close the test without saving it.

« Tests - A drop-down menu which shows existing instances of the test for the client.

o Created by - Will display the name of the logged-on user that created each instance of

the test.
o Date of test - Defaults to the highlighted date, but can be adjusted to reflect the actual
date of the test.

« Age attest - This is calculated and fixed when saving so that the age will be displayed
whenever the test is shown. The age is shown in years unless the patient is less than 5
years old, when years and months are shown.

« A special button is available for attaching the test to or detaching it from an
appointment. The button has a picture which reflects the state of the test: either

=D ::+::
) ()

attached ( or not attached . In addition, the button has a tooltip that displays
detailed information about the test linking.

NOTE: If only one appointment occurs for the client that day, and the appointment start
time is earlier than the current time, then the test will be attached to that appointment.
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« Referral stage - This displays the stage in the referral that the appointment isin
currently, if a stage can be identified.

o Testver. - Shows the version of the test being used, the default for this is set in the
System Administration and can be changed when a new version or edition is released.
This means that when auditing test results you can be sure that you are comparing like-
with-like. The version can be changed when any test is performed so that non-default
versions can still be used.

+ Not administered - a reason can be selected to record why a particular test was not
performed. The drop-down list can be defined by the System Administrator.

For individual tests where percentile is in use, the percentile rank field will take values of -1
and 99+ as well as numeric values. These values are held in the database but values of O and
100 are also stored in order to enable plotting graphically.
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21.1 CELF school age test set up

The CELF school age test can have different layouts; Concise, Extended, Extended with
limited number of values or Test Scaled Scores. The required layout is selected in the
System Administration tool -> Testing -> Test settings -> General test settings.

420
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21.2 Other speech test

After a hearing assessment, you can do other speech tests to verify primarily special hearing
aid types. In the Navigation area, under Tests, select Other speech test.

Other speech test *
Client MRS FIRSTHAME 106 LASTMAME 106 Print Sign Mew Save Delete Close
Tests 211002015, 7 ~ Created by full name tests??7? -
Date oftest 2110/2015 Age attest 26y oo Referral stage Appointmentis not linked to referral

B Mot administerad Mon English speaking1 ~| Operative Pre-operative «

Add Edit Eemove

Test |List| Audiovisual | Direction | Reliablel Result | Level | Moise HI status R | HI status L Comment Te:

Testtype’1 | Audiovisual TestLeftD Yes -99.9 150de |10 dB Unaided112 HA1 test comment Total

Click on Add to register a new test; a pop up will open. Choose from the drop-down lists and
enter the results directly into the different fields. Some column content is configured by your
System Administrator.

Once a test has been registered, you can edit or remove the test by highlighting it in the table
and clicking either Edit (which opens a pop-up window for editing) or Remove (deletes the test
from the list). You can also edit the test directly in the table by clicking in each field.

You can Sign the test so that it is locked for editing, it cannot be changed apart from linking it

to an appointment.

The signed user appears on the window title bar.
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Other speech test - Signed by: SYSTEM ADMIMISTRATOR 13/01/2020 16:31:35, [Read only] it
Client MRS FIRSTMAME106 LASTMAME106 Print Sign Mew Save Delete Close
Tests 211012015, 7 » Created by full name tests?77 -
Date of test 21102015 Age attest 26y =o| Referral stage Appointment is not linked to referral
Mot administered Operative Pre-operative «
Add Edit Eemoave
Test |List| Audiovisual | Direction | Reliablel Result | Level | Moise Hl status R | Histatus L Comment Tes:
Testtype” 1 |Audiovisual TestLeftD| Yes -99.9 150dB -10dB Unaided112 | HA1 test comment Total
< >

The Notes field is for general notes about the client in connection with the tests and the field

Comments under each test refers to the specific test.
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22 Auditory Implant module

With an extended licence for Auditbase, you can have access to the Auditory Implant module,
which handles the workflow for Implant patients.

elLearning
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22.1 Referral settings

A Treatment Type for Implant needs to be set up by your System Administrator. Please contact
your System Administrator for more information.

The Referral Module now shows a client’s age in years. If the client is under the age of 5, the

age is shown in years and months.

Referral overview || Client's referral | Referral answer | Clinical actions

Referrals: 95061, 30/09/2008, PAEDIATRIC hearing aid journey (PHAC = Client name MISS FIRSTNAME1605 LASTNAME1605 Refresh Ca
Book Search and book Add to list Add observation Print referral Print receipt Print answer Mew Save Delete
Selected referral
PathwaylD || Edit Waiting list entries Aftach Detac Ed 5 waiting lis
RTT start date 30/09/2008 Age at start 18y Waittime 104 Wait time Date Waiting list Informati
Referral date 30/00/2008 Other date 30/09/2008 -506 30/09/2008 | TGW - DOMI new 1 2y review - during Uni summer break
Treatment type PAEDIATRIC hearing aid journey (PHAC) -
Reason AUDIOLOGY referral -
Customer SWINDON PCT - |f 24
Referred by REGISTERED PRACTICE, MARLBOROUGH SURGE | ..\ Appointments Attach D Ed 5 B g
Referring agent ref. Date |Time | Symbol|8tatus| Resource
Medical priority - |0B03:2020 (13:00) I * | Stassy AUDIOLOGY re
. 05/03/2020 |08:00) DOf * |Res78 AUDIOLOGY re
Referral handling -
Information Put on waiting list Booked directly Edit
2y review - during Uni summer break - < >
b
Observations and procedures Ed
Interview SEHETREEE Obsno. [ SNOMED code | Date  |Add[S] Text
bnmy -
b
Registered by ALISON STAGG M P >
Current status
Outcome  30a, Treatment commenced Clock  Stopped Referral stages
i Active length: 596w, 2d
since 05/03/2020 11:48:17 Addnew | | History Name _|Targe! date and wamings|Current _ » ’
z i [ro e G T ETAL. Tl T = % Assessmen 10/11/2008 | RTT end date: ~ 05/03/2020
Uto assigne . a new patient mould-~
ommen 2 b e L Treatment |30/12/2008 O RTT end date set by outcome status
MNew outcome status 30a, Treatment commenced - |Follow up 30a, Treatment commenced
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22.2 Opening the main Auditory Implant module page

To open the main Auditory Implant module, Navigation — Client pathway overview. The
views are described in more detail in the Client pathway overview.

<) Auditbase - [Referal] - o X
File View Functions
E Client  T1106 MRS FIRSTNAME106 LASTNAME106 - R|Z Bl|user SYSTEM ADMINISTRATOR All locations ~ | All departments - a 9
Navigation R Clients referral | Referral answer | Clinical actions
- Favourites -
I 5\ Referral Referrals: 109547, 15/08/2019, ++FITTING - from previous referral Clientname MRS FIRSTNAME 106 LASTNAME 106 Refresh Cancel
i--£f] Documents and attachments
| P Waiting list Book Search and book Add to list Add observation Print referral Print receipt Print answer New Save Delete
5] 4B Audiogram Selected referral
i fi\. Attention list 4 PathwaylD Edit Waiting list entries Attach Detach Edit Show in waiting list
Client pathway view RTT start date 15/08/2019 Age atstart 30y Waittime Wait time Date Waiting list Informati
Full pathway - o Referral date 15/08/2019 Other date 15/08/2019
Treatment type ++FITTING - from previous referral -
~
TN Reason ++GP direct referral -

07/12/2018 ++FITTING - from previa Customer Auto-created customer with code IEMPTY! - I* z
2110812016 ,++AUDIO REVIEW reas: Referred by * DR CN BARRY, CORNERSTONE PRACTICE, STAT Appointments Attach | [ Detach Edit w in Booking
2211212015 ++AUDIO REVIEW reas: Dals [ Time Symbol[stau e
301112015 ++AUDIO REVIEW reass .

061112015 ++AUDIO REVIEW reass Medical oy e

H 08/06/2015 ++AUDIO REVIEW reas: Referral handling -
12i05/2015 ++AUDIO REVIEW reass S Edit
01/05/2015 ++AUDIO REVIEW reas: =~ < 3

28i04/2015 ++AUDIO REVIEW reas:s -

= ZUDAZ15 A-AUHO REVIEW reass Observations and procedures De{Click to sort column
i aimoar +svimie ¥ || Intenview SELEIIELEE Obsno. | SNOMED code |  Date | Add]s| Text
< > N
-
individual chen
2, Individual client
Registered by Oleksandr Pushchalo - < >
&5 Client pathway view Current stalus
E) Cii " Outcome  20a, Decision to treati@#§%*&*/?"  Clock  Counting Referral stages
inic managemen Active length 21w 4d
since 1510812019 16:36 Add new | | History Name [ Target date and warmings{Curent _ ~ g
Stock management R Treatment | 14/11/2019, Has been bre[4] RTT end date:
Followup  14/05/2020 O RTT end date set by outcome siatus
iq User tasks New outcome status 20a, Decision to treat!@#5%"&*/2\" - Completed O v
ppp PPPlist
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22.3 Opening other Auditory Implant Module pages

To open other pages in the Auditory Implant Module, select from the Navigation-> Implant —
choose which page from the following options:

« Pre-op assessment Form
Switch on / Review sessions
Programming sessions

« Rehabilitation sessions
Implant surgery
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22.4 Pre-op assessment forms

This screen serves several purposes:

« A checklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

« A collector for the results that should be produced on the report for that stage.

o A place to record information specific to that stage in the pathway that is not recorded
elsewhere in Auditbase.

Pre-op assessment *
Client MRS FIRSTNAME 106 LASTMAME 106 Print - New Save Delete Close
Assessment 011042013 - Date 0110/2013 | [5] User full name tests?27? -

Funding authority  WILTSHIRE PCT - Referral  0310/2013, x DO NOT USE-VRA
Planned date of . ;
srET 03M0/2013 E Earside Right + Treatmentstage Follow up -

Essential | Optional = Decision | Final = Baseline testresults | Counszelling

Related data Clinician Concerns
Initial appt 01/10£2013, PHAC new patient mould~ JULIE TYAS ~ | Addconcern
PTA 27/09/2013, no. 1, Pre-operative -~ full name tests?7? ~* | Addconcemn
Aided Aud. 27109/2013, no. 2, Post-operative 2-6m | full name tests??7? ~ | Add concern
Tymp 30/09/2013, no. 3 - full name tests?77? ~ | Addconcemn
OAE ~ | Addconcern
Speech tests 30/09/2013, PHAC new patient mould-~ JULIE TYAS ... | Add concern
Hearing Aid trial 30/09/2013, 2 USER MAME32 ~ | Addconcern
Rehab assess 27109/2013, 2 USER MAME15 .| | Add concern
Medical history
CT Scan MRI Scan
B L B R M Head MRALLENPAUL ORALSURG| | /L W R M Head ANAESTHETIC CONSULTANT, | | M Scanshave been reviewed
031102013 [5] Add concern 04/10/2013  [5] Add concern
Concerns ShowAll | Remaove

Adi0n|00ncern descripti0n|8ide| Date|CIinician|User Comment
CT Mormal cochlea Right 0110 MR ALLE| full n: 234234
MR Absent cochlea Righy 01110 AMANDA full nz 123

The following options are available:

o« New - Select to create a new test.

o Save - To save the current test.

o Delete - Will remove the selected test from the database.
Close - Will close the test without saving it.

Assessment - Displays a list of any previous assessment forms.
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« Date - Defaults to the highlighted date but can be adjusted to reflect the date of the
assessment either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

« User - Will be the name of the logged in user.

« Funding authority - Will be the client’s customer but can be altered if required.

« Referral - The relevant referral for the client can be attached to the form using the
button.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

« Planned date of surgery - The date for surgery can be entered manually or by clicking
on the calendar icon to choose a date from a calendar float-window. Double-click in the
field to enter today’s date.

« Ear side - Right, Left or Binaural can be selected. This is a mandatory field.

« Treatment stage - If a Referral has been selected above, the relevant treatment stage is
displayed here.

« DR-Med - it is now possible to create a new DR-Med questionnaire from the Pre-Op
Assessment form in the Implant Module.
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Pre-op assessment X
Client MRS FIRSTMAME106 LASTNAME106 Print - New Save Delete Close
Assessment - Date  13/01/2020 E User SYSTEM ADMINISTRATOR -
Funding authority  SWINDOMN PCT - Referral

Planned date of .
surgery E Ear side « Treatment stage

Essential | Optional Decision  Final | Baseline testresults | Counselling

Related data Clinician Concerns
Initial appt - | Add concern
PTA v | Add concern
Aided Aud. * | Add concern
Tymp - | Add concern
OAE v | Add concern
Speech tests Add concern
Hearing Aid trial * | Add concern
Rehab assess .| | Add concern
Medical history
CT Scan NIRI Scan Stiach
L R Head L R By Scans have been reviewed
[=1 Add concern h Review/Edit Add concern
Create new

Caoncerns ShowAll | Remave

Action | Concern descripti0n| Side | Date | Clinician | User| Comment

There are a number of tabs which can be selected. These tabs show different information
under the following headings:

« Essential
« Related data - Various tests and appointments that are stored in Auditbase can be
added including Initial appointment, PTA, Tymp, OAE etc. can be added to the form by

selecting the browse button. |-

o Clinician - The user that saw the client can be added from this drop-down menu.
Clinician can be used if Resource is not linked to a specific staff member and you want to
manually assign the staff member involved.

o Concerns -

o Adding Concerns - These can be added to the form by selecting the Add concern
button. Once selected, the Concern name can be chosen from the drop-down
menu. The Type of action, ear Side and Date can be added and a Clinician should
be pre-selected from the appointment or test that the concern is logged against.
There is a text box for comments.
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o Viewing Concerns - The concerns from each tab are then displayed at the bottom
of each tab page. You can see the action the concern came from. Numerous
concerns can be displayed.

o Show all - All concerns can be shown regardless of which tab they were inserted
under.

CT Scan - It can be indicated if a left, right or head CT has been performed, on which
date and by whom. A concern can be added in the same way as above.

MRI Scan - It can be indicated if a left, right or head MRI has been performed, on which
date and by whom. A concern can be added in the same way as above.

Optional - Various Related data, Clinicians and Concerns can be added in the same
way as the essential tab.

Decision - Various Related data and data specific to the team decision and client’s
choices can be saved here. The implant decision or Discharge reason, Clinicians and
Concerns can be added in the same way as the Essential tab. In this tab, there is now a
section where multiple client preferences can be selected relating to their accessories.
Where these have been selected they will transfer through to the Client Information tab.

Client

MRS FIRSTNAME106 LASTNAME106 Print - Mew Save Delete Close

Assessment

Funding authority  SWINDON PC
Planned date of

surgery

Type |R| L| MName

Essential | Optional | Decision | 5. Cable O

FI[C]ITE10MR
Cl Clinic B, ][] Danalogic 163D
Consent = MO DANALOGIC 163D White

o ) Ood id 10268

ST g DANALOGIC 163D Red
Meningitis vaccination Magnet ][] ITE10ML

Multi disciplinary team

Drecision made

RIGHT
Implant type

Select stock preferences X

Select Cancel

|mE|ar|t T ITETIMR
Processor |[][]ITE11ML
Ear hook CJC1BE101

Battery type [][]BE101B

Client preferences

Other ] BE101G
= Colour [l

Type|R|L| Name|

Concerns

Action| Concern description | Side|

Multi-disciplinary team - Decisions made by the multi-disciplinary team can be recorded
including the date of decision and any Discharge reason.
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« Implant type - Right and Left are identical options. There are a number of options from
the drop-down menus. These are set up by the system administrator. These client
preferences are transferred to the Client Information module on the Implant tab. This is
done by selecting the Copy to Client Information button.

o Final - Various related data, clinicians and concerns can be added in the same way as
the Essential tab.

« Baseline testresults - Tests performed during the stage can be selected. The results of
these tests will be the ones which are included on the report for that stage. Other
instances of these tests may have been performed in that stage which you may not want
to include in the summary. The tests will be grouped under the same test type and some
summary results will be seen. A New test can be created, the list of available tests and
any custom questionnaires will be listed and can be selected. The selected test or
questionnaire will open in a new window. Tests can be viewed by selecting a test and
choosing Open. The appropriate test will be displayed. Additional tests can be added
using Attach or removed using Detach. The order of the tests is based on the priority
order in the System Administration tool -> Client Scheduling -> Client pathway overview
settings -> Auto-linking settings and ordering.

o Counselling - Appointments are shown in chronological order with a series of
counselling topics which can be checked to show they have been covered. There are 4
user definable topics that are set by the system administrator.

« Questionnaires - These can be added by selecting the button and attaching any
previously completed questionnaires.

« Concerns can be added in the same way as above.
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22.5 Switch on / Review sessions
This screen serves several purposes:

« A checklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

« A collector for the results that should be produced on the report for that stage.

o A place to record information specific to that stage in the pathway that is not recorded
elsewhere in Auditbase

Switch on / Review sessions =

Client MRS FIRSTNAME106 LASTNAME106 Print |~ New Save Delete Close
Reviews 01/10/2013 - Review date  01M10/2013 User full name tests??? -
Treatment stage Completed - Referral  03M0/2013, x DO NOT USE-VRA
Purpose Switch-on/Reimplant ~| Upgrade due date 01/10/2013 | [ Earside Right -
kain data | Attached tests and other | Issued devices and accessories

Programming sessions Aftach | Detach MNew Open Rehab sessions Attach | Detach Mew Cpen

Date Purpose of session Date

01/10/2013 | Mapping requested 011052013

Middle ear status (Right) Middle ear status (Left)

Condition  Grommet - 54 Condition  Perforation + 49

Result Flat - Result Megative -

Programming summary Rehab summary

L} A |7 -

- -
Audiometry = e
Condition left ear Condition right ear

PTA Unaided112 w HA1 - 27/09/2013, no. 2, Post-operative 2-5m

AR Unaided112 * Unaided112 - 27109/2013, no. 1, Pre-operative
Preservation of hearing ‘None - ENTreview 1771002013 E AMAMDA CARROLL, MERCHISTO | ..
Expectations Q 15M10/2013 g LISER MAMES1.. » OtherQ 141002013 ﬁ LSER MAMEST.. A
Infarmation Pack  25/10/2013 g USER MAKMET9. - 30/09/2013, PHAC new patient mould~
Report Sent 191002013 ﬁ USER MNAKE42. -

There are the following options:

« New - Select to create a new session.

o Save - To save the current session.

« Delete - Will remove the selected session from the database.
o Close - Will close the session without saving it.
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+ Reviews - Displays a list of any previous sessions.

« Review Date - Defaults to the highlighted date but can be adjusted to reflect the date of
the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

o User - Will be the name of the logged in user.

« Treatment stage - If a Referral has been selected above, the relevant treatment stage is
displayed here.

« Referral - The relevant referral for the client can be attached to the form using the
button. This is a mandatory field; a referral must be selected.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

+ Purpose - The purpose of the session can be selected from the user defined drop down
list.

o The selection here will define which date appears on the Implant tab on the Client
Information screen. If Switch-on/Re-implant is selected, then the date on this form will
transfer to Latest Switch on date in Client Information.

« Upgrade due date - Can be selected from the calendar

« This date is calculated depending on the value of the field in the Administration tool
under Implant module definitions - General settings - General settings. It will add this
period to today’s date when opening a new form

« This date will be shown on the Client Information screen - Implant tab - Upgrade Due
date

« Ear side - Right, Left or Binaural can be selected. This is a mandatory field.

There are a number of tabs which can be selected. These tabs show different information
under the following headings:

« Main data - Multiple Programming and Rehabilitation sessions can be recorded and
saved. Any of these can be linked to a Switch-on/Review screen. They will be linked
automatically if they are opened using the New button on the Switch-on/Review screen
or can be attached after saving.

« Attach - Can be used to attach a Programming or Rehabilitation session. Once selected,
choose the required session and Select.

« Detach - Can be used to remove a selected Programming or Rehabilitation session.

« New - This will create a new Programming or Rehabilitation session.

« Open - This will open a selected Programming or Rehabilitation session for viewing.

o Condition - The condition of the middle ear can be selected from the drop-down menu
and further information can be added to the free text box.

o Result - Tympanometry results can be selected from the drop down menu.

o Programming summary - Additional information can be added to this free text box.

« Rehab summary - Additional information can be added to this free text box.

© Auditdata - 2022, ID: 20.0040/29 433



User Guide

Audiometry - Results from audiometry can be displayed.
o Condition left or right ear — The type of audiometry can be displayed by selecting
from the drop-down menu.

o An audiogram can be selected by using the browse button:.. This can either by
attached to the session or just viewed by selecting Show.

Preservation of hearing - This can be selected from the drop-down menu.
ENT review - The date of an ENT review and the name of the referring agent can be
added.
Expectations Q - The date and a user can be added to show when this questionnaire
was completed.
Other Q - The date and a user can be added to show when another questionnaire was
completed.
Information Pack - The date and a user can be added to show when an information
pack was given to the client.
Report sent - The date and a user can be added to show when a report was sent for this
client.
Attached tests and other - Once a review has been selected, any tests that have been
attached to that session can be observed.

Tests performed during the stage can be selected. The results of these tests will be the ones
which are included on the report for that stage. Other instances of these tests may have been
performed in that stage which you may not want to include in the summary. The tests will be
grouped under the same test type and some summary results will be seen. Tests and
questionnaires can be added in the following manner:

New test - A list of tests and questionnaires will be shown. Select from the list and
complete the test then Save and Close.

Open - If a test is already attached, the test can be viewed by selecting the test and
choosing Open. The test will then be displayed.

Attach - By selecting Attach, all currently saved tests and questionnaires will be
displayed. Check the required test and Select. These will then be added to the session.
Any test or questionnaire can be removed by selecting it and then using the Detach
button. Tests can be viewed by selecting a test and choosing Open. The appropriate test
will be displayed. Additional tests can be added using Attach or removed using Detach.
The order of the tests is based on the priority order in the System Administration tool ->
Client Scheduling -> Client pathway overview settings -> Auto-linking settings and
ordering.

Issued devices and accessories - Once a review has been selected, any stock articles
that have been attached to that session can be observed. Articles can be added in the
following manner:

Issue device - A search dialogue will be shown.

o Add a serial number or article name to the search fields. Please note that
these fields are case sensitive.
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o Articles can be filtered using the Default filter view button. By selecting
this, options are shown for various Articles and Stock Types.

o Select Search.

o Select from the list ensuring the left-hand column in the table is checked
and then Issue.

o A New status for serial number: XX or New status for quantity controlled
article: XX window will appear.

o Select a Location if relevant.

o Select the new To stock type.

o Depending on the selection, a number of other fields will need to be
completed in the same way as for issuing an article from the Stock module
directly. Once the options have been selected, select OK.

o The selected article will now be included in the table.

NOTE: Changes in device statuses create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

« Attach - By selecting Attach, all currently issued articles will be displayed. Check the
required article and Select. These will then be added to the session.

« Articles can be removed from the list by using the Detach button.

« Warranty registration - A Right and Left check box are available to show that the
warranty registration for an implant has been sent back to the manufacturer.
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22.6 Programming sessions

This screen serves several purposes:

« A checklist that can be used to ensure that all the necessary steps have been completed
before moving the patient to the next stage in their pathway.

« A collector for the results that should be produced on the report for that stage.

o A place to record information specific to that stage in the pathway that is not recorded

elsewhere in Auditbase

FPurpose of session  Mapping requested

hain data | Additional data

Processor (Right)

Processor type - Magnet strength, M -

Actions performed (Right)

Electrode mapping

FM/Radio aid

Device instruction
Other
Mapping details (Right)
Meural responses Al -
Comfort levels All -
Threshold levels Al -

Electrodes activated
Electrodes deactivated

Accessories fitted
Repairs
Implant site checked

Impedance testing ot Within normal range  +

Balancing

Interpolation

Electrodes deactivated

Prograrmming sessions *
Client MRS FIRSTNAME106 LASTNAME106 Print MNew Save Sign Delete Close
Sessions 01/10/2013 - Session date  01/10/2013 E oo User full name tests??? -

- Referral stage Assessment

Processor (Left)
Processor type

Actions performed (Left)
B Electrode mapping

B FM/Radio aid

M Device instruction
Other 2

Mapping details (Left)
Meural responses  Some
Comfort levels Some
Threshold levels Some

M Electrodes activated
Electrodes deactivated

M Electrodes deactivated

- Magnet strength, M -

B Accessories fitted
B Repairs
B Implant site checked

- Impedance testing |Within normal range -

~ W Balancing

~ W Interpolation

MNumber Electrode reason ~ MNumber Electrode reason ~
1 ART shows no nerve response 2 Disturbing overall sound impression
2 Extra Cochlear
3 Excessive noise
v v

Electrodes inuse 3 Electrodes in use (previous) Electrodes inuse 4 Electrodes in use (previous)

Comments Comments
5 6
Information
7 -

Multiple instances of Programming screens can be recorded and saved. Any of these can be
linked to a Switch-on/Review screen. They will be linked automatically if they are opened
using the New button on the Switch-on/Review screen or can be attached after saving using
the Attach button.

o New - Select to create a new session.
o Save - To save the current session.

+ Delete - Will remove the selected session from the database.
« Close - Will close the session without saving it.
o Sessions - Displays a list of any previous sessions.
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« Session Date - Defaults to the highlighted date, but can be adjusted to reflect the date
of the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

« User - Will be the name of the logged in user.

o Purpose of session - The purpose of the session can be selected from the user defined
drop down list.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

iy +

attached ( == ) or not attached ( == ). In addition, the button has a tooltip that displays
detailed information about the session linking.

« Referral stage - This displays the stage in the referral that the appointment isin

currently, if a stage can be identified.

There are two tabs which can be selected. These tabs show different information under the
following headings:

« Main data - A number of check boxes, free text boxes and drop-down lists can be
selected. The drop-down lists can be defined by the System Administrator. In this
section the Processor type has now had Hearing Aid added, as this particular drop down
is hard-coded it is only possible to have changes made by the developers.

« A reason for electrode deactivation can be added by clicking in the Reason field under
Electrode reason and selecting from the drop-down list. The reason lists can be defined
by the System Administrator.

« Electrodes in use - The current electrodes in use can be entered into this box. The
Electrodes in use (previous) box will display the previously saved figure. The number of
electrodes entered can be up to twenty one.

« Additional data - More information can be added to the number of free text boxes and
drop-down lists.

o Program - Is a free text box.

« Strategies and Add-ons are drop down lists configured by the System Administrator.
Where more than one Add on is in use for a Strategy, that Add on pair can be defined as
a new one by the System Administrator.
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22.7 Rehabilitation sessions

This screen serves several purposes:

o A collector for the results that should be produced on the report for that stage.
o A place to record information specific to that stage in the pathway that is not recorded

elsewhere in Auditbase.

Session content or aim

B Assessment(screening orformal) Session details
B Counselling 1
B Advising

B Rehab

B Coaching/demonstrating Goals identified
B Goal Setting 2

M Speech Tracking

B Closed set (multiple choice)

M Open set Management plan
3

B Musictraining

B Telephone training

B Expectations counselling

W Tinnitus counselling

B QofL Questionnaire 4

W Accessories fitted

M User checkbox 1

Other (eg. attention, school liaison, play)

B User checkbox 2 Device use ] hours per day estimate (0 to 24)

Speech
5

Receptive language
]

Expressive language
7

Listening
8

Rehabilitation sessions *
Client MRS FIRSTMAME 106 LASTNAME 106 Print Mew Save Sign Delete Close
Sessions 011012013 - Session date  01/10/2013 E =)

User full name tests??? - Referral stage Assessment

Multiple instances of Rehabilitation sessions can be recorded and saved. Any of these can be
linked to a Switch-on/Review screen. They will be linked automatically if they are opened using
the New button on the Switch-on/Review screen or can be attached after saving using the

Attach button.

New - Select to create a new session.

Save - To save the current session.

Delete - Will remove the selected session from the database.

Close - Will close the session without saving it.

Sessions - Displays a list of any previous sessions.

Session Date - Defaults to the highlighted date, but can be adjusted to reflect the date
of the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

User - Will be the name of the logged in user.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either
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+
attached ) or not attached ( == ). In addition, the button has a tooltip that displays

detailed information about the session linking.

« Referral stage - This displays the stage in the referral that the appointment isin
currently, if a stage can be identified.

o Device use can be used to record hours in use (0- 24 hours).

( oD

Information can be added to the various check boxes and free test boxes. User check box 1
and 2 labels at the bottom left of the screen can be defined by the System

Administrator. Checkboxes are grouped into roughly child or adult at the top, adult at the
bottom and closed/open set question in the centre.

When saving the Rehabilitation session it is possible to Sign and Lock the data. This is done by
pressing Save and the following pop-up will appear:

Client MRS FIRSTNAME106 LASTNAME 106 Print New Save Sign Delete | Close
Sessions 01/10/2013 - Session date  0110/2013 ﬁ oD
iUser full name tests??? - Referral stage Assessment
i Session content or aim
[| Assessment(screening or formal) Session details Speech
| M Counselling 1 5
|| Adisin
| 2 Sign a session X

B Rehab
| i y OK Cancel

B Coaching/demonstrating Goals idé
| M Goal Setting 2 Client

W Speech Tracking MRS FIRSTNAME106 LASTNAME 106

Date

B Closed set (multiple choice) 0110/2013
; B Open set Managen| &) sign with d-
. : 13012020 | full name tests 277 -
| M Musictraining

| M Telephone training

| M Expectations counselling

|| M Tinnitus counselling Other (eg. attention, school liaison, play) Listening
4 8
| M QoflL Questionnaire
W Accessories fitted
M User checkbox 1
B User checkbox 2 Device use g hours per day estimate (0 to 24)

Selecting the sign with date box will allow the user to lock the data which has been entered
therefore preventing anyone from editing the information. It is possible to Save the document
without signing it and then review and Sign later.

If Save is selected and sign with date is not completed then the Sign button will become
available for selection in the top right corner. Selecting it will provide a pop-up where the
information is filled and the user selects OK to save and sign.
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Sign a session

DK Cancel

Client

MRS FIRSTHNAME106 LASTHNAME106
Date

011042013

Sign with date

1307172020 full name tests 777

When looking at the previous sessions there is information in the heading to state by whom it
was signed and locked.

Rehabilitation sessions

X
Client MRS FIRSTNAME106 LASTNAME106 Print New Save Sion | [ Delete | [ Close

Sessions 01/10/2013 - Locked and signed by full name te -

Session date 011012013 [37] e=
User

full name tests???

-

Referral stage  Assessment
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22.8 Implant surgery

This screen serves several purposes:

o A collector for the results that should be produced on the report for that stage.
o A place to record information specific to that stage in the pathway that is not recorded

elsewhere in Auditbase.

Implant surgery >
Client MRS FIRSTMAME 106 LASTNAME106 Print Mew Save Delete Close
Surgeries 0211012013 -| Date 020102013 [5] == M Active User SYSTEM ADMINISTRATOR -
Referral 03/10/2013, x DO NOT USE-VRA .. Treatmentstage Treatment - Add compl.

Irmplant data and summary | Approachfentry | Anchoring and closure | Postoperative | Explant | Intra-Op audiology | Complications

Summary
Ear side Left ~ Procedure name  Initial implant - Age at surgery 24y
Implant type
Right Electro acoustic implant - Left Electro acoustic implant -  Surgeon MISS SE CHALSTREY, CONSULT |
Summary from other tabs, fill here or on other tabs Additional details of procedure Add/Remove
) ) ) Electrodes usable 3
Ossification Partial - e Code MName
Insertion Partial A Electrodes outside 4
Implant requires u 34
explant
Implant data
Issue device Aftach Detach

Implant details
Modified date | Stock type to| Article | LIR| User| Serial number | Notes| aty

Multiple instances of Implant surgery screens can be recorded and saved.

« New - Select to create a new session.

o Save - To save the current session.

o Delete - Will remove the selected session from the database.

« Close - Will close the session without saving it.

« Surgeries - Displays a list of any previous sessions.

« Date - Defaults to the current date, but can be adjusted to reflect the date of the session

either by entering the date manually or by clicking on the calendar icon to choose a date
from a calendar float-window. Double-click in the field to enter today’s date.

« User - Will be the name of the logged in user.
« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

g +
attached ( == ) or not attached ( == ). In addition, the button has a tooltip that displays
detailed information about the session linking.
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« Referral - The relevant referral for the client can be attached to the form using the
button. This is a mandatory field.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

« Treatment stage - The relevant treatment stage is displayed here.
« Active - A check box can be selected to show that the client is active.
o Add compl. - A surgical complication can be added on any of the tabs below by

selecting this button.

Add implant surgery complication X

Add Cancel

Surgery compl. -
Side Right v Date 13/01/2020 5]
User SYSTEM ADMINISTRATOR -
Comment

« Select a complication from the drop-down list Surgery Compl. Select a Side, Date, User
and add a Comment if required. Select Add to include this in the list of complications or
Cancel to leave the screen without saving.

There are a number of tabs which can be selected. These tabs show different information
under the following headings:

« Implant data and summary - Information from a number of drop-down lists can be
selected. The drop-down lists can be defined by the System Administrator.

o Ear side - Right, Left, Unknown or Binaural can be selected. This is a mandatory
field.

o Procedure name - The name of the procedure can be selected from the drop-
down menu.

o Age at surgery - Will display the client’s age at the date of surgery not their
current age.

o |Implant type - This can be selected for Right and Left.

o Surgeon - Can be selected from the Referring Agents table using the button.

o Summary from other tabs, fill here or on other tabs - Selections can be made
from the drop-down boxes if there are no entries in other tabs.
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o Additional details of procedures - Can be added using the Add/Remove button.
By selecting this, a list of procedures is displayed. Procedures can be selected
from this list.

o Implant details - Any stock articles that have been attached to that session can be
observed. Articles can be added in the following manner:

o |Issue device - A search dialogue will be shown.
Add a serial number or article name to the search fields.

o

Please note that these fields are case sensitive.

o Articles can be filtered using the Default filter view button. By selecting this,
options are shown for various Articles and Stock Types.

o Select Search.

o Select from the list ensuring the left-hand column in the table is checked and
then Issue.

o A New status for serial number: XX or New status for quantity controlled
article: XX window will appear.

o Select a Location if relevant.

o Select the new To stock type.

o Depending on the selection, a number of other fields will need to be
completed in the same way as for issuing an article from the Stock module
directly. Once the options have been selected, select OK.

o The selected article will now be included in the table.

NOTE: Changes in device status create clinical actions. If you have attached them to
appropriate appointments, they can be seen on the Clinical actions tab of the Referral
module.

o Attach - By selecting Attach, all currently issued articles will be displayed. Check
the required article and Select. These will then be added to the session.
o Detach - Articles can be removed from the list by using the Detach button.

o Approach/entry - A number of drop-down and free field text boxes are shown and
information can be added to them.

« Anchoring and closure - A number of drop-down boxes are shown and information can
be added to them.

o Postoperative - A number of drop-down and free field text boxes are shown and
information can be added to them.

o Explant - A number of drop-down and free field text boxes are shown and information
can be added to them. Check the Explant performed box to make the options active.

« Intra-Op audiology - Information from a number of free text boxes and drop-down lists
can be selected.

« Complications - Surgical complications can be added by selecting either Add or Add
compl. Both have the same function.
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o Select a complication from the drop-down list Surgery Compl.

o Select a Side, Date, User and add a Comment if required.

o Select Add to include this in the list of complications or Cancel to leave the screen
without saving.
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22.9 Implant surgery complications

Any surgical complications that are added to the Implant surgery form can be listed here. All
surgeries are shown here grouped by surgery; if there are no complications recorded, a value of
<No complications> will be shown. You can also add any complications which may appear
after the surgery from this screen and thus the date of them will not be a surgery date.

Implant surgery complications X
Client MRS FIRSTNAME 106 LASTMAME106 Add Delete Print Close
Surgery date |Procedure name| Side of surgery Surgical complication | Side | Date User Comment

NIA Flap problem without removal | Right 03/10/2013 | USER NAMESD sdfsdf

0211012013 | Initial implant Left Flap problem without removal | Binaural | 01/10/2013 | USER NAMES0 234

03/03/2013 | Explant Left Flap problem with removal Left 04/03/2015 | full name tests?77| 123

04/03/2014 | Initial implant Right =Mo complications=

05/03/2014 | Explant Left =Mo complications=

27/04/2013 | Explant Right =Mo complications=

o Add - Will display a further window.

Add implant surgery complication

Add Cancel

pod

Surgery compl. Flap problem with removal -
Side Right - Date 13/01/2020 f5]
User SYSTEM ADMINISTRATOR -
Comment

Some comment

« Select a complication from the drop-down list Surgery Compl. Select a Side, Date, User
and add a Comment if required. Select Add to include this in the list of complications or

Cancel to leave the screen without saving.
« Delete - Will remove a highlighted complication from the list.
o Print - Will send a copy of the list to the default printer.
o Close - Will close the Implant surgery complications window.
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22.10 Additions to other Auditbase screens

22.10.1 Client Information screen
An additional tab has been added to the Client Information screen. This is the Implant tab.

Contacts | Details | Lists/Photo | Devices || Implant | Visit charge @ Paediatric | PPP 4 »

Invoice senvices Print device info report
r RIGHT rLEFT
Implant type Implant type
Electro acoustic implant Electro acoustic implant
First surgery date 0303/2013 First surgery date 03/0242043
Latest surgery date 021002013 Latest surgery date 021002013
First switch-on date 04/M10/2013 First switch-on date
Latest switch-on date 011012013 Latest switch-on date
Upgrade due date 01/10/2013 Upgrade due date
Client preferences \mmunisation
Select
Type |R| L| Name | Status
Cable ] ITETOMR v
Magnet 1] ITE10ML
Date =
Ear hook |[©][]BE101
Battery type [][]BE101B Surgical consent
Other =[] BE101G -
Date E

Consortium (Customer Group)

Funding Status

Implant keyworker

The top section shows information from various Implant screens including;:

« Implant type - From the Implant surgery screen.

o First surgery date - From the Implant surgery screen.

« Latest surgery date - From the Implant surgery screen.

« First switch-on date - From the Implant surgery screen.

« Latest switch-on date - From the Implant surgery screen.

« Upgrade due date - From the Switch on / Review sessions screen.

« Client preferences - From the Decision tab on the Pre-op assessment form.
Thesepreferences can be overwritten as choices change.

« Immunisation and Status - Choose an immunisation and/or a status e.g. Immunized,
Patient advised, Parent advised or GP advised. Double-click in the date field for today’s
date or chose a date by clicking on the calendar icon.
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« Surgical consent - Indicate whether or not consent has been given to e.g. use pictures
of the patient for educational purposes or scientific research. Double-click in the date
field for today’s date or chose a date by clicking on the calendar icon.

o Consortium (Customer Group) - A consortium or group of customers can be added by
selecting from the drop-down list. This list is populated by the following method and
assumes that Customers have been set up:

« From the Client Information screen select Functions in the menu bar.

o Select Settings.

o Select Customer Groups.

« Select New and enter a name for the Customer group.

o Other details can be added as required.

« Save the new group. Once this has been done, group members can be added.

« Select the required Customer group and choose the Edit group members button.

o A list of available customers will be displayed. These can be chosen by highlighting them
and using the Add button. Customers can be removed from a group using the Remove
button.

« Once the customers have been selected, Close the window.

o Close will then save the customer group.

o A group can be removed by using the Delete button.

o Funding status - This is a drop-down list that can be defined by the System
Administrator.

« Implant keyworker - This field displays a list of users, one of which can be selected.
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23 Surgery Module

An optional module for entering Surgery details is available. It is possible to record pre-
operative and perioperative assessment and post-operative follow-up data for three main ear
surgery types.

o Otosurgery
o Stapes surgery
o Implant surgery - using existing screens from the Auditory Implant module.

For complete research data, the majority of field options are hard-coded and are not user
definable. The two user definable fields in each type of surgery can be defined in the System
Administration tool. Client drop out and the reason for it, can be recorded.

Surgery stages can be linked to appointments either automatically or manually. Referrals can
be attached to surgeries, this can either be made mandatory or non-mandatory in the System
Administration tool.

Planned clinical actions will be visible in the Client Pathway Overview. These clinical actions
include Pre/Per-operative, Postoperative 2-5 month follow-up and Postoperative >12 month
follow-up for Otosurgery and Stapes surgery.

User reports have been added to include:

o Audiometric outcome and surgery data reports
« Visual histograms and CSV export for full research

To open the Surgery module, Navigation — Surgery or Ctrl+Shift+Y. If the client does not
already have an ongoing surgery, a window is displayed for you to select the type of surgery
required.

Mew Surgery *

QK Cancel

Choose a surgery type

iOtoSurgery
Stapes3Surgery
Implant

Double-click on the required surgery or highlight it and click OK. Cancel will close the window
without selecting a surgery.

Be aware: Before proceeding, please make sure the correct client is selected to avoid
incorrect operation planned.
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23.1 OtoSurgery

There are tabs for Pre/Per-operative, Postoperative 2-5 month follow-up, Postoperative

>12 month follow-up and Drop Out along the top of the page showing different information.

General data will display the Operation information on each tab, it can only be edited on the
first tab, the same information is displayed but greyed out on the others. Other indications and
diagnosis are also shown above each tab. To save an OtoSurgery, the minimum data required
to be entered is Op. side. Date is also required but is set to today’s date by default. If Referral

has been made mandatory, this will need to be saved as well.

Surgery

Client MRS FIRSTNAME106 LASTNAME106 Surgery type OtoSurgery Select

Mew | Delste

Close

Pre-/per-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg.  17/07/2018 E Age 20y Op.Side Right ~ OpMNumber ~ Per-operative diagnosis

Referral

21/08/2018, ++AUDIO REVIEW reass ..

Hearing impairment

MNeeda Hl
Pre-iper-operative data
Status of ear at surgery

Tympanosclerosis
Eustachian tube function
Crigin of cholesteatoma
Approach

Myringoplasty
Ossiculoplasty

Type of graft

Prosthesis material
Prosthesis type

Batch

Added to gel foam
Anaesthetic
Chorda tympany
Field3

Field4

Vertigo
Discharge

Dry ear

L

Silastic

ot

Surgeon

Tinnitus
Wish to swim

-

Cholesteatoma

Created by
Appt oo

Additional diagnoses

Submit

SYSTEM ADMINISTRATOR

EEl S Completed hd

Care
Checkbox 2

Delete | Save

-

Add/Remove

Code

Mame

Audiometry

Comments

Concurrent procedures

B Goto

=

AddiRemove

Code

MName

« Select - Displays a list of any previous sessions. Choose a surgery and click OK to display
the information relating to that date.

Client Surgeries

OK Cancel

X

Choose a surgery

10 04 2015 OtoSurgery (Left)
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« New - Select to create a new surgery. The New Surgery dialogue will open.

« Delete - Will remove the selected surgery and all related sessions from the database.

o Close - Will close the session without saving it.

« Date of surg. - Defaults to the current date, but can be adjusted to reflect the date of
the operation either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date again.

+ Age - Will show the client’s age at the time of the surgery. If the client is less than 5
years old, the age will be displayed in years and months.

« Op. side - Left or right can be selected for the Operated side. This is a mandatory field.

e Op. Number - 1-12 or unknown can be selected manually.

« Created by - Will be the name of the logged in user.

« Referral - The relevant referral for the client can be attached to the form using the
button. This may be a mandatory field depending on your settings.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

« Surgeon - Can be selected from the Referring Agents table using the button. The list will
default to the Surgeon referring agent type. Click New to create yourself as a Surgeon if
not already in the system. If another referring agent type is required by default, your
System Administrator can set this up. If you as a user are linked in Administration to a
Referring Agent, the Surgeon field will be pre-filled with your data.

o Otherindications, such as Hearing impairment, Tinnitus and Need to Swim are
displayed as check boxes on each surgery screen. There are two site configurable
checkboxes available. Apply your own values to these from within System Administration.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

g +
attached (C 3) or not attached (7). In addition, the button has a tooltip that displays

detailed information about the session linking. The appointment will be linked
automatically if the data entry takes place on the same day.
« Stage - The relevant treatment stage is displayed here.

23.1.1 Pre-/per Operative Assess

o Pre-/per-operative data - There are a number of hard coded drop-down lists which can
be selected. These are not user definable, in order to produce consistent research data.

o User field #1 and User field #2 - These fields’ labels and content can be defined by
your System Administrator.
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+ Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button at the top as described in
the OtoSurgery topic.

« Save - To save the information on the selected tab for the current session.

« Other indications - These can be added by using the Add/Remove button. A user
definable list of other indications is displayed. Check all that are appropriate and click
Select. Cancel will close the dialogue box without adding any indications.

o Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

Audiometry 04M10/2013, no. 1, Pre-operative .. Bl Goto

o Click Go to to open the audiogram in the full Audiogram module.

« Comments - A free text box is available for comments.

o Concurrent procedures - These can be added by using the Add/Remove button. A
user definable list of other procedures is displayed. Check all that are appropriate and
click Select. Cancel will close the window without adding any indications.

23.1.2 Post-Operative follow up 2-5 m

« General data is displayed as described in the OtoSurgery topic.

o Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=) or not attached (‘:+:’ ). In addition, the button has a tooltip that displays
detailed information about the session linking.

« Stage - The relevant treatment stage is displayed here.

« Post-operative data 2-5 months - Information from a number of drop-down lists can be
selected here.

« Date of event - This will be the date of the 2-5 month review and is independent of the
main date of surgery.

« Delete - This delete button will only remove the details on the current session. It does
not remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery topic.

« Save - To save the information on the selected tab for the current session.

o Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to

Show an already attached audiogram. Clicking Attach will display the list of currently
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saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the Preview button.

o Press Go to to open the audiogram in the full Audiogram module.

« Comments - A free text box is available for comments.

o Drop out - This button will take you directly to the Drop out tab so that information can
be added.

Surgery X

Client MR JOHN SMITH Surgery type  OtoSurgery Select | MNew | Delete | Close

Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg. | RLUEIERE Age 5y Op.Side Left + OpNumber 1 + Per-operative diagnosis
Referral 10/04/2015, ++AUDIC REVIEW reass Surgeon MRS AMMAN, 222 5TR, HOME CITY H72.9  « Perforatio membrana tympani A
M Hearing impairment Vertigo B Tinnitus Cholesteatoma B Care
M MeedaHl M Discharge Wish to swim M Checkbox 2
Post-operative data 2-5 months
11/04/2015 i
Postoperative infection Mo .| Date of event = Submit Delete
) Created by SYSTEM ADMINISTRATOR -

Chorda function Mormalino change -

Appt oD Stage Assessment -
Facial nerve function Normal hd ) :

Audiometry 11/04/2015, no. 1, Post-operative 2-5m .. B Goto
Anacusis MNew anacusis -

) Comments
Vertigo Preoperative level -
Tinnitus Preoperative level -
Otomicroscopy Intact, normal aeration -
Drop gut

23.1.3 Post-Operative follow up >12m

« General data is displayed as described in the OtoSurgery topic.

« Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=) or not attached ( <5 ). In addition, the button has a tooltip that displays
detailed information about the session linking.

« Stage - The relevant treatment stage is displayed here.

o Post-operative data 12 months - Information from a number of drop-down lists can be
selected here.

« Date of event - This will be the date of the twelve month review and is independent of
the main date of surgery.

« Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery topic.
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o Save - To save the information on the selected tab for the current session.

« Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Selecting Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double clicking or by highlighting and
Select. Once the audiogram has been attached, the details for it are displayed. The
attached audiogram can be viewed by selecting the preview button

o Toopen the audiogram in the full Audiogram module, click Go to.

« Comments - A free text box is available for comments.

o Drop out - This button will take you directly to the Drop out tab so that information can

be added.
Surgery X
Client MR JOHMN SMITH Surgery type  OtoSurgery Select Mew Delete Close
Pre-lper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | plUEIPy] Age 5y Op.Side Left + OpMNumber 1 » Per-operative diagnosis
Referral 1000442015, ++AUDIO REVIEW reass Surgeon MRS ANMNAN, 222 STR, HOME CITY H729 |+ Perforatio membrana tympani -
B Hearing impairment Vertigo B Tinnitus Cholesteatoma W Care
B MNeedaHl M Discharge Wish to swim B Checkbox 2
Post-operative data 12 months
Charda function - Date of event 1310172020 E Submit Delete Save
Created by -
Facial nerve function -
Appt & Stage -
Anacusis -
Audiometry .. B Goto
Vertigo -
Comments
Tinnitus -
Otomicroscopy -
|5 client satisfied -
Drop out
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23.2 Stapes Surgery

There are a number of tabs along the top of the page showing different information.

General data will display the same information on each tab. Once a surgery session has been

saved, this information is displayed but greyed out on all but the first tab. To save a Stapes

Surgery, the minimum data required is Op. side. If Referral has been made mandatory, this

will need to be saved as well.

Surgery

Client MRS FIRSTMNAME 106 LASTMAME106 Surgery type StapesSurgery Select MNew Delete | Close
Pre-iper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg. | (lg{VFE0gE E Age 24y Op.Side Right ~ OpMNumber 1 ~ Per-operative diagnosis

Referral 071212018, ++FITTING - from previot .| Surgeon MISS SE CHALSTREY, CONSULTANT EM . H80.9 = Otosclerosis -
B Hearing impairment W ‘ertigo W Tinnitus W Aid

B Hl on operated ear Family members with Otosclerosis B Checkbox 2
Pre-iper-operative data

Anaesthetic General anaesthesia - Submit Delete

ACCess Trans canal ~ Created by full name tests??? -
Procedure DDAOD |~ Stapedotomy ~ Appt =) Stage Treatment v
Type of laser Diode ~ Additional diagnoses

Drill Skeeter ~| testdiagnoses

Prosthesis Mitinol-Smart v

Batch Lot

Piston diameter 04 -

Piston length . Audiometry 04/10/2013, no. 1, Pre-operative .. B Goto

Comments
test comments
Facial nerve Marmal -
B Stapedial artery
Add/R
Niche dressing Gelfoam . Concurrent procedures emove
Code MName

Ear canal dressing Gelfoam + HT-meche MERTT exc probat meatus ac ext

Field1 1 -

Field2 3 -

« Select - Displays a list of any previous sessions. Choose a surgery and click OK to display

the information relating to that date.

+« New - Select to create a new surgery.

Delete - Will remove the selected surgery and all related sessions from the database.
Close - Will close the session without saving it.

Date of surg. - Defaults to the current date, but can be adjusted to reflect the date of
the session either by entering the date manually or by clicking on the calendar icon to
choose a date from a calendar float-window. Double-click in the field to enter today’s
date.

Age - Will show the client’s age at the time of the surgery. If the client is less than 5
years old, the age will be displayed in years and months.

Op. side - Left or right can be selected. This is a mandatory field.
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e Op. Number - 1-12 or unknown can be selected.
o Created by - Will be the name of the logged in user.
« Referral - The relevant referral for the client can be attached to the form using the

button. This is may be a mandatory field depending on your settings.

If the referral does not exist or an existing one cannot be used, you can create a ‘quick’

referral by clicking the New button from the == button to the right of the Referral field.
See details in Quick referral creation.

« Surgeon - Can be selected from the Referring Agents table using the button. The list will
default to the Surgeon referring agent type. If another referring agent type is required by
default, your System Administrator can set this up. If you as a user are linked in
Administration to a Surgeon Referring Agent, the Surgeon field will be pre-filled with
your name.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

. +
attached (C 3) or not attached ( '==). In addition, the button has a tooltip that displays
detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

23.2.1 Pre-/per Operative Assess

o Pre-/per-operative data - There are a number of hard-coded drop-down lists which can
be selected. These are not user definable to assist in research.

o User field #1 and User field #2 - These fields can be defined by your System
Administrator.

« Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

« Save - To save the information on the selected tab for the current session.

« Other indications - These can be added by using the Add/Remove button. A user
definable list of other indications is displayed. Check all that are appropriate and click
Select. Cancel will close the window without adding any indications.

« Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

Audiometry 04M10/2013, no. 1, Pre-operative /Bl Goto
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Click Go to to open the audiogram in the full Audiogram module.

Comments - A free text box is available for comments.

Concurrent procedures - These can be added by using the Add/Remove button. A user
definable list of other procedures is displayed. Check all that are appropriate and click
Select. Cancel will close the window without adding any indications.

23.2.2 Post-Operative follow up 2-5 m

General data is displayed as described in the Stapes Surgery topic.

Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=) or not attached (‘:+:’ ). In addition, the button has a tooltip that displays
detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

Post-operative data 2-5 months - Information from a number of drop-down lists can be
selected here.

Date of event - This will be the date of the 2-5 month review and is independent of the
main date of surgery.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

Save - To save the information on the selected tab for the current session.

Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.

Click Go to to open the audiogram in the full Audiogram module.

Comments - A free text box is available for comments.

Drop out - This button will take you directly to the Drop out tab so that information can
be added.

© Auditdata - 2022, ID: 20.0040/29 456



User Guide

Surgery x
Client MRS FIRSTMAME106 LASTHAME 106 Surgery type StapesSurgery Select New Delete Close
Pre-/per-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | [Vl Age 24y Op.Side Right v OpMNumber 1 ~ Per-operative diagnosis
Referral 071212018, ++FITTING - from previou Surgeon MISS SE CHALSTREY, CONSULTANT EP H80.9 - Otosclerosis -
M Hearing impairment M Vertigo M Tinnitus W Aid
M Hl on operated ear Family members with Otosclerosis M Checkbox 2
Post-operative data 2-5 months
091072013 i
R r e AE it Yes . Date of event ﬁ Submit Delete
) Created by full name tests 2?77 -
Charda function Maormal/no change -
Appt =5 Stage -
Facial nerve function Preoperative function -
Audiometry 03M10/2013, no. 1, Post-operative 2-5m .. |B Goto
Anacusis Monefno change hd
) Comments
Vertige Preoperative level > testcomments
Tinnitus MNone -
Otomicroscopy Intact, normal aeration -
Drop out
23.2.3 Post-Operative follow up >12m

General data is displayed as described in the Stapes Surgery topic.

Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (=%)) or not attached (°+°). In addition, the button has a tooltip that displays
detailed information about the session linking.

Stage - The relevant treatment stage is displayed here.

Post-operative data 12 months - Information from a number of drop-down lists can be
selected here.

Date of event - This will be the date of the twelve month review and is independent of
the main date of surgery.

Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the Stapes
Surgery topic.

Save - To save the information on the selected tab for the current session.

Audiometry - Audiograms can be added to the session by selecting the button. This will
give you a choice to Attach an audiogram, Detach an already attached audiogram or to
Show an already attached audiogram. Clicking Attach will display the list of currently
saved audiograms for the client. This list will include the ability to Preview a selected
audiogram. The audiogram can be selected by double-clicking or by highlighting and
clicking Select. Once the audiogram has been attached, the details for it are displayed.
The attached audiogram can be viewed by selecting the preview button.
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Surgery X
Client MRS FIRSTNAME106 LASTNAME 106 Surgery type StapesSurgery Select New Delete Close
Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out
General data
Date of surg. | [eRlvFNy| Age 24y Op.Side Right ~ OpMNumber 1 ~ Per-operative diagnosis
Referral 07/12/12018, ++FITTING - from previot | Surgeon MISS SE CHALSTREY, CONSULTANTEPM | H80.9 = Otosclerosis -
M Hearing impairment W Vertigo M Tinnitus M Aid
M Hl on operated ear Family members with Otosclerosis M Checkbox 2
Post-operative data 12 months
] Date of event 091072013 Submit Delete Save
Chorda function Normalino change - ﬁ = =
. . Created by full name tests?77 -
Facial nerve function Maormal -
Appt = Stage -
Audiometry 021062013, no. 3, Post-operative =12m .. /B Goto
Vertigo Mone -
Comments
Tinnitus Mone ¥ testcomments -~
Otomicroscopy Intact, normal aeration -
|5 client satisfied Satisfied - w7
Drop out

« Click Go to to open the audiogram in the full Audiogram module.
« Comments - A free text box is available for comments.

o Drop out - This button will take you directly to the Drop out tab so that information can
be added.
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23.3 Surgery Drop out

A client Drop out can be opened from the tab of the Surgery window or with the button of that
name on the two follow up screens.

« General data is displayed as described in the OtoSurgery and StapesSurgery topics,
correspondingly.

o Created by - This will be the user that has created the information on this tab. Users can
be selected from the drop-down list.

« A special button is available for attaching the session to or detaching it from an
appointment. The button has a picture which reflects the state of the session: either

attached (7)) or not attached (‘:+D ). In addition, the button has a tooltip that displays
detailed information about the session linking.

« Stage - The relevant treatment stage is displayed here.

« Drop-out data - A Reason for the drop-out can be chosen. If the selected Reason is
State of drum, then the field Otomicroscopy is activated and items can be selected.

o Date of interruption - This can be added in the same way as other dates. Once a date
has been added, the Follow-up duration is displayed in months and days.

o Delete - This button will only remove the details on the current session. It does not
remove the entire surgery. To do that, use the Delete button as described in the
OtoSurgery and StapesSurgery topics, correspondingly.

o Save - To save the information on the selected tab for the current session.

« Comments - A free text box is available for comments.

Surgery X

Client MRS FIRSTMAME106 LASTNAME106 Surgery type  StapesSurgery Select Mew Delete Close

Pre-fper-Operative Assess | Post-Operative follow up 2-5m | Post-Operative follow up =12m | Drop-out

General data

Date of surg. | MEIR{VPgE Age 24y Op.Side Right ~ OpMNumber 1 ~ Per-operative diagnosis

Referral 07M2/12018, ++FITTING - from previot Surgeon MISS SE CHALSTREY, CONSULTANT EM H80.9 ~ Otosclerosis -

M Hearing impairment W Vertigo M Tinnitus W Aid

M Hl on operated ear Family members with Otosclerosis M Checkbox 2

Drop-out data

S State of drum - Date of interruption 09/10/2013 E Submit Delete &

) Created by full name tests?7?7? -

Otomicroscopy Lateralization A
Appt oD Stage Completed hd
Follow-up duration om

Comments
test comments
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23.4 Additions to AB Audiogram

If the Surgery module has been added as an option, an additional tab is activated in
Measurements — AB Audiogram. This tab is called Surgery and shows additional data for a

selected audiogram.

o)) Auditbase - [AB Audiogram - 10/01/2020, no. 1, PTA, Initial assessment [READ OMNLY]] - O x
Eile View Functions
| Client  T1106 MRS FIRSTNAME106 LASTNAME 106 ||| Z| Bl|user SYSTEM ADMINISTRATOR | All locations ~ Al departments ~ x| ?
Measure
125 250 500 1000 2000 4000 8000 HORMAL - 1285 250 500 1000 2000 4000 8000
-10 -10 Q s -10 -10
ymbol @
0 0 O > 0 0
@ AC MASKED s

10 10 10 10

£ BC UNMASKED Ty

20 20 L BC MASKED | 20 20

0@ 30 |L ucLum 4 3 30

’ UcL M ] KWK X % X % X
0 —O0—&—86—0& L& 5 & 1 . MCL UM Mo 40 40
50 so [k woLu L A A A AN AN A A A A e S )
% SF &

60 S 60 60 60

~f---C-G---C- G- C-G-—C-C ® SFH -

] 7o ® RIPSY &= T0 a, 70
80 80 O mEVIL " 50 80
& R CONTRA *

90 90 90 90
100 100 100 100
110 110 110 110
120 120 120 120
130 130 130 130
140 140 140 140
hight T Surgery 17.07.2018 OtoSurgery (Rignt) |l open Lot Reference

Surgery stage b
Compare to - D

EEErE) B operated ear side . B BECE pajics
AC (4-pta) 40 ABG "overclosure AC (4-pta) 35
BC (3-pta) 65 AC (4-pta) improvement BC (3-pta) 57
ABG (4-pta) 25 ABG (4-pta) improvement = ABG (4-pta) 20
Inter-Aural DiffAC 5 Belfast 15/30 dB rule of thumb using "AND" using 'OR’ Inter-Aural DIFAC -5

® |nformation | @ Referral | @ Speech | Speechin hoize | Tump | Compare | Graphical Speech | Others | Westibular | @ Surgery

Linking audiograms to surgeries can be performed in either direction. Audiograms can be linked to

surgeries or surgeries can be linked to audiograms. To link an audiogram to a surgery, see above

sections.

An audiogram can only be attached to one stage in any surgery but to more than one surgery. An
audiogram cannot be attached to a stage date earlier than one that is attached to a later stage date

for the same surgery.

« Tolink a surgery to an audiogram, select the button at the end of the Surgery field.
Select Attach and a list of the client’s available surgeries will be displayed.
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Client Surgeries X

QK Cancel

Choose a surgery

30.09.2013 OtoSurgery (Left) -
09.10.2013 StapesSurgery (Right)

15.04 2014 OtoSurgery (Left)

20.03.2015 OtoSurgery (Right)

26.03.2015 OtoSurgery (Left)

03.11.2015 OtoSurgery (Left)

17.07.2018 OtoSurgery (Left) hd

Aftach to stage

Post-operative 2-5m -

o Double-click or highlight the appropriate surgery and click OK. Cancel will close the
window without selecting a surgery.

Surgen 17.07.2018 OtoSurgery (Right) ... | Open

Surgery stage Post-operative =12m A

o The surgery is now linked to the audiogram and the information will be displayed
including Surgery stage.

o The surgery can be viewed by clicking the Open button.

o 4 point mean values for AC, BC and Air-Bone Gap (ABQG) are displayed. These means are
set for US research publication purposes.

Right Operated

BC (4-pta) E5

AC (4-pta) 40

BC (3-pta) 65

ABG (4-pta) -25
Inter-Aural DiffAC 5

o If 3 kHz is not plotted, the user will get a warning by the relevant box flashing in an
appropriate colour, i.e. red for right and blue for left. The mean will then be calculated
using 4 kHz instead. If this is the case, a tooltip will be displayed.

o Aflag is stored in the database for the audiogram if this warning is required. This flag is
for reporting purposes only and cannot be seen by the user.

« By checking Compare to operated ear side, a previous audiogram can be selected. This
will populate further fields regarding the operated side.
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W Compare to 5122015, 3 hd |:|

operated ear side
ABG "overclosure”

AC (4-pta) improvement 8
ABG (4-pta) improvement

B S
Belfast 15/30 dB rule ofthumb using 'AND" [(/)|  using 'OR

« Anicon will be displayed to show whether the compared audiograms meet the Belfast
15/30 dB rule of thumb. The Belfast rule is calculated according to two interpretations
of the rule. One with 'AND' where the interaural difference must be less than 15dB and
the hearing loss in the ear is under 30dB and the other with 'OR' where either of these
conditions can be met.

« The colour of the audiogram that is being compared can be changed by selecting the
coloured square to the right of the compare field. A colour palette opens and the new
colour can be selected.

« If more than two audiograms need to be compared then the Compare tab on AB
Audiogram should be used. The current selections will be shared between the two tabs.
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23.5 Other Additions
23.5.1 Reports

Crystal and CSV reports have been added to Navigation — User reports — Surgery — Crystal
Reports tab or CSV reporting tab. These are run in the same way as other Crystal and CSV
reports.

23.5.2 Client pathway overview

The following actions have been added to client pathway overview settings in the System
Administration tool. All except Surgery Drop out can be added as planned actions.

o OtoSurgery Pre-Op

o OtoSurgery PostOp 2-5m

o OtoSurgery PostOp > 12m

o StapesSurgery Pre-op

« StapesSurgery PostOp 2-5m
o StapesSurgery PostOp > 12m
o Surgery Drop out.

Icons have been added to the Client Pathway Overview for these surgery actions. The relevant
surgery screen can be viewed by selecting it from the overview. They will be under the
appropriate referral if this has been set by your System Administrator.
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24 Laptop Synchronization

If laptop synchronization has been purchased, Auditdata IT Support staff will set up a laptop to
allow parts of Auditbase to be used without a network connection. If this has been set up, you
must connect your laptop to a network point and create the database you will be using without
your network connection. This is the 'off line-database' and is usually called ABASEOFF.

It is not possible to transfer clients who have a Noah action on the date you are creating
the offline database.
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24.1 Creating the offline database

o Log in tothe online database as a normal user.

« System settings -> Prepare offline database.

o Make sure that you have selected the correct name of the database you want to create in
the Offline database drop-down list, usually ABASEOFF.

o Click Next.

« Click OK to overwrite the existing database. Note that the laptop database must be
synchronised in advance with the main system to recreate the same database. If this has
not been done an error message will be displayed.

« When the database structure has been created you can choose clients to add to the
database in one of the following ways:

« Add Client allows you to use the Search Client function and add individual clients by
highlighting them and clicking on Select.

« Add Clients from waiting list allows you to add all the clients from a waiting list to the
offline database by choosing the waiting list from the drop-down list.

« Add clients from a resource allows you to select the clients who already have
appointments booked in the diary. Choose the name of the resource from the drop-down
list and fill in the date range required. The date range needs to specify the date before
and the date after those required, for instance for 3rd April 2005 choose 02/04/2005 to
04/04/2005.

« When all the required clients are selected, click Next.

« When the wizard is complete, click Finish. The database is now ready to use offline.

It is important that the network connection is not unplugged during this procedure.

Prepare for off-line work >
Add client Add clients from waiting list Add clients from a resource

Code | Mame
T1104 MR FIRSTMAME 104 LASTNAME104
T1105 MRS FIRSTMNAME 105 LASTNAME105
T1108 MRS FIRSTMNAME 106 LASTNAME 106
T1107 MRS FIRSTMAME107 LASTNAME107

L to sort colu
Currently 4 clients are selected Remove
B Mext Cancel Help
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24.2 Appointment symbols in the offline database

To minimize the time it takes to prepare an offline database not all appointments are visible on
the laptop.

« If the selection of clients for creating the offline database was made based on Resources
then all the appointments and reservations in the period selected will have their symbols

copied to the booking screen on the offline laptop.

« If the selection of clients for creating the offline database was based on client names or
via a Waiting List then only the appointments for the forthcoming 30 days will have a
symbol on the booking screen. No other reservations or group appointments will be
copied.

« All the appointments belonging to a client, that have taken place in the past or are
booked for the future, will be copied to the laptop, but apart from the ones above the
symbols will not be visible on the booking screen.
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24.3 Logging in to the offline database

« Double-click on the Auditbase icon on your desktop.
o Change the database name in the drop-down list to the name of your offline database,
usually ABASEOFF.
e Loggingin
1. Logging in with a Microsoft Windows account
« The login name will be preselected. No need to enter a password.
2. Logging in with an Auditbase account
« Type your normal username and password.
« You can now use the areas of the database which are accessible offline in the normal
way.

« Creation of documents and templates is allowed. Editing of either offline is not
supported. To work around this, make a copy of an existing document when offline and
edit that.
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24.4 Synchronization

When a user has connected to the offline database, for instance during a house visit, changes
in the laptop (local database) must be synchronized with the central database when back at
the clinic.

o Connect the laptop to a network point.

o Log onto the normal Auditbase database, usually the database name is ABASE.

« System settings -> Laptop synchronization.

« Follow the onscreen wizard instructions ensuring that the right name appears in the
database name field, usually ABASEOFF.

It is important that the network connection is not unplugged during this procedure.

o The synchronization wizard activates a search for the name of the offline database. If not
found, the user is asked to select from a list.

« A search on the client ID(s) from the offline database is performed in the central
database. If a client with the same ID exists in the central database, the client data is
transferred without prompting the user.

« If noidentical client ID is found in the central database, the user is asked whether the
client should be inserted as new or merged with an existing client in the central
database.

o If the replication log table holds a record of a new client registration, the merge client
dialog will appear.

« To process client data from offline database, one of three solutions must be selected:

o import as new
o merge with existing client data
o sKip client —all data related to this client is skipped and cannot be retrieved
o By using a subset of client data from the offline database, the user can locate the right
client in the central database by searching on for instance:
o clientID
o name(s)
o birth date
o address

o Entering one or some of the criteria and pressing Search opens the Client search dialog
with results matching those criteria.

« Not entering any criteria but pressing Search still opens the search dialog for a user to
search for a client in the usual way.

» After processing all new and changed client information, other changes are copied to the
offline database by the system. The user is informed that the offline database is no
longer available but needs to be reinitialized prior to further use.

« In the offline laptop database, clinical actions will not be linked automatically to
appointments and cannot be linked manually. Appointments from the offline database
are not synchronised back to the main database so linking cannot be updated. To link
actions on the offline laptop to appointments use the Attach feature after the database
has been synchronised and the actions are in the main database. Noah actions however
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can be linked automatically to the appointment when the database is synched back to
the main database. If the patient has more than one appointment on the same day then
the action will be linked to the latest appointment.
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24.5 Merging new clients created when you were offline

If new clients were created in the offline database you can merge them into existing records or
create them as new records in the main database during laptop synchronisation.

A window box named A new client is found in the offline database appears during the laptop
synchronisation wizard.

The left-hand side of the window fields are filled with the new client data and the user should
select which criteria to search on by pressing the arrow(s) > copying the field value(s) to the
right-hand side and pressing Search.

Clients matching the criteria are listed to Select from filling in the information in the right-hand
side fields.

Having the data of the clients to be merged respectively on the left and right-hand side,
pressing Merge will log all data on the ‘two’ clients into a log table in the database.

Client data as first name, surname and address of client in the offline database are ignored as
this data is retrieved via a PAS link connection and updated from there.

If the user decides not to merge the two clients, pressing Load as new will save the client from
the offline database as a new, separate client.

If the user decides to leave the client from the offline database out of the central database,
pressing Skip will perform this action.

Continue the synchronisation wizard in the usual way.

A new client is found in the offline database. You can import him/her as new, merge with existing client or skip... d

Mew Client Search Existing Client
Hospital no 11108 Generate new
MNH3no. 7777777777 Generate new =
Names  FIRSTNAME =
Surname | ASTNAME =
Birthday

Address - = -

Merge AS anew Skip

o) Auditbase

ext Cancel Help
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25 PPP and Import/Export

Auditbase contains an import/export facility to enable the transfer of patient data between
databases.

With the PPP module, you can export a selected number of clients from a Public Partner, put
the client data on a CD and send it to a Private dispensing company who will consult the client
and fit them with a hearing instrument. Having done so, the Private Partner will refer the client
back to the Public Partner with the revised client data.

All PPP transfers have to be approved by the client.
The module is also referred to as PPP list.
General workflow of the PPP module goes in 5 stages:

o Export of client data from Public Partner (data retrieved from Auditbase System e.g. at
hearing clinic).

« Import of client data at Private Partner (data imported to local Auditbase System e.g. at
hearing instrument dispenser A).

« Intermediate work with client data at Private Partner's (e.g. client visiting hearing
instrument dispenser A and being granted a hearing instrument).

o Export of revised client data from Private Partner (revised data retrieved from local
Auditbase System e.g. at hearing instrument dispenser A).

o Import of revised client data to Public Partner (revised data is merged into respective
client records in central Auditbase System e.g. at hearing clinic).

The most likely flow is looking up a Waiting list and selecting one or more clients to be referred
to the private partner.
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25.1 Definitions

The following definitions are used throughout this document.

« External site - this is the site to which you are sending the database. It could be a PPP
partner, education or another hospital.

« External partner - essentially the same as an external site also known as a private
partner.

« Configuration file - this is a special type of file which is used to set up the import/export
facility.

« Journal mapping - this is where you decide what a journal string is called. Rarely do two
databases have the same names for journal strings so you need to associate what you
call your string with what the external site calls theirs.

e PPP - Public Private Partnership.
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25.2 Setting up

The following will assist you to set up and use this facility. The setting up needs to be
performed in the Auditbase Administration tool, which is opened from Auditbase by going to
System settings -> Open system administration. Once opened, select Import/Export.

25.2.1 Import Configuration

Setting up the import configuration will define which fields are imported into the database.
There are two default configurations. Default has all options selected. Default demographics
only has client demographic information only. A new configuration can be made by selecting
New. The Name of the new configuration should be entered in the field provided. There are
then 3 tabs which also need to be selected.

« Client - The client demographics can be selected for import.

« Update demographics for existing clients - If this option is selected, then the client’s
demographic details will be automatically over written when data is imported. When you,
at the public partner, import a PPP file from a private partner, data will never be updated,
but when differences shown in a log file after the import is completed.

« Selection of client data to import - Here information from the Clientinformation
module can be selected for import. To select all demographics select All.

« Journal - Journal data will be imported if this option is selected. Note that only mapped
journal strings are imported.

o Other - There are a number of check boxes that can be used to select which information
is created or updated when the data is imported. Check the required options or All for
everyone.

Once the options have been selected, Save will store the configuration. To remove a
configuration, select Delete.

Note: When importing a PPP file at a private partner, you will not be able to select a
specific import configuration; all data for the client will automatically be
created/updated when imported.

25.2.2 Export Configuration

Setting up the export configuration will define which fields are exported from the database.
There are two default configurations. Default has all options selected. Default demographics
only has client demographic information only. A new configuration can be made by selecting
New. The Name of the new configuration should be entered in the field provided. There are
then 3 tabs which also need to be selected.

« Client - The client demographics can be selected for export.

« Journal - Here, choices are made as to how much of the journal is to be exported.

« Enable export of journal data - If this option is selected, the journal search strings can
be chosen to export data.
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« Export data for all search strings - When this option is selected, all search strings from
both Audiologist and Hearing therapist journal are exported. Also search strings to be
created in future will be included in an export.

o The alternative is to configure exactly which search strings those are to be exported.
There are a number of check boxes that can be used to define this. Check the required
options or All for everyone.

o Other - There are a number of check boxes that can be used to select which information
is exported. Check the required options or All for everyone.

Once the options have been selected, Save will store the configuration. To remove a
configuration, select Delete.

Note: When exporting a PPP file from a private partner, you will not be able to select a
specific export configuration; all data for the client will automatically be exported.

25.2.3 External site set up

« Once a configuration file has been sent to an external site, the file can be used to set up
that external partner.

« The site name will be produced by the imported configuration file and cannot be
adjusted manually.

« The Default configuration can be set for both importing and exporting. The required
configuration is selected from the drop-down menu.

o The search strings in the journal must be mapped so that the search strings from the
external database match those for the main database.

« Selecting Journal mappings will open a window called Map search strings for journal.
Search strings for the audiologist or hearing therapist can be selected using the Select
type of journal search string to map drop down menu.

o The journal entries for the Source site are shown in the left window, the Target search
strings are shown on the right. Select a search string from the source site by clicking on
it.

« Select a Target search string and Map. The Current mappings are displayed at the
bottom of the window.

« Toremove a map, select from this window and Delete map. Note that unmapped search
strings will not be imported.

25.2.4 Exchange set up

o This is where the exchange configuration files are imported and exported. A partnership
cannot be set up until these files have been exchanged.

o To export a configuration file, it has to be decided if the file will be password protected or
locked for a single site. A site locked configuration file can only be made for already
known sites.

o Choose either Password protect file or Lock for site and then select the site from the
drop-down list. If no site is in the drop-down list, a file will have to be imported first.

© Auditdata - 2022, ID: 20.0040,/29 474



User Guide

« To export this file, select Export and decided where the file should be saved. This file can
then be saved to disk or emailed to the appropriate partner.

o Toimport a file from a partner, select Import and open the file from wherever it has been
saved to. You will be asked to confirm the password that the partner will have sent you
and the configuration will be imported. At this point you will be asked if you wish to map
journal search strings in the same way as for the external site set up above.

« The Exchange identification code is used to identify a client when exchanging between
Auditbase databases. This can either be the NHS or Case note number. It is possible to
allow export without identification number, but this is mandatory for the PPP project.
Partners in the NHS project must use the NHS number as exchange identification code
when exchanging client information.

25.2.5 PPP specific set up

This feature is only available if you have a license to the PPP module. There are 3 Site
definable settings check boxes.

« Warn before creation of sessions if PPP exchange is not approved by client - A
warning will appear when adding a client to PPP list if the client has not given approval
to join the PPP.

« Block for export of clients without approved PPP exchange -

« Display warning when client with open session is selected - A warning is given each
time a client is selected that has an open PPP session.

Once the options have been selected, Save will store the information.

It is possible to add status labels for two of the system statuses, In process and Returned.
Status labels can be added by selecting the New button. The label name is then added in the
Status label field. Save will store the information and Delete will remove a Status label from
the database.

25.2.6 Session filter set up
This feature is only available if you have a license to the PPP module.

« The session filter can be set up so that the PPP list can be viewed any way that the user
wants. A new filter can be created by clicking the New button. Visible columns can be
selected by checking or un-checking the boxes. Conditions can also be added by
selecting from the Status, Public partner or Private partner drop down menus and
clicking the Add buttons.

« The order that columns appear in the PPP list can be changed by selecting a column and
then moving it up or down using the arrows. Once the filter has been set up, Save will
store the information.

« The order of filters in the drop-down list in PPP list can be changed by selecting a filter,
and then moving it up or down using the arrows. The filter on top will be the default filter
used when the PPP list is opened.
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25.3 Additions to modules
25.3.1 Client Information

The Client Information module now has an additional tab called PPP (only available with
license to PPP module). This tab contains information on the client’s PPP session status. If the
client gives permission for them to be added to the PPP list, the Approval field should be
checked.

The Sessions drop down list shows all the instances that this client has of PPP sessions.

25.3.2 Waiting List

Once a client has been selected, Export and Move to PPP become active. The client is selected
by checking the box on the left-hand side of the waiting list. All clients on the waiting list can
be selected by checking the Select all field. The number of clients selected is displayed below
this field. These selected clients can now either be moved to the PPP export list or exported
directly.

« Move to PPP - When this option is selected, a PPP session properties window is
displayed. The client’s name and NHS number are displayed as well as their approval
status. If the PPP approval given box is un-checked, it must be determined if this client
has given approval to be sent to a PPP dispenser. This field must be checked in order for
the patient to be exported. The Session status will default to new as this client is being
moved from a waiting list. The Session setup will determine which external site the
client is being sent to. Choose the Private partner from the drop-down list. The Referral
status can be selected from another drop-down list. This will indicate the referral route. If
the client is being transferred by paper only then the box should be checked. Once the
choices have been made, Save will transfer the details from the waiting list to the PPP
list.

o Export - When this option is selected, an Export data window is displayed. Clients can
be added to the export by using the Search button. Remove will take the selected client
off the list for export. The export file can either than be password protected or locked for
the particular external site. The Export configuration has to be selected from the drop-
down list. This operation can be cancelled using the Cancel button. Once Export has
been selected, you must Enter password for encryption and then re-enter to confirm.
Once Ok has been chosen, the Saveexport file window opens and the path where to
save the file can be chosen. Auditbase automatically names the file, but this can be re-
named providing the file extension remains agi. Once Save is selected, a progress bar
appears. Once the export is complete, the Export status log can be viewed or printed.
The text can be copied and pasted into another application such as Word. The export log
can be saved as a text file by selecting Save as. Close will complete the export. The
client’s details will remain on the waiting list.
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25.4 PPP list

The PPP list is open from Navigation -> PPP list.
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25.5 Exporting from the PPP list

« The session information can be displayed using the drop-down list titled Filter. These
filters are set up by the System Administrator. Clients for export must be selected by
checking the box to the left-hand side of the client’s details.

o Next to this box is a flag, this will be green if the client is ready for export. Red flag shows
that there are details missing for the export. All the clients can be selected by using the
Select all check box. The number of rows selected will be displayed. Once at least one
client has been selected, the Properties and Export buttons become active.

o Properties will display the PPP session properties window where changes can be made
to ensure the client is ready for export. The client’s name and NHS number are displayed
as well as their approval status. If the PPP approval given box is un-checked, it must be
determined if this client has given approval to be sent to a PPP dispenser. This field must
be checked in order for the patient to be exported.

o The selected client’s import/export History can be shown. The Session status can be
changed to show that the client has been exported. The Session setup will determine
which external site the client is being sent to. Choose the Private partner from the drop-
down list. The Referral status can be selected from another drop-down list. This will
indicate the referral route. If the client is being transferred by paper only then the box
should be checked.

« Once all clients are ready, the Export button should be selected, which will display the
Export clients for PPP window. This will show the Destination site, number of Clients
and the export File name. The Export configuration can be chosen, either the default
one or a particular configuration depending on the external site to which this data is
being exported. The file name can be changed by selecting the Change file name
button. The export can be cancelled or a file skipped by selecting the appropriate
buttons.

« Once the Export button is selected, a progress bar appears and then a window telling
you how many clients were successfully exported.
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25.6 Importing to the PPP li

st

Once a file has been sent to you, it must be imported to be read. Once the PPP list is opened,
select the Import button and a Client import for PPP window is displayed. Use the browse
button to find the correct file and then Import. The import file must now be found using the

browse button.

P

Client import for PPP
Import Cancel

Folder | CAUsers\ANDSHU\Deskiopt
File |

File information

Exporting site

Uszer

Date/Time

Mumber of clients in fila

Import configuration

C5V file

Generate C3V file with client demographics
Cutput file

Once the file has been found and opened, the details are displayed, including Exporting site,

User, Date/time and Number of clients in the file.
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25.7 Exporting an Import/Export data file

Clients can be added to be exported by hitting Search. When a client is selected, they are
added to be exported by pressing Add client. Remove will take the selected clients off the
export list. Multiple clients can be selected using the Shift key.

The export file can either be password protected or locked for the particular external site. The
Export configuration has to be selected from the drop-down list but can be cancelled by
pressing Cancel.

Once Export has been selected, the Password for encryption must be entered twice for
confirmation. Press OK, and a window opens to Save export file and the path where to save
the file is defined.

Auditbase automatically names the file which can be renamed providing the file extension
remains *.agi.

Pressing Save is followed by a progress bar and when this has finished, the Export status log
can be viewed or printed. The text can be copied and pasted into another application, for
instance Word. The export log can be saved as a text file by selecting Save as.

Close will complete the export.

When exporting from a waiting list, the client's data will remain in the selected list and must be
deleted when the export is initiated by moving the client. This should then also be reflected in
the client information/Alert. See Client information.
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25.8 Importing an Import/Export data file

Client import for PPP

Import Cancel

ot

Folder Cilsers\aMNDSHUNDeskiopl

File ||

File infarmation
Exporting site
User
Date/Time

Mumber of clients in file

Import configuration

SV file
Generate C3V file with client demographics
Cutput file
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26 Reports

Click the button below to access our training materials.

You can create your own reports or queries in Crystal Reports, Microsoft Query and Microsoft
Excel, and access them directly from Auditbase. Reports can be stored in sub-directories in the
correct country directory under the directory specified in Auditbase Administration ->
Workstation settings -> Other -> Path for user-defined reports. The system shows reports in
a folder-like structure corresponding to the disk sub-directories reports. This may be used for
logical reports grouping. Folders will appear under each tab on the User Reports dialog whether
they include reports of that type or not.

A CSV reporting tool tab provides reporting in a different format. Report parameters are
indicated and corresponding values must be selected in order to run the report.

When you open a Crystal Reports report, the database, user and password currently used in
Auditbase will be used for an automatic login with the ODBC data source name Auditbase -

ODBC. When using Microsoft Excel and Query, you will be prompted for login, with database
and username set in the ODBC set-up in the administration tool.

To edit a report made with Crystal Reports, you will need a full installation of Crystal Reports
Professional edition. A license for this product is not provided by Auditdata. With Auditbase
only a viewer for existing Crystal Reports 11 is provided. When Standard User reports provided
with Auditbase are saved, they are editable in Crystal Reports Version 9 Professional. However,
this version will not work on an Auditbase client PC without first installing the Crystal Reports
Service Pack 7, which can be found on the Auditbase installation disk or on the Crystal Reports
website.

To use the Microsoft Excel and Query examples you will need an installation of Microsoft Office
(or the products mentioned), in order to open the files. To open a Microsoft Query file (*.dqy) in
Microsoft Query, you will need to manually associate the file type with Microsoft Query.

Notes:
Microsoft Query editor is not installed by default by the Microsoft Office installation wizard.

When you create your own new report, you should always use the ODBC data source name
(also called DSN) Auditbase - ODBC to make sure the settings are correct. You should then
make sure your report is located in the folder specified by the system administrator.
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When you create reports in Microsoft Excel, you should be aware that Excel by default saves
the password and data with the spreadsheet. To avoid this, you should modify the properties
for the data area in the Excel sheet. With Crystal Reports, you have a similar setting under File -
> Save data with report where you should avoid saving data with the report.

If using Windows Single Sign-on to access Auditbase and you receive a log in prompt for any
report, please enter an asterisk symbol * in the user field and leave the password field empty.

Be aware

It is strongly recommended NOT to edit data in the Auditbase database from an external tool.
Errors caused by such an action are not supported by Auditdata. If you want to edit data in an
Auditbase database from an external tool, you should only do it on a database copy - never the
live database - and make sure you are actually connected to this copy before performing any
actions.
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26.1 Report examples
The following reports (specified by the UK user group) have been supplied as examples on how
to access the Auditbase database from external tools supporting ODBC.

Crystal Reports

Age of All Clients Alive

Shows the basic client data with a simple calculation of the age based on today's date and
date of birth. Only clients alive are listed.

Created with Microsoft Query.

All Client Type of Aid - Quantity Controlled

Shows the quantity controlled hearing instrument models and counts currently issued. The
report is based on stock types set up as Released.
Created with Crystal Reports.

All Client Type of Aid - Serial Number Controlled

Shows the serial number controlled hearing instrument models and counts currently used by
clients alive, in the specified date of birth range. Aids issued to clients with no registered date
of birth will not be included. The report is based on stock types set up as Released.

Created with Crystal Reports.

Appointment symbol list

Shows the Appointment symbol names and symbol id referenced from Calendar table

Appointment Type and Article

Shows the hearing instrument models and count associated with the appointment type the
client had in a certain date range.

Created with Microsoft Query and Microsoft Excel.

Duplicate lasthame, firsthame, DOB and sex

Shows groups of clients having the same last name, first name, DOB, and sex and displays
their addresses and primary codes so that merging can be considered.

Earmould Types Left

Shows the count of the different types of earmoulds for left ears made in a certain date range.
Created with Microsoft Query.
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Earmould Types Right

Shows the count of the different types of earmoulds for right ears made in a certain date range.
Created with Microsoft Query.

Earmould Types

Shows that you can have two Microsoft Queries in the same Excel sheet.

Created with Microsoft Excel.

Firstname with space character at beginning

Lists clients having a space character at the start of the name which therefore may not be
found using Firsthname as a search criteria.

Lastname with space character at beginning

Lists clients having a space character at the start of the name which therefore may not be
found using Lastname as a search criteria.

Hearing Aid Clients Male-Female-Other

Shows the distribution of gender among clients alive. Can also be used to check for typing
errors in the gender data field.

Created with Crystal Reports.

Hearing Aid Clients Gender Other List

Lists clients alive with a gender different from M (male) or F (female). Should be used to check
for typing errors in the gender data field.

Created with Crystal Reports.

Hearing Aid Type

Shows basic client data with used hearing instrument(s) born in a certain date range.

Created with Microsoft Query.

Incorrect Age

Lists all clients with a default age of less than O (negative) or greater than 110, default can be
changed. Use this report to check if you have clients with wrong D.O.B. registration.
Created with Crystal Reports.

Number of 15 Minute
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One-page report displaying the most frequently used appointments in a pie chart. This version
is ordered by the number of used 15 minutes timeslots in a certain date range. This report also
demonstrates how to use parameters in Crystal Reports.

Created with Crystal Reports.

Number of 15 Minute - Resource

Same as above, except that you can limit the appointments to those booked with a certain
resource. The resource parameter can be configured to some default values. This is site
dependent and has to be done for each site. The resource parameter must match the case
used in the database (upper case).

Created with Crystal Reports.

Number of Procedures

One-page report displaying the most frequently used appointments in a pie chart. This version
is ordered by the number of procedures booked in a specific date range. This report also
demonstrates how to use parameters in Crystal Reports.

Created with Crystal Reports.

Number of Procedures - Resource

Same as above, except that you can limit the appointments to those booked with a specific
resource. The resource parameter can be configured to some default values - this is site
dependent and has to be done for each site. The resource parameter must match the case
used in the database (upper case).

Created with Crystal Reports.

Number of referenced appointments

Appointments created with Referred by field completed.

Number of Left Earmoulds

Displays the number of earmoulds for left ears created in a specific date range.
Created with Microsoft Query.

Number of Right Earmoulds

Displays the number of earmoulds for right ears created in a specific date range.
Created with Microsoft Query.

Client List With Temporary Numbers
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Lists all clients that have been created with a temporary hospital ID. If you use a prefix different
from 'T' for your temporary hospital IDs, you will need to modify the criteria in the report.
Created with Crystal Reports, Microsoft Query and Microsoft Excel.

Referrals grouped by Treatment Type & Client's GP PCT Code

Shows summary count of client referrals between specified Start and End dates, grouped by
Client’s GP PCT Code and by Treatment type.

Referrals grouped by Treatment Type & Client's GP PCT Code - detailed

Shows summary count and individual details of client referrals between specified Start and
End dates, grouped by Client’s GP PCT Code and by Treatment type.

Post Code Extract

Lists hospital ID with post code for all clients where the Comm. Hearing Aid or the NHS Hearing
Aid check box has been checked in the Client information window, but you can modify this to
meet your wishes. This report is intended for further processing by another tool - i.e. Excel.
Created with Microsoft Query.

Furthermore, a report to view/print the schedule of a certain resource has been added as a
system report, and it can be accessed from the menu Functions->Print schedule in the
Booking screen. This report should not be modified by the user.

Activity by PCT code

Shows a table of appointments by PCT code within a date range. The PCT code is taken from
the Referring Agents (GP) table within Auditbase.

Appointment code nhumbers

Shows the appointment symbol names and their symbol id referenced from the Calendar table.

Appointments by PCT code with date range

This shows two tables of selected appointments using the code numbers obtained from the
Appointment code numbers report. The first table shows how many appointments have been
made for each PCT code. The second shows the amount of time in weeks that the
appointments have been waiting since their referral. To use this report accurately, the referral
page must be used.

Waiting list by customer with last referral using AC date

This report shows two tables of selected waiting lists using the code numbers obtained from
the Waiting list code numbers report referenced to the customer table rather than the Referring

© Auditdata - 2022, ID: 20.0040/29 487



User Guide

Agents table. The first table on the report shows how many clients are on the selected waiting
lists for each customer. The second table shows how long each client has waited on the
selected waiting lists for each customer. The wait time is calculated from the last audiogram
made for the client.

Waiting list code numbers

Shows the waiting list names and their symbol ID referenced from the waiting list table.

Waiting list printout with addresses
Shows a printout of a selected waiting list and includes the following details:

« Wait time - taken from the waiting list module.
o Hospital number

« Name and address

o Date of Birth

o Postcode

« Home phone

o Information taken from the waiting list module

Custom Report and Statistics

These reports can be accessed from the Custom reports and statistics reporting tab and will
report data in Comma Separated Values (CSV) format. For these reports, the user is able to
select the parameter values from a list of options (pre-defined in Administration).

Reports for this tab can be found in the folders:

o AQP reports
o Surgery
o CIDS reports

These include:

o AQP - Monthly full patient minimum dataset - Per piece of activity

o AQP - Monthly full patient minimum dataset - Per referral

« Hearing aid journey outcomes

« Patients access service in extended hours

« Re-fitted with hearing aid after re-assess

o Referrals with a ‘rejected’ referral outcome applied in a chosen period
o Referral with an outcome of a request to transfer provider

o Aids replaced due to mechanical failure

o Lost, damaged hearing aids

o And more.
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26.2 Running a standard user report

A series of standard reports are available in Crystal Reports, Excel or Microsoft Query report
formats.

« Navigation -> User Reports.

« Use the tabs to select a Crystal Report, Microsoft Excel, Microsoft Query or Custom
report.

o Open the relevant folder.

User reports *

Edit Open Close

Crystal Reports | Microsoft Excel | Microsoft Query | Custom reports and statistics

(C AQP reports

(I Articles

C3 CIDS reports

[Z] Data checks

(23 Hearing screening
(23 Implant

(£ Paediatric

[Z1 Referrals

(Z1 Schema Templates
(23 Surgery

[ Tests

(3 Waiting and activity

o Select the relevant report.
« Select Open or double-click the report to run it.

Crystal Reports

« You may need to press the refresh button on the report to update the report.
e Print as required.

The user reports will only work on a computer where the system administrator has enabled the
correct driver.

For advanced reports, Crystal Reports training courses can be provided. Please contact the
Auditdata Help-desk for further information.
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26.3 Running a report from the Custom reports and Statistics
tab

Select and Open the required report by double clicking it.

User reports x

Open Close

Crystal Reports | Microsoft Excel | Microsoft Query | Custom reports and statistics

[C1 AQP reports ~
. Additional follow-up availability xml

-Aftercare availability. xml

-Aids replaced due to mechanical failure after 3yr review.xml

-AQP - Monthly full patient minimum dataset - Per piece of activity xml
AP - Monthly full patient minimum dataset - Per referral xml
rAssessment to fitting time.xml

0S| questionnaire results xml

Fitting to follow up time.xml

Glasgow questionnaire results xml

Hearing aid journey outcomes.xml

Information shared.xml

101-HA questionnaire results xml

Lost, damaged hearing aids xml

Patient wearing HA at review.xml

Patients accessing semvice in extended hours.xml

Patients reached 3 years review pointxml

Personalised care planning (IMP audit based on AuditBase IMP).xml
Personalised care planning (IMP audit based on Documents).xml
Personalised care planning (IMP audit based on Journal).xml
Quicker follow-up availability.xml

Re-fitted with hearing aid after re-asses.xml A

To set up the report fill each of the mandatory parameters and whichever of the non-mandatory
parameters you want to filter your data on.

Mandatory items

The red exclamation mark alongside a parameter denotes a mandatory field. When a
mandatory field is completed, the exclamation mark will disappear from alongside it.

If you attempt to run a report without completing one or all of these parameters, a warning will
appear on screen.

Message x

‘ I Al mandatory figlds marked with 1" must be completed in order to run repart.
i oY

If you should save a report without completing one or all of these parameters, a warning will
appear on screen.
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Message *

I@I Some mandatary fields marked with " are not completed. Would you like to save the fiter without completing these?
k.

Output file name and location

Each report requires a designated name and location for the output file, which is where the
data will be saved once the report is run. On selecting the Value field for the output file the
user must browse to select the destination folder for the report output.

It will however still be possible to save the report without completing the mandatory fields.
Filling parameter values

Parameters selections are made in recognisable controls depending on the type of data, such
as dates, single selections, multi-selections, number fields, etc.

For drop-down single selections, click on the drop-down arrow for a parameter.
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Report Filters
Current filter
. Default [Default] A Save Save as ... Delete

4| Ifatleast one of report dates is not entered, the previous whole calendar month will be used.
When clicking 'Save parameters for future use’ or 'Save parameters for future use and Run report’ |+ Run report

If report start or end date is not entered, then start or end of the previous whole calendar month will be used.

Start date

6

End date

6

Holiday and working day settings, if saved, will be used also for other AQP reports.
Holiday date 1

6

Holiday date 2

=

Holiday date 3

6

Holiday date 4

6

Holiday date 5

6

Saturdays are working days
No -

Included additional GP details
No -

Parameters below are only saved for this report:

Exclude patients with alerts and parameters in list

Include only patients with alerts and parameters in list

Select the value you wish to populate that parameter.

Multi selection fields

To report on multiple values from multi-selection fields, each value is clicked on and moved to
the Selected items box using the arrows adjacent to the box. When a value is transferred to
the Selected items box that value will be reported on and anything left in the Available items

box will not be reported on.
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Report Filters
Current filter
¢ | <Mew filter= - Save Saveas ...

1 | Ifreport dates are blank, no filtering by date will be done
Run report

Enter parameter: -

[5] surgery &

Enter parameter:

Age at

Surgeon

Available items: Selected items:
AMAMDACARROLL

WMISS SE CHALSTREY

MR BASS0O

MR D GUPTA

MR JP DONNELLY »

MRS ANNAN

AddAll Remove All

Operation side

Available items: Selected items
Left
Right

AddAll Remove All

Operation number
Available items: Selected items:
<Empty value= a

EIF R CIN

Above each Selected items box is a check box titled Ignored. This remains checked until a
value is moved into the box. If values are not moved across to a Selected items box and that
box remains empty, no filtering will be done on that selection and all parameter values will be
included in the report.

Selected items:

Remaove All
Lists

If there is a list of possible values which could be used in multiple reports (such as Assessment
appointment symbols) these can be defined in Lists set up in Auditbase Administration ->
Other definitions -> Lists for report parameters.

Show List Items
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When a parameter is a list of items, you can view the items by clicking on the Show list items

button. The button will only appear when you have selected a value containing a list.

Although the list items will be shown, you cannot make changes to the list from here. This

must be done from within Auditbase Administration since the same list may be being used in

other reports and to make changes will affect all the reports it is used in.

Moved + Interprete

Close

X

| Text

[] D Deceased

1 Interprete

M Moved

[J| T Transport

[] 0 .0perated

[J HHome visit

[J/F Medical

[J ¥.Check info

[J] Research

[] Paed. client

[J| Commercial

7| July 04 - digital aid info leaflet
[] MHAS digital aid

[] NHS

[J Domiciliary patient

[]| Private

[] Paper journal

[] 02,02

[/ 09,09

[] 03,08

[J .Comm. need - Large print
[] =, Comm. need - Braille

[J] #Comm. need - Easy read

Report Filters

To save report value selections you have made, click Save. You will be asked to give the
selections a Filter name.

Save report filker

Save

Close

X

Rename the current filter

# Save as a new filter

Save to the current filter =Default=

Mame

B Save as the default filter
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Once you have done this, the report selections are saved as a named Filter and can be
accessed from the Current filter drop down list.

Multiple Report Filters

You can create differing versions of the same report and save them as Filters. To do this, open
the report you wish to adjust the parameters on. Change the values and click Save as. Give the
filter a name.

Save report filter x

Save Close

Save to the current filter =Default=
Rename the current filter

#| Save as a new filter
Name |testd |

[W] Save as the default filter

This will now be available in the Current filter drop down box along with your original report
set-up. Saving each report change as a filter will mean they are all there to be re-used in the
future. There is no need to keep re-building reports with varying values.

You can also direct Auditbase as to which report should be the default.

Save report filter >

Save Cloze

Save to the current filter =Default=

« Rename the current filter;

Save as a new filter
MName test2

W Save as the default filter

The report will always open the default report as standard.

If you have made changes to report parameters but have not saved them, you will be asked if
you wish to save them if you re-open the User reports list or exit Auditbase.

Run and refresh

The Run report button will highlight yellow as soon as a parameter is changed. This will alert
the user to the need for refreshing the existing report output. Clicking on the Run report
button will generate a new output for CSV reports.
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Report Filters
Current filter
o testz [Defauli] A Save Save as ... Delete

4 Ifatleast one of report dates is not entered, the previous whole calendar month will be used. -
When clicking "Save parameters for future use® or "Save parameters for future use and Run report’ [+

The white space to the right of the parameter lists will display the running dialogue and its
progress. If the report data is short, the dialogue will only flash onto the white area before
disappearing. A Stop button will display along with the report dialogue in order that the
process can be brought to a halt if it is taking too long to complete.

A LOG file is included in the output file in case there were errors which can be reported to
Support. If the report ran without errors, then it does not need to be retained and can be
deleted.

Once the report has completed running, the output file will open automatically in Excel.
Opening the report in Excel

The output file will open automatically in Excel.

H ©- = Extraction of StapesSurgery data and audiogram cutcome - Excel ? EH - O %
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ADD-INS Team Sona Aghayan ~
X - sert - -
[ Calbri A =E=E 8- SEwepTe General - S st E‘“""E“ = éY ik
- G rJ' | F o C‘\I & Delete - v Sort & Find &
" B I U- #. & s === &E35= EMegefiCenter - - % 0 %10 onditional Formatas Cel . ort in
4 4 ? ° " 7% Formatting - Table- Styles- 0 Formats & = oo gojeq -
Clipboard 1 Font o Alignment 7] Mumber ] Styles Cells Editing ~
D1 - S Preop Date v
A B C D E F G H | J K L M N a |-
1 |nSurgery ID Surgery date Surgery Nr|Preop Da‘te_Pustop Date Followup Date Dropout Date Earside nAge atsuAge groug Concurrer ConcProcz ConcProc: ConcProct ConcPro
2 8 10/9/2013 1 10/9/2013  10/9/2013 10/9/2013 10/9/2013 R 13 19-Oct DBADO, exc probat meatus ac ext
3 9 2/7/2014 1 2/7/2014 2/7/2014 2/7/2014 2/7/2014 R 13 19-Oct DBAOO, ex DBBOO, ex DBD20, op plast meatus ac ex
4 12 3/7/2014 2 3/7/2014 3/7/2014 3/7/2014 L 46 40- 49

Data will populate the corresponding headed columns. Empty cells will indicate there is no
corresponding information available in the patient’s record.

The CSV report once opened in Excel can be re-saved as an Excel document using the File ->
Save As option. If required it can also be renamed and/or dated to prevent overwriting by a
future report run.

Opening other reports from the Custom reports and statistics tab
To open a new report, go back to Modules -> User reports.

When you open a new report from Modules -> User reports, and another report is already
open, the back-ground screen will change. Despite this, the report screen will re-open once
your desired report has been selected.

Custom Reports and Statistics with Crystal report output
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Only in the Surgery folder will you find reports that display as Crystal reports. The Crystal report
output is displayed in the white space to the right of the report parameters.

When parameters are changed on a report, clicking the Run report button will cause the report
to be refreshed. Differences in output with modified selections can therefore be easily seen.

Crystal report output can be exported to a PDF document.
Scroll Bar

The scroll bar to the right of the report cannot recognise the size of the report and therefore will
always display as though the report is large (the scroll bar will be small). This scroll bar does
not support mouse scroll wheels.
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27 Communication
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27.1 Task list

Click the button below to access our training materials.

A task list is a list of tasks that are not completed yet, for instance new appointments. Access
the Task list module from Navigation -> Task list or press Shift+Ctrl+T.

o}) Auditbase - [Task list]
File  Functions
[ Client 7132153 MRFIRSTNAME32153 LASTNAME32153 |~| 2 55 User  SYSTEMADMINISTRATOR | Alllocations Al departments -2
Filter | Al v| [ Complsted Selectall No rows selscled | New Edit
| [ [pate createa] Tasktype | Taskiapel [ Description | Hospital no Client name Assigned [ User Completed by| Date completed
0! 040812021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAWE32 SYSTEM ADMINISTRATOR
0! 04/08/2021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAMETT SYSTEM ADMINISTRATOR
0ot 040812021 | Repair T132153 MR FIRSTNAME32153 LASTNAME32153 | USER NAME41 SYSTEMADMINISTRATOR
0ot 040812021 | Appointment T132153 VR FIRSTNAME32153 LASTNAME32153 | USER NAMEST SYSTEMADMINISTRATOR
ot 0410812021 | Repair T132153 MR FIRSTNAME32153 LASTNAME32153 | USER NAME42 SYSTEMADMINISTRATOR

o The Task list shows the tasks created by any user linked to the current location or to the

global location. Change location to filter all entries for the desired location or choose All
to see all tasks.

« When location filtering is used, tasks will appear in the locations to which both the

assignee and the assigner belong.

« Tasks assigned to me will show all your tasks to do regardless of location.

o To create a new task, click New.
Mew task x
Add client Clear client Search client Save Cancel
Client
Hospitalno.  T18767 Mame FIRSTMNAMEBTGET LASTNAMEBTET
Task "
Date 130172020 Assign
d Users
Taskiyps - | User narme -
Task label []| USER MNAME11
USER NAMEGT
Priority Normal M USER MAME44
Description - ]| USER NAME14
[ USER NAMES
[]| USER NAMES2
[]| USER NAME3S v
< >
s Resource group
User full name tests?7? - -

e Select a client.
o Click Add client to select the current client or press Alt+a for a shortcut to add the

current client. If you wish to add a different client, click Search client. Click Clear client
to create a task without associating it with a client.
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« Select Task type, for instance Appointment or Audiogram. The task types are predefined
by your System Administrator. Task types can be outdated by your system administrator
and if so they will show in Auditbase with an asterisk * but will not be selectable.

o Select Task label. The task labels are only enabled in Auditbase if defined by your
system administrator first and linked to a task type.

« Add/move sections from below on entering Assignee, date priority etc.

« The default date is set to today’s date. You can change the date manually.

« Select the person to whom you wish to assign this task. You can select one or more
resources or a resource group. Users are listed by those from the currently selected
location first.

¢ You can set the task to high, normal or low priority.

o The System Administrator can link a predefined description to the task label or you can
type a description here.

« When you have completed a task, select the check box column to the left and click
Complete.

o To delete a task, select the check box column to the left and click Delete. Deleting tasks
is a permanent action. Once deleted, tasks cannot be retrieved. The System
Administrator can control which users are permitted to delete tasks which are not created
by themselves. If a user does not have the extended user right Task list: Delete any task
they will only be able to delete tasks created by themselves.

« A warning is displayed to users when deleting tasks and includes the number of tasks
being deleted, this will mitigate the risk of users accidentally deleting tasks or deleting
more tasks than intended.

« An Auto Journal Event can be enabled for Task deletion of uncompleted tasks associated
with Clients. This can be used to ensure that a record of an uncompleted Client Task is
always kept since it can include the Task description.

From the task list view you can see the priority of a task, which can be high, normal or low:
! High priority
< Low priority

o Tofilter the task list view, select a filter from the drop-down box. You can also filter on
Completed tasks by checking the corresponding box.

« Tasks related only to the current global client can be filtered by selecting Tasks for
selected client from the filter drop down.

o The content of the filter and state of the Completed checkmark is remembered for each
user so they do not have to reapply their preferred filter.

o To edit a task, double click on the task or select the check box column to the left and
click Edit.

« When a user selects a Task on the list which is related to a different client, the System
Administrator can enable a warning to the user that the client is changing.
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« As adefault, only the creator of the task and the person assigned to the task have a right
to edit the task. However, the system administrator can give extended rights to other
users so they can edit tasks as well.

« Click Save.

« When assigning a task, the user to whom the task was assigned will be alerted. If the
task is assigned to a whole group, all resources within the group will receive an alert. The
user must be associated with a group to receive group alerts. The alert for the task will be
cleared for all resources once the first user opens the task for review. Your system
administrator can set up whether the user should be notified only at login or also on the
screen while working.

o Bulk multi selection of Tasks is done using Shift and Control buttons in combination with
the mouse click in the normal Windows method. This will highlight the chosen rows in
black which can be selected for a Delete or Complete operation by checking the Select
highlighted button which reads Select all when no rows are highlighted.

o)) Auditbase - [Task list]

File Functions

| Client 7132153 MR FIRSTNAME32153 LASTNAME32153 | -| 8 5 ]| User  SYSTEM ADMINISTRATOR | Alllocations ~ | All departments -|[fx] 2

Filter | Al ~ W Completed ‘ Select highlighted rows | New

[ [ | [oatecreated| Tasktype | Taskiavel | Description [ Hospital no Client name Assigned [ User
0! Appointment T132153 | MR FIRSTNANE USER NAME32 SYSTEM ADMINISTRATOR
0! Audiogram T132153 | MR FIRSTNA 5 |USER NAMET1. SYSTEM ADMINISTRATOR
= Audiogram T132153 | MR FIRSTNAN 153 |USER NAMEGT SYSTEM ADMINISTRATOR
0! Earmouild T132153 | MR FIRSTNA 53 |USER NAME32 SYSTEM ADMINISTRATOR
01! |04m@iz021 |Appaintment T132153 | MR FIRSTNAME32153 LASTNANE32153 |USER NAMETT SYSTEM ADMINISTRATOR
Ot Jos Repair Ti USER NAME41 TEMAD TOR
O/t Jos Appaintment Ti: USER NAMEGT TEMAD TOR
O '] [04/08/2021 |Repair T132153 | MR FIRSTNAME32153 LASTNAME32153 | USER NAME42. SYSTEMADMINISTRATOR
0| [v/|0408/2021 |Appaintment T132153 MR FIRSTNAME32153 LASTNAME32153 |USER NAMETT.. SYSTEMADMINISTRATOR
0| [v/|0408/2021 |Appaintment T132153 MR FIRSTNAME32153 LASTNANE32153 |USER NAMEGT SYSTEM ADMINISTRATOR
O ' [/ |04108/2021 |Audiogram T132153 MR FIRSTNAME32153 LASTNANE32153 |USER NAME32 SYSTEM ADMINISTRATOR
O [v/|0408:2021 |Appaintment T132153 | MR FIRSTNAME32153 LASTNANE32153 |USER NAME32 SYSTEM ADMINISTRATOR
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27.2 Auditbase Viewer

The Viewer enables a user to view a client’s articles and audiograms. The user is not allowed to
enter any client data.

The Viewer is typically used as an interface application between a central Client Journal system
and Auditbase.

« Start the Viewer from the desktop icon.
o Log in with username and password.

You can also start the Viewer from the command line or from external application launch
facilities in third party applications in the following way:

o To start the program only by logging in:

o Viewer.exe - DBNAME:xxx-USERID:xxx-PASSWORD:xxx

o To start the program only by logging in and by pre-selecting a client:

o Viewer.exe - DBNAME:xxx-USERID:xxx-PASSWORD:xxx- CODE_P:xxx-CODE_S:xxxx
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27.3 General notes and daily notes

Both General notes and Daily notes are resource specific. General notes will be seen every day
until they are deleted. Daily notes will only appear for that particular day.

« Notes may be entered by clicking either General or Daily on the booking screen while

having selected a resource.

o To save the note, close the window and click Yes when prompted to save.

o The resource name in the resource list will now appear in red. To see the note, select the
resource and click Daily note/General note.

o The resource will also be alerted of the note with an alert, either at login or on screen
while working. Settings for this function are done by your system administrator.

503
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28 Technical Information
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28.1 Installation and Set-Up

For minimum and recommended client and server specifications, please refer to the Auditbase
Server and Client Specification.

For full step by step guidelines on how to install Auditbase System, please refer to the
Auditbase Complete Install Guide.

505
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28.2 Symbols Used on the System and in Documentation

Symbols are used on the system and in the documentation in places where this is required by
regulations or where it is simply more convenient due to space restrictions.

You can find an overview of the symbols used on packaging. Also, see below.

A General Warnings

c 60123 CE-notified body

506
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29 Manufacturer and System Data

The SaMD Auditbase System is manufactured and sold in the EU by:

Auditdata A/S
Wildersgade 10B
1408 Kgbenhavn K
Denmark

Phone: +45 70203124

www.auditdata.com

0123

2003 Manage Auditbase Audiogram module MDR Class lIb Rule 11
2003 Manage Auditbase Implant module MDR Class llb Rule 11
2003 Manage Auditbase Surgery module MDR Class lla Rule 11
2003 Manage Auditbase ABR/OAE module MDR Class lla Rule 11

2003 Manage Auditbase Questionnaire module MDR Class lla Rule 11

Documentation version:

Auditbase Help System version 20.0040/29

Symbols used on the system, its packaging, and in documentation:

See the section "Safety instructions and warnings" for an overview of symbols used.
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